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d'extension d'accès » page 532
■ Modifications de capacité de bibliothèque de 

bandes sans interruption. Voir « Modifications 
de capacité sans interruption » page 222. 

■ Partitionnement sans interruption. Voir 
« Partitionnement sans interruption » 
page 285. 

■ Messages d'alerte d'état. Voir « Messages 
d'alerte d'état » page 75. 
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EC001137
suite

Mai 2009 AB ■ Rapports Energy Monitor de la bibliothèque 
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■ « Affichage du rapport « Last 24 Hours » 
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Library Energy Monitor » page 120
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Library Energy Monitor » page 122

AA ■ Rapports d'événements de lecteur et de 
support. Voir les éléments suivants :

■ « Affichage du rapport Media Events » 
page 155

■ « Affichage du rapport Drive Events » 
page 168 

■ « Affichage du rapport Drive Media 
Events » page 170 

■ Consigner un journal d'instantané. Voir les 
éléments suivants :

■ « Fichier d'instantané de journal de 
bibliothèque de bandes » page 429

■ « Transfert du fichier d'instantané du 
journal de la bibliothèque de bandes » 
page 449

EC Date Révision Description
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Préface

Le présent guide s'adresse essentiellement aux administrateurs système et aux 
opérateurs de la bibliothèque de bandes SL3000. Il peut également être utilisé par 
les partenaires et les représentant du support techniques de Sun StorageTek. 

La majorité des informations concerne la bibliothèque de bandes, la Console de la 
bibliothèque de bandes StorageTek et les opérations connexes. Pour obtenir des 
informations spécifiques sur les lecteurs ou connaître les commandes des applications 
logicielles clientes, consultez la documentation des lecteurs ou des logiciels appropriée. 

Organisation

Chapitre 1 Introduction à la bibliothèque de bandes SL3000. Présentation des caractéristiques et 
des fonctions du système de bibliothèque modulaire SL3000 Sun StorageTek. 

Chapitre 2 StorageTek Console de la bibliothèque de bandes. Rubriques et procédures 
relatives à l'installation et à l'utilisation de l'interface graphique utilisateur de la 
Console d'administration StreamLine Library. 

Chapitre 3 Mode opératoire de la bibliothèque de bandes SL3000. Rubriques et procédures 
relatives à l'utilisation de la Console d'administration StreamLine Library afin de 
configurer, gérer et contrôler la bibliothèque de bandes SL3000 en mode automatisé. 

Chapitre 4 Gestion des licences. Rubriques et procédures relatives à l'installation et à la gestion 
des licences des fonctionnalités de la bibliothèque de bandes SL3000. 

Chapitre 5 Capacity on Demand. Rubriques et procédures relatives à l'installation et à la gestion 
des licences d'utilisation des cellules de stockage de la bibliothèque de bandes SL3000.

Chapitre 6 Partitionnement de la bibliothèque de bandes. Rubriques et procédures relatives à 
l'installation et à la gestion du partitionnement de la bibliothèque de bandes SL3000.

Chapitre 7 Utilitaires et procédures de diagnostic de la console d'administration StreamLine 
Library. Rubriques et procédures relatives à l'utilisation de la Console d'administration 
StreamLine Library afin d'exécuter des fonctions de diagnostic et d'utilitaire sur la 
bibliothèque de bandes SL3000. 

Chapitre 8 Utilisation en mode manuel. Rubriques et procédures relatives à l'utilisation de la 
bibliothèque de bandes SL3000 en mode manuel en toute sécurité. 
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Messages d'alerte
Les messages d'alerte attirent votre attention sur des informations d'une importance 
capitale ou sur des informations qui portent sur le texte ou le graphique principal.

Remarque – Une remarque donne des informations supplémentaires tout 
particulièrement intéressantes. Une remarque peut signaler des exceptions à des règles 
ou des procédures. 

Mise en garde – Une mise en garde informe le lecteur des conditions susceptibles 
d'endommager le matériel, de corrompre les données et l'application logicielle, ou 
d'entraîner des problèmes de santé à long terme. Une mise en garde précède toujours 
les informations auxquelles elle se rapporte.

Avertissement – Risque de blessure physique.  Un avertissement alerte le 
lecteur sur des conditions susceptibles de provoquer des blessures ou le décès de 
l'utilisateur. Un avertissement précède toujours les informations auxquelles il se 
rapporte.

Annexe A Adresses des composants de la bibliothèque de bandes. Informations sur l'adressage 
des cellules de stockage, des port d'accès aux cartouches (CAP) et des lecteurs utilisés 
avec la bibliothèque de bandes SL3000. 

Annexe B Diagramme des murs. Diagramme détaillé de l'agencement des cellules de stockage, 
des port d'accès aux cartouches (CAP) et des lecteurs. 

Annexe C Manipulation des cartouches. Informations sur l'étiquetage et la manipulation des 
cartouches de la bibliothèque de bandes SL3000. 

Annexe D Serveur de la Console d'administration StreamLine Library Web. Rubriques et 
procédures relatives à l'installation et à la configuration du serveur  Web nécessaire à 
la Console d'administration StreamLine Library Web. 

Index Liste alphabétique des rubriques du présent manuel.
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Conventions
Les conventions typographiques mettent en relief des mots, des expressions et des 
actions spécifiques dans cette publication.

Élément Exemple Description de la convention

Boutons MENU La police et l'emploi des majuscules sont 
identiques à ceux utilisés sur l'étiquette 
du produit

Commandes Mode Select Majuscule initiale

Titres de documents Guide d'assurance du 
système

Police italique

Emphase pas ou doit Police italique

Noms de fichiers fsc.txt Police à espacement constant

Liens hypertexte Figure 2-1 à la page 2-5 Bleu (en noir dans les publications 
papier)

Indicateurs Open La police et l'emploi des majuscules sont 
identiques à ceux utilisés sur l'étiquette 
du produit

Noms de cavaliers TERMPWR Majuscules uniquement

Touches de clavier <O> 
<Entrée> ou 
<Ctrl+Alt+Suppr>

La police et l'emploi des majuscules sont 
identiques à ceux utilisés sur l'étiquette 
du produit ; entre crochets obliques

Noms de menus Menu Configuration L'emploi des majuscules est identique à 
celui utilisé sur l'étiquette du produit

Paramètres et variables Périphérique = xx Police italique

Noms de chemins d'accès c:/mydirectory Police à espacement constant

Noms de ports ou de 
connecteurs

SER1 La police et l'emploi des majuscules sont 
identiques à ceux utilisés sur l'étiquette 
du produit ; sinon, uniquement des 
majuscules

Positions des disjoncteurs, des 
cavaliers et des commutateurs

MARCHE La police et l'emploi des majuscules sont 
identiques à ceux utilisés sur l'étiquette 
du produit ; sinon, uniquement des 
majuscules

Texte à l'écran (y compris les 
captures d'écran, les messages 
d'écran et la saisie utilisateur)

téléchargement Police à espacement constant

Noms de commutateurs Alimentation La police et l'emploi des majuscules sont 
identiques à ceux utilisés sur l'étiquette 
du produit

URL http://www.sun.com Bleu (en noir dans les publications 
papier)
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Documentation connexe

Publications relatives au système de bibliothèque modulaire SL3000 Numéro de référence

SL3000 Systems Assurance Guide 3161941xx

SNMP Guide for SL3000 Libraries 3161945xx

SL3000 Troubleshooting Guide 4186091xx

Documentation sur les lecteurs de bande Numéro de référence

Hewlett Packard Ultrium Tape Drive Manual CD inclus avec le lecteur 

IBM Ultrium Tape Drive Manual CD inclus avec le lecteur

T10000 Tape Drive Installation Manual 96173

T10000 Tape Drive Service Manual 96175

T10000 Virtual Operator’s Panel User’s Guide (pour les représentants du 
service technique)

96180

T9840 Tape Drive User’s Reference Manual 95739

T9x40 Tape Drive Installation Manual 95879

T9x40 Tape Drive Service Reference Manual 95740

Publications relatives au logiciel de gestion des bibliothèques de bandes Numéro de référence

Automated Cartridge System Library Software (ACSLS) 

ACSLS Administrator’s Guide 3161201xx

ACSLS Messages 3161202xx

ACSLS Quick Reference 3161204xx

Publications Host Software Component (HSC) MVS

HSC Configuration Guide 3126422xx 

HSC Messages and Codes Guide 3126425xx 

HSC Operator’s Guide 3126423xx 

HSC Reference Summary Guide 3126426xx 

HSC System Programmer’s Guide 3126424xx 
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Autres publications Numéro de référence

Product Regulatory and Safety Compliance Manual 3161956xx

American National Standard Dictionary for Information Processing Systems ANSI X3/TR-1-82

American National Standard Magnetic Tape and Cartridge for Information 
Interchange 

ANSI X3B5/87-009

Magnetic Tape Labels and File Structure for Information Interchange ANSI X3.27-1978

SCSI-3 Parallel Interface (SPI) ANSI X3T9.2/91-010R7

Small Computer System Interface ISO 9316:1989

Fibre Optics User's Guide 9433

Lien vers des publications

SunSolve ou docs.sun.com
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Informations supplémentaires
Sun Microsystems, Inc. (Sun) vous permet d'obtenir des informations supplémentaires 
selon plusieurs méthodes. 

Site Web externe de Sun 
Le site Web externe de Sun fournit des informations de type marketing ou relatives aux 
produits, à des événements, à l'entreprise et aux services disponibles. Il est accessible à 
toute personne disposant d'un navigateur Web et d'une connexion Web.

L'URL est la suivante : http://www.sun.com 

L'URL menant à des informations spécifiques de la marque Sun StorageTek est la 
suivante : 

http://www.sun.com/storagetek 

SunSolve et liens utiles
SunSolve et les liens Sun ci-dessous présentent des sites Web qui permettent aux 
membres d'effectuer des recherches via divers supports, tels que des documents 
techniques, des téléchargements, des correctifs, des fonctionnalités, des articles et le 
manuel Sun System Handbook.

■ Téléchargements du microprogramme de la bibliothèque de bandes et du code de la 
Console d'administration StreamLine Library :

http://http://www.sun.com/download/index.jsp 

■ Pilotes : http://www.sun.com/download/index.jsp 

■ Documentation (client) : http://docs.sun.com/app/docs 

■ Informations générales sur les produits :

http://www.sun.com/storagetek/products.jsp 

■ Site externe SunSolve : http://sunsolve.sun.com 

■ Sun System Handbook (client) :

http://sunsolve.sun.com/handbook_pub/validateUser.do?target=
index 

■ Sun Learning Services : Formation : http://www.sun.com/training 
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Site des partenaires
Le site des partenaires Sun StorageTek s'adresse aux personnes ayant signé un contrat 
de partenariat StorageTek. Ce site donne des informations sur les produits, les services, 
le support client, les événements à venir, les programmes de formation et les outils de 
vente afin de soutenir les partenaires StorageTek. L'accès à ce site est restreint. Dans la 
page Connexion des partenaires, les employés et les partenaires actuels de Sun qui ne 
possèdent pas de droits d'accès peuvent demander un ID de connexion et un mot de 
passe, et les partenaires potentiels peuvent déposer une demande pour devenir 
revendeurs StorageTek. 

http://www.sun.com/partners 
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CHAPITRE 1

Introduction à la bibliothèque de 
bandes SL3000 

La bibliothèque de bandes SL3000 constitue la dernière-née de la gamme des systèmes 
de bibliothèque modulaire Sun StorageTek regroupant notamment les systèmes de 
bibliothèque modulaire SL500 et SL8500. 

FIGURE 1-1 Système de bibliothèque modulaire SL3000

Ce chapitre présente la bibliothèque de bandes SL3000, ses composants et ses 
configurations, notamment dans le cadre des rubriques suivantes :

■ « Fonctionnalités de la bibliothèque de bandes SL3000 » page 3

■ « Conception modulaire » page 4

■ « Module de base » page 8

■ « Module d'extension de lecteur » page 11

■ « Module d'extension de cartouche » page 14

■ « Module d'extension de stockage » page 16

■ « Module d'extension d'accès » page 17

■ « Lecteurs de bande » page 19

■ « Port d'accès aux cartouches (CAP) » page 21

■ « Bras robotisés » page 22

■ « Options d'alimentation » page 25
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■ « Refroidissement » page 26

■ « Interfaces » page 27

■ « Logiciel de gestion de la bibliothèque de bandes » page 32

■ « Modes de fonctionnement » page 34
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Fonctionnalités de la bibliothèque de 
bandes SL3000 
La bibliothèque de bandes SL3000 offre les avantages suivants : 

■ Capacité de stockage évolutive, de 200 à 5 821 cellules de stockage 

■ Une performance de 1 à 56 lecteurs de bande 

■ Mixité de différentes technologies de lecteurs de bande

■ Any cartridge, Any slot™ : cellules de stockage banalisées 

■ Support d'environnements hétérogènes 

■ Différentes possibilités de gestion des logiciels 

Le système de bibliothèque modulaire SL3000 a été conçu dans l'optique suivante : 

■ Répondre aux besoins de stockage de bandes modulaires pour les systèmes ouverts 
de taille moyenne et pour les environnements « mainframe/enterprise » de petite et 
moyenne taille 

■ Occuper une place au sol réduite. Dimensions générales : 

■ Hauteur : 198 cm (78 pouces) 

■ Profondeur : 124 cm (48,8 pouces) 

■ Longueur : entre 91,5 cm (36 pouces) pour un module et 478 cm (188 pouces) pour 
six modules 
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Conception modulaire 
La bibliothèque de bandes SL3000 est un système de conception modulaire et évolutif 
permettant aux clients de répondre aux exigences d'un environnement en constante 
évolution et en perpétuelle croissance. 

Modules 
Il existe cinq types de module dans une bibliothèque de bandes SL3000. Seul le module 
de base est nécessaire. 

■ Module de basee – un seul 

■ Module d'extension de lecteur Module d'extension de lecteur (DEM) : un seul par 
bibliothèque, toujours installé à gauche du module de base 

■ Module d'extension de cartouche Module d'extension de cartouche (CEM) : jusqu'à 
huit au total, quatre maximum sur la partie gauche du module de base (et du DEM 
en option) et quatre maximum sur la partie droite

■ Module d'extension de stockage Module d'extension de stockage (PEM, Parking 
Expansion Module) : toujours installé par paires, une à chaque extrémité de la 
bibliothèque de bandes 

■ Module d'extension d'accès Module d'extension d'accès (AEM) : un ou deux, 
toujours installé à l'extrémité de la bibliothèque de bandes. 

Remarque – Les AEM et les PEM ne peuvent pas être installés dans la même 
bibliothèque de bandes. 

Les modules se composent de façades, de colonnes et de lignes qui contiennent les 
cellules de stockage de cartouches, les lecteurs de bande, les ports d'accès aux 
cartouches (CAP) et les unités robotiques (TallBot). 

Technologie CenterLine
La conception modulaire de la bibliothèque de bandes SL3000 fait appel à la 
technologie CenterLine pour équilibrer les déplacements robotiques et améliorer les 
performances de la bibliothèque de bandes. La partie gauche du module de base tient 
lieu de point milieu (centerline). Vous pouvez ajouter d'autres modules à gauche et à 
droite du module de base. Les colonnes situées à droite du point milieu comportent des 
numéros positifs (+) et celles à gauche des numéros négatifs (-). 

La FIGURE 1-2 page 5 illustre le point milieu (centerline) de la bibliothèque de bandes 
et certaines configurations possibles, notamment : 

■ Module de base seulement 

■ Module de base et module d'extension de lecteur (DEM) 

■ Ajout de modules d'extension de cartouche (CEM) et de modules d'extension de 
stockage (PEM) 
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FIGURE 1-2 Configurations de la bibliothèque de bandes autour du point milieu (centerline) 

Configurations à partir du module de base 
Configurations à partir du module de base et du 

module d'extension de lecteur
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Technologie Any cartridge, Any slot™
Les cellules de stockage de cartouches de la bibliothèque de bandes SL3000 
sont banalisées. La technologie Sun StorageTek Any cartridge, Any slot permet 
d'accommoder une grande variété de types de support sans modifier ou reconfigurer 
pour autant la bibliothèque de bandes et sans dédier des cellules de stockage à une 
technologie de cartouche. 

Les cartouches reposent à plat. Elles sont placées dans les cellules de stockage 
parallèlement au sol, le noyau vers le bas. Pour éviter qu'elles ne glissent, les cartouches 
sont maintenues en place par des clips de fixation internes. 

Capacités physiques 
La bibliothèque de bandes SL3000 est évolutive, avec des capacités de stockage 
physique allant de 200 à 5 821 cellules de stockage. De plus, la fonctionnalité Capacity 
on Demand (Capacité à la demande) vous permet d'installer plus de capacité en ne 
payant que la capacité que vous utilisez réellement. L'extension de la capacité se fait 
alors avec une perturbation minimale de la disponibilité de la bibliothèque de bandes. 

Voir Chapitre 5, « Capacity on Demand » page 217 pour des détails sur l'installation et 
la gestion de la capacité de stockage de la bibliothèque de bandes. 

Voir le TABLEAU 1-1 page 7 pour des informations détaillées sur les capacités 
physiques de chaque type de module. Pour calculer le nombre total de cellules de 
stockage accessibles pour une configuration, commencez par le nombre de cellules de la 
configuration standard, indiqué par une bordure épaisse, puis ajoutez ou retranchez le 
nombre de cellules suivant les options ou les configurations choisies. Voici quelques 
exemples :

■ Module de base avec panneau opérateur, un module d'extension de stockage installé 
sur la droite et trois baies de lecteurs : 

320 + 0 + 13 – 55 – 60 = 218 

■ DEM avec un module d'extension de stockage installé sur la partie gauche, une 
fenêtre, un CAP et quatre baies de lecteurs : 

410 + 88 + 23 – 77 – 66 – 72 – 78 = 228

■ CEM installé sur la partie gauche du point milieu (centerline), un module installé sur 
la partie gauche et un CAP :

516 + 104 – 78 = 542

■ PEM (toujours installés par paire), un (module installé à gauche du point milieu) 
avec un CAP et l'autre (module installé à droite du point milieu) sans :

308 + 312 – 78 = 542 

Détection d'incendie/de fumée (facultative)
Des points d'accès situés dans les plafonds des modules sont destinés à recevoir des 
appareils d'extinction des incendies ou de détection de fumée (facultatifs) L'installation 
et la maintenance de ces appareils doivent être organisées par le client.
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TABLEAU 1-1 Nombre de cellules physiques accessibles par module

Autonome ou 
indépendant 

de la position

Module adjacent
installé sur la partie :

Options de modules Droite Gauche
Nombre 

total

Module de base

Standard (avec fenêtre), autonome 320
+13 +88

Avec panneau opérateur +0

Avec cellules de stockage à la 
place de la fenêtre 

+23

Avec une deuxième baie de 
lecteurs

-55 -66

Avec une troisième baie de lecteurs -60 -72

Module d'extension de lecteur (DEM)

Standard (avec fenêtre et sans CAP) — 410 +88

Avec cellules de stockage à la 
place de la fenêtre

— +23

Avec CAP — -77

Avec une deuxième baie de lecteurs — -55 -66

Avec une troisième baie de lecteurs — -60 -72

Avec une quatrième baie de 
lecteurs

— -65 -78

Module d'extension de cartouche (CEM)

Standard (sans CAP), à gauche du 
point milieu (centerline) 

516 +0 +104

Standard (sans CAP), à droite du 
point milieu (centerline) 

620 +0 +0

Avec CAP -78

Module d'extension de stockage (PEM)

Standard (sans CAP), à gauche du 
point milieu (centerline)

308

Standard (sans CAP), à droite du 
point milieu (centerline)

312

Avec CAP -78

Module d'extension d'accès (AEM)

Ne peut être utilisé pour un 
stockage à long terme 

0

Nombre total de cellules de stockage accessibles 
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Module de base 
Le module de base permet le stockage des cartouches et accueille de un à huit lecteurs 
de bande. Ce module inclut des configurations d'alimentation, des unités robotiques, 
des modules électroniques, le port d'accès aux cartouches (CAP), des cellules de 
stockage des cartouches, des lecteurs de bande et des commandes. Il centralise 
l'infrastructure pour tous les autres modules de la bibliothèque de bandes. 

L'installation de chaque bibliothèque de bandes ne nécessite qu'un seul module de 
base.

FIGURE 1-3 Module de base : vue avant

Configurations Capacité 

8 lecteurs 
16 lecteurs 
24 lecteurs 

8 lecteurs, CAP 
16 lecteurs, CAP 
24 lecteurs, CAP 

Voir le 
TABLEAU 1-1 

page 7. 

8 lecteurs, CAP et panneau opérateur/fenêtre 
16 lecteurs, CAP et panneau opérateur/fenêtre 
24 lecteurs, CAP et panneau opérateur/fenêtre 

Dimensions Mesures 

Hauteur 197 cm (77,625 pouces) à 
200 cm (78,63 pouces) hauteur maximale 

Largeur  76,76 cm (30,22 pouces) sans capots1

91,5 cm (36 pouces) avec capots 

Profondeur 121,9 cm (48 pouces) sans poignées
124 cm (49 pouces) avec poignées 

Poids 265 kg (584 livres), structure uniquement 

Dégagement pour le 
service technique 

Les deux portes 
ouvertes 

Avant : 46 cm (18 pouces) 
Arrière : 81 cm (32 pouces) 
262 cm (103 pouces) 

Dégagement 
latéral2

Refroidissement : 5 cm (2 pouces) 
Installation : 91 cm (36 pouces) 

Remarques : 
1. Lorsque des modules supplémentaires sont installés, les capots 

sont retirés du module de base et remis aux extrémités du 
dernier module de la chaîne. 

2. Indispensable pour l'installation ou le retrait des capots 
latéraux ; ils s'escamotent et s'enlèvent des crochets. 



Module de base

418605501 • Révision AB Chapitre 1 Introduction à la bibliothèque de bandes SL3000 9

La partie avant du module de base comporte les composants suivants : 

■ Port d'accès aux cartouches (CAP) unique, de 26 cartouches, double magasin 

■ Porte de service pour l'accès à la bibliothèque de bandes 

■ Panneau avant muni de trois DEL : Library Active (Bibliothèque de bandes active), 
Service Required (Dépannage requis) et Wait (Patienter). 

■ Fenêtre de visualisation standard, pouvant être remplacée par l'une des options 
suivantes :

■ Panneau opérateur (panneau tactile) 

■ Cellules de stockage de cartouches

Le module de base peut contenir jusqu'à 24 lecteurs de bande dans toutes les 
combinaisons prises en charge par la bibliothèque de bandes  voir « Lecteurs de 
bande » page 19 pour obtenir une liste et une description. La configuration minimale 
comprend une seule baie de lecteurs pouvant contenir entre un et huit lecteurs. Il 
est possible d'ajouter deux baies de lecteurs supplémentaires pour accueillir 8 ou 
16 lecteurs supplémentaires, jusqu'à un maximum de 24 lecteurs. 

Remarque – L'ajout d'une baie de lecteurs supprime environ 55 à 72 cellules de 
stockage supplémentaires, selon la configuration de la bibliothèque de bandes. Voir 
le TABLEAU 1-1 page 7 pour connaître le nombre exact. 

Voir la FIGURE 1-4 page 10 pour une vue arrière du module de base. La porte arrière 
permet d'accéder aux éléments suivants :

■ Module de contrôle de système électronique (ECM) 

■ Unités de distribution de courant (PDU) 

■ Alimentations CC 

■ Lecteurs de bande 

■ Deux espaces de rack d'une unité (1 unité = 44,5 mm [1,75 pouces]) pour le montage 
vertical du matériel auxiliaire, par exemple des commutateurs Ethernet 

Remarque – Le module de base ne comporte pas d'espace de rack de 47,5 pouces 
universel. 

Voir FIGURE B-1, « Façades du module de base » page 526 pour un diagramme détaillé 
de l'agencement des façades. 
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FIGURE 1-4 Module de base : dessin de la vue arrière 

Description 

Alimentations CC des unités robotisées 
■ DCPS 1 et 2 ou 3 

Première baie de lecteurs (haut)
La première baie de lecteurs est 
standard.
Les baies de lecteurs sont ajoutées de 
haut en bas. 


Deuxième baie de lecteurs (centre) 





Troisième baie de lecteurs (bas) 



Module de contrôle de système 
électronique 

Cartes HBC et HBT 
Carte Fibre Channel MPU2 (non 
illustrée)
Deux alimentations cPCI 
Deux ventilateurs de refroidissement 
Deux interrupteurs d'alimentation (N+1 
et 2N)

Unités de distribution de courant CA 
(deux maximum)

■ PDU 1 et PDU 2 

Alimentations CC des lecteurs (huit 
maximum) 

■ DCPS 4 à 11 



Module d'extension de lecteur

418605501 • Révision AB Chapitre 1 Introduction à la bibliothèque de bandes SL3000 11

Module d'extension de lecteur 
Le module d'extension de lecteur (DEM) optionnel apporte à la bibliothèque de bandes 
des emplacements pour des lecteurs de bande et une capacité de stockage de cartouches 
supplémentaires. Un seul DEM peut être inclus dans l'installation d'une bibliothèque de 
bandes. Le DEM est toujours installé à gauche du module de base. 

FIGURE 1-5 Module d'extension de lecteur : vue avant

Configurations Capacité 

8 lecteurs 
16 lecteurs 
24 lecteurs 
32 lecteurs 

8 lecteurs, CAP 
16 lecteurs, CAP 
24 lecteurs, CAP 
32 lecteurs, CAP 

Voir le 
TABLEAU 1-1 

page 7. 

8 lecteurs, CAP et cellules de stockage suppl. 
16 lecteurs, CAP et cellules de stockage suppl. 
24 lecteurs, CAP et cellules de stockage suppl. 
32 lecteurs, CAP et cellules de stockage suppl. 

Dimensions1 Mesures 

Hauteur 197 cm (77,625 pouces) à 
200 cm (78,63 pouces)

Largeur 
DEM seulement
Module de base et 
DEM 

 
76,76 cm (30,22 pouces) 
168,2 cm (66,22 pouces) avec capots2

Profondeur 121,9 cm (48 pouces) sans poignées
124 cm (49 pouces) avec poignées 

Poids 265 kg (584 livres), structure uniquement 

Dégagement pour le 
service technique 

Les deux portes 
ouvertes 

Avant : 46 cm (18 pouces) 
Arrière : 81 cm (32 pouces) 
262 cm (103 pouces) 

Dégagement 
latéral3 

Refroidissement : 5 cm (2 pouces) 
Installation : 91 cm (36 pouces) 

Remarques : 
1. Les dimensions du DEM sont les mêmes que celles du module 

de base. 
2. Lorsque des modules supplémentaires sont installés, les capots 

sont retirés du module de base et remis aux extrémités du 
dernier module de la chaîne. 

3. Indispensable pour l'installation ou le retrait des capots 
latéraux ; ils s'escamotent et s'enlèvent des crochets. 
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La partie avant du DEM laisse de l'espace pour les composants suivants : 

■ Porte de service pour l'accès à la bibliothèque de bandes (standard) 

■ Panneau avant muni de trois DEL : Library Active (Bibliothèque de bandes active), 
Service Required (Dépannage requis) et Wait (Patienter) 

■ Port d'accès aux cartouches (CAP) deux magasins de 13 cartouches (optionnel) 

■ Fenêtre de visualisation standard, pouvant être remplacée par l'une des options 
suivantes :

■ Panneau opérateur tactile, s'il n'est pas déjà installé dans le module de base 

■ Cellules de stockage de cartouches

Le DEM est doté en standard d'une baie de lecteurs pouvant accueillir jusqu'à huit 
lecteurs de bande. Les baies de lecteurs du DEM peuvent être augmentées (facultatif) 
jusqu'à un maximum de 4 baies, soit 32 emplacements de lecteur. 

Remarque – L'ajout d'une baie de lecteurs supprime environ 55 à 78 cellules de 
stockage supplémentaires, selon la configuration de la bibliothèque de bandes. Voir 
le TABLEAU 1-1 page 7 pour connaître le nombre exact. 

Un système d'alimentation supplémentaire est intégré au DEM afin de prendre en 
charge les lecteurs de bande supplémentaires. 

Voir la FIGURE 1-6 page 13 pour une vue arrière du DEM. La porte arrière permet 
d'accéder aux éléments suivants :

■ Lecteurs de bande 

■ Alimentations CC des lecteurs

■ Unités de distribution de courant CA (PDU)

Voir FIGURE B-2, « Façades du module d'extension de lecteur » page 527 pour un 
diagramme détaillé de l'agencement des façades. 
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FIGURE 1-6 Module d'extension de lecteur : dessin de la vue arrière 

Description 


Première baie de lecteurs (haut)
La première baie de lecteurs est 
standard. 

Les baies de lecteurs sont ajoutées 
de haut en bas.

Deuxième baie de lecteurs 





Troisième baie de lecteurs 





Quatrième baie de lecteurs 





Unités de distribution de courant 
CA (deux maximum) 

■ PDU 3 et PDU 4 

Alimentations CC des lecteurs (huit 
maximum) 

■ DCPS 15 à 22 
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Module d'extension de cartouche 
Le module d'extension de cartouche (CEM) en option permet d'augmenter le nombre 
de cellules de stockage. Ce module ne comporte aucun lecteur de bande. Huit CEM 
maximum peuvent être installés dans une bibliothèque de bandes.

Les conseils qui suivent permettent d'accroître l'efficacité de la bibliothèque de bandes : 
■ Il est conseillé d'équilibrer les CEM en installant un CEM alternativement à droite et 

à gauche du module de base (et du DEM si installé). Ceci permet d'optimiser le 
déplacement des unités robotiques. Le premier CEM s'installe à la droite du module 
de base. 

■ Si des bras robotisés (TallBot) sont installés à des fins de redondance, les deux CEM 
installés en bout de la bibliothèque de bandes sont convertis en modules d'extension 
de stockage (PEM). Les zones ainsi constituées permettent aux TallBot de ne pas se 
croiser. 

Chaque CEM ajoute jusqu'à 620 cellules de stockage physique de cartouches de 
données. La capacité varie selon la direction d'augmentation (gauche ou droite) et selon 
si un CAP est ou non présent. 
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Voir FIGURE B-3, « Façades du module d'extension de cartouche » page 529 pour un 
diagramme détaillé de l'agencement des façades. 

FIGURE 1-7 Module d'extension de cartouche avec module de base 

         Module de base     |               CEM

Configuration 
(en regard du module de base avec 
24 lecteurs) Capacité 

CEM (étendu vers la gauche) 
CEM avec CAP en option (gauche) Voir le 

TABLEAU 1-1 
page 7. CEM (étendu vers la droite) 

CEM avec CAP en option (droite) 

Dimensions Mesures

Hauteur 197 cm (77,625 pouces) à 200 cm 
(78,63 pouces) hauteur maximale 

Largeur 76,75 cm (30,22 pouces) sans 
capots1

Le capot ajoute 7,62 cm (3 pouces) 

Profondeur 80 cm (31,5 pouces) 

Poids 175 kg (385 livres), structure 
uniquement

Dégagement 
latéral2 

Refroidissement : 5 cm (2 pouces) 
Installation : 91 cm (36 pouces) 

Dégagement pour 
le service techni-
que, avant et ar-
rière 

Aucun requis 

Remarques : 
1. Lorsque des modules supplémentaires sont installés, 

les capots sont retirés du module de base et remis 
aux extrémités du dernier module de la chaîne. 

2. Indispensable pour l'installation ou le retrait des 
capots latéraux ; ils s'escamotent et s'enlèvent des 
crochets. 
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Module d'extension de stockage 
Les modules d'extension de stockage (PEM) en option offrent une capacité de cellules 
de stockage supplémentaires, ainsi qu'un espace permettant de stocker un bras robotisé 
ou TallBot défectueux en vue de son dépannage. L'espace de stockage rend inaccessible 
les trois colonnes de cellules les plus à l'extérieur des façades avant et arrière. Les 
cellules inaccessibles peuvent être retirées du module ou bien installées pour convertir 
ultérieurement le PEM en CEM. Les PEM n'incluent pas de lecteurs de bande. 

Les PEM sont utilisés uniquement avec des bras robotisés (TallBot) redondants. Ils sont 
toujours installés par paires. Les PEM doivent être les derniers modules des parties 
droite et gauche de la bibliothèque de bandes. 

Remarque – Les AEM et les PEM ne peuvent pas être installés dans la même 
bibliothèque de bandes. 

Voir FIGURE B-4, « Façades du module d'extension de stockage » page 531 pour un 
diagramme détaillé de l'agencement des façades. 

FIGURE 1-8 Module d'extension de stockage (PEM) 

Configuration Capacité 

PEM (installé à gauche) 308 cellules
PEM (installé à droite) 312 cellules 
CAP : 78 cellules
Installés par paires pour la fonctionnalité des 
TallBot redondants. 

Voir le 
TABLEAU 1-1 

page 7. 

Dimensions1 Mesures

Hauteur : 197 cm (77,625 pouces) à 200 cm 
(78,63 pouces) hauteur maximale 

Largeur : 76,75 cm (30,22 pouces) sans capots
77,5 cm (30,5 pouces) avec capots2

Profondeur : 80 cm (31,5 pouces) 

Poids : 103,4 kg (277 livres), structure 
uniquement

Dégagement latéral Refroidissement : 5 cm (2 pouces) 
Installation : 91 cm (36 pouces)3

Dégagement pour le 
service technique, 
avant et arrière 

Aucun requis

Remarques : 
1. Les dimensions du PEM sont les mêmes que celles du module 

d'extension de cartouche. 
2. Lorsque des modules supplémentaires sont installés, les 

capots sont retirés du module de base et remis aux extrémités 
du dernier module de la chaîne. 

3. Indispensable pour l'installation ou le retrait des capots 
latéraux ; ils s'escamotent et s'enlèvent des crochets. 
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Module d'extension d'accès 
Le module d'extension d'accès (AEM) facultatif fournit les fonctionnalités suivantes : 

■ Chargement et le déchargement en masse jusqu'à 234 cartouches à la fois dans 
une bibliothèque de bandes SL3000 ou à partir de celle-ci via le CAP des AEM. 
L'AEM constitue essentiellement un CAP de taille très importante, avec toutes les 
caractéristiques d'un CAP, tel que l'état en ligne/hors ligne, la possibilité de partage 
entre des partitions, etc. Les emplacements de cartouche dans l'AEM ne peuvent pas 
servir à un stockage à long terme. 

■ Maintenance robotisée sans interruption via l'utilisation d'une porte de sécurité (ou 
porte de « garage ») avec des parties d'un robot défectueux provenant des autres 
modules de bibliothèque de bandes. Un représentant du service technique de Sun 
peut accéder en toute sécurité aux robots désactivés, via la porte d'accès de l'AEM 
pendant que la bibliothèque de bandes demeure en ligne. En cas d'installation de 
robots redondants, la bibliothèque de bandes peut poursuivre les opérations 
normales via le robot fonctionnel restant. 

La bibliothèque de bandes peut contenir un ou deux AEM. L'AEM doit être installé 
tout à la fin de la chaîne de la bibliothèque de bandes. Si la bibliothèque de bandes 
comprend des robots redondants, deux AEM doivent alors être installés, un à chaque 
extrémité de la bibliothèque de bandes.

Remarque – Les AEM et les PEM ne peuvent pas être installés dans la même 
bibliothèque de bandes. 

Les AEM n'incluent pas de lecteurs de bande. 

Voir « Opérations au niveau des AEM » page 80 pour plus de détails sur les fonctions et 
l'utilisation de l'AEM. 
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FIGURE 1-9 Module d'extension d'accès 

Configuration Capacité 

AEM (installé à gauche) 234 cellules de CAP
AEM (installé à droite) 234 cellules de CAP 
Installés par paires pour la fonctionnalité des 
TallBot redondants. 

Voir le 
TABLEAU 1-1 

page 7. 

Dimensions Mesures

Hauteur : 197 cm (77,625 pouces) à 200 cm 
(78,63 pouces) hauteur maximale 

Largeur : 91,5 cm (36,0 pouces) sans capots
96,5 cm (38,0 pouces) avec capots1

Profondeur : 80 cm (31,5 pouces) 

Poids : 204,12 kg (450 livres)

Dégagement latéral Refroidissement : 5 cm (2 pouces) 
Installation : 91 cm (36 pouces)2

Dégagement pour le 
service technique 

Avant : 58.7 cm (23m1 pouces)
Arrière : Accès à Ethernet requis ; aucun 
capot. 

Remarques : 
1. Lorsque des modules supplémentaires sont installés, les 

capots sont retirés du module de base et remis aux extrémités 
du dernier module de la chaîne. 

2. Indispensable pour l'installation ou le retrait des capots 
latéraux ; ils s'escamotent et s'enlèvent des crochets. 
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Lecteurs de bande 
Voir le TABLEAU 1-2 pour prendre connaissance des lecteurs de bande, des interfaces 
de chemin de données et des types de support pris en charge par la bibliothèque de 
bandes SL3000. 

Vous pouvez installer jusqu'à 56 lecteurs dans une bibliothèque de bandes de la 
manière suivante :

■ 24 maximum dans le module de base

■ 32 maximum dans un DEM 

Le nombre réel de lecteurs varie en fonction de l'option d'alimentation CA et des types 
de support. Voir TABLEAU 1-3 pour plus de détails. 

TABLEAU 1-2 Lecteurs de bande pris en charge 

Fournisseur Type de lecteur Type d'interface Support

Sun StorageTek1 T9840C 
T9840D (chiffrement pris 
en charge) 

Fibre Channel
FICON
ESCON

9840 
Worm (VolSafe)

Sun StorageTek T10000A, T10000B 
(chiffrement pris en 
charge) 

2 Go/4 Go 
Fibre Channel 
FICON

T0000 Standard, Sport et 
Worm (Volsafe) 

HP LTO 3 
LTO 4 (chiffrement pris 
en charge) 

Fibre Channel LTO 3
LTO 4 
WORM (LT) 
LTO 2 (lecture seule)4

IBM LTO 3 
LTO 4 

Fibre Channel LTO 3 
LTO 4 
WORM (LT) 
LTO 2 (lecture seule)2

Remarques :
1. Sun Les lecteurs StorageTek T9840A et T9840B, ainsi que les lecteurs T9940A et T9940B, ne sont pas 

pris en charge.
2. Le support LTO 2 est pris en charge pour assurer la compatibilité ascendante des produits LTO 

(migration de données).

TABLEAU 1-3 Options d'alimentation et nombre de lecteurs

110–127 PDU 220-240 PDU

Module de base DEM Module de base DEM

T9840 12 14 24 32

T10000 13 16 24 32

LTO 3, 4 24 32 24 32

Support mixte variable tout mélange
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Tiroirs des lecteurs 
Dans la bibliothèque de bandes SL3000, un seul tiroir de lecteurs universel contient 
tous les types de lecteur de bande et d'interface. Les tiroirs des lecteurs de la 
bibliothèque de bandes SL3000 comportent deux couches, comme suit : 

■ L'alimentation et les connexions se trouvent en haut. 

■ Le lecteur de bande se situe sous l'alimentation. 

Chaque tiroir de lecteurs glisse dans une baie de huit lecteurs. 

Les cartes d'alimentation internes et le câblage sont uniques selon le type de lecteur et 
l'interface vers le serveur. Les câbles d'interfaces du lecteur sortent de l'arrière du tiroir 
de lecteur et de la bibliothèque de bandes pour être ensuite acheminés vers les chemins 
de câbles. Les câbles d'interfaces peuvent être sortis par le sol ou par le plafond. 

FIGURE 1-10 Tiroir des lecteurs 

Mesures 

Hauteur :  16,5 cm (6,5 pouces)

Largeur :   16,5 cm (6,5 pouces)

Profondeur :  45 cm (18,5 pouces)



Port d'accès aux cartouches (CAP)

418605501 • Révision AB Chapitre 1 Introduction à la bibliothèque de bandes SL3000 21

Port d'accès aux cartouches (CAP) 
Le port d'accès aux cartouches (CAP) est un cylindre en rotation monté verticalement 
qui comporte deux magazins amovibles de 13 emplacements (26 cellules au total). Les 
CAP permettent d'introduire ou d'éjecter des cartouches de la bibliothèque de bandes. 

Le module de base est équipé en standard d'un seul CAP. Un CAP peut être installé 
dans chaque module d'extension, jusqu'à un maximum de dix CAP pour la 
bibliothèque de bandes (facultatif). 

Chaque CAP possède son propre jeu de commandes, à savoir un petit pavé numérique 
et des indicateurs. Le CAP et ses magazines pivotent comme une seule unité. 

Voir « Opérations CAP » page 76 pour plus de détails sur l'utilisation des CAP. 

FIGURE 1-11 Port d'accès aux cartouches (CAP)

1. Port d'accès aux cartouches (CAP) 
2. Panneaux vides.

Lorsqu'aucun CAP n'est installé, un capot vide est mis en place. Un CAP peut être installé ultérieurement. 
3. Interface utilisateur du pavé numérique et des indicateurs. 

1 2 1 2

3
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Bras robotisés 
L'unité robotique d'une bibliothèque de bandes SL3000 est appelée TallBot. Chaque 
bibliothèque de bandes peut comprendre un TallBot (standard) ou deux TallBot 
(redondants). 

Les TallBot sont chargés de déplacer et de cataloguer (ou d'auditer) les cartouches sur 
l'ensemble de la bibliothèque de bandes. 

Mesures du TallBot :

■ Largeur : 30 cm (11,84 pouces)

■ Profondeur : 39 cm (15,36 pouces)

■ Poids : 8,6 kg (19 livres)

FIGURE 1-12 TallBot 
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Les TallBot sont guidés et pilotés le long de deux rails sur la façade arrière de la 
bibliothèque de bandes : un rail en haut de la bandothèque et un rail en bas sur le 
plancher de la bibliothèque de bandes. 

Le rail supérieur contient deux contacts en cuivre qui fournissent l'alimentation 
électrique de l'unité robotique (moteurs, main robotique) et les signaux de commande. 

■ L'alimentation électique provient des alimentations électriques (+48 VCC, 1 200 W) 
partagées. 

■ Les signaux de commande sont échangées (émission et réception) entre le tallbot et 
le contrôleur de la la bibliothèque de bandes. 

■ L'alimentation des rails est sécurisée par un module d'activation de l'alimentation.

La manipulation des cartouches par les TallBot regroupe les opérations suivantes : 

■ Extraction des cartouches des CAP

■ Insertion des cartouches dans les CAP

■ Extraction et insertion des cartouches de ou dans une cellule de stockage 

■ Montage et démontage des cartouches des lecteurs de bande 

Les mains robotiques sont munies d'un lecteur de codes à barres qui : 

■ Lit les blocs de configuration de chaque module pendant l'initialisation de la 
bibliothèque de bandes. Voir la FIGURE B-6 « Bloc de configuration » page 533 pour 
un exemple. 

■ Positionne la main sur les cellules de stockage de cartouches et du CAP et sur les 
lecteurs de bande en utilisant les cibles qui ont la forme suivante, identique à la 
lettre « n » : 

|\|

■ Identifie les ID de volume (VOLID) des cartouches lors des : 

■ Entrées du CAP

■ Audits

Le TallBot lit les ID de volume des cartouches uniquement lors des audits et lors 
de l'entrée d'une cartouche par les CAP. L'emplacement de stockage de chaque 
cartouche est inscrit dans la base de données du contrôleur de la bibliothèque de 
bandes et le TallBot se sert de cet emplacement pour retrouver la cartouche. 

Robotiques redondantes (dual-TallBot) 
La redondance des tallBot est une option de haute disponibilité. Elle offre les 
possibilités suivantes :

■ Réduction des temps robotiques puisque les tallbots fonctionnent en simultané

■ Tolérance aux pannes, un TallBot pouvant suppléer un autre TallBot en cas de 
défaillance

Cette option exige que des PEM soient présents à chaque extrémité de la bibliothèque 
de bandes. Un TallBot défectueux se mettra lui-même hors service et se déplacera, ou 
sera poussé, dans l'un des PEM, permettant ainsi à la bibliothèque de bandes de rester 
opérationnelle avec un seul TallBot jusqu'à ce que le remplacement du TallBot 
défectueux puisse être effectué. 
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La configuration requise pour un fonctionnement avec des TallBot redondants est la 
suivante :

■ Alimentation 2N 240 VCA

■ Un PEM à chaque extrémité de la bibliothèque de bandes 

■ Liicence d'utilisation de TallBot redondants 
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Options d'alimentation 

Configurations de l'alimentation CA 
Les options de sources d'alimentation CA disponibles sont les suivantes :

■ Fonctionnalités limitées : 110 VCA, 50/60 Hz, 20 A (plage : 100-127 VCA, 50-60 Hz, 
16 A) 

■ Fonctionnalités complètes : 220 VCA, 50/60 Hz, 30 A (plage : 200-240 VCA, 50-60 Hz, 
24 A) 

Les unités de distribution de courant (PDU) sont situées à l'arrière du module de base 
et du DEM en option. 

Redondance de l'alimentation
La bibliothèque de bandes SL3000 est équipée de lecteurs de bandes, d'unités robotisées 
et de systèmes électroniques redondants. Les différentes options de redondance sont les 
suivantes : 

■ N+1 : un PDU CA, avec une alimentation CC supplémentaire pour la redondance 
de l'alimentation CC. Cette configuration d'alimentation est standard pour la 
bibliothèque de bandes SL3000. Elle requiert au moins un disjoncteur de 20 A 
au niveau du panneau principal de dérivation du client. 

■ 2N : deux PDU pour la redondance CA, chaque PDU disposant d'un jeu 
d'alimentations CC (alimentations CC N) Cette configuration requiert une deuxième 
source d'alimentation distincte chez le client. 

■ 2N+1 : deux PDU pour la redondance CA ; chaque PDU dispose d'alimentations CC 
supplémentaires pour la redondance N+1 pour chaque PDU. La deuxième PDU ne 
comprend pas l'option N+1 pour le TallBot. 

Alimentation CC
Les alimentations CC 1 200 W de partage des charges sont indispensables pour 
distribuer +48 VCC pour le fonctionnement des TallBot et des lecteurs de bande. Le 
nombre d'alimentations CC requises dépend de la configuration de l'alimentation et du 
nombre total de lecteurs dans la bibliothèque de bandes. 

Un module d'activation de l'alimentation des rails est également installé comme circuit 
de sécurité pour l'alimentation des rails. Deux alimentations cPCI (200 W chacune) 
distribuent l'alimentation au module de contrôle de système électronique. Ces 
alimentations se trouvent sous la carte HBT, deux sur la gauche pour N+1 ou une de 
chaque côté pour 2N. 
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Refroidissement 
Le refroidissement dans la bibliothèque de bandes SL3000 se divise en trois zones : 

■ Systèmes électroniques de la bibliothèque de bandes 

■ Lecteurs de bande 

■ Alimentations CC 

Systèmes électroniques de la bibliothèque 
Deux ventilateurs sont situés à droite du module de contrôle de système électronique et 
servent à refroidir les systèmes électroniques présents dans la bibliothèque de bandes. 
L'air est aspiré du sol et des côtés de la bibliothèque de bandes, et circule par les 
ventilateurs vers l'arrière de la bibliothèque de bandes. 

■ Ces ventilateurs sont contrôlés par la carte HBC qui garantit leur bon 
fonctionnement. 

■ Un indicateur Fault (Défaillance) orange, placé sur l'assemblage des ventilateurs, 
indique une défaillance. 

Bien qu'il y ait deux ventilateurs dédiés, un seul suffit pour refroidir correctement la 
bibliothèque de bandes et les systèmes électroniques. Toutefois, étant donné que les 
ventilateurs peuvent être remplacés sans perturber les opérations de la bibliothèque de 
bandes, il est préférable de remplacer un ventilateur défectueux dès que la défaillance 
est détectée. 

Lecteurs de bande
Chaque tiroir de lecteurs de bande contient un ou deux ventilateurs assurant le 
refroidissement des lecteurs. 

L'alimentation des ventilateurs est fournie par la carte du convertisseur d'alimentation 
des lecteurs de bande. L'air est aspiré de l'avant du lecteur et circule par le ventilateur 
vers l'arrière du lecteur/de la bibliothèque de bandes. 

Alimentations CC
Chaque alimentation CC 1 200 W contient un ventilateur qui aspire l'air de l'avant de la 
bibliothèque de bandes par l'arrière de l'alimentation et le rejette par l'arrière de la 
bibliothèque de bandes. 
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Interfaces 
La bibliothèque de bandes SL3000 prend en charge les types d'interface suivants : 

■ Chemin de contrôle de la bibliothèque de bandes : transfère les commandes de 
gestion de la bibliothèque de bandes, comme les montages et démontages des 
cartouches, entre l'hôte et les composants de la bibliothèque de bandes. Cette 
interface ne comprend aucune donnée sur l'hôte. 

■ Chemin de données : transfère les données entre l'hôte et les lecteurs de bande. 

■ Interface de ligne de commande : permet à un Sun représentant du support 
technique de configurer et de diagnostiquer la bibliothèque de bandes.

■ SNMP : permet aux administrateurs système d'interroger la bibliothèque de bandes 
et de recevoir des informations sur des problèmes potentiels. 

■ Console d'administration StreamLine Library : permet aux utilisateurs et aux 
administrateurs de la bibliothèque de bandes de configurer et de gérer la 
bibliothèque de bandes depuis une interface graphique utilisateur. 

Chemin de contrôle de la bibliothèque de bandes 

Remarque – Lorsqu'une nouvelle bibliothèque de bandes est intégrée à un réseau, il 
est vivement recommandé que l'administrateur système/réseau travaille en étroite 
collaboration avec un représentant Sun StorageTek pour définir la configuration. 

Le chemin de contrôle permet le transfert des commandes de gestion de la bibliothèque 
de bandes entre l'hôte et la bibliothèque de bandes. La bibliothèque de bandes SL3000 
prend en charge les types de connexion de l'hôte suivantes pour le chemin de contrôle : 

■ Interface TCP/IP : protocole TCP/IP utilisant des câbles Ethernet 10/100 Base-T et 
CAT-5 

■ Interface FC-SCSI : protocole et jeu de commandes SCSI (Small Computer System 
Interface) sur une interface Fibre Channel physique 

Une bibliothèque de bandes non partitionnée peut n'utiliser qu'un seul type d'interface : 
FC SCSI ou TCP/IP. Grâce à la fonctionnalité Partitioning (Partitionnement) en option, 
une bibliothèque de bandes peut se connecter à plusieurs hôtes sur une combinaison 
des deux types d'interface. Voir Chapitre 6, « Partitionnement de la bibliothèque de 
bandes » page 269 pour plus de détails. 

L'adressage de la bibliothèque de bandes dépend du type de connexion de l'hôte : 
■ Les hôtes TCP/IP utilisent un schéma de numérotation PRC (Panel, Row, Column). 
■ Les hôtes FC-SCSI utilisent un schéma de numérotation d'éléments séquentiel, 

chaque type d'élément (cellules de stockage, lecteurs de bande et CAP) possédant sa 
propre plage séquentielle. 

Voir Annexe A, « Adresses des ressources de la bibliothèque de bandes » page 507 pour 
plus de détails. 
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Interface TCP/IP
Le type d'interface TCP/IP utilise le protocole TCP/IP sur une interface physique 
Ethernet (câble CAT-5, Ethernet, 10/100 BaseT). Cette interface permet aux plate-formes 
hôtes suivantes de se connecter à la bibliothèque de bandes de communiquer avec celle-
ci : 

■ Plate-formes système ouvertes avec ACSLS (voir « Logiciel automatisé de la bibliothè-
que de bandes du système de cartouches (ACSLS) » page 33 pour plus de détails). 

■ Mainframes d'entreprise avec HSC (voir « Composant du logiciel hôte » page 32 
pour plus de détails). 

Le contrôleur de la bibliothèque de bandes coordonne toutes les opérations des 
composants dans la bibliothèque de bandes et établit la connexion de l'interface avec 
l'hôte. 

Connexions

La carte du contrôleur de la bibliothèque de bandes comporte deux connexions Ethernet 
distinctes pour les communications entre l'hôte et la bibliothèque de bandes. 
■ Le port 2A permet la connexion TCP/IP double, une fonctionnalité sous licence en 

option offrant une redondance intégrée. 
■ Le port 2B établit la connexion primaire de l'hôte, qui constitue la connexion 

standard pour les bibliothèques de bandes SL3000.

Les deux ports sont conformes à la norme IEEE (Institute of Electrical and Electronics 
Engineers) 802.3 pour les réseaux Ethernet. Les deux ports sont capables de négocier 
automatiquement les fonctions suivantes : 

■ Méthode de transmission   

■ Semi-duplex : transmet les données dans une seule direction à la fois 

■ Duplex intégral : transmet les données dans deux directions en même temps 

■ Vitesse de la transmission 

■ 10Base-T : 10 mégabits par second (Mbps)

■ 100Base-T : 100 mégabits par second (Mbps)   

Réseau

La bibliothèque de bandes SL3000 étant installée sur un réseau, il est préférable que 
l'activité de la bibliothèque de bandes soit isolée du trafic réseau régulier. Les réseaux 
distincts suivants sont ainsi présents : 

■ Réseau public : gestion de l'intégralité de la mise en réseau reliée au client pour les 
ports du contrôleur système publics, par exemple :

■ Accès Internet 

■ Commandes bibliothèque de bandes-hôte 

■ Réseau privé : gestion de l'intégralité de la mise en réseau interne de la bibliothèque 
de bandes pour les ports du contrôleur système privés, par exemple :

■ CAP

■ Chemin de contrôle des lecteurs 

■ Panneau opérateur local 
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Remarque – Une connexion réseau privée entre la bibliothèque de bandes et le 
logiciel de gestion de l'hôte, au moyen d'un hub ou d'un commutateur Ethernet, est 
recommandée pour optimiser le débit et réduire au maximum le conflit de ressources. 

Si un réseau partagé s'avère indispensable, les actions suivantes peuvent contribuer à 
établir la communication entre l'hôte et la bibliothèque de bandes : 

■ Connecter directement la bibliothèque de bandes à un commutateur. 

■ Placer la bibliothèque de bandes sur son propre sous-réseau. 

■ Utiliser un commutateur géré capable de :

■ Définir des priorités sur les ports afin d'accorder une priorité plus élevée à l'hôte 
et à la bibliothèque de bandes.

■ Fournir une bande passante dédiée entre l'hôte et la bibliothèque de bandes.

■ Créer un VLAN entre l'hôte et la bibliothèque de bandes. 

■ Utiliser un réseau privé virtuel (VPN) pour isoler le trafic entre l'hôte et la 
bibliothèque de bandes. 

Sun L'adaptateur de chemin de contrôle 9300 de StorageTek établit la connexion 
matérielle pour les hôtes (mainframes). Cet adaptateur d'interface est installé sur le 
mainframe et convertit les données sur le réseau Ethernet en commandes HLI (Host 
Library Interface) compatibles. 

Interface FC-SCSI
Le type d'interface FC-SCSI utilise le jeu de commandes SCSI sur une connexion Fibre 
Channel physique. L'implémentation Sun StorageTek de Fibre Channel est conforme 
aux normes suivantes : 

■ American National Standards Institute (ANSI) 

■ National Committee for Information Technology Standards (NCITS) 

Les hôtes FC-SCSI doivent être dotés d'applications prenant en charge le protocole 
SCSI-3. 

La topologie Fibre Channel recommandée pour la bibliothèque de bandes SL3000 est la 
structure commutée. Une structure commutée offre des interconnexions dynamiques 
entre les noeuds et plusieurs connexions Fibre Channel simultanées pour le réseau.

Si la bibliothèque de bandes SL3000 est connectée à un commutateur Fibre Channel ou 
à un hôte structure capable, elle se configure automatiquement comme une topologie 
commutée et peut prendre en charge jusqu'à 16 millions de ports connectés dans la 
structure. 

Voir le Manuel de référence de l'interface de la bibliothèque de bandes SL3000 (n° de réf. 
3161952xx) pour des informations détaillées. Ce manuel renferme des informations sur 
le jeu de commandes SCSI, ainsi que sur les opérations Fibre Channel, les 
implémentations de commandes, les topologies, les câbles et les connecteurs. 

Remarque – Tandis que la bibliothèque de bandes SL3000 prend en charge la 
topologie de boucle arbitrée, cette topologie n'est pas recommandée.
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Remarque – La bibliothèque de bandes SL3000 ne prend pas en charge le forçage de la 
connexion de boucle arbitrée en définissant des Hard ALPA (adresses physiques de 
boucle arbitrée) 

Chemin de données
Le chemin de données, séparé et distinct du chemin de contrôle de la bibliothèque de 
bandes, prend en charge le transfert de données entre l'hôte et le lecteur de bandes. Les 
chemins de données de l'hôte vers les lecteurs de bande peuvent être Fibre Channel, 
FICON ou ESCON, selon les caractéristiques opérationnelles du type de lecteur. Voir 
« Lecteurs de bande » page 19 pour plus de détails. 

Interface de ligne de commande 
La bibliothèque de bandes SL3000 Interface de ligne de commande (CLI) est 
une interface de bibliothèque de bandes destinée uniquement au représentant du 
support technique Sun dûment formé et qualifié. Cette interface permet au représentant 
du support technique de configurer et de diagnostiquer les problèmes survenus sur la 
bibliothèque de bandes. 

Remarque – Les clients n'ont pas accès à l'interface CLI. 

SNMP
Le protocole SNMP (Simple Network Management Protocol) permet aux 
administrateurs système et aux gestionnaires réseau de contrôler et de recevoir 
des informations sur l'état de la bibliothèque de bandes, notamment : 

■ État opérationnel de la bibliothèque de bandes (par exemple, niveau de microcode, 
numéro de série, état en ligne/hors ligne)

■ État des CAP (ouvert, fermé, nombre de cellules)

■ Éléments de la bibliothèque de bandes (nombre de TallBot, cellules de stockage, 
CAP) 

■ Nombre de cellules de stockage et de types de support dans la bibliothèque de 
bandes 

■ Nombre et types de lecteurs de bande installés dans la bibliothèque de bandes

Remarque – L'agent SNMP est désactivé par défaut et doit être activé par votre 
représentant du support technique Sun via l'Interface de ligne de commande (CLI). 
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La bibliothèque de bandes SL3000 prend en charge les versions suivantes du protocole 
SNMP : 

■ SNMPv2c : pour les requêtes sur l'état de la machine ; les informations transmises ne 
sont pas sécurisées.

■ SNMPv3 : réservé aux informations classées « confidentielles » : usage interne 
uniquement » de Sun, car il prend en charge le chiffrement et l'identification de 
l'utilisateur. SNMPv3 représente ainsi le protocole de prédilection pour les données 
propriétaires.

Remarque – Consultez le Guide SNMP de la bibliothèque de bandes SL3000 (n° de réf. 
3161945xx) pour des informations détaillées sur le protocole SNMP et les procédures de 
configuration.

Console d'administration StreamLine Library
La Console de la bibliothèque de bandes StorageTek (Console d'administration 
StreamLine Library) est une application logicielle Java qui fournit une interface 
graphique utilisateur (IG) pour le contrôle et la gestion de la bibliothèque de bandes 
StorageTek SL3000. Voir Chapitre 2, « Console de la bibliothèque de bandes 
StorageTek » page 37 pour plus de détails. 
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Logiciel de gestion de la bibliothèque de 
bandes
Les composants du logiciel de gestion de la bibliothèque de bandes contrôlent la 
bibliothèque de bandes afin d'effectuer des activités telles que les montages et 
démontages, les insertions et les éjections. Ils gèrent également leurs propres bases de 
données de cartouches, qui contiennent des informations sur les emplacements et les 
attributs des volumes. 

Sun propose plusieurs composants logiciels en fonction de la plate-forme, du type de 
connexion et du système d'exploitation. Ces composants sont les suivants : 

■ ACSLS

■ HSC (MVS), avec une interface TCP/IP uniquement

■ SCSI à connexion directe, avec une interface Fibre Channel uniquement

■ ExLM 

■ ExHPDM 

■ ExPR

■ VSM 

■ VTL 

Remarque – Consultez la documentation appropriée du logiciel de gestion de la 
bibliothèque de bandes pour connaître les niveaux de version prenant en charge la 
bibliothèque de bandes SL3000. 

Remarque – LibraryStation n'est pas pris en charge pour la bibliothèque de bandes 
SL3000. 

Nearline Control Solutions
La bibliothèque de bandes SL3000 prend en charge les produits logiciels Sun Nearline 
Control Solutions (NCS) suivants.

■ Composant du logiciel hôte

■ Composant de gestion de stockage

■ Sun Serveur HTTP de StorageTek

Composant du logiciel hôte 
Lorsqu'une bibliothèque de bandes SL3000 est reliée à un hôte MVS, l'hôte doit exécuter 
une version du composant du logiciel hôte (HSC) de Sun StorageTek conjointement 
avec le composant de gestion de stockage (SMC).
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Les HSC et SMC de StorageTek :

■ Influencent les allocations

■ Interceptent les messages sur les montages et démontages

■ Reçoivent les requêtes de l'hôte et les traduisent en commandes de contrôle de la 
bibliothèque de bandes

Le HSC réside dans l'hôte MVS, mais reste invisible aux yeux du système d'exploitation 
réel.

Composant de gestion de stockage
Le composant de gestion de stockage (SMC) représente l'interface entre les systèmes 
d'exploitation OS/390 et z/OS d'IBM et une bibliothèque de bandes Sun StorageTek. Le 
SMC procède au traitement des allocations, à la gestion des messages et au traitement 
des SMS pour la solution NCS. Le SMC réside sur le système hôte MVS avec le HSC ou 
sur un système distant utilisant le serveur HTTP de Sun StorageTek pour communiquer 
avec le HSC. Le SMC communique avec le HSC afin de déterminer les stratégies, les 
emplacements des volumes et la propriété des lecteurs.

Remarque – Le SMC est un composant NCS indispensable.

Sun Serveur HTTP de StorageTek
Sun Le serveur HTTP de StorageTek pour OS/390 et z/OS fournit (en option) 
l'intergiciel permettant d'établir la communication entre le SMC (client) et un sous-
système HSC distant (serveur). Le serveur HTTP s'exécute en tant que sous-système 
distinct sur l'hôte MVS sur lequel réside le sous-système HSC distant. 

Logiciel automatisé de la bibliothèque de bandes du 
système de cartouches (ACSLS)
Le logiciel ACSLS gère le contenu de la bibliothèque de bandes et contrôle le matériel 
de la bibliothèque de bandes pour ce qui est du montage et du démontage des 
cartouches. 

Le logiciel ACSLS assure des services de gestion de bibliothèque de bandes, comme le 
suivi des cartouches, le groupement, les rapports et le contrôle de la bibliothèque de 
bandes. Il maintient une base de données qui suit les noms des volumes de données et 
leurs emplacements actuels dans les bibliothèques de bandes. 
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Modes de fonctionnement
Quatre modes de fonctionnement sont possibles pour la bibliothèque de bandes 
SL3000 :

■ Mode automatisé 

■ Mode manuel

■ Mode de maintenance

■ Mode endommagé

Mode automatisé 
Lorsque la bibliothèque de bandes est en mode de fonctionnement automatisé, elle 
monte et démonte automatiquement des cartouches sans nécessiter l'intervention d'une 
personne.

Les opérations automatisées comprennent les activités suivantes :

■ Montage et démontage des cartouches
■ Insertion et éjection des cartouches par le CAP
■ Journalisation des événements de la bibliothèque de bandes
■ Nettoyage des lecteurs 

Voir Chapitre 3, « Mode opératoire de la bibliothèque de bandes SL3000 » page 69 pour 
plus de détails. 

Mode manuel
Le mode de fonctionnement manuel intervient lorsque la bibliothèque de bandes ne 
peut pas être utilisée par le système et que l'intervention d'une personne est nécessaire. 
La bibliothèque de bandes doit passer en mode manuel lorsqu'elle rencontre une erreur 
irrécupérable rendant les montages et démontages automatisés impossibles.

Le mode manuel est également nécessaire lorsqu'un composant de la bibliothèque de 
bandes ne peut pas procéder à un montage sur un lecteur dans le cadre d'une demande 
de travail particulièrement importante. Dans ce cas, il peut s'avérer nécessaire qu'une 
personne entre dans une bibliothèque de bandes, localise la cartouche et la monte 
manuellement dans le lecteur demandé. 

Avertissement – Risque de blessure physique.  Toute personne entrant dans la 
bibliothèque de bandes doit être familiarisée avec les procédures de sécurité 
qu'elle doit observer. 

Voir Chapitre 8, « Utilisation en mode manuel » page 491 pour plus de détails. 
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Mode de maintenance
En cas de défaillance d'un composant non redondant de la bibliothèque de bandes (par 
exemple, un TallBot unique pour toute la bibliothèque de bandes), la bibliothèque de 
bandes est dite « indisponible » pour le système. Dans ce cas, la bibliothèque de bandes 
dans son ensemble doit être mise hors ligne jusqu'à ce que la réparation soit effectuée.

Lorsque le composant défectueux a été réparé ou remplacé, la bibliothèque de bandes 
peut être mise en mode de maintenance pendant la réalisation de tests de vérification. 

Mode endommagé
En mode endommagé, la bibliothèque de bandes est toujours opérationnelle et en 
ligne, mais son efficacité opérationnelle est endommagée en raison d'un composant 
défectueux. Voici quelques exemples de fonctionnement de la bibliothèque de bandes 
en mode endommagé : 

■ Dans une configuration de TallBot redondants, un seul TallBot est défaillant ; l'autre 
TallBot a assumé toutes les opérations de montage et de démontage sur l'ensemble 
de la bibliothèque de bandes.

■ Un seul lecteur de bande est défectueux et doit être remplacé.
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CHAPITRE 2

Console de la bibliothèque de bandes 
StorageTek 

Introduction 
La Console de la bibliothèque de bandes StorageTek (Console d’administration 
StreamLine Library) est une application logicielle Java qui fournit une interface 
graphique utilisateur (IG) pour le contrôle et la gestion de la bibliothèque de bandes 
StorageTek. 

Les activités suivantes peuvent être effectuées avec la Console d’administration 
StreamLine Library :

■ Gestion de la capacité de stockage disponible de la bibliothèque de bandes

■ Gestion et configuration des partitions de la bibliothèque de bandes (fonctionnalité 
facultative)

■ Visualisation et modification de l'état et des propriétés de la bibliothèque de bandes 
et des périphériques associés (lecteurs, CAP, robots et ascenseurs)

■ Exécution d'un audit sur l'ensemble ou une partie de la bibliothèque de bandes

■ Exécution d'un autotest sur la bibliothèque de bandes ou un périphérique associé

■ Exécution d'une action de diagnostic (tester un robot)

■ Localisation d'une cartouche

■ Déplacement d'une cartouche d'un emplacement vers un autre

■ Affichage des journaux de la bibliothèque de bandes

■ Affichage des messages d'événement d'état de la bibliothèque de bandes

■ Affichage des explications sur les erreurs 

■ Téléchargement d'un nouveau microprogramme de la bibliothèque de bandes 
pendant que la bibliothèque de bandes est utilisée

■ Affichage de l'aide contextuelle 
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Modes de la Console d’administration 
StreamLine Library
En fonction de vos besoins, vous pouvez exécuter la Console d’administration 
StreamLine Library dans l'un des modes suivants. Pour plus d'informations et pour 
connaître les procédures, voir : 

■ « Panneau opérateur local » page 46 

■ « Console d’administration StreamLine Library autonome » page 48

■ « Console d’administration StreamLine Library Web » page 56 
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Console d’administration StreamLine 
Library Sécurité de la 
Les fonctionnalités de sécurité intégrées à la Console d’administration StreamLine 
Library contrôlent les procédures d'authentification et d'autorisation de l'utilisateur. Les 
fonctionnalités de sécurité sont les suivantes :

■ ID utilisateur : les ID utilisateur contrôlent l'authentification de l'utilisateur. Chaque 
utilisateur doit posséder un ID utilisateur et un mot de passe actifs valides pour se 
connecter à la Console d’administration StreamLine Library.

■ Droits d'accès : les droits d'accès contrôlent l'autorisation de l'utilisateur. Chaque 
ID utilisateur est affecté à un ensemble de droits d'accès qui déterminent les types 
de demande que l'utilisateur peut soumettre via la Console d’administration 
StreamLine Library. Par exemple, afin de modifier les propriétés système d'un 
lecteur, un utilisateur doit se connecter avec un ID utilisateur possédant les droits 
d'accès appropriés.

Lorsque vous vous connectez à la Console d’administration StreamLine Library avec un 
ID utilisateur, un mot de passe et un nom de bibliothèque de bandes valides, le système 
authentifie votre identité, puis autorise votre accès aux diverses fonctions de la Console 
d’administration StreamLine Library. 

ID utilisateur
Pour vous connecter à la Console d’administration StreamLine Library, vous devez 
posséder un ID utilisateur actif valide. Un mot de passe doit être affecté à chaque ID 
utilisateur.

Un site comprend un ensemble défini d'ID utilisateur. Les ID utilisateur sont admin 
(administrateur du client), service (Sun Ingénieur du service client) et oem (technicien 
du service après-vente tiers). Lorsque vous vous connectez correctement, la Console 
d’administration StreamLine Library affiche votre ID utilisateur dans la barre d'état de 
la fenêtre.

Un seul utilisateur à la fois peut se connecter au Panneau opérateur local, mais un 
nombre indéfini d'utilisateurs peuvent se connecter à une bibliothèque de bandes via la 
Console d'administration StreamLine Library autonome ou la Console d’administration 
StreamLine Library Web. 
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Mot de passe d'activation 
Avant que les utilisateurs de votre site puissent utiliser la Console d’administration 
StreamLine Library pour la première fois, votre administrateur de la bibliothèque de 
bandes doit activer l'ID utilisateur « admin » avec un mot de passe d'activation spécial. 
Votre Sun représentant du support technique fournit à votre administrateur le mot de 
passe d'activation, qui n'est valide qu'une seule fois. 

Après s'être connecté avec le mot de passe d'activation, l'administrateur doit modifier le 
mot de passe associé à l'ID utilisateur admin pour garantir la sécurité du système. 

Pour plus d'informations sur ce processus, consultez le Guide d'installation de la 
bibliothèque de bandes appropriée. 
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Tâches d'utilisation de la Console 
d’administration StreamLine Library
■ Connexion à la Console d’administration StreamLine Library

■ Se déconnecter de la Console d’administration StreamLine Library

■ Modification d'un mot de passe utilisateur

▼ Connexion à la Console d’administration 
StreamLine Library
Les procédures de connexion dépendent du mode utilisé sur la Console 
d’administration StreamLine Library. Pour plus d'informations, reportez-vous aux 
rubriques suivantes :

■ « Connexion au panneau opérateur local » page 47

■ « Connexion à la SL Console autonome Console d’administration StreamLine 
Library » page 54

■ « Connexion à la Console d’administration StreamLine Library Web à l'aide d'un 
navigateur ou d'une ligne de commande » page 57

■ « Connexion à la Console d’administration StreamLine Library Web à l'aide d'une 
icône » page 63

Remarque – Le contrôleur de la bibliothèque de bandes transfère à la Console 
d’administration StreamLine Library l'ensemble des données de configuration de 
la bibliothèque de bandes. Par conséquent, vous devez faire preuve de précaution 
lorsque vous vous connectez à la Console d’administration StreamLine Library avant 
l'initialisation complète de la bibliothèque de bandes. Des messages d'avertissement 
risquent de s'afficher indiquant que les données de configuration ne sont pas encore 
disponibles, auquel cas vous devrez quitter l'application et vous reconnecter 
ultérieurement. Par ailleurs, en cas de réalisation d'un audit pendant la séquence 
d'initialisation, les données de configuration qui s'affichent risquent de ne pas 
être totalement actualisées et exactes avant la fin de l'audit. 

▼ Se déconnecter de la Console d’administration 
StreamLine Library

Remarque – Avant de vous déconnecter, assurez-vous que toutes les opérations de la 
session en cours de la Console d’administration StreamLine Library sont terminées (par 
exemple, chargement de code, audits, actions de diagnostic). 

1. Depuis n'importe quelle fenêtre de la Console d’administration StreamLine Library, 
sélectionnez Tools > Log Off.
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2. Dans la fenêtre contextuelle Confirm, procédez comme suit :

■ Cliquez sur Cancel pour rester connecté à la Console d’administration StreamLine 
Library.

■ Cliquez sur OK pour terminer la session en cours de la Console d’administration 
StreamLine Library. 

La fenêtre Login s'affiche. 

3. Cliquez sur Exit pour fermer la Console d’administration StreamLine Library.

▼ Modification d'un mot de passe utilisateur
1. Sélectionnez Tools > User Mgmt.

2. Dans l'arborescence User, développez le dossier Permanent. 

3. Cliquez sur le compte utilisateur à modifier. 

4. Renseignez les champs suivants : Current Password, New Password et 
Retype Password. 

5. Cliquez sur Modify.
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Console d’administration StreamLine 
Library Affichage à la fenêtre 
La figure et le tableau suivants détaillent les composants de la fenêtre de la Console 
d’administration StreamLine Library. 

Nom du composant Description

1 Barre de menu : 
comprend le menu Tools 
et le menu Help 

Le menu Tools permet d'accéder aux fonctions System Detail, 
Reports, Monitors, Utilities, Partitioning, User Management et 
Log off. 
Le menu Help permet d'accéder à la table des matières du 
système d'aide. Il identifie également la version de la Console 
d’administration StreamLine Library utilisée.

2 Barre de titre Affiche le titre de la fenêtre actuelle. 

3 Onglets Function Identifie les fonctions disponibles pour une fenêtre. 

1 2 43

5

78 6

9
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Synchronisation de l'affichage avec la base de 
données du contrôleur
Lorsque vous ouvrez une fenêtre de la Console d’administration StreamLine Library 
pour la première fois, l'affichage reflète les dernières données enregistrées de la base de 
données du contrôleur de la bibliothèque de bandes. Si vous utilisez la fenêtre pour 
modifier le contenu ou la configuration de la bibliothèque de bandes, vos modifications 
ne mettent pas à jour la base de données du contrôleur jusqu'à ce que vous validiez vos 
modifications en cliquant sur le bouton Apply. Plusieurs utilisateurs peuvent accéder à 
la bibliothèque de bandes simultanément en utilisant la Console d’administration 
StreamLine Library, l'Interface de ligne de commande et diverses applications hôtes 
pour modifier le contenu et la configuration de la bibliothèque de bandes. Si d'autres 
utilisateurs apportent des modifications et les appliquent à la base de données du 
contrôleur, vous ne verrez pas ces modifications tant que vous n'aurez pas cliqué sur 
Apply ou sur Refresh sur votre écran. Par conséquent, l'affichage que vous voyez sur 
la Console d’administration StreamLine Library peut ne pas refléter la configuration 
enregistrée réelle de la bibliothèque de bandes à un moment donné.

Pour ces raisons, si vous apportez des modifications majeures à la configuration de la 
bibliothèque de bandes (ajout de modules, définition de partitions,  etc.), coordonnez 
ces modifications avec les autres utilisateurs de la bibliothèque de bandes. Sinon, des 
conflits pourraient se produire dans la base de données du contrôleur. 

4 Barre Options Emplacement des boutons associés à la fenêtre (par exemple, 
Apply, Refresh, Print). Inclut toujours le bouton Console 
d’administration StreamLine Library Help (?). Voir 
« Synchronisation de l'affichage avec la base de données du 
contrôleur » page 44 pour des informations détaillées sur 
l'utilisation des boutons Apply et Refresh. 

5 Zone de travail Emplacement des données de la fenêtre. 

6 Indicateur de santé de la 
bibliothèque de bandes

Identifie la bibliothèque de bandes à laquelle est connectée la 
Console d’administration StreamLine Library et affiche une 
représentation graphique de la santé de la bibliothèque de 
bandes. 

7 Indicateur d'ID 
utilisateur

Affiche l'ID utilisateur actuellement connecté à la Console 
d’administration StreamLine Library.

8 Indicateur de santé de la 
communication avec le 
serveur

Affiche un écran de contrôle graphique des pulsations qui 
indique l'état de santé de la communication avec le serveur.

9 Arborescence des 
périphériques

Dresse la liste des périphériques figurant dans la bibliothèque 
de bandes.

Nom du composant Description
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Modification de la mise en page de la fenêtre 

Remarque – Cette fonctionnalité est disponible dès la version FRS_3.30 de la Console 
d’administration StreamLine Library. Elle apparaît uniquement sur des fenêtres 
choisies. 

Vous pouvez modifier la mise en page et l'affichage des fenêtres choisies de la Console 
d’administration StreamLine Library en procédant comme suit. 

Option d'affichage Instructions

Trier l'affichage par 
une colonne 
quelconque

Cliquez sur l'en-tête de la colonne à trier. Le tri se fait 
initialement dans l'ordre croissant. Cliquez à nouveau sur 
l'en-tête pour basculer entre l'ordre croissant et l'ordre 
décroissant.

Organiser les colonnes 
dans un ordre 
quelconque

Cliquez et glissez un en-tête de colonne à l'horizontale vers 
une position quelconque dans la ligne de l'en-tête. 

Redimensionner les 
colonnes

Cliquez sur une bordure de l'en-tête d'une colonne et glissez-
la vers la gauche ou la droite pour modifier la largeur de la 
colonne. 
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Panneau opérateur local 
Le Panneau opérateur local est une fonctionnalité facultative de la bibliothèque de 
bandes qui est intégrée au module de base de la SL500 et de la SL300. Il vous permet 
d'exécuter la majorité de l'application de la Console d’administration StreamLine 
Library directement dans la bibliothèque de bandes sur un affichage à écran plat doté 
d'une interface à écran tactile. 

Les fonctionnalités du Panneau opérateur local sont les suivantes :

■ Affichage à écran plat, résidant dans la bibliothèque de bandes (12,1 pouces sur la 
SL3000 et la SL8500) 

■ Interface à écran tactile pour saisir des données alphanumériques ; stylo et stylet 
sont disponibles 

■ Pas d'option de clavier ou de souris

Des DEL placées juste sous le Panneau opérateur local donnent les informations 
suivantes sur l'état :

■ LIB ACTIVE : le processeur de la bibliothèque de bandes est en cours d'exécution. 

■ WAIT : le microprogramme de la bibliothèque de bandes se charge. 

■ SVC REQ : la bibliothèque de bandes redémarre. 

▼ Saisie des données à l'aide du pavé numérique 
1. Cliquez sur l'icône du clavier associée au champ souhaité.

Une fenêtre contextuelle contenant un clavier graphique et une zone d'affichage 
apparaît. 

2. Cliquez sur les touches graphiques permettant de saisir les données souhaitées.

3. Cliquez sur Enter pour enregistrer votre saisie. 

La fenêtre contextuelle se ferme et les données sont affichées dans le champ associé.

▼ Modifier les données à l'aide du pavé numérique 
1. Utilisez les touches de navigation pour positionner le curseur en regard des 

caractères à modifier.

Le texte existant reste sur l'affichage, mais il est remplacé par du texte normal.

2. Cliquez sur les touches de navigation, de modification et texte pour apporter les 
modifications souhaitées.

3. Cliquez sur Enter pour enregistrer les modifications ou sur Cancel pour restaurer le 
texte d'origine dans le champ. 
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▼ Connexion au panneau opérateur local 

Remarque – Un seul utilisateur à la fois peut se connecter au Panneau opérateur local. 

Remarque – Si le panneau à écran tactile est vide, touchez l'écran à un endroit 
quelconque pour activer la fenêtre Login. 

1. Utilisez le pavé numérique pour saisir vos données de connexion (voir « Saisie des 
données à l'aide du pavé numérique » page 46 pour des informations détaillées). 

ID utilisateur : Mot de passe SLC_login 
 : password 

où :

■ SLC_login correspond à l'ID utilisateur de la Console d’administration StreamLine 
Library.

■ password représente le mot de passe affecté à cet ID utilisateur. 

Remarque – L'ID utilisateur utilisé détermine les fenêtres auxquelles vous pouvez 
accéder. Voir « Console d’administration StreamLine Library Sécurité de la » page 39. 

2. Cliquez sur Log on. 
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Console d’administration StreamLine 
Library autonome 
La Console d'administration StreamLine Library autonome est une fonctionnalité 
standard de la bibliothèque de bandes StorageTek. Elle vous permet d'exécuter 
l'application de la Console d’administration StreamLine Library à distance depuis un 
PC ou une station de travail disposant d'une connexion réseau avec la bibliothèque de 
bandes. Grâce à la Console d'administration StreamLine Library autonome, vous 
pouvez vous connecter à n'importe quelle bibliothèque de bandes pour laquelle vous 
possédez un ID utilisateur valide. 

Considérations de sécurité
L'application de la Console d’administration StreamLine Library communique avec 
l'interface de bibliothèque de bandes primaire (PLI) sur une couche logicielle de 
sécurité (SSL). La SSL établit un chemin de communication sécurisé entre la 
bibliothèque de bandes et le panneau opérateur du client afin d'empêcher un utilisateur 
réseau non autorisé de contrôler l'activité de la bibliothèque de bandes.

Exigences d'installation
Vous pouvez installer la Console d'administration StreamLine Library autonome sur un 
ordinateur répondant aux exigences suivantes :  

Le logiciel de la Console d'administration StreamLine Library autonome peut être 
téléchargé sur les sites Sun Microsystems, Inc. suivants :

Plate-forme Solaris 9 – SPARC
Solaris 10 – SPARC
Windows 2003 Server – 32 bits
Windows XP Client – 32 bits
Windows Vista – 32 bits

Autre Connexion Ethernet à la bibliothèque de bandes

Utilisateur
Nom de 
l'emplacement URL

Clients Sun Sun Download Center http://www.sun.com/download
/index.jsp

Partenaires et 
OEM Sun

Sun Partner Exchange https://spe.sun.com/spx/control
/Login 
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Remarque – Vous devez disposer d'un ID de connexion et d'un mot de passe valides 
pour le site de téléchargement que vous consultez. Si vous avez besoin d'aide, contactez 
votre représentant du support technique Sun. 

Installation de la Console d’administration 
StreamLine Library autonome

Remarque – Votre CSE du StorageTek peut avoir effectué ces procédures à votre place 
pendant l'installation de la bibliothèque de bandes.

Pour installer la Console d'administration StreamLine Library autonome sur votre PC 
ou votre station de travail, vous devez suivre les procédures ci-dessous :

1. « Téléchargement et lancement du programme d'installation de la Console 
d’administration StreamLine Library autonome depuis le site de téléchargement de 
Sun » page 49. 

2. « Installation de la SL Console autonome Console d’administration StreamLine 
Library » page 50. 

▼ Téléchargement et lancement du programme d'installation de 
la Console d’administration StreamLine Library autonome 
depuis le site de téléchargement de Sun
Cette procédure permet de télécharger le programme d'installation de la 
Console d'administration StreamLine Library autonome et de le lancer sur votre PC 
ou votre station de travail. 

Remarque – Vous devez disposer d'un ID de connexion et d'un mot de passe valides 
pour le site de téléchargement que vous consultez. Si vous avez besoin d'aide, contactez 
votre représentant du support technique Sun. 

1. Démarrez un navigateur Web sur votre PC ou station de travail. 

2. Dans la barre d'adresse ou le champ Address, saisissez l'URL du site de 
téléchargement de Sun approprié. Voir « Exigences d'installation » page 48 pour 
plus de détails. 

3. Connectez-vous au site de téléchargement de Sun à l'aide de l'ID de connexion et du 
mot de passe qui vous ont été assignés.

4. Naviguez vers le fichier du programme d'installation de la Console d'administration 
StreamLine Library autonome. 

5. Sélectionnez le niveau de code souhaité de la Console d’administration StreamLine 
Library.
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6. Sélectionnez le fichier du programme d'installation approprié pour votre plate-
forme :

■ Microsoft Windows : SLConsoleWindowsSTK.exe 

■ Sun Solaris : SLConsoleSolarisSTK.bin 

7. Enregistrez le fichier sur votre PC ou votre station de travail. 

8. Double-cliquez sur l'icône du fichier du programme d'installation de la Console 
d’administration StreamLine Library sur votre PC ou votre station de travail pour 
démarrer l'installation. 

9. Pour terminer l'installation, voir « Installation de la SL Console autonome Console 
d’administration StreamLine Library » page 50. 

▼ Installation de la SL Console autonome Console 
d’administration StreamLine Library 
Cette procédure permet d'installer la Console d'administration StreamLine Library 
autonome sur votre PC ou station de travail. 

1. Démarrez le programme d'installation en suivant les instructions de la section 
« Téléchargement et lancement du programme d'installation de la Console 
d’administration StreamLine Library autonome depuis le site de téléchargement de 
Sun » page 49. 

La fenêtre License Agreement s'affiche. 
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2. Lisez les informations fournies et cliquez sur I accept. 

La fenêtre Introduction s'affiche.

3. Lisez les informations fournies et cliquez sur Next. 

La fenêtre Choose Install Folder s'affiche. 
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4. Saisissez l'emplacement dans lequel vous souhaitez installer le fichier, puis cliquez 
sur Next.

La fenêtre Choose Shortcut Folder s'affiche. 

5. Saisissez l'emplacement dans lequel vous souhaitez créer l'icône de raccourci, puis 
cliquez sur Next. 

Remarque – Sous Solaris, l'emplacement par défaut des raccourcis est le répertoire 
personnel de l'utilisateur. Il n'est toutefois pas possible de créer des raccourcis dans /, 
qui correspond au dossier personnel de l'utilisateur root, de sorte que si vous 
procédez à l'installation sur une plate-forme Solaris en tant que root, vous devez 
choisir un emplacement autre que l'emplacement par défaut. Dans ce cas, il est 
recommandé de choisir /usr/bin ou un emplacement similaire. 

La fenêtre Pre-Installation Summary apparaît.



 

Console d’administration StreamLine Library autonome

418605501 • Révision AB Console de la bibliothèque de bandes StorageTek 53

6. Lisez les informations fournies et cliquez sur Install. 

L'installation commence et la fenêtre Installing SL Console s'affiche. 

7. Lorsque l'installation se termine, la fenêtre Install Complete s'affiche. 

8. Lisez les informations fournies et cliquez sur Done pour quitter le programme 
d'installation. 
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▼ Connexion à la SL Console autonome Console 
d’administration StreamLine Library 

Remarque – Grâce à la Console d'administration StreamLine Library autonome, vous 
pouvez vous connecter à n'importe quelle bibliothèque de bandes pour laquelle vous 
possédez un ID utilisateur valide. 

1. Démarrez l'application de la Console d’administration StreamLine Library sur votre 
PC ou votre station de travail en procédant comme suit :

■ Double-cliquez sur l'icône Console d’administration StreamLine Library sur le 
bureau.

■ Sélectionnez Start > RunSLConsole ou Launch > RunSLConsole 

La Console d’administration StreamLine Library démarre et la fenêtre Login s'affiche. 

2. Saisissez vos informations de connexion.

ID utilisateur : Mot de passe SLC_login 
 : mot de passe 
Bibliothèque de bandes : library_ID 

où :

■ SLC_login correspond à l'ID utilisateur de la Console d’administration StreamLine 
Library.

■ password représente le mot de passe affecté à cet ID utilisateur. 

■ library_ID indique la bibliothèque de bandes à laquelle vous souhaitez vous 
connecter, selon l'une des manières suivantes :

■ adresse IP de la bibliothèque de bandes, exprimée sous la forme de la 
numérotation décimale avec points (nnn.nnn.nnn.nnn) 

■ alias DNS de la bibliothèque de bandes

Remarque – L'ID utilisateur utilisé détermine les fenêtres auxquelles vous pouvez 
accéder. Voir « Console d’administration StreamLine Library Sécurité de la » page 39. 

3. Cliquez sur Log on. 
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Mises à jour de la Console d’administration 
StreamLine Library autonome 

Remarque – Avant d'installer une nouvelle version de la Console d'administration 
StreamLine Library autonome, vous devez désinstaller la version précédente. Consultez 
la documentation de votre PC ou de votre station de travail pour des informations 
détaillées. L'exécution de plusieurs versions de la Console d’administration StreamLine 
Library sur le même PC ou la même station de travail peut engendrer des problèmes 
tels qu'une incohérence des données figurant dans les rapports. 

Après avoir désinstallé la version précédente de la Console d’administration 
StreamLine Library, consultez la section « Installation de la Console d’administration 
StreamLine Library autonome » page 49 pour des informations détaillées sur la mise à 
niveau du logiciel. 
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Console d’administration StreamLine 
Library Web
La Console d’administration StreamLine Library Web est une fonctionnalité standard 
de la bibliothèque de bandes. Elle permet d'installer la Console d’administration 
StreamLine Library sur un serveur Web centralisé. Les clients individuels peuvent alors 
utiliser un navigateur Web pris en charge pour télécharger la Console d’administration 
StreamLine Library Web. Grâce à la Console d’administration StreamLine Library Web, 
vous pouvez vous connecter à n'importe quelle bibliothèque de bandes pour laquelle 
vous possédez un ID utilisateur valide.

La Console d’administration StreamLine Library Web est remise aux clients en tant que 
processus Java Web Start, qui s'exécute en dehors du navigateur. 

Considérations de sécurité
Le logiciel de la Console d’administration StreamLine Library Web est signé 
numériquement, ce qui garantit qu'il a bien été émis par Sun Microsystems, Inc. et 
qu'il n'a pas été modifié ni corrompu depuis sa création. En tant que processus Java 
Web Start, la Console d’administration StreamLine Library Web comprend les 
fonctionnalités de sécurité fournies par la plate-forme Java 2.

Le client est chargé de déployer tous les systèmes de sécurité supplémentaires 
appropriés, dont des pare-feux, l'accès utilisateur, etc.

Exigences des clients
Vous pouvez télécharger la Console d’administration StreamLine Library Web sur les 
clients répondant aux exigences suivantes :  

Plate-forme Solaris 9 – SPARC (Firefox 2.x)
Solaris 10 – SPARC (Firefox 2.x)
Windows 2000 – 32 bits (IE 5, IE 5.5, Firefox 2.x)
Windows XP – 32 bits (IE 6, IE 7, Firefox 2.x)
Windows Vista – 32 bits (IE 7, Firefox 2.x)

Autre ■ Plug-in Java 1.5 (le navigateur l'installera 
automatiquement s'il ne l'est pas déjà)

■ Connexion Ethernet à la bibliothèque de bandes
■ Connexion Ethernet au serveur de la Console 

d’administration StreamLine Library Web 
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Mises à jour de la Console d’administration 
StreamLine Library Web
Les mises à jour de la Console d’administration StreamLine Library Web doivent 
uniquement être installées sur le serveur Web centralisé. Une fois que les mises à jour 
ont été installées sur le serveur, elles sont téléchargées automatiquement sur tous les 
clients à chaque démarrage de l'application sur le client. 

Démarrage de la Console d’administration 
StreamLine Library Web sur un client
Vous pouvez utiliser l'une des méthodes suivantes pour démarrer la Console 
d’administration StreamLine Library Web sur un client et vous y connecter : 

■ Depuis une ligne de commande (Solaris uniquement) ou un navigateur pris en 
charge. Voir « Connexion à la Console d’administration StreamLine Library Web à 
l'aide d'un navigateur ou d'une ligne de commande » page 57. 

■ En double-cliquant sur l'icône slc.jnlp sur votre client. Pour utiliser cette méthode 
depuis un client, vous devez utiliser la méthode du navigateur au moins une fois et 
enregistrer le fichier slc.jnlp localement. Voir « Connexion à la Console 
d’administration StreamLine Library Web à l'aide d'une icône » page 63. 

▼ Connexion à la Console d’administration 
StreamLine Library Web à l'aide d'un navigateur 
ou d'une ligne de commande 

Remarque – Avant d'effectuer cette activité, vous devez obtenir l'alias DNS ou 
l'adresse IP du serveur de la Console d’administration StreamLine Library. Selon son 
mode de configuration, le serveur Console d’administration StreamLine Library Web, 
celui-ci peut être accessible uniquement par adresse IP. Si vous avez besoin d'aide, 
contactez votre administrateur de la bibliothèque de bandes. 

Remarque – L'option de la ligne de commande est disponible uniquement sur les 
plate-formes Solaris. 

Sous Windows 2000, vous devrez probablement installer un plug-in Java pour votre 
navigateur Web avant d'exécuter cette procédure. Vous pouvez télécharger le plug-in à 
l'emplacement suivant :
http://java.sun.com/products/archive/j2se/5.0_04/index.html 

Sur les plates-formes Solaris, il est plus aisé de se connecter à la Console 
d’administration StreamLine Library Web à l'aide de la ligne de commande. Si vous 
préférez vous connecter à l'aide d'un navigateur Web, vous devez télécharger une 
version récente du navigateur Web Firefox à l'emplacement suivant : 
www.mozilla.com
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1. Choisissez votre méthode de connexion :

■ Ligne de commande : disponible uniquement sous Solaris. Passez à l'Étape 2. 

■ Navigateur Web : disponible sous Windows ou sous Solaris. Passez à l'Étape 3. 

2. Ouvrez une fenêtre de terminal et tapez la commande suivante :

javaws http://server_ID/opel/slc.jnlp 

où :

■ server_ID correspond à l'un des éléments suivants :

■ adresse IP du serveur de la Console d’administration StreamLine Library (au 
format nnn.nnn.nnn.nnn)

■ alias DNS du serveur de la Console d’administration StreamLine Library

■ opel représente le nom (racine du contexte) de l'application de la Console 
d’administration StreamLine Library Web sur le serveur. 

Passez à l'Étape 4. 

3. Démarrez un navigateur Web pris en charge sur votre PC ou votre station de travail 
client (voir « Exigences des clients » page 56 pour une liste des navigateurs pris en 
charge) et, dans la barre d'adresse ou dans le champ Address, saisissez l'URL de 
l'application Console d’administration StreamLine Library Web Start : 

http://server_ID/opel

où :

■ server_ID correspond à l'un des éléments suivants :

■ adresse IP du serveur de la Console d’administration StreamLine Library (au 
format nnn.nnn.nnn.nnn)

■ alias DNS du serveur de la Console d’administration StreamLine Library

■ opel représente le nom (racine du contexte) de l'application de la Console 
d’administration StreamLine Library Web sur le serveur. 

Remarque – Vous pouvez marquer cette URL pour vous y reconnecter 
ultérieurement. 
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4. La fenêtre Console d’administration StreamLine Library Launch s'affiche. Cliquez 
sur Launch Now.

Le processus Web Start récupère l'application de la Console d’administration 
StreamLine Library Web sur le serveur. Toutes les mises à jour sont téléchargées 
automatiquement. 

5. La fenêtre contextuelle Opening slc.jnlp s'affiche. 

Complétez la fenêtre contextuelle comme suit :

a. Spécifiez l'action que vous souhaitez réaliser avec le fichier slc.jnlp :

■ Cliquez sur le bouton radio Open with Java(TM) Web Start Launcher si vous 
souhaitez démarrer la Console d’administration StreamLine Library directement. 
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■ Cliquez sur le bouton radio Save to Disk si vous souhaitez enregistrer le fichier 
slc.jnlp sur votre client et vous connecter à la Console d’administration 
StreamLine Library ultérieurement. Voir « Connexion à la Console d’administra-
tion StreamLine Library Web à l'aide d'une icône » page 63 pour plus de détails 
sur la connexion. 

b. Cochez la case « Do this automatically for files like this from now on (facultatif) ». 
Si vous cochez cette case, cette fenêtre contextuelle n'apparaît pas lors des futures 
connexions. 

c. Cliquez sur OK. 

6. Si vous exécutez la Console d’administration StreamLine Library Web pour la 
première fois, une fenêtre contextuelle d'avertissement de signature numérique 
apparaît. 

Complétez la fenêtre contextuelle comme suit :

a. Vérifiez l'éditeur. 

b. Cochez la case « Always trust content from the publisher » (facultatif). Si vous 
cochez cette case, cette fenêtre contextuelle n'apparaît pas lors des futures 
connexions. 

c. Cliquez sur Run.
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7. Si vous exécutez la Console d’administration StreamLine Library Web pour la 
première fois, la fenêtre contextuelle License Agreement apparaît. 

Défilez vers le bas pour lire le contrat de licence dans son intégralité. Cliquez sur 
I accept the terms of the License Agreement, puis sur OK.
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8. La fenêtre Login de la Console d’administration StreamLine Library s'affiche. 

Saisissez vos informations de connexion, puis cliquez sur Log on.

ID utilisateur : Mot de passe SLC_login 
 : mot de passe 
Bibliothèque de bandes : library_ID 

où :

■ SLC_login correspond à l'ID utilisateur de la Console d’administration StreamLine 
Library.

■ password représente le mot de passe affecté à cet ID utilisateur. 

■ library_ID indique la bibliothèque de bandes à laquelle vous souhaitez vous 
connecter, selon l'une des manières suivantes :

■ adresse IP de la bibliothèque de bandes, exprimée sous la forme de la 
numérotation décimale avec points (nnn.nnn.nnn.nnn) 

■ alias DNS de la bibliothèque de bandes  
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▼ Connexion à la Console d’administration 
StreamLine Library Web à l'aide d'une icône

Remarque – Pour effectuer cette activité, vous devez d'abord enregistrer le fichier 
slc.jnlp de la Console d’administration StreamLine Library Web sur votre client. Voir 
« Connexion à la Console d’administration StreamLine Library Web à l'aide d'un 
navigateur ou d'une ligne de commande » page 57 pour plus de détails. 

1. Double-cliquez sur l'icône de bureau slc.jnlp sur votre client. 

Le processus Web Start récupère l'application de la Console d’administration 
StreamLine Library Web sur le serveur. Toutes les mises à jour sont téléchargées 
automatiquement. 

■ adresse IP de la bibliothèque de bandes, exprimée sous la forme de la 
numérotation décimale avec points (nnn.nnn.nnn.nnn) 

■ alias DNS de la bibliothèque de bandes 
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2. La fenêtre Console d’administration StreamLine Library Launch s'affiche. Cliquez 
sur Launch Now.

Le processus Web Start récupère l'application de la Console d’administration 
StreamLine Library Web sur le serveur. Toutes les mises à jour sont téléchargées 
automatiquement. 

3. Si vous exécutez la Console d’administration StreamLine Library Web pour la 
première fois, une fenêtre contextuelle d'avertissement de sécurité apparaît. 
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Complétez la fenêtre contextuelle comme suit :

a. Vérifiez que Sun Microsystems, Inc. est bien l'éditeur 

b. Cochez la case « Always trust content from the publisher » (facultatif). Si vous 
cochez cette case, cette fenêtre contextuelle n'apparaît pas lors des futures 
connexions. 

c. Cliquez sur Yes.

4. Si vous exécutez la Console d’administration StreamLine Library Web pour la 
première fois, la fenêtre contextuelle License Agreement apparaît. 

Défilez vers le bas pour lire le contrat de licence dans son intégralité. Cliquez sur I 
accept the terms of the License Agreement, puis sur OK.
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5. La fenêtre Login de la Console d’administration StreamLine Library s'affiche. 

Saisissez vos informations de connexion, puis cliquez sur Log on.

ID utilisateur : Mot de passe SLC_login 
 : mot de passe 
Bibliothèque de bandes : library_ID 

où :

■ SLC_login correspond à l'ID utilisateur de la Console d’administration StreamLine 
Library.

■ password représente le mot de passe affecté à cet ID utilisateur. 

■ library_ID indique la bibliothèque de bandes à laquelle vous souhaitez vous 
connecter, selon l'une des manières suivantes :

■ adresse IP de la bibliothèque de bandes, exprimée sous la forme de la 
numérotation décimale avec points (nnn.nnn.nnn.nnn) 

■ alias DNS de la bibliothèque de bandes 
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Console d’administration StreamLine 
Library Aide  
L'aide de la Console d’administration StreamLine Library affiche des informations 
destinées aux utilisateurs de la bibliothèque de bandes, aux programmateurs système, 
aux administrateurs système et aux représentants du service technique. 

Remarque – Les informations concernent exclusivement la Console d’administration 
StreamLine Library. Pour des informations sur le matériel de la bibliothèque de bandes, 
les lecteurs de bande ou le logiciel hôte, consultez la publication appropriée du produit.

L'exemple ci-dessous illustre la fenêtre Help de la Console d’administration StreamLine 
Library. 

▼ Accéder à l'aide de la Console d’administration 
StreamLine Library 
Vous pouvez afficher l'aide de la Console d’administration StreamLine Library depuis 
n'importe quelle fenêtre de la Console d’administration StreamLine Library. Utilisez 
l'une des méthodes suivantes : 

■ Pour afficher l'aide contextuelle de la fenêtre actuelle de la Console d’administration 
StreamLine Library, cliquez sur le bouton ? de la barre Options. 

■ Pour afficher des informations générales sur l'aide, cliquez sur Help > Contents 
dans la barre Menu. 

Navigation dans l'aide
Le panneau gauche de la fenêtre Help de la Console d’administration StreamLine 
Library affiche les éléments suivants :

■ Table of contents (TOC) : un plan des rubriques et des sous-rubriques
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■ Index : une liste des termes et des rubriques dans l'ordre alphabétique

Le panneau droit affiche la rubrique Help elle-même. 

La partie supérieure de la fenêtre Help de la Console d’administration StreamLine 
Library comporte les boutons de navigation suivants. 

Conseils d'utilisation de l'aide de la Console 
d’administration StreamLine Library
■ Vous pouvez réduire, agrandir ou redimensionner la fenêtre Help selon vos besoins.

■ Vous pouvez redimensionner les panneaux gauche et droit de la fenêtre Help en 
cliquant sur la bordure qui les sépare et en la glissant vers la gauche ou vers la 
droite. 

■ La plupart des rubriques incluent un bouton Related Topics en bas de la page. 
Cliquez sur ce bouton pour afficher les rubriques d'aide contenant des informations 
connexes et naviguer dans ces rubriques. 

Bouton Action

 Back Retrace vos étapes, en remontant d'une rubrique à la fois. 

 Forward Retrace vos étapes, en avançant d'une rubrique à la fois. 

 Print Affiche la fenêtre contextuelle Print qui vous permet 
d'imprimer une ou plusieurs rubriques :
■ Pour imprimer la rubrique actuelle, cliquez sur le bouton 

Print.
■ Pour imprimer une autre rubrique, cliquez sur le titre de 

cette rubrique dans la table des matières de l'aide de la 
Console d’administration StreamLine Library puis cliquez 
sur le bouton Print.

■ Pour imprimer plusieurs rubriques, mettez les rubriques en 
surbrillance dans la table des matières de l'aide de la 
Console d’administration StreamLine Library en appuyant 
sur Maj-Clic ou sur Ctrl-Clic, puis cliquez sur le bouton 
Print. 

 Print Setup Affiche la fenêtre contextuelle Page Setup qui vous permet de 
modifier la mise en page de l'impression.

 TOC Affiche la table des matières de l'aide de la Console 
d’administration StreamLine Library. 

 Index Affiche l'aide de l'index de la Console d’administration 
StreamLine Library. 
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CHAPITRE 3

Mode opératoire de la bibliothèque 
de bandes SL3000

Mode automatisé
Lorsque la bibliothèque de bandes fonctionne de manière automatisée, elle s'occupe 
automatiquement de monter et de démonter des cartouches sans nécessiter 
l'intervention d'un opérateur.

Les opérations automatisées comprennent les activités suivantes :

■ Montage et démontage des cartouches

■ Insertion et éjection des cartouches par un port d'accès aux cartouches (CAP) des 
AEM de rotation ou facultatif 

■ Journalisation des événements de la bibliothèque de bandes

■ Nettoyage des lecteurs 

Opérations de montage et de démontage desz 
cartouches
La fonction première de la bibliothèque de bandes est le montage et le démontage 
automatique des cartouches. Les commandes de montage et de démontage effectuées 
par l'hôte sont acceptées par le contrôleur de la bibliothèque de bandes qui les traduit 
en commandes robotisées réalisées par les TallBots. 

Séquence de montage
Une séquence de montage simplifiée comprend les étapes suivantes :

1. Un hôte demande le montage d'un numéro de série de volume (ID de volume) dans 
un lecteur.

2. Le contrôleur de la bibliothèque de bandes indique que l'ID de volume se trouve 
dans la bibliothèque de bandes et qu'un lecteur est prêt à exécuter la demande de 
montage.
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3. La bibliothèque de bandes se charge de l'opération de montage.

4. La commande de l'hôte est traduite par le contrôleur de la bibliothèque de bandes en 
commandes de déplacement pour le TallBot.

5. La cartouche est déplacée de sa cellule de stockage vers le lecteur.

6. La bibliothèque de bandes informe l'hôte que l'opération de montage est terminée.

7. Le lecteur exécute la commande de lecture/écriture demandée par l'hôte.

Séquence de démontage
Une séquence de démontage simplifiée comprend les étapes suivantes :

1. Un hôte demande qu'un ID de volume spécifique soit retiré d'un lecteur.

2. Le contrôleur de la bibliothèque de bandes indique à l'hôte que l'ID de volume se 
trouve dans lecteur et la bibliothèque de bandes est prête à exécuter la demande de 
démontage.

3. La bibliothèque de bandes se charge de l'opération de démontage.

4. La commande de l'hôte est traduite par le contrôleur de la bibliothèque de bandes en 
commandes mécaniques pour le TallBot.

5. La cartouche est déplacée du lecteur vers sa cellule initiale.

6. La bibliothèque de bandes informe l'hôte que l'opération de démontage est terminée.

Détermination des cas où la bibliothèque de bandes 
n'est pas en mode automatisé 
La bibliothèque de bandes n'est pas en mode automatisé lorsqu'elle n'est pas en mesure 
d'accepter des demandes émises par les hôtes. Les conditions suivantes indiquent que 
la bibliothèque de bandes n'est pas en mode automatisé.

■ Une porte d'accès principal à la bibliothèque de bandes est ouverte. 

■ Le TallBot n'exécute pas automatiquement les opérations de montage et de 
démontage des cartouches. 

■ L'arborescence des périphériques de la Console d’administration StreamLine Library 
indique que la bibliothèque de bandes rencontre un problème.
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État de la bibliothèque et des 
périphériques
La fenêtre Console d’administration StreamLine Library affiche des indicateurs de santé 
pour chacun des périphériques suivants :

■ Library 

■ Lecteurs

■ CAP de rotation et des AEM 

■ Alimentation électrique

■ Robots(s) 

■ Portes de sécurité d'AEM

21 3

4
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Le tableau ci-dessous présente les indicateurs de santé. 

L'indicateur de santé de la bibliothèque de bandes (3) reflète également les 
alertes d'état, sous forme de messages concernant des problèmes notables avec le 
microprogramme de la bibliothèque de bandes ou l'état de la configuration. Ces 
messages peuvent être affichés et gérés à partir de la fenêtre Status Module, si la 
licence Service de la bibliothèque de bandes est active. Voir « Messages d'alerte d'état » 
page 75 pour plus de détails. 

Si les conditions d'alerte de périphérique ou d'état indiquent plusieurs problèmes, 
l'indicateur de santé reflète le plus grave. Si, par exemple, une licence est sur le point 
d'expirer (condition « jaune ») et qu'un CAP est défectueux (condition « rouge »), 
l'indicateur de santé de la bibliothèque de bandes apparaît en rouge. Une fois le 
problème de CAP résolu, l'indicateur de santé de la bibliothèque de bandes devient 
jaune. Cet indicateur ne redevient vert qu'une fois que le problème de licence a 
également été résolu ou que le message d'alerte a été effacé manuellement. 

Indicateur Description

Comm 
Status

État actuel du canal de communication entre la Console d’administration 
StreamLine Library et le contrôleur de la bibliothèque de bandes. Les 
différentes icônes sont les suivantes :

Communications normales L'écran de contrôle des pulsations 
clignote périodiquement lorsque la Console d’administration 
StreamLine Library communique normalement avec le 
contrôleur de la bibliothèque de bandes. 

Un avertissement. Cette icône apparaît lorsque la réponse du 
serveur prend plus de 10 secondes.

Une erreur. Cette icône apparaît lorsque la réponse du serveur 
prend plus de 30 secondes. 

Userid Identifiant de l'utilisateur actuellement connecté à la Console 
d’administration StreamLine Library 

Library Bibliothèque à laquelle la Console d’administration StreamLine Library est 
connectée et représentation graphique de l'état actuel de la bibliothèque de 
bandes et de ses périphériques. Les différentes icônes sont les suivantes :

Tous les périphériques de la bibliothèque de bandes 
fonctionnent normalement. 

Un avertissement. Un ou plusieurs périphériques de la 
bibliothèque de bandes sont déconnectés ou fonctionnent en 
mode dégradé. 

Une erreur. Un ou plusieurs périphériques de la bibliothèque de 
bandes présentent un dysfonctionnement. 

Icône 
Device 
health

État actuel du périphérique indiqué. Si un indicateur de type périphérique 
est jaune ou rouge, vous pouvez développer le dossier du périphérique 
afin d'afficher les icônes de santé de périphérique individuelles, puis les 
détails concernant les périphériques spécifiques rencontrant des 
problèmes. 
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Problèmes de communication
En cas de perte de communication entre la Console d’administration StreamLine 
Library et le contrôleur de la bibliothèque de bandes, l'écran de contrôle des pulsations 
devient gris au bout de 30-60 secondes puis rouge et le message d'erreur suivant 
apparaît :
Heartbeat message not received from the library controller.

Vous devez fermer la session de la Console d’administration StreamLine Library puis 
vous reconnectez afin de restaurer la communication.



 

Rapports de bibliothèque de bandes

74 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

Rapports de bibliothèque de bandes 
Les rapports de la bibliothèque de bandes donnent des informations sur la bibliothèque 
de bandes et ses périphériques associés (par exemple, lecteurs, robots et CAP), les 
événements et les cartouches de bande. Vous pouvez utiliser les rapports de la 
bibliothèque de bandes pour contrôler l'activité de celle-ci et identifier les problèmes 
potentiels. En plus d'afficher les rapports à l'écran, vous pouvez enregistrer les données 
du rapport dans un fichier que vous pouvez ensuite imprimer ou envoyer par e-mail. 

La sortie d'un rapport affiche de manière statique les informations envoyées depuis 
le contrôleur de la bibliothèque de bandes lors de sa génération. La Console 
d’administration StreamLine Library ne met pas à jour les informations de manière 
dynamique tant que vous ne sélectionnez pas le bouton Update de la barre Options.

Remarque – L'exécution de plusieurs instances de la Console d'administration 
StreamLine Library autonome ou de la Console d'administration StreamLine Library 
Web sur le même PC ou la même station de travail peut engendrer des problèmes 
tels qu'une incohérence des données figurant dans les rapports. Il est recommandé 
qu'un seul utilisateur à la fois produise des rapports de la Console d’administration 
StreamLine Library sur un PC ou une station de travail, sauf si toutes les instances de la 
Console d’administration StreamLine Library sont de la même version.

Types de rapport
La Console d’administration StreamLine Library offre les types suivants de rapport :

■ Log : journaux détaillés des événements système

■ Statistics : informations statistiques sur les opérations de la bibliothèque de bandes 

■ Status Detail : informations détaillées sur l'état de la bibliothèque de bandes et des 
périphériques associés, comme les CAP, les lecteurs et les robots

■ Status Summary : informations récapitulatives sur l'état de la bibliothèque de bandes 
et des périphériques associés

■ Version : informations détaillées sur les versions du matériel et du logiciel de la 
bibliothèque de bandes

Barre Options du rapport
La barre Options sur chaque rapport vous permet d'exécuter les fonctions suivantes :

■ Recherche d'un rapport de la bibliothèque

■ Mise à jour du rapport avec les données actuelles

■ Enregistrement des données d'un rapport de la bibliothèque de bandes 
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Messages d'alerte d'état 

Remarque – Cette fonctionnalité est disponible uniquement si la licence Service est 
active sur la bibliothèque de bandes. 

Le Module d'état de la bibliothèque de bandes fournit un mécanisme centralisé 
pour l'affichage et la gestion des alertes d'état de la bibliothèque de bandes, 
qui correspondent à des messages concernant des problèmes notables liés au 
microprogramme ou à la configuration de la bibliothèque de bandes. Les alertes d'état 
apparaissent également dans le Journal d'événements de la bibliothèque de bandes, 
mais celui-ci contient un tel volume de messages qu'il est difficile d'y repérer ces 
alertes. La fenêtre Status Module met en surbrillance les messages importants, ce qui 
facilite leur identification et la résolution de certains problèmes. 

Ci-dessous figurent des exemples de messages d'alerte d'état pouvant apparaître dans 
des fenêtres Status Module :

■ Des robots redondants ont été installés, mais la licence Dual Robot n'est pas active

■ Une fonctionnalité sous licence est sur le point d'expirer

■ Une configuration de partition non valide a été détectée 

La fenêtre Status Module ne contient pas de message concernant les problèmes de 
périphériques, car les détails les concernant apparaissent dans les fenêtres d'état de 
périphériques respectifs (CAP Status, Drive Status, etc.) 

Un message d'alerte d'état peut également entraîner le changement de l'indicateur 
de santé de bibliothèque de bandes en jaune ou rouge, en fonction de la gravité du 
problème. Voir « État de la bibliothèque et des périphériques » page 71 pour plus de 
détails. 

Pour plus d'informations sur la gestion des messages d'alerte d'état, reportez-vous aux 
procédures suivantes :

■ « Affichage des alertes d'état de la bibliothèque de bandes » page 97

■ « Effacement des alertes d'état de la bibliothèque de bandes » page 100
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Opérations CAP 

Remarque – La plupart des fonctions CAP décrites dans cette section s'appliquent aux 
AEM ainsi qu'aux CAP réguliers. Dans les cas où il convient d'effectuer la distinction 
entre les deux, le terme « CAP de rotation » est utilisé pour désigner les CAP réguliers. 

Les CAP (port d'accès aux cartouches) permettent à un utilisateur de la bibliothèque de 
bandes d'insérer ou d'éjecter des cartouches dans la bibliothèque de bandes. Vous 
pouvez utiliser les CAP uniquement lorsque la bibliothèque de bandes est en mode 
automatisé. 

CAP de rotation
Le module de base comporte toujours un CAP de rotation. En option, le module 
d'extension de lecteurs et le module d'extension de cartouches peuvent également 
comporter un CAP de rotation. 

Chaque CAP de rotation est doté de deux magasins amovibles de 13 emplacements 
pouvant accueillir au total 26 cartouches à importer ou à exporter individuellement par 
chaque CAP. 

CAP des AEM
Pour obtenir une description détaillée des CAP des AEM, reportez-vous à « Opérations 
au niveau des AEM » page 80. 

Séquence CAP Open
L'ouverture d'un CAP s'effectue de la manière suivante :

1. Un hôte émet une commande de déverrouillage d'un CAP. 

2. L'état du CAP devient « unlocked » (non verrouillé).

3. L'utilisateur de la bibliothèque de bandes appuie sur le bouton CAP du pavé 
numérique.

4. L'état du CAP devient « open » (ouvert).

5. Le moteur du CAP est activé, et le CAP pivote vers l'extérieur de manière à montrer 
les magasins (CAP de rotation). Pour les CAP des AEM, une fois le voyant Enter 
allumé, l'utilisateur de la bibliothèque de bandes peut lever le loquet et ouvrir la 
porte d'accès de l'AEM (CAP des AEM). 
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Procédure de fermeture des CAP
La fermeture d'un CAP s'effectue de la manière suivante :

1. L'utilisateur de la bibliothèque de bandes appuie sur le bouton CAP du pavé 
numérique. 

2. Le moteur du CAP est activé, et le CAP pivote vers l'intérieur de manière à fermer le 
CAP (CAP de rotation). L'utilisateur de la bibliothèque de bandes peut fermer la 
porte d'accès de l'AEM et sécuriser le loquet (CAP des AEM). 

3. L'utilisateur de la bibliothèque de bandes appuie à nouveau sur le bouton CAP pour 
démarrer la séquence de fermeture. 

4. L'état du CAP devient « closed » (fermé) et « locked ».

5. Le TallBot analyse tous les emplacements des CAP.

Mode d'insertion automatique
Le mode d'insertion automatique dans les CAP (CAP auto enter mode) permet à un 
utilisateur de la bibliothèque de bandes d'ouvrir un CAP de rotation ou des AEM et de 
réaliser une opération d'insertion sans avoir besoin d'émettre une demande d'insertion 
ou une réservation depuis une application hôte. Lorsqu'un CAP est en mode d'insertion 
automatique, il est déverrouillé par défaut et son voyant est allumé. Le CAP est 
verrouillé uniquement lors des opérations d'insertion, d'éjection ou d'audit de la 
cartouche. 

Les applications hôtes gèrent le mode d'insertion automatique. Pour plus 
d'informations, consultez la documentation du logiciel de gestion des bandes 
appropriée. Pour activer le mode d'insertion automatique d'un CAP, vous devez 
saisir la commande système appropriée permettant de déverrouiller le CAP. 

Pour lancer une opération d'insertion en utilisant un CAP automatique, il vous 
suffit d'appuyer sur le bouton CAP Open du pavé numérique. Le mode d'insertion 
automatique n'a pas d'impact sur les opérations d'éjection de cartouches. Vous devez 
donc émettre une commande d'éjection explicite pour éjecter les cartouches par un CAP 
en mode d'insertion automatique.

Mode manuel des CAP 
Le mode manuel représente la méthode la plus sûre pour réaliser des opérations sur les 
CAP. 

En mode manuel, un CAP de rotation ou des AEMest verrouillé par défaut et son 
voyant est éteint. Pour lancer une opération d'insertion et d'éjection en utilisant un CAP 
manuel, vous devez saisir une commande d'insertion et d'éjection explicite avant 
d'appuyer sur le bouton d'ouverture du CAP sur le pavé numérique. 
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Priorités du CAP pour les éjections de cartouche 
par des hôtes FC-SCSI
Lorsque vous démarrez une opération d'éjection depuis un hôte HLI, vous pouvez 
spécifier le CAP à utiliser. Cependant, l'interface SCSI ne fournit pas ce niveau de 
contrôle. L'interface regroupe essentiellement l'ensemble des CAP et des AEM dans la 
bibliothèque de bandes et les traite comme un seul grand CAP. Lorsque vous démarrez 
une opération d'éjection depuis un hôte FC-SCSI, le TallBot place les cartouches dans 
des CAP, de gauche à droite et en démarrant tout d'abord avec les CAP de rotation 
pour passer ensuite aux AEM, le cas échéant. 

Supposons, par exemple, qu'une bibliothèque de bandes FC-SCSI dispose de la 
configuration suivante :

■ Module de base, avec un CAP de rotation standard

■ Deux CEM, avec des CAP de rotation en option

■ Deux AEM 

Remarque – L'exemple qui suit induit une bibliothèque de bandes non partitionnée, 
ou partitionnée, dans laquelle tous les CAP et les AEM sont partagés par l'ensemble des 
hôtes. Pour les bibliothèques de bandes partitionnées, la priorité du CAP dépend de la 
manière dont les CAP sont affectés aux partitions. 

Pour une opération d'éjection de 350 cartouches, le TallBot remplit les cellules du CAP 
selon l'ordre suivant :

Module
Nombre de 
cartouches

Nombre total
de cartouches

1 CEM gauche 26 26

2 Module de base 26 52

3 CEM droit 26 78

4 AEM gauche 234 312

5 AEM droit 38 350
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Utilisation des CAP dans une bibliothèque de 
bandes partitionnée

Remarque – Cela concerne uniquement les bibliothèques de bandes partitionnées. 
Pour plus d'informations sur la définition des partitions de la bibliothèque de bandes, 
reportez-vous à « Récapitulatif des tâches de partitionnement » page 290 

Un CAP de rotation ou des AEM est une ressource partagée de la bibliothèque de 
bandes ; en d'autres termes, il peut être utilisé par l'ensemble des partitions de la 
bibliothèque de bandes. Cependant, un CAP ne peut être utilisé que par une seule 
partition à la fois. Lorsqu'une partition utilise un CAP pour des opérations d'insertion 
ou d'éjection, celui-ci est réservé à cette partition et n'est pas disponible pour toutes les 
autres. 

Pour qu'une partition puisse réserver un CAP, toutes les conditions suivantes doivent 
être remplies :

■ Le CAP doit être disponible, il ne doit être réservé par aucune autre partition. 

■ Le CAP doit être vide.

■ Le CAP doit être fermé et verrouillé.

Pour plus d'informations, reportez-vous à « « Propriété » de CAP » page 280. 

Informations supplémentaires sur le CAP
Pour plus d'informations sur les CAP de rotation et des AEM, reportez-vous aux 
sections suivantes dans ce manuel. 

Section Type d'information Page

“Opérations au niveau des 
AEM”

Informations d'utilisation qui s'appliquent 
spécifiquement aux CAP des AEM

80

“Tâches de gestion de CAP 
de rotation et des AEM”

Procédures d'affichage d'état et de propriétés 
de CAP de rotation

125

“Tâches de gestion des 
cartouches”

Procédures d'utilisation de CAP de rotation 
pour charger et décharger des cartouches

137

“Partitions et CAP de 
rotation et des AEM”

Informations de configuration de partition 
concernant les CAP de rotation

279
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Opérations au niveau des AEM 
L'AEM (module d'extension d'accès) permet à un utilisateur de bibliothèque de bandes 
d'effectuer des chargements ou des déchargements en masse jusqu'à 234 cartouches à 
la fois, vers ou depuis la bibliothèque de bandes. L'AEM permet également une 
maintenance sans interruption d'une bibliothèque de bandes TallBot. 

Remarque – Les AEM partagent un nombre important de fonctionnalités et de 
fonctions identiques à celles des CAP de rotation, mais ils présentent également 
certaines caractéristiques uniques. Cette section décrit les éléments uniques aux AEM. 

Porte d'accès de l'AEM 
La porte d'accès de l'AEM correspond à la porte externe que vous ouvrez pour effectuer 
un chargement ou un déchargement de cartouches en masse vers ou depuis la 
bibliothèque de bandes. Le panneau avant de la porte d'accès comprend les composants 
suivants : 

■ Trois voyants : Wait, Enter et Unlocked

■ Deux verrous : 

■ Service Access : peut être ouvert uniquement par un Sun CSE du StorageTek. 
L'ouverture de ce verrou libère le pêne dormant de la porte d'accès.

■ Deadbolt Override : pour que l'utilisateur d'une bibliothèque de bandes accède 
rapidement à l'intérieur de l'AEM. Cette action produit les mêmes effets sur les 
opérations de bibliothèque de bandes que l'ouverture de la porte d'accès de 
bibliothèque de bandes principale. 

■ Bouton « Operator Request CAP » : pour accéder normalement à l'intérieur de 
l'AEM, afin de charger ou de décharger des cartouches. L'utilisation de ce bouton 
libère le pêne dormant de la porte d'accès. 

■ Latch : ouvre et ferme la porte d'accès. Le loquet peut-être ouvert uniquement une 
fois que vous avez libéré le pêne dormant ou que vous avez utilisé la redéfinition du 
pêne dormant. 

Porte desécurité d'AEM
La porte de sécurité constitue la porte de « garage » interne, qui s'abaisse pour séparer 
l'AEM du reste de la bibliothèque de bandes. Cette porte permet un accès sécurisé à 
l'intérieur de l'AEM, afin qu'un utilisateur de bibliothèque de bandes charge ou 
décharge des cartouches, ou qu'un Sun CSE du StorageTek effectue une opération de 
service sur le TallBot ou sur d'autres composants de l'AEM. 

La porte de sécurité est abaissée lorsque vous appuyez sur le bouton « Operator 
Request CAP » sur la porte d'accès de l'AEM, ou lorsqu'un Sun CSE du StorageTek 
utilise le verrou Service Access. Elle n'est pas abaissée si vous effectuez un « accès 
rapide » à l'AEM en déverrouillant le verrou Deadbolt Override. 
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La porte de sécurité est automatiquement levée lorsque vous fermez la porte d'accès de 
l'AEM. Le TallBot pénètre ensuite dans l'AEM pour y mener un audit de toutes les 
cellules AEM. Un audit complet d'un AEM doit prendre moins de trois minutes. 

Fonctions de CAP des AEM
Chaque CAP des AEM contient 18  magasins de cartouches amovibles comportant 
13 emplacements sur les façades avant et arrière, pour un total de 234 emplacements de 
cartouches. Les magasins sont organisés selon une configuration 3 X 3 sur chaque 
façade. Ils sont identiques à ceux utilisés dans des CAP de rotation.

En termes de chargements et de déchargements de cartouche, le contrôleur de la 
bibliothèque de bandes traite chaque AEM comme un CAP de très grande taille. Pour 
plus d'informations sur les fonctions du CAP qui s'appliquent aux AEM, reportez-vous 
à « Opérations CAP » page 76. 

Partitions et AEM
Concernant le partitionnement de la bibliothèque de bandes, les CAP des AEM sont 
soumis aux mêmes règles et restrictions que les CAP de rotation. Ils peuvent êtres 
affectés pour une utilisation exclusive par une partition, ou bien être partagés par 
plusieurs partitions avec le même type d'interface hôte. Voir « Partitions et CAP de 
rotation et des AEM » page 279 pour plus de détails. 

Maintenance sans interruption 
L'AEM permet à un Sun CSE du StorageTek d'accéder à une bibliothèque de bandes 
TallBot et de la dépanner en toute sécurité, sans avoir à la placer hors ligne. Si un 
TallBot est défectueux, il se stocke lui-même dans l'AEM. La bibliothèque de bandes 
demeure en ligne, et si des TallBot redondants sont installés, la bibliothèque de bandes 
peut poursuivre les opérations de manière normale, via le TallBot fonctionnel restant. 

Un Sun CSE du StorageTek peut utiliser une clé spéciale pour déverrouiller le verrou 
Service Access sur la porte d'accès. Cela entraîne l'abaissement de la porte de sécurité 
de l'AEM, et la séparation entre l'AEM et le reste de la bibliothèque de bandes. Une fois 
la porte de sécurité entièrement abaissée, le Sun CSE du StorageTek peut ouvrir la porte 
d'accès de l'AEM et effectuer la maintenance de manière sécurisée sur le TallBot ou tout 
autre composant de l'AEM défectueux, alors que la bibliothèque de bandes demeure en 
ligne. L'AEM lui-même est mis hors ligne pendant la période de maintenance, 
entraînant la suspension des fonctions de chargement/déchargement de cartouche. 

Une fois la maintenance effectuée, le CSE du StorageTek ferme la porte d'accès, la porte 
de sécurité se lève, le TallBot est réinitialisé et effectue un audit des emplacements de 
cartouche du CAP des AEM, puis l'AEM est remis en ligne. 
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Informations sur l'AEM supplémentaires
Pour plus d'informations sur les AEM, reportez-vous aux sections suivantes dans ce 
manuel. 

Section Type d'information Page

“Opérations CAP” Informations d'utilisation qui s'appliquent 
spécifiquement aux CAP de rotation et aux 
CAP des AEM

76

“Tâches de gestion de CAP 
de rotation et des AEM”

Procédures d'affichage d'état et de propriétés 
de CAP des AEM

125

“Tâches de gestion des 
cartouches”

Procédures d'utilisation des CAP des AEM 
pour charger et décharger des cartouches

137

“Tâches de gestion de la 
porte de sécurité de l'AEM”

Procédures d'affichage de l'état et des 
propriétés de la porte de sécurité de l'AEM 
(porte de « garage ») 

190

“Partitions et CAP de 
rotation et des AEM”

Informations de configuration de partition 
concernant les CAP de rotation et des AEM

279

“Tâches d'utilitaire de porte 
de sécurité de l'AEM”

Procédures de redémarrage de la porte de 
sécurité de l'AEM (porte de « garage ») 

487
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Gestion des cartouches 
Toutes les cartouches de la bibliothèque de bandes doivent être munies d'une étiquette 
externe lisible. Voir Annexe C, « Manipulation des cartouches » pour plus de détails. 

Les applications hôtes HSC et ACSLS ne prennent pas en charge les cartouches non 
étiquetées et ne permettent pas leur insertion via le CAP. Si vous placez une cartouche 
non étiquetée dans un CAP, l'hôte ne la prend pas en compte et vous devez la retirer du 
CAP. 

Si vous placez manuellement une cartouche non étiquetée dans une cellule de stockage, 
le TallBot ne la prend pas en compte lors d'une analyse du matériel et n'essaie pas 
d'installer une autre cartouche dans l'emplacement. Cependant, pendant une analyse 
ACSLS ou HSC, l'hôte déplace la cartouche du CAP en vue d'une éjection de la 
bibliothèque de bandes. 

Le contrôleur de la bibliothèque de bandes ne vous permet pas de monter une 
cartouche non étiquetée ou de type inconnu dans quelque lecteur de bande que ce soit. 

Insertion de cartouches
Vous pouvez insérer jusqu'à 26 cartouches à la fois dans chaque CAP de rotation. Vous 
pouvez charger en masse jusqu'à 234 cartouches via chaque CAP des AEM. 

Avant toute insertion de cartouches dans la bibliothèque de bandes, vous devez vérifier 
qu'elle est correctement étiquetée. Insérez chaque cartouche dans un emplacement CAP 
de manière à ce que l'étiquette du client (le cas échéant) soit face à vous, le moteur du 
hub tourné vers le bas et l'étiquette de l'ID de volume tournée vers vous. Les cartouches 
peuvent être placées dans n'importe quel emplacement CAP, dans n'importe quel 
ordre. Le TallBot analyse tous les emplacements une fois la porte des CAP refermée. 

Remarque – En raison de la conception du CAP, vous ne pouvez pas insérer une 
cartouche T9x40 ou T10000 à l'envers dans le CAP. Toutefois, elle ne vous empêche pas 
de placer une cartouche LTO à l'envers dans le CAP. 

Le lecteur de code à barres du TallBot scanne les ID de volume des cartouches 
uniquement pendant les opérations d'insertion car il s'agit de nouveaux ID devant être 
ajoutés dans la base de données du contrôleur de la bibliothèque de bandes. Le TallBot 
n'a pas besoin de scanner les ID de volume des cartouches lors des opérations 
d'éjection. 

Lorsqu'une cartouche est insérée dans la bibliothèque de bandes, soit l'hôte lui affecte 
une cellule initiale, soit elle est montée sur un lecteur, selon la raison de son insertion. 
L'emplacement des cartouches est enregistré dans la base de données du contrôleur de 
la bibliothèque de bandes en utilisant le format de l'adresse interne de la bibliothèque 
de bandes (voir « Adresse interne de la bibliothèque de bandes » page 509). Cet 
emplacement est également transmis à l'hôte afin de l'intégrer à sa base de données de 
cartouches.
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Éjecion des cartouches
Vous pouvez éjecter jusqu'à 26 cartouches à la fois dans chaque CAP de rotation. Vous 
pouvez décharger en masse jusqu'à 234 cartouches via chaque CAP des AEM.

Afin d'éjecter une cartouche, vous devez préciser l'ID de volume de la cartouche à 
retirer de la bibliothèque de bandes. Le TallBot se déplace vers l'emplacement de 
stockage indiqué dans la base de données du contrôleur de la bibliothèque de bandes, 
enlève la cartouche et la place dans un emplacement CAP. Voir « Priorités du CAP pour 
les éjections de cartouche par des hôtes FC-SCSI » page 78 pour plus de détails sur 
l'ordre d'utilisation des CAP dans des bibliothèques de bandes FC-SCSI. Après 
ouverture du CAP, la cartouche et son emplacement sont supprimés de la base de 
données du contrôleur de la bibliothèque de bandes et de celle de l'hôte. 

Remarque – Le TallBot n'a pas besoin de scanner les ID de volume des cartouches lors 
des opérations d'éjection. 

Localisation des cartouches
La Console d’administration StreamLine Library vous permet d'afficher l'adresse 
interne des cartouches dans la bibliothèque de bandes. Vous pouvez localiser une 
cartouche grâce à l'un des moyens suivants :

■ ID de volume

■ Adresse interne de la bibliothèque de bandes

■ adresse HLI-PRC 

Cet utilitaire est particulièrement utile en cas de montage manuel d'une cartouche. Le 
logiciel de gestion de la bibliothèque de bandes (par exemple, HSC ou ACSLS) fournit 
l'ID de volume et l'adresse HLI-PRC ou FC-SCSI de la cartouche ainsi que l'adresse de 
la baie de disques d'un lecteur disponible. Avant de vous connecter à la bibliothèque de 
bandes, nous vous conseillons de noter l'ID de volume, l'emplacement de la cartouche 
et celui du lecteur. 

Déplacements de récupération 
Avec la fonction de diagnostic et de récupération, vous pouvez déplacer une cartouche 
d'un emplacement vers un autre. Par exemple :

■ Vous pouvez renvoyer une cartouche vers son emplacement initial depuis une 
cellule du CAP, un lecteur ou une autre cellule de stockage. 

■ Vous pouvez décider de regrouper les cartouches par type de données ou de les 
rapprocher de leurs lecteurs affectés. 

■ Vous pouvez éjecter une cartouche de nettoyage ou de diagnostic ayant expiré.

■ Vous pouvez insérer une nouvelle cartouche de nettoyage ou de diagnostic, puis la 
déplacer vers une cellule de stockage réservée. 
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Une cartouche qui se trouve dans une cellule de stockage peut être déplacée 
uniquement vers un CAP, une cellule réservée une autre cellule de stockage, mais pas 
vers un lecteur. Une cartouche se trouvant dans un lecteur, un CAP ou une cellule 
réservée peut-être déplacée vers n'importe quel autre emplacement inoccupé dans la 
bibliothèque de bandes. Pour plus d'informations, consultez les procédures suivantes :

■ « Déplacement d'une cartouche spécifique par ID de volume » page 151

■ « Déplacement d'une cartouche depuis un emplacement spécifique » page 153

Avant tout déplacement de cartouche, il est recommandé de générer un Rapport 
récapitulatif des cartouches indiquant le contenu des cellules de stockage de la 
bibliothèque de bandes. Voir « Liste des cartouches de la bibliothèque de bandes » 
page 146 pour plus de détails. Ce rapport vous aide à déterminer l'emplacement des 
cartouches, ainsi que les cellules de stockage inoccupées. 
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Lecteurs
Vous pouvez installer jusqu'à 56 lecteurs dans une bibliothèque de bandes de la 
manière suivante :

■ 24 maximum dans le module de base

■ 32 maximum dans le module d'extension de lecteurs (DEM)

Pour obtenir une liste des lecteurs de bande pris en charge, voir « Lecteurs de bande » 
page 19. 

Identification des lecteurs
La bibliothèque de bandes utilise les méthodes d'adressage suivantes pour chaque 
lecteur :

■ Adresse interne de la bibliothèque de bandes : pour l'ensemble des lecteurs. Elle est 
affectée par le contrôleur de la bibliothèque de bandes en fonction de la bibliothèque 
de bandes, du rail, de la colonne, de la partie et de la ligne où se trouve le lecteur. 

■ Adresse HLI-PRC (Host LMU Interface-Panel, Row, Column) : uniquement pour les 
connexions hôtes TCP/IP. Elle est définie par les applications hôtes. 

■ Adresse d'élément SCSI hôte : uniquement pour les connexions hôtes FC-SCSI. Elle 
est définie par les applications hôtes. 

■ Adresse de baie de disques : pour l'ensemble des lecteurs. Elle est affectée par le 
contrôleur de la bibliothèque de bandes en fonction de l'emplacement physique du 
lecteur. 

■ Nom de port mondial dynamique : uniquement pour les connexions Fibre Channel. 
Elle est affectée par le contrôleur de la bibliothèque de bandes en fonction de 
l'emplacement du lecteur. 

Pour plus d'informations concernant les méthodes d'identification et d'adressage des 
lecteurs, voir Annexe A, « Adresses des ressources de la bibliothèque de bandes » page 
507. 

États des lecteurs
Les différents états des lecteurs peuvent être les suivants :

■ Online : le lecteur peut être utilisé pour des opérations de lecture et d'écriture.

■ Offline : le lecteur ne peut pas être utilisé pour des opérations de lecture et 
d'écriture. 

Informations supplémentaires
Pour connaître les procédures détaillées concernant le lecteur, voir « Tâches de gestion 
des lecteurs » page 157. 
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Nettoyage des lecteurs 
Le nettoyage des lecteurs de bande de la bibliothèque de bandes doit se faire 
régulièrement afin d'éviter l'apparition d'erreurs de lecture et d'écriture. La 
bibliothèque de bandes autorise deux méthodes de nettoyage des lecteurs :

■ Gestion du nettoyage automatique via le Console d’administration StreamLine 
Library 

■ Nettoyage manuel 

Cartouches de nettoyage

Remarque – Vous devez utiliser des cartouches de nettoyage dont les supports sont 
compatibles avec les lecteurs de la bibliothèque de bandes. 

Les cartouches de nettoyage ont une durée de validité limitée. Consultez la 
documentation relative à votre lecteur de bande afin de déterminer le nombre 
d'utilisation ou la limite maximum pour chaque type de cartouches de nettoyage.

Lorsque vous insérez une cartouche de nettoyage dans la bibliothèque de bandes, le 
contrôleur de la bibliothèque de bandes la considère comme une nouvelle cartouche et 
remet le compteur d'utilisation à zéro. Par conséquent, il est recommandé d'insérer 
uniquement des nouvelles cartouches de nettoyage dans la bibliothèque de bandes. 

Le compteur augmente à chaque utilisation d'une cartouche de nettoyage pour nettoyer 
un lecteur. La cartouche doit être remplacée lorsque le compteur d'utilisation d'une 
cartouche de nettoyage dépasse la limite maximum. 

La Console d’administration StreamLine Library permet d'afficher l'état d'une 
cartouche de nettoyage à tout moment. Les différents états possibles sont les suivants :

■ OK : la cartouche n'a pas dépassé le nombre d'utilisations maximum.

■ Warning : la cartouche a atteint le nombre d'utilisations maximum.

■ Expired : la cartouche a dépassé le nombre d'utilisations maximum.

Éjection des cartouches de nettoyage expirées 
Éjectez avec précaution les cartouches de nettoyage ayant expiré de la bibliothèque de 
bandes. Si vous déplacez une cartouche de nettoyage ayant expiré vers un CAP et que 
vous ouvrez celui-ci, vous devez retirer la cartouche. Si vous fermez le CAP sans 
préalablement retirer la cartouche de nettoyage, la TallBot réinsérera la cartouche ayant 
expiré dans la bibliothèque de bandes et le contrôleur de la bibliothèque de bandes 
remettra le compteur d'utilisation à zéro. 
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Gestion du nettoyage automatique via le Console 
d’administration StreamLine Library 
La fonction de nettoyage automatique (ou « auto clean ») sur la SL3000 vous permet de 
gérer le nettoyage de lecteur automatique via le Console d’administration StreamLine 
Library. Cette fonction doit être activée uniquement pour des partitions ou des 
bibliothèques de bandes entières contrôlées par des hôtes FC-SCSI. 

Pour toutes les autres partitions et bibliothèques de bandes complètes (celles qui sont con-
trôlées par les logiciels de gestion de bandes ACSLS ou HSC), vous devez désactiver la 
fonction de nettoyage automatique dans le Console d’administration StreamLine Library. 
(Voir « Configuration de la fonction de nettoyage automatique » page 173 pour plus de 
détails). Les logiciels ACSLS ou HSC gèrent ensuite la fonction de nettoyage automatique 
pour ces partitions et bibliothèques de bandes, alors que la fonction de nettoyage automa-
tique de la SL3000 empêche la notification de HSC et ACSLS lorsque des lecteurs nécessi-
tent un nettoyage. Pour plus d'informations, consultez la documentation HSC et ACSLS. 

Actuellement, la fonction de nettoyage automatique de la SL3000 ne prend pas en 
charge la fonctionnalité suivante :

■ Importation automatique des cartouches de nettoyage par le CAP et le 
positionnement de ces bandes dans les cellules réservées ou dédiées aux cartouches 
de nettoyage et de diagnostic. 

■ Exportation automatique des cartouches de nettoyage expirées par le CAP. 

Lorsque la fonction de nettoyage automatique est activée, le contrôleur de la 
bibliothèque de bandes exécute automatiquement une opération de nettoyage lorsque 
qu'un lecteur a besoin d'être nettoyé. Le robot TallBot récupère une cartouche de 
nettoyage appropriée (en fonction du type de lecteur) dans les cellules réservées, envoie 
la cartouche vers le lecteur, puis ramène la cartouche à sa cellule de stockage une fois 
l'opération de nettoyage terminée.

Nettoyage manuel 

Remarque – Le logiciel de gestion de la bibliothèque de bandes contrôle le nettoyage 
manuel des lecteurs. Pour plus d'informations concernant la syntaxe des commandes, 
consultez la documentation ACSLS ou HSC

En cas de désactivation de la fonction de nettoyage automatique, les opérations de 
nettoyage des lecteurs doivent être réalisées manuellement. Afin de déterminer si un 
lecteur a besoin d'être nettoyé, la Console d’administration StreamLine Library permet 
d'afficher l'état de nettoyage d'un lecteur ainsi que la date du dernier nettoyage. 

Si le nettoyage automatique est activé, vous pouvez éventuellement toujours démarrer 
un nettoyage manuel, selon le type de lecteur. Certains types de lecteurs permettent un 
nettoyage manuel à n'importe quel moment, tandis que d'autres n'autorisent un 
nettoyage qu'une fois un nombre maximal d'utilisations atteint. Dans le second cas, la 
bibliothèque de bandes peut vous permettre de monter une cartouche de nettoyage sur 
un lecteur, mais ce lecteur n'effectue pas réellement l'opération de nettoyage. Pour plus 
d'informations, reportez-vous à la documentation relative à votre lecteur de bandes. 

Afin de localiser le type de cartouches de nettoyage compatible avec un lecteur 
spécifique, la Console d’administration StreamLine Library permet de générer un 
rapport récapitulatif des cartouches et un rapport détaillé des lecteurs. 
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TallBot (bras robotisés) 
Le bras robotisé TallBot de la bibliothèque de bandes permet de déplacer les cartouches 
à travers l'ensemble des emplacements de stockage, lecteurs de bande et CAP de la 
bibliothèque de bandes. Il permet également d'analyser la bibliothèque de bandes. 

Le TallBot est inclus dans le module de base et est accessible depuis l'avant de 
l'armoire. Les trois composants principaux du TallBot sont les suivants :

■ X table assembly : mouvement latéral à 180°. 

■ Z drive assembly : mouvement vertical. 

■ Hand assembly : cela comprend les composants suivants :

■ Des pinces permettant le transport des cartouches. 

■ Un scanner laser de codes à barres permettant la localisation et la lecture des 
étiquettes des cartouches. 

■ Un capteur de proximité permettant de détecter les cellules de stockage vides et 
les cartouches sans étiquette. 

Pour plus d'informations concernant l'affichage et la gestion des états du TallBot et 
d'autres détails, reportez-vous à « Tâches de surveillance du robot et de l'alimentation 
électrique » page 184. 
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Alimentation électrique
La bibliothèque de bandes SL3000 est équipée de lecteurs de bandes, d'unités 
robotiques et de systèmes électroniques redondants. Les différentes options de 
redondance sont les suivantes : 

■ N+1 

■ 2N 

■ 2N+1 

Les différentes possibilités de sources d'énergie sont les suivantes :

■ 120-127 VCA, monophasé

■ 200-240 VCA, monophasé

Voir « Options d'alimentation » page 25 pour plus de détails. 
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Type d'interface hôte
La SL3000 prend en charge les interfaces de chemin de contrôle suivantes : 

■ HLI (TCP/IP) : protocole TCP/IP utilisant Ethernet 10/100 Base-T et des câbles 
CAT-5 

■ FC-SCSI : protocole et commande SCSI 3 sur une interface Fibre Channel

Voir « Chemin de contrôle de la bibliothèque de bandes » page 27 pour plus de détails. 

Bibliothèques non partitionnées
Dans les bibliothèques de bandes non partitionnées, tous les hôtes doivent utiliser le 
même type d'interface pour se connecter à la bibliothèque de bandes. 

La fenêtre System Detail > Status > General permet d'afficher le type d'interface. 

Vous pouvez modifier le type d'interface par le biais de la fenêtre 
Select Active Cells > Select Active Cells. 

Bibliothèques partitionnées
Dans les bibliothèques de bandes partitionnées, les types d'interface hôte FC-SCSI et 
HLI peuvent être utilisés. Chaque partition doit utiliser l'un ou l'autre. Au moment de 
la création d'une nouvelle partition, vous devez indiquer le type d'interface utilisé. 
Tous les hôtes d'une partition utilisent le même type d'interface. 
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Pour plus d'informations, reportez-vous à « Connexions hôte-partition » page 272 
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Tâches des opérations automatiques 
Les tâches des opérations automatiques de la bibliothèque de bandes se divisent en 
plusieurs catégories :

■ « Tâches de gestion de la bibliothèque de bandes » page 95

■ « Tâches de gestion de CAP de rotation et des AEM » page 125

■ « Tâches de gestion des cartouches » page 137

■ « Tâches de gestion des lecteurs » page 157

■ « Tâches de nettoyage des lecteurs » page 172

■ « Tâches de surveillance du robot et de l'alimentation électrique » page 184

■ « Tâches de gestion de la porte de sécurité de l'AEM » page 190
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Tâches de gestion de la bibliothèque de 
bandes

Tâche Page

Affichage de l'état de la bibliothèque 96

Affichage des alertes d'état de la bibliothèque de bandes 97

Effacement des alertes d'état de la bibliothèque de bandes 100

Affichage de l'état des ports HLI 102

Affichage des informations sur la configuration de la bibliothèque 
de bandes

104

Affichage des propriétés du contrôleur de la bibliothèque de bandes 105

Affichage des propriétés du contrôleur des lecteurs 107

Affichage des propriétés du contrôleur des lecteurs 107

Modification du type d'interface de la bibliothèque de bandes 
(bibliothèques de bandes non partitionnées)

108

Affichage d'un rapport de la bibliothèque de bandes 111

Recherche d'un rapport de la bibliothèque 114

Enregistrement des données d'un rapport de la bibliothèque de 
bandes

116

Affichage du rapport « Last 24 Hours » Library Energy Monitor 118

Affichage du rapport « Last Month » Library Energy Monitor 120

Affichage du rapport « Last Year » Library Energy Monitor 122
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▼ Affichage de l'état de la bibliothèque 
Cette fenêtre permet de visualiser l'état de fonctionnement actuel de la bibliothèque de 
bandes. Ces valeurs sont mises à jour à chaque opération d'un hôte ; opération en 
arrière plan ou opération de l'utilisateur.

Remarque – La fenêtre Reports > Library Details permet également d'avoir accès à 
ces informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library.

2. Cliquez sur l'onglet Status puis sur l'onglet General.

La fenêtre affiche l'état actuel de la bibliothèque de bandes. 
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▼ Affichage des alertes d'état de la bibliothèque de 
bandes 

Remarque – Cette fonctionnalité est disponible uniquement si la licence Service est 
active sur la bibliothèque de bandes. 

Remarque – Si la licence Service n'est pas active sur la bibliothèque de bandes, alors 
cette fenêtre est vierge et comporte uniquement un message indiquant que « La licence 
Service n'est pas valide » (Service license is not valid). 

Utilisez cette procédure pour afficher des alertes d'état de bibliothèque de bandes, 
pour vous aider à identifier des problèmes actuels ou en attente concernant le 
microprogramme ou la configuration de la bibliothèque de bandes. Vous pouvez 
effectuer cette procédure dès qu'un indicateur de santé de la bibliothèque de bandes 
passe de la couleur verte à jaune ou rouge, ce qui indique un avertissement ou une 
erreur. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Status, puis sur l'onglet Status Module. 

La fenêtre affiche toutes les alertes d'état de la bibliothèque de bandes. 
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Champs de la fenêtre
Clear Alert Number 

Facultatif.

Messages d'alerte d'état que vous voulez effacer de la fenêtre. 

Le menu déroulant affiche les nombres 0 à 20. Bien que vous puissiez sélectionner 
n'importe lequel de ces nombres, seuls les nombres correspondant à des messages 
d'alerte effaçables apparaissant dans la fenêtre entraînent l'effacement d'un message. 

Alert #

Affichage uniquement.

Nombre séquentiel affecté au message d'alerte d'état. 

Level

Affichage uniquement.

Niveau de gravité du message d'alerte d'état. Les différentes options sont les 
suivantes : 

■ OK : le module du microprogramme fonctionne normalement. 

■ Information : message d'information ; le module du microprogramme fonctionne 
normalement. 

■ Warning : le module du microprogramme fonctionne dans un état endommagé ; 
une défaillance prochaine est possible. 

■ Error : le module du microprogramme a connu une défaillance. 

Module Name

Affichage uniquement.

Module du microprogramme du contrôleur de la bibliothèque de bandes affecté par 
ce message. 

Clearable? 

Affichage uniquement.

Indique si le message d'alerte d'état peut être effacé manuellement de l'affichage. Les 
différentes options sont les suivantes :

■ Yes : le message peut être effacé et l'état du module du microprogramme 
redevient OK. 

■ No : le message ne peut pas être effacé. En général, les messages OK et 
Information ne peuvent pas être effacés. 

Description

Affichage uniquement.

Description complète du message d'alerte d'état. 
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Boutons
Apply

Cliquez pour effacer le message d'alerte sélectionné de l'affichage Status Module. 
L'état du module du microprogramme redevient OK, tandis que l'indicateur de santé 
de la bibliothèque de bandes est mis à jour. 

Remarque – Si le message d'alerte est périodiquement mis à jour, il réapparaît ensuite, 
lors du cycle de mise à jour suivant.

Refresh 

Ce bouton permet d'actualiser l'affichage avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. 
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▼ Effacement des alertes d'état de la bibliothèque de 
bandes  

Remarque – Cette fonctionnalité est disponible uniquement si la licence Service est 
active sur la bibliothèque de bandes. 

Utilisez cette procédure pour effacer une alerte d'état de microprogramme de la 
bibliothèque de bandes. Toutes les alertes ne peuvent pas être effacées.

Remarque – L'effacement d'une alerte ne la supprime que de l'affichage dans la 
fenêtre. Cela ne résout pas le problème sous-jacent. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Status, puis sur l'onglet Status Module. 

La fenêtre affiche toutes les alertes d'état de la bibliothèque de bandes. 

3. Dans le menu déroulant Clear Alert Number, sélectionnez le numéro d'alerte à 
effacer de l'affichage, puis cliquez sur Apply. 
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Remarque – Bien que vous puissiez sélectionner n'importe quel numéro d'alerte, 
seules les alertes indiquées comme « Clearable » (effaçable) peuvent réellement être 
effacées. 

L'alerte est supprimée de l'affichage Status Module. L'indicateur de santé de la 
bibliothèque de bandes repasse au vert s'il n'y a plus d'alerte concernant le 
périphérique ou l'état. 

Remarque – Si l'alerte est périodiquement mise à jour, elle réapparaît lors du cycle de 
mise à jour suivant.
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▼ Affichage de l'état des ports HLI 
Cette procédure permet d'afficher l'état actuel de l'ensemble des ports des interfaces 
HLI LMU (library management unit) hôtes dans la bibliothèque de bandes. Les 
informations comprennent le socket TCP/IP local, l'IP local, l'état de la connexion, l'état 
des ports, les transmissions envoyées et reçues depuis le début de la connexion.

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Status, puis sur l'onglet HLI. 

La fenêtre affiche l'état actuel et l'activité de l'ensemble des ports HLI de la bibliothèque 
de bandes. 
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▼ Affichage de l'état des ports FC-SCSI 
Cette procédure permet d'afficher l'état actuel de l'ensemble des ports d'interface 
FC-SCSI hôtes dans la bibliothèque de bandes. Les informations incluent le numéro de 
port, la vitesse et l'état, l'ID de boucle, le nom de nœud mondial, le nom de port 
mondial, et la topologie. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Status, puis sur l'onglet SCSI. 

La fenêtre affiche l'état actuel et l'activité de l'ensemble des ports FC-SCSI de la 
bibliothèque de bandes. 
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▼ Affichage des informations sur la configuration de 
la bibliothèque de bandes 
Cette procédure permet d'afficher la configuration physique, mécanique et logique 
de la bibliothèque de bandes. Certaines informations peuvent être paramétrées 
automatiquement pendant l'initialisation de la bibliothèque de bandes tandis que 
d'autres informations peuvent être définies par l'utilisateur. 

Remarque – La fenêtre Reports > Library Information permet également d'avoir 
accès à ces informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » 
page 111 pour plus de détails. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Properties, puis sur l'onglet General.

La fenêtre affiche les informations détaillées de la bibliothèque de bandes. 
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▼ Affichage des propriétés du contrôleur de la 
bibliothèque de bandes 
Cette fenêtre permet de visualiser les détails du contrôleur de la bibliothèque de 
bandes, y compris le numéro de série et les versions du microprogramme.

Remarque – La fenêtre Reports > Library Information permet également d'avoir 
accès à ces informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » 
page 111 pour plus de détails. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Properties, puis sur l'onglet Controller.
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▼ Affichage des propriétés du contrôleur des 
lecteurs 
Cette fenêtre permet de visualiser les détails du contrôleur des lecteurs y compris le 
numéro de série et les versions du microprogramme actuelles.

Remarque – La fenêtre Reports > Library Information permet également d'avoir 
accès à ces informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » 
page 111 pour plus de détails. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Properties, puis sur l'onglet Drive Controller

La fenêtre Drive Controller s'affiche. 
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▼ Modification du type d'interface de la 
bibliothèque de bandes (bibliothèques de bandes 
non partitionnées)
Cette procédure permet de modifier le type d'interface utilisé par les hôtes pour se 
connecter à la bibliothèque de bandes. 

Remarque – Elle concerne uniquement les bibliothèques de bandes non partitionnées. 
Pour la modification des types d'interface dans une bibliothèque de bandes 
partitionnée, voir « Modification du type d'interface d'une connexion hôte-partition » 
page 314. « Modification du type d'interface d'une connexion hôte-partition » page 314

1. Sélectionner Tools > Select Active Cells. 

La fenêtre Module Map s'affiche.
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2. Cliquez sur l'onglet Select Active Cells.

La fenêtre Select Active Cells s'affiche et indique le type d'interface actuellement 
affecté à la bibliothèque de bandes.

3. Dans la liste déroulante Interface Type, sélectionnez le type d'interface à affecter. 
Cliquez sur Apply. 

La fenêtre contextuelle Confirm Apply s'affiche. 
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4. Cliquez sur Yes pour mettre à jour la base de données du contrôleur de la 
bibliothèque de bandes. 

La fenêtre contextuelle Commit Success s'affiche. 

5. Cliquez sur OK pour revenir à la fenêtre Select Active Cells. 

Le nouveau type d'interface prend effet immédiatement. Il n'est pas nécessaire de 
redémarrer la bibliothèque de bandes. 
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▼ Affichage d'un rapport de la bibliothèque de 
bandes 
Cette procédure permet d'afficher les rapports de la bibliothèque de bandes accessibles 
depuis le menu Tools > Reports.

Remarque – La sortie d'un rapport affiche statiquement les informations envoyées 
depuis le contrôleur de la bibliothèque de bandes lors de sa génération. La Console 
d’administration StreamLine Library ne met pas à jour les informations de manière 
dynamique tant que vous ne sélectionnez pas le bouton Update de la barre Options.

Les procédures ci-dessous expliquent comment rechercher les données d'un rapport ou 
les enregistrer dans un fichier :

■ « Recherche d'un rapport de la bibliothèque » page 114 

■ « Enregistrement des données d'un rapport de la bibliothèque de bandes » page 116

D'autres rapports sont disponibles depuis les menus suivants :

■ Tools > Partitions

■ Tools > Select Active Cells 
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1. Sélectionnez Tools > Reports. 

La fenêtre Display s'affiche. Toutes les options des rapports de la bibliothèque de 
bandes sont indiquées dans la barre de navigation.

2. Dans la barre de navigation, développez un type de rapport pour afficher ses 
options.
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3. Cliquez sur le rapport à afficher. 

Le rapport sélectionné s'affiche. 
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▼ Recherche d'un rapport de la bibliothèque 
Cette procédure permet de rechercher un rapport de la bibliothèque de bandes 
correspondant à une chaîne de texte donnée. Elle peut être réalisée depuis toutes les 
fenêtres des rapports de la bibliothèque de bandes.

1. Sélectionnez Tools > Reports. 

La fenêtre Display s'affiche. Toutes les options des rapports de la bibliothèque de 
bandes sont indiquées dans la barre de navigation.

2. Dans la barre de navigation, développez un type de rapport pour afficher ses 
options.

3. Cliquez sur le rapport à afficher. 

Le rapport sélectionné s'affiche. Toutes les fenêtres des rapports comportent le bouton 
Search dans la barre Options. 

4. Cliquez sur Search. 

La fenêtre contextuelle Search Text s'affiche. 

5. Saisissez le texte à rechercher, puis cliquez sur Search. 
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Remarque – La fonction de recherche respecte la casse et les caractères génériques ne 
sont pas pris en charge. 

6. La fenêtre contextuelle Search Results s'affiche et indique le nombre d'occurrences 
de la chaîne de texte. Les occurrences de la chaîne de texte dans le rapport sont mises 
en surbrillance. 

7. Cliquez sur OK pour fermer la fenêtre contextuelle. 
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▼ Enregistrement des données d'un rapport de la 
bibliothèque de bandes
Cette procédure permet d'afficher un rapport de la bibliothèque de bandes et 
d'enregistrer les données dans un fichier. En fonction du rapport, vous pouvez 
enregistrer au format texte (.txt), HTML, XML, ou valeurs séparées par des virgules 
(.csv). Elle peut être réalisée depuis toutes les fenêtres des rapports de la bibliothèque 
de bandes.

Une fois le fichier enregistré, vous pouvez l'imprimer ou l'envoyer par e-mail. Cela 
peut s'avérer utile pour communiquer à propos de problèmes de la bibliothèque de 
bandes avec votre représentant du support technique Sun. En outre, vous pouvez 
importer un fichier .csv dans un tableur ou une application de création de tableaux, 
afin de mieux comprendre et d'interpréter les données. 

1. Sélectionnez Tools > Reports. 

La fenêtre Display s'affiche. Toutes les options des rapports de la bibliothèque de 
bandes sont indiquées dans la barre de navigation.

2. Dans la barre de navigation, développez un type de rapport pour afficher ses 
options.
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3. Cliquez sur le rapport à afficher. 

Le rapport sélectionné s'affiche. Toutes les fenêtres des rapports comportent le bouton 
Save dans la barre Options. 

4. Cliquez sur Save. 

La fenêtre contextuelle Save s'affiche. 

5. Cherchez le répertoire dans lequel vous souhaitez enregistrer le fichier. Dans le 
champ File Name, vous pouvez accepter le nom par défaut ou saisir un nom de 
fichier différent. 

6. Dans la liste déroulante Files of Type, sélectionnez le format d'enregistrement des 
données (HTML, Texte, XML, .csv). 

7. Cliquez sur Save. 

Les données sont enregistrées dans le fichier souhaité. 

Remarque – Si le fichier existe déjà, une fenêtre contextuelle s'affiche pour vous 
inviter à confirmer que vous souhaitez bien le remplacer. 
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▼ Affichage du rapport « Last 24 Hours » Library 
Energy Monitor

Remarque – Cette fonctionnalité est disponible à partir de la version FRS_2.30 du 
microprogramme de la SL3000 et de la version FRS_4.30 de la Console d’administration 
StreamLine Library. 

Le rapport Last 24 Hours Energy Monitor affiche la consommation d'énergie minute 
par minute, ainsi que la consommation moyenne d'alimentation électrique de la totalité 
de la bibliothèque de bandes sur les dernières 24 heures. Avec ce rapport, vous pouvez 
contrôler votre utilisation de l'alimentation électrique et de l'énergie et identifier les 
périodes d'utilisation les plus et les moins élevées pendant la journée.

Par défaut, ce rapport est trié selon un ordre chronologique. En option, vous pouvez 
modifier l'ordre de tri, réorganiser et redimensionner les colonnes. Voir « Modification 
de la mise en page de la fenêtre » page 45. 

Pour créer un tableau à partir de ce rapport, vous pouvez enregistrer les données dans 
un fichier séparé par des virgules (.csv), puis importer ce fichier .csv dans une 
application de création de tableaux. Pour plus d'informations, reportez-vous à 
« Enregistrement des données d'un rapport de la bibliothèque de bandes ». 

Pour consulter des rapports connexes, consultez les rubriques suivantes :

■ « Affichage du rapport « Last Month » Library Energy Monitor » page 120

■ « Affichage du rapport « Last Year » Library Energy Monitor » page 122 

1. Sélectionnez Tools  >  Reports. 
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2. Développez le dossier Statistics et cliquez sur Energy Monitor - Last 24 Hours. 

Champs de la fenêtre
Date 

Date et heure des mesures. 

kWh

Énergie utilisée par la totalité de la bibliothèque de bandes pendant l'intervalle d'une 
minute identifiée, mesurée en kilowatt-heures. 

kW

Énergie moyenne utilisée par la totalité de la bibliothèque de bandes pendant 
l'intervalle d'une minute identifié, mesurée en kilowatts. 
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▼ Affichage du rapport « Last Month » Library 
Energy Monitor

Remarque – Cette fonctionnalité est disponible à partir de la version FRS_2.30 du 
microprogramme de la SL3000 et de la version FRS_4.30 de la Console d’administration 
StreamLine Library. 

Le rapport Last Month Energy Monitor affiche la consommation d'énergie, ainsi que la 
consommation moyenne d'alimentation électrique de la totalité de la bibliothèque de 
bandes, par intervalle de 15 minutes sur les 32 derniers jours. Avec ce rapport, vous 
pouvez analyser votre utilisation de l'alimentation électrique et de l'énergie et identifier 
les périodes d'utilisation les plus et les moins élevées pendant le dernier mois. 

Par défaut, ce rapport est trié selon un ordre chronologique. En option, vous pouvez 
modifier l'ordre de tri, réorganiser et redimensionner les colonnes. Voir « Modification 
de la mise en page de la fenêtre » page 45. 

Pour créer un tableau à partir de ce rapport, vous pouvez enregistrer les données dans 
un fichier séparé par des virgules (.csv), puis importer ce fichier .csv dans une 
application de création de tableaux. Pour plus d'informations, reportez-vous à 
« Enregistrement des données d'un rapport de la bibliothèque de bandes ». 

Pour consulter des rapports connexes, consultez les rubriques suivantes :

■ « Affichage du rapport « Last 24 Hours » Library Energy Monitor » page 118

■ « Affichage du rapport « Last Year » Library Energy Monitor » page 122 

1. Sélectionnez Tools  >  Reports. 
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2. Développez le dossier Statistics et cliquez sur Energy Monitor - Last Month. 

Champs de la fenêtre
Date 

Date et heure des mesures. 

kWh

Énergie utilisée par la totalité de la bibliothèque de bandes pendant l'intervalle de 15 
minutes identifié, mesurée en kilowatt-heures. 

kW

Énergie moyenne utilisée par la totalité de la bibliothèque de bandes pendant 
l'intervalle de 15 minutes identifié, mesurée en kilowatts. 
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▼ Affichage du rapport « Last Year » Library Energy 
Monitor

Remarque – Cette fonctionnalité est disponible à partir de la version FRS_2.30 du 
microprogramme de la SL3000 et de la version FRS_4.30 de la Console d’administration 
StreamLine Library. 

Le rapport Last Year Energy Monitor affiche la consommation d'énergie, ainsi que la 
consommation moyenne d'alimentation électrique de la totalité de la bibliothèque de 
bandes, par intervalle d'une journée sur les 365 derniers jours. Avec ce rapport, vous 
pouvez analyser votre utilisation de l'alimentation électrique et de l'énergie et identifier 
les périodes d'utilisation les plus et les moins élevées pendant l'année. 

Par défaut, ce rapport est trié selon un ordre chronologique. En option, vous pouvez 
modifier l'ordre de tri, réorganiser et redimensionner les colonnes. Voir « Modification 
de la mise en page de la fenêtre » page 45. 

Pour créer un tableau à partir de ce rapport, vous pouvez enregistrer les données dans 
un fichier séparé par des virgules (.csv), puis importer ce fichier .csv dans une 
application de création de tableaux. Pour plus d'informations, reportez-vous à 
« Enregistrement des données d'un rapport de la bibliothèque de bandes ». 

Pour consulter des rapports connexes, consultez les rubriques suivantes :

■ « Affichage du rapport « Last 24 Hours » Library Energy Monitor » page 118

■ « Affichage du rapport « Last Month » Library Energy Monitor » page 120 

1. Sélectionnez Tools  >  Reports. 
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2. Développez le dossier Statistics et cliquez sur Energy Monitor - Last Year. 

Champs de la fenêtre
Date 

Date des mesures. 

Total kWh

Énergie totale utilisée par la totalité de la bibliothèque de bandes sur un jour, 
mesurée en kilowatt-heures. 

Avg kW

Énergie moyenne utilisée par la totalité de la bibliothèque de bandes sur un jour, 
mesurée en kilowatts. 

Max kWh

Valeur d'énergie maximale du jour, par période de 15 minutes. 

Min kWh

Valeur d'énergie minimale du jour, par période de 15 minutes. 

Avg kWh

Moyenne sur un jour de toutes les valeurs d'énergie par période de 15 minutes. 
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Max kW

Valeur maximale d'alimentation électrique sur un jour, par période de 15 minutes. 

Min kW

Valeur minimale d'alimentation électrique sur un jour, par période de 15 minutes. 

Avg kW

Moyenne sur un jour de toutes les valeurs d'alimentation électrique par période de 
15 minutes. 
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▼ Affichage des informations de synthèse sur les 
CAP de rotation et des AEM
Cette procédure permet d'afficher les informations de synthèse sur l'ensemble des CAP 
de rotation et des AEM de la bibliothèque de bandes. 

Remarque – La fenêtre Reports > CAP Summary permet également d'avoir accès à 
ces informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier CAP. 

Cette fenêtre répertorie tous les CAP de rotation et des AEM de la bibliothèque de 
bandes, ainsi que leurs emplacements.    
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▼ Affichage de l'état actuel des CAP de rotation et 
des AEM 
Cette procédure permet d'afficher l'état de fonctionnement actuel d'un CAP de rotation 
ou des AEM. 

Remarque – Le rapport CAP Details permet également d'avoir accès à ces 
informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

Remarque – Informations sur l'état de la porte de sécurité de l'AEM, qui correspond 
à la porte de « garage » interne qui s'abaisse pour séparer l'AEM du reste de la 
bibliothèque de bandes, et apparaissent dans la fenêtre Safety Door Status. Voir 
« Affichage de l'état de la porte de sécurité de l'AEM » page 191 pour plus de détails. 

Remarque – Cette fenêtre est utilisée pour les CAP de rotation et des AEM. Dans cette 
section, le terme « CAP » fait référence à ces deux types de CAP. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier CAP, puis cliquez sur le CAP à afficher. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 

3. Cliquez sur Status.

La fenêtre affiche l'état actuel du CAP sélectionné. 
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■ Pour les CAP de rotation : 
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■ Pour les CAP des AEM : 
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▼ Affichage des propriétés de CAP de rotation ou 
des AEM
Cette procédure permet d'afficher les informations statiques des CAP de rotation ou 
des AEM, y compris leur numéro de série et le nombre de cellules. 

Remarque – La fenêtre Reports > CAP Details permet également d'avoir accès à ces 
informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

Remarque – Pour les CAP des AEM, ces informations apparaissent également dans la 
fenêtre Safety Door Properties. Voir « Affichage des propriétés de la porte de sécurité 
de l'AEM » page 192 pour plus de détails. 

Remarque – Cette fenêtre est utilisée pour les CAP de rotation et des AEM. Dans cette 
section, le terme « CAP » fait référence à ces deux types de CAP. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier CAP, puis cliquez sur le CAP à afficher. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 

3. Cliquez sur Properties. 

La fenêtre CAP Properties s'affiche. 
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■ Pour les CAP de rotation :
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■ Pour les CAP des AEM : 
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▼ Déverrouillage de la porte d'accès du CAP ou de 
l'AEM 
En général, une porte d'accès de CAP ou d'AEM est déverrouillée depuis un hôte. 
Utilisez la procédure suivante lorsque vous devez effectuer une opération de 
déverrouillage manuel sur la Console d’administration StreamLine Library. 

Remarque – Cette fenêtre est utilisée pour les CAP de rotation et des AEM. Dans cette 
section, le terme « CAP » fait référence à ces deux types de CAP. 

1. Sélectionnez Tools  >  Diagnostics. 

2. Développez le dossier CAP puis cliquez sur le CAP à modifier. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 

3. Cliquez sur l'onglet Access. 

La fenêtre Access s'affiche.
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4. Dans la liste déroulante Locked, cliquez sur false. Cliquez sur le bouton Apply. 

La fenêtre contextuelle Confirm s'affiche. 

5. Cliquez sur OK.

La porte du CAP est déverrouillée et le voyant du bouton CAP s'allume.

Remarque – L'état du CAP devient « unlocked » dans le logiciel de gestion des hôtes 
de la bibliothèque de bandes.

Remarque – Le CAP ou l'AEM est réservé par la bibliothèque de bandes et il est 
inaccessible à tous les hôtes de la bibliothèque de bandes, jusqu'à ce que vous fermiez 
et verrouilliez la porte d'accès de CAP ou d'AEM. Voir « Verrouillage d'une porte 
d'accès de CAP ou à d'AEM » page 135 pour plus de détails. 
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▼ Verrouillage d'une porte d'accès de CAP ou à 
d'AEM 
En général, une porte d'accès de CAP ou d'AEM est verrouillée depuis un hôte. Utilisez 
la procédure suivante lorsque vous devez effectuer une opération de verrouillage 
manuel sur la Console d’administration StreamLine Library. 

Remarque – Elle concerne uniquement les CAP HLI. 

Remarque – Cette fenêtre est utilisée pour les CAP de rotation et des AEM. Dans cette 
section, le terme « CAP » fait référence à ces deux types de CAP. 

Remarque – Si vous déverrouillez une porte d'accès de CAP ou d'AEM (voir 
« Déverrouillage de la porte d'accès du CAP ou de l'AEM » page 133 plus de détails), le 
CAP ou l'AEM est réservé par la bibliothèque de bandes et devient indisponible à tous 
les hôtes, jusqu'à ce que vous ayez terminé cette procédure. 

1. Sélectionnez Tools  >  Diagnostics. 

2. Développez le dossier CAP puis cliquez sur le CAP à modifier. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 
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3. Cliquez sur l'onglet Access. 

La fenêtre Access s'affiche.

4. Dans le champ Locked, cliquez sur True. Cliquez sur le bouton Apply. 

Le CAP se verrouille et le voyant du bouton CAP s'éteint.
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▼ Insertion de cartouches via un CAP de rotation
Cette procédure explique comment insérer des cartouches dans la bibliothèque de 
bandes par le biais d'un CAP de rotation. 

Remarque – Elle concerne uniquement les bibliothèques de bandes non partitionnées. 
Dans le cas de bibliothèques de bandes partitionnées, voir « Insertion de cartouches 
dans une partition » page 334. 

Remarque – Pour obtenir des instructions détaillées concernant le chargement de 
cartouches via un CAP des AEM, voir « Chargement de cartouches en masse via un 
CAP des AEM » page 142. 

1. Lancez l'opération d'insertion au niveau de l'hôte. Consultez la documentation du 
logiciel de gestion des bandes pour plus d'informations concernant les procédures et 
les commandes. 

Remarque – Si le CAP est en mode d'insertion automatique, vous pouvez ignorer 
cette étape et passer directement à Étape 2. 

2. Appuyez sur le bouton CAP pour ouvrir le CAP. 

La porte du CAP s'ouvre. 

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture du CAP.

3. Placez les cartouches dans le CAP.

Insérez les cartouches de manière à ce que l'étiquette du client (le cas échéant) soit face 
à vous, le moteur du hub tourné vers le bas et l'étiquette de l'ID de volume tournée vers 
vous. 

Vous pouvez directement insérer les cartouches dans les magasins lorsque ceux-ci se 
trouvent dans le CAP ou vous pouvez retirer les magasins du CAP, insérer les 
cartouches dans les magasins, puis les remettre dans le CAP.

Remarque – Les cartouches peuvent être placées dans n'importe quel emplacement 
CAP, dans n'importe quel ordre. Le robot TallBot analyse tous les emplacements au 
moment de la fermeture de la porte du CAP.

Mise en garde – Risque d'endommagement des supports. Il est déconseillé d'insérer des 
cartouches sans étiquette externe ou de les positionner à l'envers. Des problèmes 
peuvent apparaître au moment de la réalisation d'une analyse. De même, vous ne 
devez pas insérer des cartouches munies d'étiquettes illisibles ou abîmées. 
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4. Appuyez sur le bouton CAP pour fermer le CAP.

Le CAP se ferme et se verrouille automatiquement et le voyant du bouton CAP s'éteint.

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture du CAP.

5. L"unité robotique TallBot analyse le CAP puis déplace les cartouches depuis le CAP 
vers les emplacements de stockage dans la partition correspondante. 

Une fois toutes les cartouches déplacées, la bibliothèque de bandes reconnaît que le 
CAP est vide et celui-ci reprend son état par défaut. 
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▼ Éjection de cartouches via un CAP de rotation 
Cette procédure explique comment éjecter des cartouches de la bibliothèque de bandes 
par le biais d'un CAP de rotation. 

Remarque – Elle concerne uniquement les bibliothèques de bandes non partitionnées. 
Dans le cas de bibliothèques de bandes partitionnées, voir « Éjection des cartouches 
d'une partition » page 335. 

Remarque – Pour obtenir des instructions détaillées concernant le déchargement de 
cartouches via un CAP des AEM, voir « Déchargement de cartouches en masse via un 
CAP des AEM » page 144. 

1. Lancez l'opération d'éjection au niveau de l'hôte. Consultez la documentation du 
logiciel de gestion des bandes pour plus d'informations concernant les procédures et 
les commandes. 

Vous devez préciser les ID de volume des cartouches à retirer de la bibliothèque de 
bandes. Pour les hôtes HLI, vous pouvez spécifier les CAP à utiliser. Pour les hôtes 
FC-SCSI, la bibliothèque de bandes utilise des CAP selon un ordre prédéfini ; voir 
« Priorités du CAP pour les éjections de cartouche par des hôtes FC-SCSI » page 78 
pour plus de détails. 

2. Le TallBot place les cartouches dans les CAP.

Une fois que toutes les cartouches requises ont été placées dans des CAP, ou que tous 
les CAP sont pleins, ceux-ci sont déverrouillés. 

3. Appuyez sur le bouton CAP pour ouvrir le CAP. 

La porte du CAP s'ouvre. 

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture du CAP.

4. Retirez les cartouches du CAP.

Vous pouvez directement retirer les cartouches des magasins lorsque ceux-ci se 
trouvent dans le CAP ou vous pouvez retirer les magasins du CAP, retirer les 
cartouches des magasins, puis réinstaller les magasins vides dans le CAP.

Remarque – Si vous ne remplacez pas les magasins dans le CAP, le contrôleur de la 
bibliothèque de bandes indique les cellules comme « absent ». 

5. Appuyez sur le bouton CAP pour refermer le CAP.

Le CAP se ferme et se verrouille automatiquement et le voyant du bouton CAP s'éteint.
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Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture du CAP.

Si d'autres cartouches doivent être exportées, l'unité robotique TallBot poursuit le 
remplissage des CAP nécessaires. Attendez le déverrouillage de la porte du CAP, puis 
recommencez les étapes Étape 3 à Étape 5. 

L'opération d'éjection se termine automatiquement une fois toutes les cartouches 
concernées retirées. 

6. Le TallBot analyse le CAP et vérifie qu'il est vide.

Le CAP reprend ensuite son état par défaut. 
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▼ Chargement de cartouches en masse via un CAP 
des AEM
Cette procédure explique comment charger des cartouches dans la bibliothèque de 
bandes par le biais d'un CAP des AEM. Vous pouvez charger jusqu'à 234 cartouches à 
la fois. 

Remarque – Elle concerne uniquement les bibliothèques de bandes non partitionnées. 
Dans le cas de bibliothèques de bandes partitionnées, voir « Insertion de cartouches 
dans une partition » page 334. 

Remarque – Pour obtenir des instructions détaillées concernant l'insertion de 
cartouches via un CAP de rotation, voir « Insertion de cartouches via un CAP de 
rotation » page 138. 

1. Lancez l'opération d'insertion au niveau de l'hôte. Consultez la documentation du 
logiciel de gestion des bandes pour plus d'informations concernant les procédures et 
les commandes. 

Remarque – Si le CAP des AEM est en mode d'insertion automatique, vous pouvez 
ignorer cette étape et passer directement à Étape 2. 

Le voyant Unlocked est allumé sur la porte d'accès de l'AEM. 

2. Appuyez sur le bouton AEM CAP. 

Le voyant Wait situé sur la porte d'accès de l'AEM commence à clignoter lorsque tous 
les tâches en cours sont terminées. Le robot est retiré de l'AEM, puis la porte de sécurité 
s'abaisse. En fonction du niveau d'activité dans la bibliothèque de bandes, cette 
opération peut prendre plusieurs minutes.

Une fois la porte de sécurité complètement abaissée et l'AEM correctement fermé, le 
voyant Wait arrête de clignoter, tandis que le voyant Enter reste allumé.

3. Levez le loquet et ouvrez la porte.

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture de la porte d'accès de l'AEM.

4. Placez les cartouches dans le CAP des AEM.

Insérez les cartouches de manière à ce que l'étiquette du client (le cas échéant) soit face 
à vous, le moteur du hub tourné vers le bas et l'étiquette de l'ID de volume tournée vers 
vous. 

Vous pouvez directement insérer les cartouches dans les magasins lorsque ceux-ci se 
trouvent dans le CAP ou vous pouvez retirer les magasins du CAP, insérer les 
cartouches dans les magasins, puis les remettre dans le CAP.
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Remarque – Les cartouches peuvent être placées dans n'importe quel emplacement 
CAP, dans n'importe quel ordre. Le robot TallBot analyse tous les emplacements au 
moment de la fermeture de la porte du CAP.

Mise en garde – Risque d'endommagement des supports. Il est déconseillé d'insérer des 
cartouches sans étiquette externe ou de les positionner à l'envers. Des problèmes 
peuvent apparaître au moment de la réalisation d'une analyse. De même, vous ne 
devez pas insérer des cartouches munies d'étiquettes illisibles ou abîmées. 

Mise en garde – Risque de dommages matériels. Lors du remplacement des magasins sur 
les façades de l'AEM, veillez à les insérer correctement.

5. Fermez la porte d'accès avec le loquet.

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture de la porte d'accès de l'AEM.

6. Appuyez sur le bouton AEM CAP.

Le voyant Enter s'éteint, tandis que le voyant Wait commence à clignoter. 

La porte de sécurité se lève.

7. Le robot pénètre dans l'AEM, effectue un audit du CAP des AEM, puis déplace les 
cartouches depuis le CAP des AEM vers les cellules de stockage disponibles. 

Une fois toutes les cartouches déplacées depuis le CAP des AEM, la bibliothèque de 
bandes reconnaît que l'AEM est vide et celui-ci reprend son état par défaut. 
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▼ Déchargement de cartouches en masse via un 
CAP des AEM
Cette procédure explique comment décharger des cartouches depuis la bibliothèque de 
bandes par le biais d'un CAP des AEM. Vous pouvez décharger jusqu'à 234 cartouches 
à la fois. 

Remarque – Pour les opérations d'éjection initiées depuis un hôte FC-SCSI, les CAP 
des AEM sont utilisés uniquement après le remplissage de tous les CAP de rotation. 
Pour plus d'informations, reportez-vous à « Priorités du CAP pour les éjections de 
cartouche par des hôtes FC-SCSI » page 78. 

Remarque – Cette procédure concerne uniquement les bibliothèques de bandes non 
partitionnées. Dans le cas de bibliothèques de bandes partitionnées, voir « Éjection des 
cartouches d'une partition » page 335. 

Remarque – Pour obtenir des instructions détaillées concernant l'éjection de 
cartouches via un CAP de rotation, voir « Éjection de cartouches via un CAP de 
rotation » page 140. 

1. Lancez l'opération d'éjection au niveau de l'hôte. Consultez la documentation du 
logiciel de gestion des bandes pour plus d'informations concernant les procédures et 
les commandes. 

Vous devez préciser les ID de volume des cartouches à retirer de la bibliothèque de 
bandes. Pour les hôtes HLI, vous pouvez spécifier les CAP des AEM à utiliser. Pour les 
hôtes FC-SCSI, la bibliothèque de bandes utilise des CAP de rotation et des AEM selon 
un ordre prédéfini ; voir « Priorités du CAP pour les éjections de cartouche par des 
hôtes FC-SCSI » page 78 pour plus de détails.

2. Le TallBot place les cartouches dans les cellules de l'AEM. 

Une fois que toutes les cartouches requises ont été placées dans l'AEM, ce dernier est 
déverrouillé et le voyant Unlocked de la porte d'accès de l'AEM s'allume. 

3. Appuyez sur le bouton AEM CAP. 

Le voyant Wait situé sur la porte d'accès de l'AEM commence à clignoter lorsque tous 
les tâches en cours sont terminées. Le TallBot est retiré de l'AEM, puis la porte de 
sécurité s'abaisse. En fonction du niveau d'activité dans la bibliothèque de bandes, cette 
opération peut prendre plusieurs minutes.

Une fois la porte de sécurité complètement abaissée et l'AEM correctement fermé, le 
voyant Wait arrête de clignoter, tandis que le voyant Enter reste allumé.

4. Levez le loquet et ouvrez la porte.

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture du CAP.
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5. Retirez les cartouches du CAP des AEM.

Vous pouvez directement retirer les cartouches des magasins lorsque ceux-ci se 
trouvent dans l'AEM ou vous pouvez retirer les magasins de l'AEM, retirer les 
cartouches des magasins, puis réinstaller les magasins vides dans l'AEM. 

Mise en garde – Risque de dommages matériels. Lors du remplacement des magasins sur 
les façades de l'AEM, veillez à les insérer correctement.

Remarque – Si vous ne remplacez pas les magasins dans l'AEM, le contrôleur de la 
bibliothèque de bandes indique les cellules comme « absent ». 

6. Fermez la porte d'accès de l'AEM avec le loquet.

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture de la porte d'accès de l'AEM.

7. Appuyez sur le bouton AEM CAP.

Le voyant Enter s'éteint, tandis que le voyant Wait commence à clignoter. 

La porte de sécurité se lève.

8. Si d'autres cartouches doivent être exportées, le robot TallBot poursuit le remplissage 
des AEM nécessaires. Patientez jusqu'à ce que le voyant Unlocked de l'AEM soit 
allumé, puis recommencez les étapes Étape 3 à Étape 6. 

L'opération d'éjection se termine automatiquement une fois toutes les cartouches 
concernées retirées. 

Le TallBot passe dans l'AEM et analyse le CAP des AEM pour s'assurer qu'il est vide. 
Le CAP des AEM reprend ensuite son état par défaut. 

Remarque – L'audit du CAP des AEM doit prendre moins de trois minutes. 
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▼ Liste des cartouches de la bibliothèque de bandes
Cette procédure permet d'afficher les informations concernant les cartouches de la biblio-
thèque de bandes, y compris leur ID de volume, leur emplacement et le type de support. 

1. Sélectionnez Tools > Reports. 

Toutes les options des rapports de la bibliothèque de bandes sont indiquées dans la 
barre de navigation. 

2. Développez le dossier Status Summary.

La liste des rapports Status Summary s'affiche. 

3. Cliquez sur Cartridge Summary. 

Le rapport Cartridge Summary apparaît. 

4. Les procédures ci-dessous expliquent comment rechercher les données d'un rapport 
ou les enregistrer dans un fichier :

■ « Recherche d'un rapport de la bibliothèque » page 114 

■ « Enregistrement des données d'un rapport de la bibliothèque de bandes » page 116
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▼ Localisation d'une cartouche par son ID de 
volume
Cette procédure permet d'afficher l'emplacement actuel d'une cartouche dans un 
identifiant de volume spécifique. L'emplacement peut être affiché selon l'un des 
formats suivants :

■ Adresse interne de la bibliothèque de bandes

■ Adresse HLI-PRC (hôtes HLI uniquement)

1. Sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Search.

La fenêtre Library Search s'affiche. 

3. Dans la liste déroulante Search Type, cliquez sur VOLID. 

4. Saisissez l'ID de volume, le demandeur et le type de cartouche. 

Le champ Requester contrôle le format d'adresse qui doit apparaître pour 
l'emplacement de la cartouche. 

■ Pour afficher l'adresse interne de la bibliothèque de bandes, cliquez sur default.

■ Pour afficher l'adresse HLI-PRC, cliquez sur hli0 ou sur hli1. 

Remarque – Vous pouvez saisir des caractères génériques dans le champ VOLID. 
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5. Cliquez sur Search. 

La fenêtre affiche les cartouches correspondant aux critères de recherche. 
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▼ Localisation d'une cartouche par son adresse
Cette procédure permet d'afficher des informations détaillées concernant les cartouches 
à un emplacement spécifique. Les caractères génériques vous permettent d'afficher 
toutes les cartouches dans une zone générale spécifique (dans un panneau, une ligne, 
ou une colonne spécifique, par exemple). Vous pouvez spécifier l'emplacement à l'aide 
de l'un des formats suivants :

■ Adresse interne de la bibliothèque de bandes

■ Adresse HLI-PRC (hôtes HLI uniquement)

■ Adresse FC-SCSI (hôtes FC-SCSI uniquement) 

1. Sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet Search.

La fenêtre Library Search s'affiche. 

3. Dans la liste déroulante Search Type, cliquez sur Location. 

Remarque – Le type de recherche (Search Type) par défaut est ID de volume. 

La fenêtre est mise à jour, de manière à afficher des champs qui vous permettent de 
rechercher par emplacement. 

4. Dans la liste déroulante Location, sélectionnez le type de correspondance que vous 
voulez effectuer pour la recherche.

5. Dans la liste déroulante Requester, sélectionnez le type de format d'adresse à utiliser 
pour la recherche. 

6. Dans le champ Location, saisissez les paramètres de recherche. 

Le format que vous utilisez doit correspondre au Demandeur que vous avez spécifié. 
Par exemple :

■ Si le demandeur est celui défini « par défaut », utilisez le format de l'adresse interne 
de la bibliothèque de bandes.

■ Si le demandeur est un hôte HLI, utilisez l'adresse HLI-PRC.

■ Si le demandeur est un hôte FC-SCSI, utilisez l'adresse FC-SCSI. 

Remarque – Ce champ n'accepte pas les caractères génériques. 
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7. Cliquez sur le bouton Search. 

La fenêtre affiche les emplacements correspondant aux critères de recherche. 

8. Pour afficher les détails d'une cartouche ou le mappage d'un emplacement, cliquez 
sur le bouton ... de la colonne Details. 

La fenêtre Location Details s'affiche. 

9. Cliquez sur Close pour fermer la fenêtre contextuelle. 
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▼ Déplacement d'une cartouche spécifique par ID de 
volume
Cette procédure permet de déplacer une cartouche d'un ID de volume spécifique vers 
un emplacement précis dans la bibliothèque de bandes. 

Remarque – Elle permet de mettre à jour les emplacements des cartouches dans la 
base de données du contrôleur de la bibliothèque de bandes mais pas dans la base de 
données de l'hôte. Par conséquent, une fois cette procédure terminée, une analyse doit 
être réalisée par le logiciel de l'hôte afin de mettre à jour sa base de données. Dans le 
cas contraire, les futurs déplacements demandés par le logiciel de l'hôte risquent 
d'échouer. 

Mise en garde – Exécutez cette procédure avec précaution dans les bibliothèques de 
bandes partitionnées. Vous risquez de déplacer involontairement une cartouche d'une 
partition à une autre permettant à la nouvelle partition d'écraser les données de la 
cartouche. 

1. Sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet RcvrMove. 

La fenêtre Recovery Move s'affiche. 

3. Dans le champ Source Location Mode, cliquez sur VOLID. 

La fenêtre est mise à jour avec les champs Source Location appropriés. 

4. Dans le champ VOLID, spécifiez l'ID de volume de la cartouche à déplacer. 

5. Dans le menu déroulant Destination Location Type, sélectionnez le type 
d'emplacement vers lequel déplacer la cartouche. Les différentes options sont les 
suivantes :

■ CAP

■ Emplacements de stockage 

■ Lecteur

■ Emplacements réservés

Les restrictions suivantes s'appliquent :

■ La destination peut être un lecteur, uniquement si la source est un CAP ou un 
emplacement réservé. 

■ Pour déplacer une cartouche vers un lecteur, le type de support de cartouche doit 
être compatible avec celui du lecteur. 

■ Vous ne pouvez pas déplacer une cartouche vers un emplacement déjà occupé. 

■ Même si cela n'est pas obligatoire, il est recommandé que seules les cartouches de 
diagnostic ou de nettoyage soient déplacées vers des emplacements réservés. 
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6. Dans le tableau Destination Location, spécifiez l'adresse interne de la bibliothèque 
de bandes de l'emplacement de destination en effectuant les sélections appropriées 
dans les menus déroulants suivants :

Les sélections spéciales suivantes sont disponibles dans les menus déroulants :

■ Min—First element of that location type——in the library 

■ Max—Last element of that location type——in the library 

Mise en garde – Dans le cas d'une bibliothèque de bandes partitionnée, assurez-
vous que la cartouche reste dans la partition à laquelle elle est affectée. En cas de 
déplacement d'une cartouche vers une cellule affectée à une autre partition, l'hôte 
risquerait de considérer la cartouche comme vide et d'écraser les données. En cas de 
déplacement d'une cartouche vers une cellule non affectée, tous les hôtes auront accès à 
la cartouche. 

7. Cliquez sur le bouton Start de la barre Options.

Le robot déplace la cartouche. Un message de réussite s'affiche une fois l'opération 
terminée. 

8. Cliquez sur OK.

9. Pour vérifier le nouvel emplacement, vous pouvez afficher un rapport Cartridge 
Summary. Voir « Liste des cartouches de la bibliothèque de bandes » page 146 pour 
plus de détails. Par exemple : 

10.Pour mettre à jour le nouvel emplacement de la cartouche dans la base de données de 
l'hôte, lancez une analyse de la bibliothèque de bandes depuis le logiciel hôte. 
Consultez la documentation du logiciel de gestion des bandes pour plus 
d'informations concernant les procédures et les commandes.
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▼ Déplacement d'une cartouche depuis un 
emplacement spécifique
Cette procédure permet de déplacer une cartouche d'un emplacement spécifique à un 
autre dans la bibliothèque de bandes. 

Remarque – Elle permet de mettre à jour les emplacements des cartouches dans la 
base de données du contrôleur de la bibliothèque de bandes mais pas dans la base de 
données de l'hôte. Par conséquent, une fois cette procédure terminée, une analyse doit 
être réalisée par le logiciel de l'hôte afin de mettre à jour sa base de données. Dans le 
cas contraire, les futurs déplacements demandés par le logiciel de l'hôte risquent 
d'échouer. 

Mise en garde – Exécutez cette procédure avec précaution dans les bibliothèques de 
bandes partitionnées. Vous risquez de déplacer involontairement une cartouche d'une 
partition à une autre permettant à la nouvelle partition d'écraser les données de la 
cartouche. 

1. Sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library. 

2. Cliquez sur l'onglet RcvrMove. 

La fenêtre Recovery Move s'affiche. 

3. Dans le champ Source Location Mode, cliquez sur Location. 

La fenêtre est mise à jour avec les champs Source Location appropriés. 

4. Dans le menu déroulant Source Location Type, sélectionnez le type d'emplacement 
actuel de la cartouche. Les différentes options sont les suivantes :

■ CAP

■ Slot

■ Drive

■ Reserved Slots

5. Dans le tableau Source Location, spécifiez l'adresse interne de la bibliothèque de 
bandes de l'emplacement source en effectuant les sélections appropriées dans les 
menus déroulants suivants :

Les sélections spéciales suivantes sont disponibles dans les menus déroulants :

■ Min—First element of that location type——in the library 

■ Max—Last element of that location type——in the library 

6. Dans le menu déroulant Destination Location Type, sélectionnez le type 
d'emplacement vers lequel déplacer la cartouche. Les différentes options sont les 
suivantes :

■ CAP

■ Storage Slots 

■ Drive

■ Reserved Slots
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Les restrictions suivantes s'appliquent :

■ L'emplacement de destination peut être un lecteur, uniquement si la source est un 
CAP ou un emplacement réservé. 

■ Pour déplacer une cartouche vers un lecteur, le type de support de cartouche doit 
être compatible avec celui du lecteur. 

■ Vous ne pouvez pas déplacer une cartouche vers un emplacement déjà occupé. 

■ Même si cela n'est pas obligatoire, il est recommandé que seules les cartouches de 
diagnostic ou de nettoyage soient déplacées vers des emplacements réservés. 

7. Dans le tableau Destination Location, spécifiez l'adresse interne de la bibliothèque 
de bandes de l'emplacement de destination en effectuant les sélections appropriées 
dans les menus déroulants suivants :

Les sélections spéciales suivantes sont disponibles dans les menus déroulants :

■ Min—First element of that location type——in the library 

■ Max—Last element of that location type——in the library 

Mise en garde – Dans le cas d'une bibliothèque de bandes partitionnée, assurez-
vous que la cartouche reste dans la partition à laquelle elle est affectée. En cas de 
déplacement d'une cartouche vers une cellule affectée à une autre partition, l'hôte 
risquerait de considérer la cartouche comme vide et d'écraser les données. En cas de 
déplacement d'une cartouche vers une cellule non affectée, tous les hôtes auront accès à 
la cartouche. 

8. Cliquez sur le bouton Start de la barre Options.

Le robot déplace la cartouche, puis une fenêtre contextuelle de message de réussite 
apparaît.

9. Cliquez sur OK.

10.Pour vérifier le nouvel emplacement, vous pouvez afficher un rapport Cartridge 
Summary. Voir « Liste des cartouches de la bibliothèque de bandes » page 146 pour 
plus de détails. Par exemple : 

11.Pour mettre à jour le nouvel emplacement de la cartouche dans la base de données de 
l'hôte, lancez une analyse de la bibliothèque de bandes depuis le logiciel hôte. 
Consultez la documentation du logiciel de gestion des bandes pour plus 
d'informations concernant les procédures et les commandes.
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▼ Affichage du rapport Media Events

Remarque – Cette fonctionnalité est disponible à partir de la version FRS_2.30 du 
microprogramme de la SL3000 et de la version FRS_4.30 de la Console d’administration 
StreamLine Library. 

Le rapport Media Events synthétise les événements de support de cartouche de la 
bibliothèque de bandes. Ce rapport est mis à jour dès qu'un événement de support ou 
une erreur se produit sur un lecteur quelconque. Vous pouvez utiliser le rapport pour 
identifier et diagnostiquer des cartouches défectueuses. 

Pour chaque cartouche pour laquelle des événements de support se sont produits, le 
rapport répertorie l'ID de volume de la cartouche, le type d'événement, le nombre 
d'occurrences, ainsi que la date et l'heure du dernier événement de ce type. Le rapport 
peut afficher jusqu'à 2000 entrées.

Par défaut, ce rapport est trié selon un ordre d'ID de volume. En option, vous pouvez 
modifier l'ordre de tri, réorganiser et redimensionner les colonnes. Voir « Modification 
de la mise en page de la fenêtre » page 45. 

Remarque – Pour les événements de cartouche associés à des lecteurs spécifiques, voir 
« Affichage du rapport Drive Media Events » page 170. 

1. Sélectionnez Tools  >  Reports. 
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2. Développez le dossier Statistics et cliquez sur Media Events. 

Champs de la fenêtre
Cartridge Label 

ID de volume de la cartouche pour laquelle un événement a été détecté. 

Event Type

Type d'événement de support suivi. Les différentes options sont les suivantes :

■ Media Error : le lecteur a signalé un problème lié au support, ce qui peut 
également signifier un problème avec le lecteur même.

■ Misbuckle Error : le lecteur n'a pas pu saisir la boucle du support et lire la bande. 
Le support est peut-être endommagé. 

Number of Events

Nombre total d'événements de ce type qui ont été enregistrés pour cette cartouche. 

Last Seen

Date et heure de l'occurrence la plus récente de l'événement. 
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▼ Affichage des informations de synthèse sur le 
lecteur
Cette procédure permet d'afficher les informations de synthèse de l'ensemble des 
lecteurs de la bibliothèque de bandes. 

Si vous souhaitez réaliser un déplacement manuel vers un lecteur, cette procédure 
permet d'afficher un mappage des adresses de chaque lecteur de la bibliothèque de 
bandes :

■ Microprogramme (adresse interne)

■ Logiciel hôte (adresse HLI-PRC)

■ Matériel (baie de disques)

Les informations suivantes sont également affichées :

■ Access State – online, offline

■ Drive State:

■ Vide

■ Unloaded : une cartouche est présente 

■ Ready : une cartouche est chargée

■ NotCommunicating

■ rewindUnload : le lecteur est occupé à rembobiner et à décharger 

■ Type de lecteur

■ Numéro de série du lecteur

■ Version du code actuelle

■ Type d'interface du lecteur

Remarque – La fenêtre Reports > Drive Summary permet également d'avoir accès à 
ces informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 
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1. Sélectionnez Tools > System Detail, puis cliquez sur le dossier Drive. 

La fenêtre répertorie les lecteurs de la bibliothèque de bandes et affiche leur 
emplacement. L'adresse interne, la baie de disques et l'adresse HLI-PRC sont détaillées. 
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▼ Affichage de l'état des lecteurs 
Cette procédure permet d'afficher l'état de fonctionnement actuel d'un lecteur. Les 
informations incluent :

■ Les informations d'état sur le lecteur et le tiroir de lecteurs actuels 

■ Si le lecteur est chargé

■ L'ID de volume de cartouche si le lecteur est chargé

■ Les informations de nettoyage de lecteur

■ L'activité de l'hôte

Remarque – La fenêtre Reports > Drive Details permet également d'avoir accès à ces 
informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

1. Sélectionnez Tools > System Detail

2. Développez le dossier Drive, puis cliquez sur le lecteur à afficher. 

3. Cliquez sur Status.

La fenêtre affiche l'état actuel du lecteur sélectionné. 
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▼ Affichage des propriétés des lecteurs 
Cette fenêtre affiche des informations détaillées sur la configuration des lecteurs, y 
compris le type de lecteur, le numéro de série et la configuration des ports.

Remarque – La fenêtre Reports > Drive Detailspermet également d'avoir accès à ces 
informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Drive, puis cliquez sur le lecteur à afficher. 

3. Cliquez sur Properties. 

La fenêtre Drive Properties s'affiche. 



 

Tâches de gestion des lecteurs

162 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

▼ Affichage du VOP des lecteurs

Remarque – Cette procédure concerne uniquement les lecteurs Sun StorageTek T10000 
et T9840D. 

Elle permet d'afficher le pupitre opérateur virtuel VOP (Virtual Operator Panel) pour 
les lecteurs T10000 et T9840D. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Drive, puis cliquez sur le lecteur à afficher. 

3. Cliquez sur Display.

Les informations VOP sur le lecteur apparaissent dans la section Drive Virtual Op 
Panel. 
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▼ Affichage des données réseau du lecteur
Cette procédure permet d'afficher les données d'adresse IP et MAC pour un lecteur de 
la bibliothèque de bandes. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Drive, puis cliquez sur le lecteur à afficher. 

3. Cliquez sur Display.

Ces données apparaissent dans la section Network Data. 
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▼ Affichage de l'état des voyants des lecteurs
Utilisez cette procédure pour afficher les états actuels des voyants d'un lecteur 
sélectionné, y compris les états loaded, online, cleaning et trace available. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Drive, puis cliquez sur le lecteur à afficher. 

3. Cliquez sur Display.

Ces données apparaissent dans la section Drive Led Status. 



 

Tâches de gestion des lecteurs

166 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501



 

Tâches de gestion des lecteurs

418605501 • Révision AB Mode opératoire de la bibliothèque de bandes SL3000 167

▼ Affichage de l'état des tiroirs des lecteurs
Cette procédure permet d'afficher l'état de fonctionnement actuel d'un tiroir de lecteur. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Drive, puis cliquez sur le lecteur à afficher. 

3. Cliquez sur DriveTray.

La fenêtre Status s'affiche. 
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▼ Affichage du rapport Drive Events

Remarque – Cette fonctionnalité est disponible à partir de la version FRS_2.30 du 
microprogramme de la SL3000 et de la version FRS_4.30 de la Console d’administration 
StreamLine Library. 

Le rapport Drive Events synthétise les événements de lecteur et les erreurs qui se sont 
produits sur les lecteurs de la bibliothèque de bandes. Ce rapport est mis à jour dès 
qu'un événement de lecteur n'est pas associé à un support. Vous pouvez utiliser le 
rapport pour identifier et diagnostiquer des lecteurs défectueux.

Pour chaque lecteur pour lequel des événements se sont produits, le rapport répertorie 
le type de lecteur, le type d'erreur, le nombre d'occurrences, ainsi que la date et l'heure 
du dernier événement de ce type. Le rapport peut afficher jusqu'à 70 entrées. 

Par défaut, ce rapport est trié selon le numéro de série de lecteur. En option, vous 
pouvez modifier l'ordre de tri, réorganiser et redimensionner les colonnes. Voir 
« Modification de la mise en page de la fenêtre » page 45. 

Remarque – Pour les erreurs de support associés à des lecteurs, voir « Affichage du 
rapport Drive Media Events » page 170. 

1. Sélectionnez Tools  >  Reports. 
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2. Développez le dossier Statistics et cliquez sur Drive Events. 

Champs de la fenêtre
Serial Number

Numéro de série du lecteur.

Type de lecteur

Marque et modèle du lecteur.

Event Type

Type d'événement faisant l'objet du suivi. L'ensemble de ces événements indiquent 
des problèmes avec le lecteur, pas avec le support. Les différentes options sont les 
suivantes :

■ Drive Error : le lecteur a connu un problème général. 

■ Load Error : le lecteur n'a pas pu charger la cartouche. 

■ Load Retry : le lecteur a nécessité plusieurs tentatives pour charger la cartouche. 

Number of Events

Nombre total d'événements de ce type qui ont été enregistrés pour ce lecteur. 

Last Seen

Date et heure de l'occurrence la plus récente de l'erreur. 
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▼ Affichage du rapport Drive Media Events

Remarque – Cette fonctionnalité est disponible à partir de la version FRS_2.30 du 
microprogramme de la SL3000 et de la version FRS_4.30 de la Console d’administration 
StreamLine Library. 

Le rapport Drive Media Events synthétise les événements de support qui se sont 
produits sur les lecteurs de la bibliothèque de bandes. Ce rapport est mis à jour dès 
qu'un événement de support ou une erreur se produit. Vous pouvez utiliser le rapport 
pour identifier et diagnostiquer des lecteurs ou des cartouches défectueux.

Pour chaque lecteur pour lequel des événements de support se sont produits, le rapport 
répertorie l'ID de volume de la cartouche, le type d'événement, le nombre 
d'occurrences, ainsi que la date et l'heure du dernier événement de ce type. Le rapport 
peut afficher jusqu'à 500 entrées. 

Par défaut, ce rapport est trié selon le numéro de série de lecteur. En option, vous 
pouvez modifier l'ordre de tri, réorganiser et redimensionner les colonnes. Voir 
« Modification de la mise en page de la fenêtre » page 45. 

Remarque – Pour les erreurs de cartouche qui ne sont pas nécessairement associées à 
des lecteurs, voir « Affichage du rapport Media Events » page 155. 

1. Sélectionnez Tools  >  Reports. 
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2. Développez le dossier Statistics et cliquez sur Drive Media Events. 

Champs de la fenêtre
Serial Number

Numéro de série du lecteur.

Type de lecteur

Marque et modèle du lecteur.

Cartridge Label 

ID de volume de la cartouche pour laquelle un événement a été détecté. 

Event Type

Type d'événement de support suivi. Les différentes options sont les suivantes :

■ Media Error : le lecteur a signalé un problème avec le support ; cela peut 
également indiquer un problème avec le lecteur.

Number of Events 

Nombre total d'événements de ce type qui ont été enregistrés pour cette cartouche 
sur ce lecteur. 

Last Seen

Date et heure de l'occurrence la plus récente de l'événement. 
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Tâches de nettoyage des lecteurs

Remarque – Les tâches de nettoyage des lecteurs s'appliquent uniquement aux 
lecteurs contrôlés par les hôtes FC-SCSI correspondants. Elles ne concernent pas les 
lecteurs gérés par HSC ou ACSLS. 

Tâche Page

Configuration de la fonction de nettoyage automatique 173

Insertion des cartouches de nettoyage ou de diagnostic 175

Éjection des cartouches de nettoyage ou de diagnostic 178

Affichage des cartouches de nettoyage 181

Affichage de l'état de nettoyage des lecteurs 182

Nettoyage manuel d'un lecteur 183
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▼ Configuration de la fonction de nettoyage 
automatique
Cette procédure permet d'activer ou de désactiver la fonction de nettoyage automatique 
des lecteurs. Dans le cas d'une bibliothèque de bandes partitionnée, la fonction de 
nettoyage automatique peut être activée ou désactivée pour chaque partition. 

Remarque – Cette procédure concerne uniquement les lecteurs qui ne sont pas gérés 
par HSC ou ACSLS. Pour plus d'informations concernant la gestion du nettoyage 
automatique, consultez la documentation HSC et ACSLS. 

1. Sélectionnez Tools > System Detail, puis sélectionnez le dossier Library dans 
l'arborescence des périphériques.

2. Cliquez sur Auto Clean, puis sur Configure.

La fenêtre Configure Auto Clean s'affiche. 
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3. Complétez la partie Auto Clean Configuration de la manière suivante :

Pour les partitions SL3000 ou les bibliothèques de bandes complètes contrôlées par 
les logiciels de gestion de bandes ACSLS ou HSC, vous devez toujours désactiver la 
fonction de nettoyage automatique dans cette fenêtre. ACSLS ou HSC gèrent ensuite 
la fonction de nettoyage automatique. Pour plus d'informations, consultez la 
documentation HSC ou ACSLS. 

Pour les partitions SL3000 ou les bibliothèques de bandes complètes contrôlées par 
des hôtes FC-SCSI, vous pouvez sélectionner « enable », afin de gérer le nettoyage 
automatique via la Console d’administration StreamLine Library, ou sélectionner 
« disable » pour gérer manuellement le nettoyage du lecteur. 

Dans le cas d'une bibliothèque de bandes partitionnée, vous pouvez utiliser les listes 
déroulantes pour activer ou désactiver le nettoyage automatique séparément pour 
chaque partition. Si la bibliothèque de bandes n'est pas partitionnée, il vous suffit 
de définir la première liste déroulante (Partition 1 (Or None)) ; les autres listes 
déroulantes sont ignorées. 

4. Dans la partie Auto Clean Configuration, indiquez les seuils d'avertissement pour 
chaque type de cartouche.

5. Cliquez sur Apply.
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▼ Insertion des cartouches de nettoyage ou de 
diagnostic 

Cette procédure explique comment insérer des cartouches de nettoyage ou de 
diagnostic dans la bibliothèque de bandes par le biais d'un CAP. 

Remarque – Elle concerne uniquement les bibliothèques de bandes non partitionnées.  

Avant de commencer cette procédure, vérifiez que toutes les conditions suivantes sont 
remplies :

■ Le nombre requis de cellules réservées est vide. 

■ L'état CAP Prevent/Allow est paramétré sur Allow (consultez votre manuel SCSI 
Reference Manual pour la syntaxe).

■ Le CAP ne doit contenir aucune cartouche de données. 

Remarque – Si le CAP est en mode d'insertion automatique, vous pouvez passer 
directement à Étape 5. 

1. Sélectionnez Tools  >  Diagnostics. 
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2. Développez le dossier CAP, cliquez sur le CAP à utiliser, puis sur l'onglet Access. 

La fenêtre Access s'affiche.

3. Dans la liste déroulante Locked, cliquez sur false. Cliquez sur le bouton Apply. 

La fenêtre contextuelle Confirm s'affiche. 

4. Cliquez sur OK.

Le contrôleur de la bibliothèque de bandes déverrouille la porte du CAP et le voyant 
CAP Open est allumé.

5. Appuyez sur le bouton CAP pour ouvrir le CAP. 

La porte du CAP s'ouvre. 

6. Placez les cartouches de nettoyage ou de diagnostic dans le CAP.
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7. Appuyez sur le bouton CAP pour fermer le CAP.

Le CAP se ferme et se verrouille automatiquement et le voyant du bouton CAP s'éteint.

8. Déplacez manuellement chaque cartouche vers une cellule réservée. Voir 
« Déplacement d'une cartouche depuis un emplacement spécifique » page 153 
pour plus de détails. 

Une fois toutes les cartouches déplacées, la bibliothèque de bandes reconnaît que le 
CAP est vide et celui-ci reprend son état par défaut. 

Remarque – Pour afficher une liste des cartouches de nettoyage et de diagnostic dans 
les emplacements réservés, reportez-vous à « Affichage des cartouches de nettoyage » 
page 181. 
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▼ Éjection des cartouches de nettoyage ou de 
diagnostic
Cette procédure décrit comment éjecter les cartouches de nettoyage ou de diagnostic 
par le CAP.

Remarque – Elle concerne uniquement les bibliothèques de bandes non partitionnées.  

Remarque – Avant de commencer cette procédure, assurez-vous que tous les 
emplacements sont vides dans le CAP que vous souhaitez utiliser.

1. Déplacez manuellement chaque cartouche de diagnostic ou de nettoyage à retirer 
depuis une cellule réservée vers un CAP. Voir « Déplacement d'une cartouche depuis 
un emplacement spécifique » page 153 pour plus de détails. 

Remarque – Pour afficher une liste des cartouches de nettoyage et de diagnostic dans 
les emplacements réservés, reportez-vous à « Affichage des cartouches de nettoyage » 
page 181. 

2. Sélectionnez Tools  >  Diagnostics. 
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3. Développez le dossier CAP, cliquez sur le CAP à utiliser, puis sur l'onglet Access. 

La fenêtre Access s'affiche.

4. Dans la liste déroulante Locked, cliquez sur false. Cliquez sur le bouton Apply. 

La fenêtre contextuelle Confirm s'affiche. 

5. Cliquez sur OK.

Le contrôleur de la bibliothèque de bandes déverrouille la porte du CAP et le voyant 
CAP Open est allumé.

6. Appuyez sur le bouton CAP pour ouvrir le CAP. 

La porte du CAP s'ouvre. 
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7. Retirez toutes les cartouches du CAP.

Éjectez avec précaution les cartouches de nettoyage ayant expiré de la bibliothèque de 
bandes. Si vous déplacez une cartouche de nettoyage ayant expiré vers un CAP et que 
vous ouvrez celui-ci, vous devez retirer la cartouche. Si vous fermez le CAP sans 
préalablement retirer la cartouche de nettoyage, la TallBot réinsérera la cartouche ayant 
expiré dans la bibliothèque de bandes et le contrôleur de la bibliothèque de bandes 
remettra le compteur d'utilisation à zéro. 

8. Appuyez sur le bouton CAP pour refermer le CAP.

Le CAP se ferme et se verrouille automatiquement et le voyant du bouton CAP s'éteint.

9. Le TallBot analyse le CAP et vérifie qu'il est vide.

Le CAP reprend ensuite son état par défaut. 
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▼ Affichage des cartouches de nettoyage
1. Sélectionnez Tools > System Detail, puis sélectionnez le dossier Library dans 

l'arborescence des périphériques.

2. Cliquez sur Auto Clean, puis sur Cleaning Cartridges.

La fenêtre Library Cleaning Cartridges s'affiche. 

Cette liste affiche les détails de chaque cartouche de nettoyage :

■ Cartridge location (reserved cells)

■ ID de volume 

■ Compteur d'utilisation 

■ État (OK, warning, expired)

■ Type de cartouche (par exemple LTO, SDLT)
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▼ Affichage de l'état de nettoyage des lecteurs 
Cette procédure permet d'afficher l'état de nettoyage d'un lecteur. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Drive, puis cliquez sur le lecteur à afficher. 

3. Cliquez sur Status.

La fenêtre affiche les informations suivantes sur le nettoyage :

■ Drive needs cleaning (le lecteur a besoin d'un nettoyage)

■ Drive Last Cleaned ou Drive Last Autocleaned (date du dernier nettoyage ou du 
dernier nettoyage automatique du lecteur)

Remarque – Vous pouvez prévoir un nettoyage manuel des lecteurs en contrôlant 
l'état « Drive needs cleaning ». 
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▼ Nettoyage manuel d'un lecteur
Cette procédure permet de nettoyer un lecteur. La SL3000 n'est pas équipée d'une 
fonction spécifique de nettoyage manuel des lecteurs. Cela consiste principalement à 
envoyer une cartouche de nettoyage vers un lecteur. 

Vous pouvez lancer un nettoyage manuel à tout moment, même avant la date prévue. 

1. Affichez la liste des cartouches de nettoyage. Voir « Affichage des cartouches de 
nettoyage » page 181 pour plus de détails. 

Votre bibliothèque de bandes peut comporter plusieurs types de lecteurs. Par 
conséquent, vous devez vérifier que les cellules réservées contiennent les cartouches 
de nettoyage correspondant au lecteur à nettoyer. 

2. Déplacez manuellement une cartouche de nettoyage depuis une cellule réservée vers 
le lecteur à nettoyer. Voir « Déplacement d'une cartouche depuis un emplacement 
spécifique » page 153 pour plus de détails. 

3. Affichez l'état de l'opération de nettoyage sur la console Drive Clean Status. Voir 
« Affichage de l'état de nettoyage des lecteurs » page 182 pour plus de détails. 

4. Une fois l'opération de nettoyage terminée, replacez la cartouche de nettoyage dans 
une cellule réservée. Voir « Déplacement d'une cartouche depuis un emplacement 
spécifique » page 153 pour plus de détails.
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Tâches de surveillance du robot et de 
l'alimentation électrique

Tâche Page

Affichage des informations de synthèse des robots 185

Affichage de l'état des robots 186

Affichage des propriétés des robots 187

Affichage des informations de synthèse de l'alimentation électrique 188

Affichage des détails des alimentations électriques 189

Affichage des informations de synthèse de l'alimentation électrique 188

Affichage des détails des alimentations électriques 189
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▼ Affichage des informations de synthèse des robots
Cette procédure permet d'afficher les informations de synthèse des TallBot de la 
bibliothèque de bandes. 

Remarque – La fenêtre Reports > Robot Summary permet également d'avoir accès à 
ces informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

1. Sélectionnez Tools > System Detail. 

2. Cliquez sur le dossier Robot dans l'arborescence des périphériques.

La fenêtre Robot Data s'affiche. 
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▼ Affichage de l'état des robots 
Cette procédure permet d'afficher l'état de fonctionnement actuel d'un TallBot. 

Remarque – La fenêtre Reports > Robot Details permet également d'avoir accès à ces 
informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Robot, puis cliquez sur le robot à afficher. 

3. Cliquez sur Status.

La fenêtre affiche l'état actuel du sélectionnéTallBot. 
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▼ Affichage des propriétés des robots 
Cette fenêtre permet d'afficher les informations de configuration détaillées des TallBot, 
y compris le numéro de série et les versions des microprogrammes.

Remarque – La fenêtre Reports > Robot Details permet également d'avoir accès à ces 
informations. Voir « Affichage d'un rapport de la bibliothèque de bandes » page 111 
pour plus de détails. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Robot, puis cliquez sur le robot à afficher. 

3. Cliquez sur Properties. 

La fenêtre Robot Properties s'affiche. 
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▼ Affichage des informations de synthèse de 
l'alimentation électrique
La fenêtre Power Supply Data affiche les informations de synthèse des alimentations 
électriques de la bibliothèque de bandes. La fenêtre permet de contrôler l'état des 
alimentations électriques. 

Par défaut, l'affichage est trié selon l'adresse interne de l'alimentation électrique. En 
option, vous pouvez modifier l'ordre de tri, réorganiser et redimensionner les colonnes. 
Voir « Modification de la mise en page de la fenêtre » page 45. 

1. Sélectionnez Tools > System Detail.

2. Dans l'arborescence Library, cliquez sur le dossier Power Supply.

3. La fenêtre Power Supply Data s'affiche. 



 

Tâches de surveillance du robot et de l'alimentation électrique

418605501 • Révision AB Mode opératoire de la bibliothèque de bandes SL3000 189

▼ Affichage des détails des alimentations électriques 
La fenêtre Power Supply Status affiche les informations détaillées pour une alimenta-
tion électrique sélectionnée. Vous pouvez utiliser cette fenêtre pour déterminer si l'ali-
mentation électrique a besoin d'être entretenue ou remplacée. 

1. Sélectionnez Tools > System Detail.

2. Dans l'arborescence Library, développez le dossier Power Supply.

3. Cliquez sur l'alimentation électrique à afficher.

4. La fenêtre Power Supply Status s'affiche. 
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Tâches de gestion de la porte de sécurité 
de l'AEM

Tâche Page

Affichage de l'état de la porte de sécurité de l'AEM 191

Affichage des propriétés de la porte de sécurité de l'AEM 192
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▼ Affichage de l'état de la porte de sécurité de 
l'AEM 
Cette procédure permet d'afficher l'état actuel d'une porte de sécurité d'AEM. La porte 
de sécurité constitue la porte de « garage » interne, qui s'abaisse pour séparer l'AEM du 
reste de la bibliothèque de bandes. 

Remarque – Des informations d'état sur la porte d'accès de l'AEM, qui constitue la 
porte que vous ouvrez pour charger et décharger en masse des cartouches dans ou 
depuis la bibliothèque de bandes, apparaissent dans la fenêtre CAP Status. Voir 
« Affichage de l'état actuel des CAP de rotation et des AEM » page 127 pour plus de 
détails. 

1. Sélectionnez Tools  >  System Detail. 

2. Développez le dossier Safety Door, puis cliquez sur la porte de sécurité à afficher. 

3. Cliquez sur Status.

La fenêtre Safety Door Status s'affiche. 

« Door open » indique que la porte de sécurité est relevée et que le TallBot peut 
pénétrer et sortir librement de l'AEM. « Door closed » signale que la porte de sécurité 
est abaissée et que vous pouvez ouvrir en toute sécurité la porte d'accès de l'AEM. 
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▼ Affichage des propriétés de la porte de sécurité de 
l'AEM
Cette procédure permet d'afficher des informations détaillées concernant une porte de 
sécurité d'un AEM, y compris le numéro de série et les versions de microprogramme 
actuelles. La porte de sécurité constitue la porte de « garage » interne, qui s'abaisse 
pour vous permettre d'ouvrir la porte d'accès de l'AEM.

Remarque – Le rapport CAP Details et la fenêtre CAP Properties permettent 
également d'avoir accès à ces informations. Voir « Affichage des propriétés de CAP de 
rotation ou des AEM » page 130 et « Affichage d'un rapport de la bibliothèque de 
bandes » page 111 pour plus de détails. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier Safety Door, puis cliquez sur la porte de sécurité à afficher. 

3. Cliquez sur Properties.

La fenêtre Safety Door Properties s'affiche. 
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CHAPITRE 4

Gestion des licences

L'utilitaire de gestion des licences permet d'installer dans la bibliothèque de bandes 
SL3000 les options sélectionnées. 

Fichier de clé de licence
Vous pouvez obtenir un fichier de clé de licence de la manière suivante :

■ Par e-mail de la part de Sun Microsystems, Inc.

■ Installation par votre Sun représentant du support technique

Le fichier de clé de licence se présente sous la forme d'un fichier archive Java (.jar) 
signé numériquement contenant une ou plusieurs clés de licence en fonction des 
fonctionnalités acquises. Afin que ces fonctionnalités soient installées dans la 
bibliothèque de bandes appropriée, le fichier de clé de licence comporte le numéro 
de série de la bibliothèque de bandes cible et peut uniquement être installé dans la 
bibliothèque de bandes correspondante. 

Toutes les fonctions sous licence du système SL3000 acquises pour une bibliothèque de 
bandes sont contenues dans un seul fichier de clé de licence. 

Mise en garde – L'installation d'un nouveau fichier de clé de licence écrase toute 
licence précédemment installée dans la bibliothèque de bandes. Il est donc vivement 
recommandé de vérifier le contenu du nouveau fichier de clé de licence avant son 
installation afin de s'assurer qu'il contient l'ensemble des fonctionnalités acquises 
tout au long de la durée de vie de la bibliothèque de bandes. Dans le cas contraire, 
en cas d'installation du nouveau fichier, vous risquez de supprimer des fonctions 
précédemment installées dans la bibliothèque de bandes. Si le fichier de clé de licence 
s'avère incomplet, de quelque manière que ce soit, n'hésitez pas à demander un 
nouveau fichier auprès de votre Sun représentant du support technique. 
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Expiration des licences

Remarque – La majorité des licences relatives au système SL3000 n'ont pas de date 
d'expiration. Seule la licence intitulée « Service » est limitée dans le temps. 

Dans le cas des licences comportant une date de fin, la gestion des expirations est 
primordiale afin d'éviter toute perte non désirée des options et fonctionnalités de la 
bibliothèque de bandes.

La fenêtre License Management > Current License indique les dates d'expiration ainsi 
que le temps restant. 

De plus, lorsque la date d'expiration d'une licence approche, le contrôleur de la 
bibliothèque de bandes envoie des messages au Journal d'événements de la Console 
d’administration StreamLine Library. Par exemple, si la licence Service arrive à 
expiration dans 30 jours, un message d'information est envoyé toutes les 12 heures. De 
plus, 10 jours avant l'expiration de la licence Service, un message d'avertissement est 
envoyé toutes les 12 heures. Vous pouvez utiliser l'une des méthodes suivantes pour 
afficher ces messages :

■ Via l'option de menu Tools > Reports. Voir « Rapports de bibliothèque de bandes » 
page 74 pour plus de détails. 

■ Via la fenêtre Status Module. Voir « Messages d'alerte d'état » page 75 pour plus de 
détails. 
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Tâches de gestion des licences 
Le présent paragraphe décrit en détail l'ensemble des tâches d'installation et de gestion 
des licences des options de la bibliothèque de bandes. 

Procédure d'installation des licences
La procédure d'installation des licences est résumée ci-dessous. En option, cette 
procédure peut être réalisée par votre Sun représentant du support technique. 

1. Vous pouvez acquérir une ou plusieurs fonctionnalités pour une bibliothèque de 
bandes Sun StorageTek spécifique auprès de Sun Microsystems, Inc. 

2. Sun vous envoie par e-mail un fichier de clé de licence. 

3. Téléchargez le fichier de clé de licence vers un système accessible par la session 
Console d’administration StreamLine Library.

4. Utilisez la Console d’administration StreamLine Library pour afficher et vérifier le 
contenu du fichier de clé de licence. 

5. Utilisez la Console d’administration StreamLine Library pour installer le fichier de 
clé de licence dans la bibliothèque de bandes cible.

6. Reportez-vous aux paragraphes ci-après pour plus d'informations concernant 
l'installation de fonctions sous licence spécifiques :

■ « Capacity on Demand » page 217

■ « Partitionnement de la bibliothèque de bandes » page 269



Tâches de gestion des licences

196 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

Récapitulatif des tâches de gestion des licences

Tâche Page

Réception d'un nouveau fichier de clé de licence 197

Affichez et vérifiez le contenu de la nouvelle licence 198

Installation d'une nouvelle licence dans la bibliothèque de bandes 
cible

201

Affichage de la licence actuelle de la bibliothèque de bandes 205
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▼ Réception d'un nouveau fichier de clé de licence
Cette procédure permet de recevoir un fichier de clé de licence autorisant l'utilisation 
des fonctionnalités dans une bibliothèque de bandes Sun StorageTek spécifique. 

Remarque – Cette procédure n'est pas réalisée à partir de la Console d’administration 
StreamLine Library. 

1. Achetez une ou plusieurs fonctionnalités auprès de Sun Microsystems, Inc. 

Si vous avez besoin d'aide, veuillez contacter Sun représentant du support technique. 

2. Sun vous envoie par e-mail le fichier de clé de licence. 

Vous trouverez ci-dessous un exemple d'en-tête d'e-mail : 
Objet :     SL3000 License Key CR6636975
Date :     Wed, 05 Dec 2007 19:24:41 -0700 (MST)
De :     siks-devoffshore@sun.com

3. Téléchargez le fichier de clé de licence vers un système accessible par la session 
Console d’administration StreamLine Library.

Enregistrez les pièces jointes de l'e-mail selon la méthode standard. 
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▼ Affichez et vérifiez le contenu de la nouvelle 
licence
Cette procédure permet d'afficher un nouveau fichier de clé de licence avant son 
installation dans une bibliothèque de bandes cible. 

Avant de réaliser cette procédure, vous devez télécharger un nouveau fichier de clé 
de licence sur un système accessible par la session de la Console d’administration 
StreamLine Library. Voir « Réception d'un nouveau fichier de clé de licence » page 197. 

1. Utilisez la Console d’administration StreamLine Library pour vous connecter à la 
bibliothèque de bandes cible. 

Voir « Connexion à la Console d’administration StreamLine Library » page 41 pour plus 
de détails. 

2. Sélectionnez Tools > License Management, puis cliquez sur l'onglet Install License. 

La fenêtre Install License s'affiche.
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3. Dans le champ File Name, saisissez le chemin complet du fichier de clé de licence à 
afficher, puis appuyez sur Enter. Vous pouvez également cliquer sur Browse et 
rechercher l'emplacement du fichier. 

Les détails du Fichier de Licence s'affichent dans la partie inférieure de l'écran. 

Remarque – Si le numéro de série de la bibliothèque de bandes indiqué dans le fichier 
de clé de licence concerné ne correspond pas au numéro de série de la bibliothèque de 
bandes à laquelle vous êtes connecté, un message d'avertissement apparaît et les détails 
du fichier de clé de licence ne s'affichent pas. 
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4. Vérifiez les informations du fichier de clé de licence, puis cliquez sur Compare. 

La fenêtre contextuelle Compare Licenses s'affiche. 

5. Vérifiez les informations relatives à la licence.

Remarque – Les modifications qui seront installées par le nouveau fichier de clé de 
licence, telles que les modifications de date d'expiration ou les fonctionnalités qui 
seront supprimées, apparaissent en rouge. 

Si vous rencontrez des problèmes avec le nouveau fichier, veuillez contacter votre Sun 
représentant du support technique afin de les résoudre avant l'installation du fichier 
dans la bibliothèque de bandes cible. 

Mise en garde – Il n'existe pas de fonction de restauration de licence permettant de 
restaurer les fonctionnalités supprimées après l'installation du nouveau fichier de clé de 
licence. 

6. Cliquez sur OK pour fermer la fenêtre contextuelle. 
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▼ Installation d'une nouvelle licence dans la 
bibliothèque de bandes cible
Cette procédure permet d'installer un nouveau fichier de clé de licence dans la 
bibliothèque de bandes cible. 

Avant de réaliser cette procédure, vous devez télécharger un nouveau fichier de clé de 
licence sur un système accessible par la session de la Console d’administration 
StreamLine Library. Voir « Réception d'un nouveau fichier de clé de licence » page 197. 

1. Utilisez la Console d’administration StreamLine Library pour vous connecter à la 
bibliothèque de bandes cible. 

Voir « Connexion à la Console d’administration StreamLine Library » page 41 pour plus 
de détails. 

2. Sélectionnez Tools > License Management, puis cliquez sur l'onglet Install License. 

La fenêtre Install License s'affiche.
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3. Dans le champ File Name, saisissez le chemin complet du fichier de clé de licence à 
installer, puis appuyez sur Enter. Vous pouvez également cliquer sur Browse et 
rechercher l'emplacement du fichier.

Les détails du Fichier de Licence s'affichent dans la partie inférieure de l'écran. 

Remarque – Si le numéro de série de la bibliothèque de bandes indiqué dans le fichier 
de clé de licence concerné ne correspond pas au numéro de série de la bibliothèque de 
bandes à laquelle vous êtes connecté, un message d'avertissement apparaît et les détails 
du fichier de clé de licence ne s'affichent pas. 
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4. Vérifiez les informations du fichier de clé de licence, puis cliquez sur Install dans la 
barre Options. 

La fenêtre contextuelle License Installation Warning s'affiche.

5. Vérifiez les fonctionnalités à installer et que le nouveau fichier de clé de licence est 
complet. 

Remarque – Les modifications qui seront installées par le nouveau fichier de clé de 
licence, telles que les modifications de date d'expiration ou les fonctionnalités qui 
seront supprimées, apparaissent en rouge. 

Si vous rencontrez des problèmes avec le nouveau fichier, cliquez sur No pour annuler 
l'installation. Contactez votre Sun représentant du support technique pour résoudre les 
problèmes avant de poursuivre l'installation. 

Mise en garde – Il n'existe pas de fonction de restauration de licence permettant de 
restaurer les fonctionnalités supprimées après l'installation du nouveau fichier de clé de 
licence. 

6. Si le nouveau fichier de clé de licence est complet, cliquez sur Yes pour commencer 
l'installation de la licence dans la bibliothèque de bandes cible. 

7. Le contrôleur de la bibliothèque de bandes vérifie le fichier de clé de licence et 
procède de la manière suivante :

■ S'il n'y a aucun problème, les fonctionnalités présentes dans le fichier sont installées. 
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■ Si le fichier de clé de licence installé dans la bibliothèque de bandes est plus récent 
que le nouveau fichier, la fenêtre contextuelle ci-dessous s'affiche et la nouvelle 
licence n'est pas installée. 

8. Vous pouvez vérifier que la licence a été installée correctement en affichant les 
licences actuelles. Voir « Affichage de la licence actuelle de la bibliothèque de bandes » 
page 205 pour plus de détails. 

9. Selon les fonctionnalités présentes dans le fichier de clé de licence, des tâches 
supplémentaires devront peut-être être réalisées afin de pouvoir utiliser les 
nouvelles fonctions. 

■ Voir « Augmentation de la capacité autorisée » page 224 et « Diminution de la 
capacité autorisée » page 224 pour les indications particulières à respecter en cas 
d'installation d'un fichier de clé de licence modifiant la capacité autorisée de la 
bibliothèque de bandes.

■ Voir « Installation de la fonctionnalité de partitionnement » page 271 pour les 
indications particulières à respecter en cas d'installation d'un fichier de clé de licence 
comportant la fonction de partitionnement. 
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▼ Affichage de la licence actuelle de la bibliothèque 
de bandes 
Cette procédure permet d'afficher les fonctionnalités actuellement installées dans la 
bibliothèque de bandes à laquelle vous êtes connecté. 

1. Sélectionnez Tools > License Management et cliquez sur l'onglet Current License. 

La fenêtre Current License s'affiche et indique les fonctionnalités actuellement 
installées. Pour plus d'informations sur les champs de la fenêtre, voir « License 
Management > Current License » page 207. 
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Référence des fenêtres de gestion des 
licences
Ce paragraphe décrit en détail l'ensemble des fenêtres de la Console d’administration 
StreamLine Library concernant la gestion des licences, organisées selon le chemin de 
navigation de la fenêtre. Par exemple, le chemin License Management > Install 
License— Compare indique la fenêtre accessible en cliquant sur Tools et License 
Management à partir de la barre de menu, puis en cliquant sur l'onglet Install License, 
et le bouton Compare. 

Remarque – Les fenêtres relatives à la gestion des licences sont uniquement 
accessibles depuis la Console d'administration StreamLine Library autonome ou la 
Console d'administration StreamLine Library Web. Elles ne sont pas disponibles depuis 
le Panneau opérateur local. 

Fenêtre Page

License Management > Current License 207

License Management > Install License 209

License Management > Install License—Compare 212

License Management > Install License—Install 214
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License Management > Current License

Exemple de fenêtre

Description
La fenêtre affiche le contenu du fichier de clé de licence actuellement installé dans la 
bibliothèque de bandes à laquelle vous êtes connecté. 

Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 

Champs de la fenêtre
Feature 

Affichage uniquement.

Nom de la fonctionnalité installée dans la bibliothèque de bandes. 
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Expiration 

Affichage uniquement.

Nombre de jours avant l'expiration attendue ou réelle de la fonctionnalité. En cas 
d'absence de date d'expiration, le champ indique « noExpiration ». 

Value 

Affichage uniquement.

Qualification de la fonctionnalité, le cas échéant. Par exemple, pour la fonctionnalité 
Capacity, ce champ affiche la capacité totale autorisée par la licence. En fonction de 
la fonctionnalité, ce champ peut être vide ou indiquer « None ». 

Time Remaining

Affichage uniquement.

Temps restant avant l'expiration de la fonctionnalité. En cas d'absence de date 
d'expiration, le champ est vide. 

Boutons
Refresh

Ce bouton permet d'actualiser l'affichage avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ License Management > Install License 
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License Management > Install License

Exemple de fenêtre

Description
Cette fenêtre permet d'afficher le contenu du nouveau fichier de clé de licence. 

Elle comprend également des boutons permettant de réaliser les actions suivantes :

■ Comparaison du nouveau fichier de clé de licence avec le fichier actuellement 
installé dans la bibliothèque de bandes. 

■ Installation du nouveau fichier de clé de licence dans la bibliothèque de bandes. 

Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 
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Champs de la fenêtre
File Name

Requis.

Saisissez le chemin complet du fichier de clé de licence à installer dans la 
bibliothèque de bandes. Vous pouvez également cliquer sur Browse et rechercher 
l'emplacement du fichier. Le fichier doit se trouver dans un système accessible par la 
session de la Console d’administration StreamLine Library. Le numéro de série 
indiqué dans le fichier doit correspondre au numéro de série de la bibliothèque de 
bandes à laquelle vous êtes connecté. 

Product

Affichage uniquement.

Type de bibliothèque de bandes auquel le fichier de clé de licence est destiné. Par 
exemple : SL3000, SL8500, SL500. 

Serial Number

Affichage uniquement.

Numéro de série de la bibliothèque de bandes à laquelle le fichier de clé de licence 
est destiné. Ce numéro doit correspondre au numéro de série de la bibliothèque de 
bandes à laquelle vous êtes connecté afin que le fichier de clé de licence soit valide 
pour cette bibliothèque de bandes. 

Generated On

Affichage uniquement.

Date de création du fichier de clé de licence. 

Comment Line 1

Affichage uniquement.

Commentaire éventuel concernant le fichier de clé de licence depuis Sun 
Microsystems, Inc. 

Comment Line 2

Affichage uniquement.

Commentaire éventuel concernant le fichier de clé de licence depuis Sun 
Microsystems, Inc. 

Feature

Affichage uniquement.

Nom d'une fonctionnalité présente dans le fichier de clé de licence.

Expiration

Affichage uniquement.

Nombre de jours avant l'expiration attendue de la fonctionnalité. En cas d'absence de 
date d'expiration, le champ indique « noExpiration ». 

Value 

Affichage uniquement.

Qualification de la fonctionnalité, le cas échéant. Par exemple, pour la fonctionnalité 
Capacity, ce champ affiche la capacité de stockage totale autorisée par la licence. En 
fonction de la fonctionnalité, ce champ peut être vide. 
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Boutons
Install

Ce bouton permet d'installer le fichier de clé de licence affiché dans la bibliothèque 
de bandes à laquelle vous êtes connecté.La fenêtre contextuelle License 
Management > Install License—Installapparaît. 

Browse

Ce bouton permet de trouver le fichier de clé de licence à afficher et à installer.

Remarque – Si le numéro de série de la bibliothèque de bandes indiqué dans le fichier 
de clé de licence concerné ne correspond pas au numéro de série de la bibliothèque de 
bandes à laquelle vous êtes connecté, un message d'avertissement apparaît et les détails 
du fichier de clé de licence ne s'affichent pas. 

Compare

Ce bouton permet de comparer le nouveau fichier de clé de licence avec le fichier 
actuellement installé dans la bibliothèque de bandes. La fenêtre contextuelle License 
Management > Install License—Compare s'affiche. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ License Management > Current License 

■ License Management > Install License—Compare 

■ License Management > Install License—Install 
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License Management > Install License—Compare 

Exemple de fenêtre

Description
Cette fenêtre permet de comparer les informations suivantes relatives aux licences : 

■ Fonctionnalités actuellement installées dans la bibliothèque de bandes à laquelle 
vous êtes connecté. 

■ Fonctionnalités présentes dans le nouveau fichier de clé de licence indiqué dans la 
fenêtre License Management > Install License. 

Remarque – Les modifications qui seront installées par le nouveau fichier de clé de 
licence, telles que les modifications de date d'expiration ou les fonctionnalités qui 
seront supprimées, apparaissent en rouge. 

Il s'agit d'une fenêtre contextuelle qui s'affiche en cliquant sur Compare dans la fenêtre 
License Management > Install License. 
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Champs de la fenêtre
Current Features

Affichage uniquement.

Liste des fonctionnalités, dates d'expiration et valeurs de toutes les fonctions 
actuellement installées dans la bibliothèque de bandes à laquelle vous êtes connecté. 

Features to be Installed

Affichage uniquement.

Liste des fonctionnalités, dates d'expiration et valeurs de toutes les fonctions 
présentes dans le nouveau fichier de clé de licence. Les modifications qui seront 
installées par le nouveau fichier de clé de licence, telles que les modifications de date 
d'expiration ou les fonctionnalités qui seront supprimées, apparaissent en rouge. 

Boutons
OK

Ce bouton permet de fermer la fenêtre popup et de revenir à la fenêtre précédente. 

Voir aussi
■ License Management > Install License 

■ License Management > Install License—Install 
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License Management > Install License—Install 

Exemple de fenêtre

Description
Cette fenêtre permet de comparer les informations suivantes relatives aux licences : 

■ Fonctionnalités actuellement installées dans la bibliothèque de bandes à laquelle 
vous êtes connecté. 

■ Fonctionnalités présentes dans le nouveau fichier de clé de licence indiqué dans la 
fenêtre License Management > Install License. 

Des messages d'avertissement s'affichent si l'installation du nouveau fichier de clé de 
licence risque de supprimer des fonctionnalités de la bibliothèque de bandes. 

Une fois la comparaison des informations relative à la licence terminée, vous pouvez 
installer le nouveau fichier de clé de licence dans la bibliothèque de bandes en cliquant 
sur le bouton Yes. 

Mise en garde – Il est extrêmement important de vérifier que le nouveau fichier de clé 
de licence est complet avant de l'installer étant donné qu'il n'existe pas de fonction de 
restauration permettant de restaurer les fonctionnalités supprimées. 

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Install dans la 
fenêtre License Management > Install License. 
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Selon les fonctionnalités présentes dans le fichier de clé de licence, des tâches 
supplémentaires devront éventuellement être réalisées afin de pouvoir utiliser les 
nouvelles fonctions.

■ Voir « Augmentation de la capacité autorisée » page 224 et « Diminution de la 
capacité autorisée » page 224 pour les indications particulières à respecter en cas 
d'installation d'un fichier de clé de licence modifiant la capacité autorisée de la 
bibliothèque de bandes.

■ Voir « Installation de la fonctionnalité de partitionnement » page 271 pour les 
indications particulières à respecter en cas d'installation d'un fichier de clé de licence 
comportant la fonction de partitionnement. 

Champs de la fenêtre
Current Features

Affichage uniquement.

Liste des fonctionnalités, dates d'expiration et valeurs de toutes les fonctions 
actuellement installées dans la bibliothèque de bandes à laquelle vous êtes connecté. 

Features to be Installed

Affichage uniquement.

Liste des fonctionnalités, dates d'expiration et valeurs de toutes les fonctions 
présentes dans le nouveau fichier de clé de licence. Des messages d'avertissement 
s'affichent si l'installation du fichier de clé de licence risque de supprimer des 
fonctionnalités de la bibliothèque de bandes. 

Boutons
Yes

Ce bouton permet d'installer le nouveau fichier de clé de licence dans la bibliothèque 
de bandes. Le contrôleur de la bibliothèque de bandes vérifie la validité du fichier de 
clé de licence et procède à son installation. 

No 

Ce bouton permet d'annuler la mise à jour et de revenir à la fenêtre précédente. 

Voir aussi
■ License Management > Install License 

■ License Management > Install License—Compare 
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CHAPITRE 5

Capacity on Demand

La bibliothèque de bandes SL3000 est dotée des fonctionnalités RealTimeGrowth™ et 
Capacity on Demand. La fonctionnalité RealTime Growth vous permet d'augmenter la 
capacité de stockage physique. La fonctionnalité Capacity on Demand différencie la 
capacité installée de celle autorisée et vous permet de ne payer que la capacité dont 
vous avez besoin. Par la suite, en fonction de l'évolution de vos besoins, vous avez 
la possibilité d'augmenter la capacité de stockage tout en minimisant les perturbations 
sur le fonctionnement de la bibliothèque de bandes. Afin d'activer la capacité 
supplémentaire, il vous suffit d'acheter et d'installer un fichier de clé de licence 
correspondant à la nouvelle capacité.

Remarque – L'installation de la capacité de stockage de la bibliothèque de bandes 
s'effectue à l'aide de l'utilitaire de gestion de licences de la SL3000. Voir Chapitre 4, 
« Gestion des licences » pour plus de détails. 

Remarque – Cette fonction commande uniquement les cellules de stockage des 
cartouches. Par défaut, tous les CAP et les lecteurs de bande installés sont activés. 

Caractéristiques et limites de la fonction 
Capacity on Demand
Le présent paragraphe décrit les principales caractéristiques et limites de la 
fonctionnalité Capacity on Demand pour vous aider à programmer et à utiliser cette 
fonction dans votre bibliothèque de bandes SL3000. 

■ La capacité autorisée minimum est de 200 cellules de stockage. 

■ La capacité autorisée maximum est égale à la capacité physique de la bibliothèque de 
bandes, soit 5 821 cellules. 

■ Vous avez la possibilité d'augmenter la capacité autorisée par bloc de 1, 100, 200, 500 
ou 1 000 cellules. 
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■ L'installation de la capacité autorisée supplémentaire s'effectue en perturbant 
le moins possible le fonctionnement de la bibliothèque de bandes. Après 
vérification par le contrôleur de la bibliothèque de bandes, les cellules de stockage 
supplémentaires sont disponibles immédiatement. Il n'est pas nécessaire de 
redémarrer la bibliothèque de bandes. Selon l'interface hôte (HLI ou FC-SCSI), les 
opérations d'hôte risquent de connaître une brève interruption, car les hôtes mettent 
à jour les nouvelles informations de ressource. Voir « Modifications de capacité sans 
interruption » page 222 pour plus de détails. 

■ La capacité de stockage autorisée d'une bibliothèque de bandes correspond à la 
capacité indiquée dans le dernier fichier de clé de licence installé. 

■ Des modifications peuvent être apportées à la capacité active, tout en entraînant 
des interruptions minimales des opérations de la bibliothèque de bandes. Voir 
« Modifications de capacité sans interruption » page 222 pour plus de détails.

Terminologie
On utilise les termes suivants pour décrire la gestion de la capacité de la bibliothèque 
de bandes :

■ Capacité physique ou installée : nombre de cellules de stockage physiquement 
présentes dans la bibliothèque de bandes.

■ Capacité autorisée : nombre de cellules de stockage que la bibliothèque de bandes est 
autorisée à utiliser. Ce nombre ne peut pas dépasser la capacité installée. 

■ Capacité active : nombre de cellules de stockage autorisées pouvant être utilisées. 
Par défaut, elle est identique à la capacité autorisée. En option, vous avez la 
possibilité de désactiver les cellules de stockage sélectionnées afin de ne pas 
dépasser la capacité autorisée. 

■ Zone de stockage active : zone rectangulaire de cellules de stockage pouvant être 
utilisées. Une zone de stockage active peut comprendre aussi bien une cellule de 
stockage unique que la capacité autorisée totale de la bibliothèque de bandes. 

■ Cellule active : cellule de stockage pouvant être utilisée. Seules les cellules activées 
peuvent être utilisées pour le stockage de cartouches.

■ Cellule inactive : cellule de stockage désactivée et, par conséquent, ne pouvant pas 
être utilisée pour le stockage de cartouches. 

■ Cellule sélectionnée : cellule de stockage inactive mais qui sera automatiquement 
activée par le contrôleur de la bibliothèque de bandes après augmentation de la 
capacité autorisée. 



Configuration de la zone de stockage active

418605501 • Révision AB Chapitre 5 Capacity on Demand 219

Configuration de la zone de stockage 
active
L'affectation des zones de stockage actives peut se faire de manière automatique par le 
contrôleur de la bibliothèque de bandes ou de manière manuelle par l'utilisateur. 
L'affectation automatique effectuée par le contrôleur de la bibliothèque de bandes 
permet une croissance équilibrée des modules de la bibliothèque de bandes.

Les différents états des cellules de stockage peuvent être les suivants :

■ Active : les cellules activées peuvent être utilisées pour le stockage de cartouches. 

■ Inactive : les cellules ont été désactivées et, par conséquent, ne peuvent pas être uti-
lisées pour le stockage des cartouches. Les écrans et les rapports de la bibliothèque 
de bandes permettent de contrôler la cellule. Toutefois, le contrôleur de la bibliothè-
que de bandes rejette les demandes de déplacement de cartouches vers la cellule. 

■ Selected : la cellule est inactive mais sera automatiquement activée par le contrôleur 
de la bibliothèque de bandes après augmentation de la capacité autorisée. Cet état 
existe uniquement dans les bibliothèques de bandes non partitionnées. 

Seules les cellules de stockage actives peuvent être utilisées pour le stockage de 
cartouches de bande. Les cellules de stockage inactives ne peuvent pas être utilisées 
pour le stockage de cartouches. Par ailleurs, aucun hôte n'a accès à ces cellules. 
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Règles d'activation des cellules
Le contrôleur de la bibliothèque de bandes respecte les règles suivantes pour ajouter 
des cellules aux zones de stockage actives :

■ L'activation des cellules s'effectue depuis la partie arrière supérieure gauche de la 
zone de stockage active vers la partie avant inférieure droite. 

■ L'activation des cellules d'une même colonne s'effectue de haut en bas avant de 
passer à la colonne suivante. 

■ L'activation des colonnes d'un même tableau se fait de gauche à droite. 

Bibliothèques non partitionnées
Dans le cas d'une bibliothèque de bandes non partitionnée, le contrôleur de la 
bibliothèque de bandes sélectionne automatiquement l'ensemble des cellules physiques 
mais active uniquement le nombre de cellules correspondant à la capacité autorisée 
totale de la bibliothèque de bandes. Lorsque la capacité autorisée maximum est atteinte, 
les cellules sélectionnées ne pouvant pas être activées restent sélectionnées et 
s'activeront automatiquement après augmentation de la capacité autorisée.

À l'activation des cellules, le contrôleur de la bibliothèque de bandes commence par la 
partie arrière de la bibliothèque de bandes en partant du module se trouvant le plus à 
gauche puis se dirige vers la droite. Ensuite, il continue vers l'avant de la bibliothèque 
de bandes en partant du module se trouvant le plus à gauche puis vers la droite. 

Dans le but d'optimiser l'emplacement des cartouches, vous avez la possibilité de 
désigner des zones de stockage actives dans la bibliothèque de bandes auxquelles le 
contrôleur de la bibliothèque de bandes applique les règles indiquées ci-dessus. 

Bibliothèques partitionnées
Dans les bibliothèques de bandes partitionnées, le nombre total de cellules de stockage 
affectées à l'ensemble des partitions de la bibliothèque de bandes ne peut pas dépasser 
la capacité autorisée de celle-ci.

Dans les bibliothèques de bandes partitionnées, aucune zone de stockage active n'est 
définie par défaut. Vous devez affecter des cellules de stockage aux partitions en 
configurant les zones de stockage actives pour chaque partition. Voir « Procédures de 
partitionnement » page 288 pour plus de détails. 

Au moment de positionner les cartouches dans les cellules de stockage, le contrôleur de 
la bibliothèque de bandes applique individuellement les règles d'activation des cellules 
prédéfinies à chaque partition. Voir « Règles d'activation des cellules » page 220 pour 
plus de détails. 

Désactivation de la capacité de stockage 
La désactivation des cellules de stockage sélectionnées permet de réduire la taille d'une 
zone de stockage active. Un message d'avertissement s'affiche en cas de présence de 
cartouche orpheline suite à la diminution de la capacité.
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Cartouches orphelines dans les bibliothèques de 
bandes non partitionnées

Remarque – Pour plus d'informations sur les cartouches orphelines dans les 
bibliothèques de bandes partitionnées, voir « Cartouches orphelines dans les 
bibliothèques de bandes non partitionnées » page 277. 

Dans les bibliothèques de bandes non partitionnées, une cartouche orpheline désigne 
une cartouche située dans une cellule de stockage inactive. Aucun hôte n'a accès aux 
cartouches orphelines. 

Une cartouche peut devenir orpheline pour plusieurs raisons. En voici quelques 
exemples :

■ La capacité de stockage active a été diminuée.

■ La cartouche a été déplacée manuellement vers une cellule inactive ou inaccessible. 

En cas d'identification d'une cartouche orpheline par la Console d’administration 
StreamLine Library, un message d'avertissement s'affiche. Les actions suivantes 
permettent de corriger les problèmes de cartouches orphelines :

■ Génération d'un rapport sur les cartouches orphelines. 

■ Réalisation d'un audit de la bibliothèque de bandes. 

■ Récupération d'une cartouche. 

Pour plus d'informations concernant la vérification des cartouches orphelines et la 
résolution de problèmes, consultez les procédures ci-après :

■ « Affichage d'un rapport d'une zone de stockage active » page 235

■ « Validation des modifications des zones de stockage actives » page 232
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Modifications de capacité sans 
interruption 
Les modifications de la capacité active entraînent des interruptions minimales des 
opérations de la bibliothèque de bandes. Le comportement de la bibliothèque de bandes 
spécifique dépend du type de connexion hôte, comme décrit dans les sections 
suivantes :

■ « Modifications de capacité active et connexions HLI » page 222

■ « Modifications de capacité active et connexions FC-SCSI » page 223

Mise en garde – Bien que les modifications de la capacité active n'interrompent pas 
les hôtes de la bibliothèque de bandes, il est recommandé d'interdire l'accès à la 
bibliothèque de bandes aux autres utilisateurs avant de valider les modifications 
apportées à la zone de stockage active. Du fait que la Console d’administration 
StreamLine Library ne valide pas les délimitations de la zone de stockage par rapport à 
la base de données du contrôleur de la bibliothèque de bandes en temps réel, des 
conflits de configuration peuvent se produire si vous modifiez des délimitations de la 
zone de stockage active, alors que d'autres utilisateurs déplacent des cartouches ou 
modifient la configuration de la bibliothèque de bandes. Voir « Synchronisation de 
l'affichage avec la base de données du contrôleur » page 44 pour plus de détails. 

Modifications de capacité active et connexions HLI
Avec les bibliothèques de bandes HLI, vous pouvez augmenter la capacité active sans 
arrêter les tâches d'hôte ni déconnecter d'hôtes. Lorsque vous réduisez la capacité, la 
bibliothèque de bandes est alors hors ligne momentanément seulement, puis revient en 
ligne automatiquement.

Ajout de capacité active 
Dès que vous ajoutez des cellules de stockage actives, la bibliothèque de bandes 
demeure en ligne. Le contrôleur de la bibliothèque de bandes envoie un message 
asynchrone à tous les hôtes, en les avertissant que la configuration de la bibliothèque de 
bandes a changé. Les hôtes connaissent alors une brève interruption lors de la mise à 
jour des informations de configuration de leur bibliothèque de bandes, puis ils 
continuent automatiquement à traiter les tâches. 

Suppression de capacité active 
Dès que vous apportez n'importe lequel des types suivants de modification de capacité, 
la bibliothèque de bandes est alors momentanément hors ligne. 

■ Désactivation d'une cellule de stockage

■ Suppression d'un emplacement de lecteur vide 
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Une fois la modification de configuration mise à jour dans la base de données du 
contrôleur de la bibliothèque de bandes, la bibliothèque de bandes est remise en ligne 
et le contrôleur de la bibliothèque de bandes envoie un message asynchrone à tous les 
hôtes, en les avertissant que la configuration de la bibliothèque de bandes a changé. Les 
hôtes connaissent alors une brève interruption lors de la mise à jour des informations 
de configuration de leur bibliothèque de bandes, puis ils continuent automatiquement à 
traiter les tâches. 

Modifications de capacité active et connexions 
FC-SCSI
Avec les bibliothèques de bandes FC-SCSI, dès que vous apportez n'importe laquelle 
des modifications suivantes, la bibliothèque de bandes est momentanément hors ligne 
avec une condition Unit Attention : 

■ Activation ou désactivation d'une cellule de stockage

■ Ajout, modification ou suppression d'une connexion hôte

■ Suppression d'un emplacement de lecteur vide 

Plusieurs messages d'erreur peuvent être générés et tous les hôtes doivent émettre 
les commandes appropriées, de manière à mettre à jour leurs informations de 
configuration de bibliothèque de bandes. Reportez-vous à la documentation du logiciel 
de gestion des bandes pour plus d'informations concernant les procédures et les 
commandes. Dans le cas d'un ajout ou d'une suppression de lecteurs, la numérotation 
SCSI du périphérique est également mise à jour.
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Augmentation de la capacité autorisée
Les indications spécifiques ci-dessous ne s'appliquent qu'après avoir correctement 
installé une licence de capacité octroyant de la capacité supplémentaire. Voir Chapitre 4, 
« Gestion des licences » page 193 pour plus d'informations concernant l'installation des 
fichiers de clé de licence. 

■ La nouvelle capacité de la bibliothèque de bandes est égale à la capacité indiquée 
dans le dernier fichier de clé de licence installé. 

■ Il n'est pas nécessaire de redémarrer la bibliothèque de bandes avant d'utiliser la 
nouvelle capacité. Cependant, vous devez configurer l'ensemble des applications 
hôtes de la bibliothèque de bandes concernées afin qu'elles puissent reconnaître la 
nouvelle capacité. Voir « Modifications de capacité sans interruption » page 222 pour 
plus de détails. 

■ Si la nouvelle capacité autorisée dépasse la capacité physique, un message 
d'avertissement s'affiche. Aucune action corrective n'est nécessaire. 

■ Dans le cas d'une bibliothèque de bandes non partitionnée, le contrôleur de la 
bibliothèque de bandes active automatiquement les cellules que l'utilisateur n'a pas 
désactivées. Dans ce cas, aucune intervention de l'utilisateur n'est demandée pour 
rendre disponible la nouvelle capacité autorisée. Toutefois, en cas de désactivation 
des cellules, elles devront être sélectionnées manuellement pour pouvoir utiliser la 
nouvelle capacité. 

■ Dans le cas d'une bibliothèque de bandes partitionnée, la nouvelle capacité 
ajoutée correspond à des cellules non affectées. L'affectation de nouvelles cellules de 
stockage aux partitions doit se faire manuellement pour pouvoir utiliser les cellules; 
voir « Conception d'une partition : modules de base, DEM ou CEM » page 297 pour 
plus de détails. 

Diminution de la capacité autorisée
Les indications spécifiques ci-dessous ne s'appliquent qu'après avoir correctement 
installé une licence de capacité résultant en une capacité réduite. Voir Chapitre 4, 
« Gestion des licences » page 193 pour plus d'informations concernant l'installation des 
fichiers de clé de licence.

Remarque – La diminution de la capacité est une action exceptionnelle. Avant 
d'installer le fichier de clé de licence, soyez certain de votre choix. 

■ Un message d'avertissement s'affiche en cas de présence de cartouches orphelines 
suite à la diminution de la capacité. Voir « Cartouches orphelines dans les 
bibliothèques de bandes non partitionnées » page 221 pour plus de détails.  

■ Dans le cas de bibliothèques de bandes non partitionnées :

■ La diminution de la capacité est effective immédiatement. 

■ Le contrôleur de la capacité désactive les cellules dans l'ordre inverse de leur 
activation ; les dernières cellules activées sont désactivées en premier. 
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■ Dans le cas de bibliothèques de bandes partitionnées :

■ Si le nombre total de cellules affectées à l'ensemble des partitions dépasse 
la nouvelle capacité autorisée, la bibliothèque de bandes se déconnecte 
automatiquement. Les cellules doivent être désaffectées des partitions de manière 
à ce que l'affectation totale ne dépasse pas la nouvelle capacité autorisée.

■ Si le nombre total de cellules affectées à l'ensemble des partitions est inférieur 
à la nouvelle capacité autorisée, la diminution de la capacité est effective 
immédiatement sans qu'aucune modification ne soit apportée aux affectations des 
partitions existantes. Le fonctionnement de la bibliothèque de bandes n'est pas 
interrompu. 
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Tâches de gestion de la capacité 
Le présent paragraphe explique en détail l'ensemble des tâches relatives à l'installation 
et à la gestion de la capacité de stockage active dans la bibliothèque de bandes. 

Procédure d'installation de la capacité de stockage
La procédure d'installation d'une nouvelle capacité de stockage dans la bibliothèque de 
bandes est la suivante : 

1. Vous devez acquérir et installer une licence de capacité pour la bibliothèque de 
bandes. Voir « Procédure d'installation des licences » page 195 pour plus de détails. 

2. La nouvelle capacité autorisée est effective immédiatement. Il n'est pas nécessaire de 
redémarrer la bibliothèque de bandes. 

3. Par défaut, les nouvelles cellules activées peuvent être utilisées immédiatement dans 
les bibliothèques de bandes non partitionnées. La procédure est la suivante :

■ Si vous souhaitez utiliser la configuration de la zone de stockage définie par 
défaut par le contrôleur de la bibliothèque de bandes, vous devez configurer 
l'ensemble des applications hôtes de la bibliothèque de bandes concernées 
de manière à pouvoir reconnaître les nouvelles zones de stockage. Voir 
« Modifications de capacité sans interruption » page 222 pour plus de détails. 

■ Si vous souhaitez modifier la configuration par défaut de la zone de stockage, 
voir « Définition des zones de stockage actives » page 229. 

4. Dans les bibliothèques de bandes partitionnées, les nouvelles cellules activées n'ont 
pas d'affectation et, par conséquent, ne peuvent pas être utilisées. Vous devez 
affecter manuellement les nouvelles cellules aux partitions. Voir « Procédures de 
partitionnement » page 288 pour plus de détails. 

Espace de travail de la zone de stockage active de la 
Console d’administration StreamLine Library
Les fenêtres Select Active Cells, ainsi que les fenêtres contextuelles correspondantes, 
donnent accès à un espace de travail dynamique vous permettant de personnaliser 
la configuration de la capacité autorisée. Toutes les informations concernant la 
configuration de la capacité autorisée sont enregistrées automatiquement dans l'espace 
de travail de la zone de stockage active dans la mémoire de la Console d’administration 
StreamLine Library et sont conservées pendant toute la durée de votre session sur la 
Console d’administration StreamLine Library. Ainsi, vous pouvez passer d'un affichage 
de zone de stockage active à l'autre, revenir aux fenêtres Select Active Cells autant de 
fois que vous voulez sans perdre vos changements de configuration.
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Le bouton Apply de la fenêtre Select Active Cells > Select Active Cells permet 
d'enregistrer les données de l'espace de travail de la zone de stockage active de la 
Console d’administration StreamLine Library dans la base de données du contrôleur de 
la bibliothèque de bandes. Les données risquent d'être perdues si l'un des événements 
suivants se produit avant la validation de vos mises à jour : 

■ Vous vous déconnectez de la session de la Console d’administration StreamLine 
Library.

■ Le délai de connexion de la session sur la Console d’administration StreamLine 
Library est dépassé ou la connexion vers la bibliothèque de bandes est interrompue. 

■ Vous actualisez l'espace de travail de la zone de stockage active depuis la base de 
données actuelle du contrôleur de la bibliothèque de bandes en cliquant sur le 
bouton Refresh des fenêtres Select Active Cells. 

Mise en garde – Bien que les modifications de la capacité active n'interrompent pas 
les hôtes de la bibliothèque de bandes, il est recommandé d'interdire l'accès à la 
bibliothèque de bandes aux autres utilisateurs avant de valider les modifications 
apportées à la zone de stockage active. Du fait que la Console d’administration 
StreamLine Library ne valide pas les délimitations de la zone de stockage par rapport à 
la base de données du contrôleur de la bibliothèque de bandes en temps réel, des 
conflits de configuration peuvent se produire si vous modifiez des délimitations de la 
zone de stockage active, alors que d'autres utilisateurs déplacent des cartouches ou 
modifient la configuration de la bibliothèque de bandes. Voir « Synchronisation de 
l'affichage avec la base de données du contrôleur » page 44 pour plus de détails. 
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Tâches de gestion de la capacité

Remarque – Les tâches suivantes concernent uniquement les bibliothèques de bandes 
non partitionnées. Pour plus d'informations concernant la configuration des zones 
de stockage dans les bibliothèques de bandes partitionnées, voir « Procédures de 
partitionnement » page 288. 

Remarque – Les tâches suivantes peuvent être effectuées uniquement depuis la 
Console d’administration StreamLine Library autonome ou la Console d’administration 
StreamLine Library Web. Elles ne peuvent pas être effectuées depuis le Panneau 
opérateur local. 

Tâche Page

Définition des zones de stockage actives 229

Validation des modifications des zones de stockage actives 232

Affichage d'un rapport d'une zone de stockage active 235

Impression des données des rapports des zones de stockage actives 237

Enregistrement des données des rapports de zones de stockage 
actives

239

Affichage des détails de cellule active 241



Tâches de gestion de la capacité

418605501 • Révision AB Chapitre 5 Capacity on Demand 229

▼ Définition des zones de stockage actives 

Remarque – Voir « Procédure d'installation des licences » page 195 pour plus 
d'informations concernant l'installation de la capacité autorisée. 

Pendant l'installation de la capacité autorisée supplémentaire, le contrôleur de la 
bibliothèque de bandes active automatiquement le nombre de cellules de stockage 
correspondant à la capacité autorisée. Le choix des cellules à activer suit un ensemble 
de règles internes. Voir « Configuration de la zone de stockage active » page 219 pour 
plus de détails. 

Cette procédure doit être respectée pour réaliser les actions suivantes :

■ Personnalisation des zones de stockage actives pour les différencier de la 
configuration définie par défaut par le contrôleur de la bibliothèque de bandes. 
Vous pouvez, par exemple, configurer des cellules de stockage actives de manière 
à regrouper les cartouches autour des lecteurs et à réserver les extrémités de la 
bibliothèque de bandes pour une future augmentation. 

■ Désactivation des cellules de stockage afin que le nombre total de cellules de 
stockage actives ne dépasse pas la capacité autorisée. 

■ Désélection des cellules de stockage pour éviter leur activation automatique après 
l'augmentation de la capacité autorisée de la bibliothèque de bandes. 

Remarque – Ne tenez pas compte de cette procédure si vous comptez utiliser la 
configuration des zones de stockage définie par défaut par le contrôleur de la 
bibliothèque de bandes. 
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1. Sélectionnez Tools > Select Active Cells. 

La fenêtre Module Map s'affiche.

2. Cliquez sur le module pour lequel vous souhaitez définir les zones de stockage 
actives. 

3. Cliquez sur l'onglet Select Active Cells.

La fenêtre Select Active Cells apparaît et affiche la configuration actuelle du module 
sélectionné.

Remarque – Lorsque cette fenêtre s'affiche pour la première fois, le nombre de cellules 
sélectionnées correspond à la capacité physique de la bibliothèque de bandes et le 
nombre de cellules actives est égal à la capacité autorisée totale. 
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Remarque – Cliquez sur les boutons Move Left ou Move Right pour afficher un 
module adjacent à celui affiché. 

4. Choisissez la méthode de sélection à l'aide de la liste Select by, puis cliquez sur le 
bouton radio Add ou Remove.

5. Servez-vous du plan de la bibliothèque de bandes pour sélectionner les cellules de 
stockage que vous souhaitez activer ou désactiver. 

Remarque – Voir « Select Active Cells > Select Active Cells » page 247 pour plus 
d'informations concernant le plan de la bibliothèque de bandes. 

Les modifications que vous apportez à la configuration de la capacité sont enregistrées 
dans l'espace de travail de la zone de stockage active de la Console d’administration 
StreamLine Library pendant la durée de la session. Vous pouvez faire d'autres 
changements puis revenir aux fenêtres Select Active Cells autant de fois que vous 
le souhaitez sans perdre vos modifications.

6. Une fois vos modifications terminées, reportez-vous au paragraphe « Validation des 
modifications des zones de stockage actives » page 232 afin de vérifier et de valider 
vos modifications. 
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▼ Validation des modifications des zones de 
stockage actives 
Cette procédure permet de vérifier et de valider les modifications apportées à la 
configuration des zones de stockage actives dans la fenêtre Select Active Cells. Elle 
vous permet de détecter les erreurs potentielles suivantes :

■ Présence de cartouches orphelines dans la bibliothèque de bandes. Voir « Cartouches 
orphelines dans les bibliothèques de bandes non partitionnées » page 221 pour plus 
de détails.

■ Cellules inaccessibles pour les hôtes de la bibliothèque de bandes. 

Mise en garde – Bien que les modifications de la capacité active n'interrompent pas 
les hôtes de la bibliothèque de bandes, il est recommandé d'interdire l'accès à la 
bibliothèque de bandes aux autres utilisateurs avant de valider les modifications 
apportées à la zone de stockage active. Du fait que la Console d’administration 
StreamLine Library ne valide pas les délimitations de la zone de stockage par rapport à 
la base de données du contrôleur de la bibliothèque de bandes en temps réel, des 
conflits de configuration peuvent se produire si vous modifiez des délimitations de la 
zone de stockage active, alors que d'autres utilisateurs déplacent des cartouches ou 
modifient la configuration de la bibliothèque de bandes. Voir « Synchronisation de 
l'affichage avec la base de données du contrôleur » page 44 pour plus de détails. 

1. Suivez les étapes décrites dans le paragraphe « Définition des zones de stockage 
actives » page 229. 

Les modifications réalisées s'affichent dans la fenêtre Select Active Cells. 

2. Dans la barre Options, cliquez sur Apply. 

Les délimitations des zones de stockage actives sont contrôlées, y compris les 
emplacements de l'ensemble des cartouches de bande. 
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Remarque – Cette vérification porte uniquement sur la configuration des zones de 
stockage actives définie dans les fenêtres Select Active Cells. Elle ne contrôle pas les 
zones de stockage actives dans la base de données du contrôleur de la bibliothèque de 
bandes. Par conséquent, elle ne permet pas d'identifier les conflits de configuration 
pouvant se produire en cas de déplacements de cartouches réalisés par d'autres utilisa-
teurs ou de modification de la configuration de la bibliothèque de bandes, par le biais 
de l'Interface de ligne de commande, d'autres sessions sur la Console d’administration 
StreamLine Library ou d'applications hôtes, en même temps que les modifications des 
zones de stockage actives. 

La fenêtre contextuelle Confirm Apply s'affiche et indique la présence éventuelle de 
cartouches orphelines ou d'autres problèmes au niveau de la configuration des zones de 
stockage actives. 

3. Cliquez sur Details pour afficher les messages d'avertissement détaillés expliquant 
les raisons de la présence de cartouches orphelines. 

Utilisez le bouton Details pour basculer entre les fenêtres développées et réduites des 
messages d'avertissement. 
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4. Dans la fenêtre développée des messages d'avertissement, vous pouvez réaliser les 
actions suivantes :

■ Cliquez sur Print pour imprimer les données du message détaillé.

■ Cliquez sur Save to File pour enregistrer les données du message dans un fichier de 
type csv. 

5. La procédure est la suivante :

■ Cliquez sur No pour annuler la mise à jour. 

La base de données du contrôleur de la bibliothèque de bandes n'est pas mise à jour 
mais toutes les modifications réalisées sont conservées dans la fenêtre Select Active 
Cells. 

■ Cliquez sur Yes pour poursuivre les mises à jour de la base de données du 
contrôleur de la bibliothèque de bandes, puis reportez-vous à Étape 6. 

■ Les cellules blanches dont le bord gauche est « corné » sont désactivées.

■ Les cellules violettes dont le bord gauche n'est pas corné sont activées jusqu'à ce 
que la capacité autorisée totale de la bibliothèque de bandes soit atteinte. Lorsque 
la capacité autorisée maximum est atteinte, les cellules violettes ne pouvant pas 
être activées restent affichées en violet et s'activeront automatiquement après 
augmentation de la capacité autorisée. 

■ Les autres cellules ne sont pas modifiées. 

Commit Success s'affiche. 

6. Cliquez sur OK pour revenir à la fenêtre Select Active Cells. 

Toutes les nouvelles cellules activées peuvent être utilisées immédiatement. Il n'est pas 
nécessaire de redémarrer la bibliothèque de bandes. 

7. Toutes les applications hôtes de la bibliothèque de bandes concernées doivent à 
présent être configurées pour prendre en compte ces mises à jour. Consultez la 
documentation du logiciel de gestion des bandes pour plus d'informations 
concernant les procédures et les commandes.
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▼ Affichage d'un rapport d'une zone de stockage 
active 
Cette procédure permet d'afficher les rapports suivants concernant les zones de 
stockage actives :

■ Cartridge Cell and Media Summary : ce rapport affiche la liste détaillée de 
l'ensemble des ressources de la bibliothèque de bandes ainsi que leur état (actif 
ou inactif).

■ Orphaned Cartridge Report : ce rapport affiche la liste détaillée de toutes les 
cartouches orphelines.

Remarque – Les rapports de zones de stockage actives affichent les données 
enregistrées dans la base de données du contrôleur de la bibliothèque de bandes. 
En cas de modification apportée à la configuration des zones de stockage actives sans 
validation des changements au niveau du contrôleur de la bibliothèque de bandes, 
les données de ces rapports seront différentes de celles indiquées dans la fenêtre 
Select Active Cells. 

1. Sélectionnez Tools > Select Active Cells, puis cliquez sur l'onglet View Reports.

La fenêtre View Reports s'affiche.
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2. Dans la liste déroulante, sélectionnez le rapport à afficher. 

La fenêtre est mise à jour avec les informations de la base de données du contrôleur de 
la bibliothèque de bandes. 

3. La procédure ci-dessous explique comment imprimer les données du rapport ou les 
enregistrer dans un fichier :

■ « Impression des données des rapports des zones de stockage actives » page 237

■ « Enregistrement des données des rapports de zones de stockage actives » page 239 
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▼ Impression des données des rapports des zones de 
stockage actives
Cette procédure permet d'imprimer un rapport de zones de stockage actives. Cette 
procédure peut être réalisée depuis n'importe quelle fenêtre de rapports de zones de 
stockage actives. 

1. Sélectionnez Tools > Select Active Cells, puis cliquez sur l'onglet View  Reports.

La fenêtre View Reports s'affiche.

2. Dans la liste déroulante, sélectionnez le rapport souhaité. 

Le rapport sélectionné s'affiche. Toutes les fenêtres des rapports comprennent les 
boutons Print et Save to File. 
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3. Cliquez sur Print. 

La fenêtre contextuelle Print s'affiche. 

4. Complétez la fenêtre contextuelle d'impression, puis cliquez sur Print. 

Le rapport s'imprime sur l'imprimante sélectionnée. 
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▼ Enregistrement des données des rapports de 
zones de stockage actives
Cette procédure permet d'enregistrer les données des rapports de zones de stockage 
actives dans un fichier de type .csv (valeurs séparées par des virgules). Plusieurs 
types de tableurs permettent de visualiser le fichier. Cette procédure peut être réalisée 
depuis n'importe quelle fenêtre de rapports de zones de stockage actives. 

1. Sélectionnez Tools > Select Active Cells, puis cliquez sur l'onglet View  Reports.

La fenêtre View Reports s'affiche.

2. Dans la liste déroulante, sélectionnez le rapport souhaité. 

Le rapport sélectionné s'affiche. Toutes les fenêtres des rapports comprennent les 
boutons Print et Save to File. 
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3. Cliquez sur Save to File.

La fenêtre contextuelle Save s'affiche. 

4. Cherchez le répertoire dans lequel vous souhaitez enregistrer le fichier et saisissez 
son nom. 

5. Cliquez sur Save. 

Les données sont enregistrées dans le fichier souhaité. 
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▼ Affichage des détails de cellule active 
Cette procédure permet d'afficher les cellules de stockage actuellement actives, 
inactives ou sélectionnées pour être activées. Vous pouvez également afficher des 
informations détaillées sur la cartouche, le lecteur et les emplacements de cellule de 
stockage. 

Remarque – Cette procédure est disponible sur le Panneau opérateur local.

1. Sélectionner Tools > Select Active Cells. 

La fenêtre Module Map s'affiche.

2. Cliquez sur le module à afficher. 
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3. Cliquez sur l'onglet Current Active Cells.

La fenêtre Active Cells apparaît et affiche la configuration actuelle du module que vous 
avez sélectionné.

Vous pouvez déplacer le curseur de la souris sur une cellule ou un lecteur, afin 
d'afficher une infobulle avec des informations détaillées. 
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Référence des fenêtres des zones de 
stockage actives
Le présent paragraphe décrit en détail l'ensemble des fenêtres des régions de stockage 
actives de la Console d’administration StreamLine Library, organisées selon le chemin 
de navigation de la fenêtre. Par exemple, le chemin Select Active Cells—Select Active 
Cells—Confirm Apply correspond à la fenêtre accessible en cliquant sur Tools et 
Select Active Cells dans la barre de menu, puis sur l'onglet Select Active Cells et le 
bouton Confirm Apply. 

Remarque – Ces fenêtres concernent uniquement les bibliothèques de bandes non 
partitionnées. Voir « Référence des fenêtres de partition » page 340 pour les fenêtres de 
gestion de la capacité dans les bibliothèques de bandes partitionnées. 

Remarque – Seule la fenêtre Select Active Cells—Current Active Cells est disponible 
depuis le Panneau opérateur local. Les autres fenêtres sont uniquement accessibles 
depuis la Console d’administration StreamLine Library autonome ou la Console 
d’administration StreamLine Library Web.

Remarque – La fenêtre Select Active Cells, et les fenêtres contextuelles correspondan-
tes, donne accès à un espace de travail dynamique pour la conception des zones de 
stockage actives. Toutes les informations concernant les cellules actives sont enregis-
trées automatiquement dans l'espace de travail de la zone de stockage active dans la 
mémoire de la Console d’administration StreamLine Library et sont conservées pendant 
toute la durée de votre session sur la Console d’administration StreamLine Library. 
Vous pouvez faire d'autres changements puis revenir aux fenêtres Select Active Cells 
autant de fois que vous le souhaitez sans perdre vos modifications. 

Fenêtre Page

Select Active Cells > Module Map 245

Select Active Cells > Select Active Cells 247

Select Active Cells > Select Active Cells—Confirm Apply 254

Select Active Cells—View Reports—Cartridge Cell and Media 
Summary

260

Select Active Cells—View Reports—Orphaned Cartridge Report 263

Select Active Cells—Current Active Cells 266
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Mise en garde – Le bouton Apply permet d'enregistrer les données de l'espace de tra-
vail de la zone de stockage active de la Console d’administration StreamLine Library 
dans la base de données du contrôleur de la bibliothèque de bandes. En cas de fermetu-
re de votre session sur la Console d’administration StreamLine Library ou d'actualisa-
tion des données de l'espace de travail avant la validation de vos mises à jour à l'aide 
du bouton Apply, les modifications que vous avez apportées aux zones de stockage ac-
tives dans les fenêtres Select Active Cells et les fenêtres contextuelles associées seront 
perdues. 
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Select Active Cells > Module Map

Exemple de fenêtre

Description
Cette fenêtre permet de sélectionner le module de la bibliothèque de bandes dans 
lequel vous souhaitez activer ou désactiver des cellules pour le stockage de cartouches. 

Champs de la fenêtre
Select a module from the map below 

Cette fenêtre affiche un schéma de la configuration actuelle des modules de la 
bibliothèque de bandes. Cette information provient directement de la base de 
données du contrôleur de la bibliothèque de bandes. 

Cliquez sur le module dans lequel vous souhaitez sélectionner des cellules de 
stockage, puis cliquez sur l'onglet Select Active Cells. 
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Boutons
? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Select Active Cells > Select Active Cells 
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Select Active Cells > Select Active Cells

Exemple de fenêtre

Description

Remarque – Ne tenez pas compte de cette fenêtre si vous comptez utiliser la 
configuration des zones de stockage définie par défaut par le contrôleur de la 
bibliothèque de bandes. 

Cette fenêtre permet de définir des zones de stockage actives de la bibliothèque de 
bandes en sélectionnant les cellules de stockage à activer ou à désactiver. Vous pouvez, 
par exemple, configurer des cellules de stockage actives de manière à regrouper les 
cartouches autour des lecteurs et à réserver les extrémités de la bibliothèque de bandes 
pour une future augmentation.

Vous pouvez activer le nombre de cellules que vous souhaitez tant que la capacité 
autorisée totale de la bibliothèque de bandes n'est pas atteinte. Lorsque la capacité 
autorisée maximum est atteinte, les cellules sélectionnées ne pouvant pas être activées 
restent sélectionnées et s'activeront automatiquement après augmentation de la capacité 
autorisée. 
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Vous pouvez utiliser l'une des méthodes suivantes pour sélectionner les cellules de 
stockage (voir « Library Map » page 251 pour plus d'informations) : 

■ Sélection de cellules individuelles ou de groupes de cellules 

■ Sélection d'une colonne entière d'un module de la bibliothèque de bandes 

■ Sélection d'une partie d'un module de la bibliothèque de bandes (avant ou arrière) 

■ Sélection d'un module entier de la bibliothèque de bandes 

■ Sélection de toutes les cellules de la bibliothèque de bandes 

Mise en garde – La désactivation des cellules de stockage peut donner lieu à des 
cartouches orphelines et rendre des données inaccessibles. Voir « Cartouches orphelines 
dans les bibliothèques de bandes non partitionnées » page 221 pour plus de détails. 

Remarque – Vous pouvez sélectionner uniquement des cellules de stockage ; les CAP 
et les lecteurs de bande installés restent toujours actifs. 

Remarque – La fenêtre Select Active Cells, et les fenêtres contextuelles correspondan-
tes, donne accès à un espace de travail dynamique pour la conception des zones de 
stockage actives. Toutes les informations concernant les cellules actives sont enregis-
trées automatiquement dans l'espace de travail de la zone de stockage active dans la 
mémoire de la Console d’administration StreamLine Library et sont conservées pendant 
toute la durée de votre session sur la Console d’administration StreamLine Library. 
Vous pouvez faire d'autres changements puis revenir aux fenêtres Select Active Cells 
autant de fois que vous le souhaitez sans perdre vos modifications. 

Mise en garde – Le bouton Apply permet d'enregistrer les données de l'espace de 
travail de la zone de stockage active de la Console d’administration StreamLine Library 
dans la base de données du contrôleur de la bibliothèque de bandes. En cas de 
fermeture de votre session sur la Console d’administration StreamLine Library ou 
d'actualisation des données de l'espace de travail avant la validation de vos mises à 
jour à l'aide du bouton Apply, les modifications que vous avez apportées aux zones de 
stockage actives dans les fenêtres Select Active Cells et les fenêtres contextuelles 
associées seront perdues. 

Champs de la fenêtre
Select by

Requis.

La fenêtre indique la méthode que vous souhaitez utiliser pour sélectionner les 
cellules de stockage à activer ou à désactiver. Les différentes options sont les 
suivantes :

■ Cell : sélection de cellules individuelles ou de groupes rectangulaires de cellules.

■ Column : sélection de toutes les cellules d'une colonne. 
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■ Side : sélection de toutes les cellules d'une partie d'un module de la bibliothèque 
de bandes. 

■ Module : sélection de toutes les cellules d'un module de la bibliothèque de 
bandes. 

■ Library : sélection de toutes les cellules de la bibliothèque de bandes. 

Remarque – Vous devez sélectionner Add ou Remove. 

Add 

Requis.

Ce champ indique que vous souhaitez ajouter des cellules dans la zone de stockage 
active. Vous pourrez uniquement sélectionner des cellules inactives sur le plan de la 
bibliothèque de bandes. 

Remove

Requis.

Ce champ indique que vous souhaitez supprimer des cellules dans la zone de 
stockage active. Vous pourrez uniquement sélectionner des cellules actives ou 
sélectionnées sur le plan de la bibliothèque de bandes. 

Current Library Totals

Capacité

Affichage uniquement.

Capacité de stockage autorisée totale de la bibliothèque de bandes. 

Active Cells

Affichage uniquement.

Nombre total de cellules de stockage activées dans la base de données du contrôleur 
de la bibliothèque de bandes. Il ne peut pas dépasser la capacité autorisée. 

Selection Totals 

Selected Cells 

Affichage uniquement.

Nombre total de cellules sélectionnées et actives. Il peut être supérieur à la capacité 
autorisée. 

Unselected Cells 

Affichage uniquement.

Nombre total de cellules désélectionnées et inactives. 

Remarque – Selected Cells + Unselected Cells = capacité physique de la bibliothèque 
de bandes
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% Capacity Used 

Affichage uniquement.

Pourcentage de la capacité autorisée totale ayant été sélectionnée (ce pourcentage ne 
peut pas être supérieur à 100 %). Il se calcule de la manière suivante :

Selected Cells / (licensed) Capacity 

Interface Type 

Requis.

Type d'interface devant être utilisé pour la connexion des hôtes de la bibliothèque de 
bandes. Les différentes options sont les suivantes :

■ HLI

■ FC-SCSI 

La fenêtre affiche la valeur précédente. Vous pouvez la laisser en l'état ou la 
modifier. 

Remarque – Pour plus d'informations concernant la modification de ce champ, voir 
« Modification du type d'interface de la bibliothèque de bandes (bibliothèques de 
bandes non partitionnées) » page 108. 

Legend 

Il s'agit de la légende du plan de la bibliothèque de bandes. L'état de chaque ressource 
de la bibliothèque de bandes (cellule de stockage, lecteur de bande ou cellule du CAP) 
s'affiche de la manière suivante : 

■ Not Accessible (rectangle blanc et b-arré d'une croix). Aucun hôte n'a accès à la 
ressource. Quelques exemples de causes :

■ Les cellules de stockage ont été configurées pour des cartouches de diagnostic. 

■ Aucun lecteur n'est installé dans la baie. 

■ CAP a été configuré pour le stockage et non pour les opérations CAP. 

■ Inactive (rectangle blanc). La cellule de stockage n'est pas sélectionnée. 

■ Si le bord gauche de la cellule est « corné », la cellule est activée dans la base de 
données du contrôleur de la bibliothèque de bandes et vous avez choisi de la 
retirer de la zone de stockage active. En cliquant sur le bouton Apply, la cellule 
deviendra inactive dans la base de données du contrôleur de la bibliothèque de 
bandes.

■ Si le bord gauche de la cellule n'est pas corné, la cellule n'est pas activée dans la 
base de données du contrôleur de la bibliothèque de bandes. En cliquant sur le 
bouton Apply, l'état de la cellule ne sera pas modifié dans la base de données du 
contrôleur de la bibliothèque de bandes. 

■ Active (bord gauche corné). Indique l'état de la cellule de stockage dans la base de 
données du contrôleur de la bibliothèque de bandes :

■ Les cellules dont le bord gauche est « corné » sont actives. 

■ Les cellules dont le bord gauche n'est pas corné sont désactivées. 
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■ Selected (violet). La cellule de stockage est sélectionnée. La sélection des cellules 
peut se faire automatiquement par le contrôleur de la bibliothèque de bandes ou 
manuellement par l'utilisateur. 

■ Si le bord gauche de la cellule est « corné », la cellule est activée dans la base de 
données du contrôleur de la bibliothèque de bandes. En cliquant sur le bouton 
Apply, l'état de la cellule ne sera pas modifié dans la base de données du 
contrôleur de la bibliothèque de bandes.

■ Si le bord gauche de la cellule n'est pas corné, la cellule est désactivée dans la base 
de données du contrôleur de la bibliothèque de bandes et vous avez choisi de la 
retirer de la zone de stockage active. En cliquant sur le bouton Apply, la cellule 
deviendra active dans la base de données du contrôleur de la bibliothèque de 
bandes jusqu'à atteindre la capacité autorisée totale de la bibliothèque de bandes. 
Lorsque la capacité autorisée maximum est atteinte, les cellules violettes ne 
pouvant pas être activées restent affichées en violet et s'activeront 
automatiquement après augmentation de la capacité autorisée. 

■ No Activation Needed (marron). La ressource ne peut pas être sélectionnée depuis 
cette fenêtre car elle est active par défaut. Cela concerne l'ensemble des cellules du 
CAP et des lecteurs de bande. 

■ Cartridge (icône cartouche). La ressource contient une cartouche de bande. 

■ Les emplacements dans lesquels sont installés des lecteurs sont indiqués par une 
bordure épaisse. Les emplacements des lecteurs vides sont indiqués par une bordure 
fine. 

Library Map 
Représentation graphique de la configuration actuelle de la bibliothèque de bandes. 
L'affichage initial de la session de la Console d’administration StreamLine Library en 
cours provient de la base de données du contrôleur de la bibliothèque de bandes. 
Ensuite, l'affichage prend en compte vos modifications. L'affichage comprend les 
informations suivantes :

■ Type de module actuellement affiché (module de base, module d'extension de 
lecteurs, module d'extension d'accès, module d'extension de cartouches avec zone 
de parking robot (PEM)). 

■ Identifiant numérique du module (1–12)

■ Emplacement de l'ensemble des ressources (cellules de stockage, lecteurs de 
bande, cellules du CAP) à l'intérieur de la bibliothèque de bandes. 

Remarque – Déplacez le curseur sur l'une des ressources afin d'afficher une infobulle 
contenant des informations détaillées sur la cellule ou le lecteur, son activation ou non 
dans la base de données du contrôleur de la bibliothèque, sa sélection ou non dans la 
fenêtre et le nom des éventuelles cartouches. 

Utilisez le plan de la bibliothèque de bandes pour modifier les délimitations des 
zones de stockage actives. Selon l'option choisie, Add ou Remove, les cellules sur 
lesquelles vous cliquez seront sélectionnées ou désélectionnées. 

Selon le choix que vous avez fait dans le champ Select by, vous pourrez réaliser les 
actions suivantes. 

■ Select by cell : sélection d'une ressource ou de groupes de ressources. Il n'est pas 
nécessaire que les cellules de stockage actives soient adjacentes. 

- Pour sélectionner une cellule de stockage, cliquez deux fois sur celle-ci.
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- Pour sélectionner un groupe rectangulaire de cellules de stockage, cliquez 
sur la cellule de l'un des coins du rectangle, puis cliquez sur la cellule 
diagonalement opposée. 

■ Select by column : sélection d'une colonne entière du module. Il n'est pas 
nécessaire que les colonnes de cellules actives soient adjacentes. Cliquez sur 
une cellule de stockage se trouvant dans la colonne à sélectionner. 

■ Select by side : sélection de toutes les cellules de stockage d'une partie entière du 
module. Il n'est pas nécessaire que les parties actives soient adjacentes. Cliquez 
sur une cellule de stockage se trouvant dans la partie à sélectionner. 

■ Select by module : sélection de l'ensemble des cellules de stockage d'un module. 
Il n'est pas nécessaire que les modules actifs soient adjacents. Cliquez sur une 
cellule de stockage se trouvant dans le module à sélectionner. 

■ Select the library : sélection de toutes les cellules de stockage de la bibliothèque de 
bandes. Cliquez sur une cellule de stockage de la bibliothèque de bandes. 

Boutons
Move Left 

Cliquez sur ce bouton pour afficher le module de la bibliothèque de bandes situé à 
gauche du module actuellement affiché. Ce bouton est grisé s'il n'existe aucun 
module à gauche. 

Move Right 

Cliquez sur ce bouton pour afficher le module de la bibliothèque de bandes situé à 
droite du module actuellement affiché. Ce bouton est grisé s'il n'existe aucun module 
à droite. 

Apply 

Cliquez sur ce bouton pour mettre à jour la base de données du contrôleur de 
la bibliothèque de bandes avec les paramètres actuels de la fenêtre. La fenêtre 
contextuelle Confirm Apply s'affiche et indique la présence éventuelle de cartouches 
orphelines ou d'autres erreurs au niveau de la configuration des zones de stockage 
actives. 

Remarque – Ce bouton est grisé si aucune modification n'a été apportée à la fenêtre 
Select Active Cells depuis la dernière mise à jour. 

L'actualisation de l'état des cellules dans la base de données du contrôleur de la 
bibliothèque de bandes s'effectue de la manière suivante : 

■ Les cellules blanches dont le bord gauche est « corné » sont désactivées.

■ Les cellules violettes dont le bord gauche n'est pas corné sont activées jusqu'à ce 
que la capacité autorisée totale de la bibliothèque de bandes soit atteinte. Lorsque 
la capacité autorisée maximum est atteinte, les cellules violettes ne pouvant pas 
être activées restent affichées en violet et s'activeront automatiquement après 
augmentation de la capacité autorisée. 

■ Les autres cellules ne sont pas modifiées. 
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Refresh

Ce bouton permet d'actualiser la fenêtre avec les données de la base de données 
du contrôleur de la bibliothèque de bandes. Toutes les modifications non 
appliquées apportées aux zones de stockage actives au cours de la session de 
la Console d’administration StreamLine Library ne seront pas prises en compte. 
La fenêtre contextuelle Cell Selection Refresh s'affiche pour demander une 
confirmation de l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne relative à la fenêtre. 

Voir aussi
■ Select Active Cells > Module Map 

■ Select Active Cells > Select Active Cells—Confirm Apply 

■ Select Active Cells—Current Active Cells 
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Select Active Cells > Select Active Cells—Confirm 
Apply

Exemple de fenêtre

Description
Cette fenêtre affiche une liste des erreurs de configuration au niveau des zones de 
stockage actives définies. Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous 
cliquez sur Apply dans la fenêtre Select Active Cells > Select Active Cells. 

Après examen des messages d'erreur, vous pouvez valider l'ensemble des données de la 
fenêtre Select Active Cells dans la base de données du contrôleur de la bibliothèque de 
bandes en cliquant sur le bouton Yes. 

Mise en garde – Bien que les modifications de la capacité active n'interrompent pas 
les hôtes de la bibliothèque de bandes, il est recommandé d'interdire l'accès à la 
bibliothèque de bandes aux autres utilisateurs avant de valider les modifications 
apportées à la zone de stockage active. Du fait que la Console d’administration 
StreamLine Library ne valide pas les délimitations de la zone de stockage par rapport à 
la base de données du contrôleur de la bibliothèque de bandes en temps réel, des 
conflits de configuration peuvent se produire si vous modifiez des délimitations de la 
zone de stockage active, alors que d'autres utilisateurs déplacent des cartouches ou 
modifient la configuration de la bibliothèque de bandes. Voir « Synchronisation de 
l'affichage avec la base de données du contrôleur » page 44 pour plus de détails. 
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Les erreurs potentielles sont les suivantes :

■ Présence de cartouches orphelines dans la bibliothèque de bandes. Voir « Cartouches 
orphelines dans les bibliothèques de bandes non partitionnées » page 277 pour plus 
de détails.

■ Cellules de stockage supprimées de la bibliothèque de bandes. 

En cas d'apparition de l'une de ces erreurs, la fenêtre affiche en premier lieu des 
messages d'erreur de synthèse. Vous pouvez voir les messages détaillés en cliquant sur 
le bouton Details. 

Il est recommandé de corriger toutes les erreurs avant de valider les données dans la 
base de données du contrôleur de la bibliothèque de bandes. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv. 

Champs de la fenêtre
Warnings found

Affichage uniquement.

Messages d'erreur de synthèse concernant la configuration des zones de stockage. 

Library 

Affichage uniquement.

Numéro de la bibliothèque de bandes dans laquelle se trouve la cartouche orpheline. 
Ce numéro est toujours « 1 ». 

Rail 

Affichage uniquement.

Numéro du rail dans lequel se trouve la cartouche orpheline. Ce numéro est toujours 
« 1 ». 

Column

Affichage uniquement.

Numéro de la colonne dans laquelle se trouve la cartouche orpheline. Le 
référencement des emplacements des colonnes commence à partir du bord gauche 
du module de référence. « +1 » signifie vers la droite ; « -1 » vers la gauche.

Side

Affichage uniquement.

Partie du module dans laquelle se trouve la cartouche orpheline. « 1 » correspond à 
la façade arrière ; « 2 » à la façade avant.

Row

Affichage uniquement.

Numéro de la ligne dans laquelle se trouve la cartouche orpheline. La numérotation 
des lignes s'effectue de haut en bas, de manière consécutive ; la ligne « 1 » se 
trouvant tout en haut.
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Cause for Orphaned State

Affichage uniquement.

Cause de la présence de cartouches orphelines. Les différentes options sont les 
suivantes :

■ Just Activated 

■ Inactive Media 

Vol Ser 

Affichage uniquement.

Numéro de série du volume (ID de volume) de la cartouche orpheline. 

Explanation

Affichage uniquement.

Explication de la présence d'une cartouche orpheline. 

Les raisons potentielles sont les suivantes :

■ Présence du support dans une cellule inactive. 

■ La cellule inactive contenant le support vient juste d'être activée. 

Boutons

Remarque – Pour afficher les boutons Print et Save to File, vous devez faire défiler les 
éléments de la fenêtre intérieure. 

Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save to File

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

Yes

Cliquez sur ce bouton pour confirmer la mise à jour de la base de données du 
contrôleur de la bibliothèque de bandes avec les paramètres actuels de 
Select Active Cells. L'actualisation de l'état des cellules dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue de la manière suivante : 

■ Les cellules blanches dont le bord gauche est « corné » sont désactivées.

■ Les cellules violettes dont le bord gauche n'est pas corné sont activées jusqu'à ce 
que la capacité autorisée totale de la bibliothèque de bandes soit atteinte. Lorsque 
la capacité autorisée maximum est atteinte, les cellules violettes ne pouvant pas 
être activées restent affichées en violet et s'activeront automatiquement après 
augmentation de la capacité autorisée. 

■ Les autres cellules ne sont pas modifiées. 

No

Cliquez sur ce bouton pour annuler la mise à jour. La base de données du contrôleur 
de la bibliothèque de bandes n'est pas actualisée. Toutefois, les paramètres actuels de 
Select Active Cells sont conservés. 



Référence des fenêtres des zones de stockage actives

418605501 • Révision AB Chapitre 5 Capacity on Demand 257

Details 

Cliquez sur ce bouton pour basculer entre les fenêtres développées et réduites des 
messages d'avertissement. 

Voir aussi
■ Select Active Cells > Select Active Cells 
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Select Active Cells—View Reports

Exemple de fenêtre

Description
Cette fenêtre vous permet de sélectionner l'un des rapports de zones de stockage 
actives suivants :

■ Cartridge Cell and Media Summary

■ Orphaned Cartridge Report

Remarque – Les rapports de zones de stockage actives affichent les données 
enregistrées dans la base de données du contrôleur de la bibliothèque de bandes. 
En cas de modification apportée à la configuration des zones de stockage actives sans 
validation des changements à l'aide du bouton Apply, les données de ces rapports 
seront différentes de celles indiquées dans la fenêtre Select Active Cells. 
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Champs de la fenêtre
Please select a report to display

Requis.

Cliquez sur le rapport à afficher. Le menu déroulant comprend l'ensemble des 
rapports de zones de stockage actives disponibles. 

Boutons
Apply 

Cliquez sur ce bouton pour mettre à jour la base de données du contrôleur de 
la bibliothèque de bandes avec les paramètres actuels de la fenêtre. La fenêtre 
contextuelle Confirm Apply s'affiche et indique la présence éventuelle de cartouches 
orphelines ou d'autres erreurs au niveau de la configuration des zones de stockage 
actives. 

Remarque – Ce bouton est grisé si aucune modification n'a été apportée à la fenêtre 
Select Active Cells depuis la dernière mise à jour. 

Refresh

Ce bouton permet d'actualiser la fenêtre avec les données de la base de données 
du contrôleur de la bibliothèque de bandes. Toutes les modifications non 
appliquées apportées aux zones de stockage actives au cours de la session de 
la Console d’administration StreamLine Library ne seront pas prises en compte. 
La fenêtre contextuelle Cell Selection Refresh s'affiche pour demander une 
confirmation de l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Select Active Cells > Select Active Cells 

■ Select Active Cells—View Reports—Cartridge Cell and Media Summary 

■ Select Active Cells—View Reports—Orphaned Cartridge Report 
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Select Active Cells—View Reports—Cartridge Cell 
and Media Summary

Exemple de fenêtre

Description
Cette fenêtre affiche des informations détaillées concernant l'ensemble des ressources 
de la bibliothèques de bandes (cellules de stockage, lecteurs de bande, et cellules du 
CAP) et les éventuelles cartouches stockées.

Remarque – Les rapports de zones de stockage actives affichent les données 
enregistrées dans la base de données du contrôleur de la bibliothèque de bandes. 
En cas de modification apportée à la configuration des zones de stockage actives sans 
validation des changements au niveau du contrôleur de la bibliothèque de bandes, 
les données de ces rapports seront différentes de celles indiquées dans la fenêtre 
Select Active Cells. 
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Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv.

Champs de la fenêtre
Library 

Affichage uniquement.

Numéro de la bibliothèque de bandes dans laquelle se trouve la ressource de la 
bibliothèque de bandes. Ce numéro est toujours « 1 ». 

Rail 

Affichage uniquement.

Numéro du rail dans lequel se trouve la ressource de la bibliothèque de bandes. Ce 
numéro est toujours « 1 ». 

Column

Affichage uniquement.

Numéro de la colonne dans laquelle se trouve la ressource de la bibliothèque de 
bandes. Le référencement des emplacements des colonnes commence à partir du 
bord gauche du module de référence. « +1 » signifie vers la droite ; « -1 » vers la 
gauche.

Side

Affichage uniquement.

Partie du module dans laquelle se trouve la ressource de la bibliothèque de bandes. 
« 1 » correspond à la façade arrière ; « 2 » à la façade avant.

Row

Affichage uniquement.

Numéro de la ligne dans laquelle se trouve la ressource de la bibliothèque de bandes. 
La numérotation des lignes s'effectue de haut en bas, de manière consécutive ; la 
ligne « 1 » se trouvant tout en haut.

Element Type

Affichage uniquement.

Type de ressources de la bibliothèque de bandes. Les différentes options sont les 
suivantes :

■ CAP
■ CELL
■ DRIVE

Vol Ser 

Affichage uniquement.

Numéro de série du volume (ID de volume) de la cartouche éventuellement présente 
dans la ressource de la bibliothèque de bandes. 
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Cell Status

Affichage uniquement.

État de la capacité de la ressource de la bibliothèque de bandes. Cela concerne 
uniquement les cellules de stockage. Les différentes options sont les suivantes :

■ Active : la cellule est activée et peut être utilisée pour le stockage de cartouche. 

■ Inactive : la cellule n'est pas activée et ne peut pas être utilisée pour le stockage de 
cartouche. 

Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save to File

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Select Active Cells—View Reports

■ Select Active Cells—View Reports—Orphaned Cartridge Report



Référence des fenêtres des zones de stockage actives

418605501 • Révision AB Chapitre 5 Capacity on Demand 263

Select Active Cells—View Reports—Orphaned 
Cartridge Report 

Exemple de fenêtre

Description
Cette fenêtre affiche les emplacements ainsi que les numéros de série de volume (ID de 
volume) de l'ensemble des cartouches orphelines présentes dans la bibliothèque de 
bandes. Elle indique également le motif de la présence de la cartouche orpheline. 

Remarque – Les rapports de zones de stockage actives affichent les données 
enregistrées dans la base de données du contrôleur de la bibliothèque de bandes. 
En cas de modification apportée à la configuration des zones de stockage actives sans 
validation des changements au niveau du contrôleur de la bibliothèque de bandes, 
les données de ces rapports seront différentes de celles indiquées dans la fenêtre 
Select Active Cells. 
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Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv.

Champs de la fenêtre
Library 

Affichage uniquement.

Numéro de la bibliothèque de bandes dans laquelle se trouve la cartouche orpheline. 
Ce numéro est toujours « 1 ». 

Rail 

Affichage uniquement.

Numéro du rail dans lequel se trouve la cartouche orpheline. Ce numéro est toujours 
« 1 ». 

Column

Affichage uniquement.

Numéro de la colonne dans laquelle se trouve la cartouche orpheline. Le 
référencement des emplacements des colonnes commence à partir du bord gauche 
du module de référence. « +1 » signifie vers la droite ; « -1 » vers la gauche.

Side

Affichage uniquement.

Partie du module dans laquelle se trouve la cartouche orpheline. « 1 » correspond à 
la façade arrière ; « 2 » à la façade avant.

Row

Affichage uniquement.

Numéro de la ligne dans laquelle se trouve la cartouche orpheline. La numérotation 
des lignes s'effectue de haut en bas, de manière consécutive ; la ligne « 1 » se 
trouvant tout en haut.

Vol Ser 

Affichage uniquement.

Numéro de série du volume (ID de volume) de la cartouche orpheline. 

Explanation

Affichage uniquement.

Explication de la présence d'une cartouche orpheline. 

Les raisons potentielles sont les suivantes :

■ Présence du support dans une cellule inactive. 

■ La cellule inactive contenant le support vient juste d'être activée. 
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Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Select Active Cells—View Reports 

■ Select Active Cells—View Reports—Orphaned Cartridge Report 
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Select Active Cells—Current Active Cells

Exemple de fenêtre

Description
Cette fenêtre affiche les zones de stockage actuellement actives dans la bibliothèque 
de bandes. Elle indique les cellules de stockage actuellement actives, inactives ou 
sélectionnées pour être activées.

Il s'agit de l'unique fenêtre Select Active Cells disponible sur le Panneau opérateur 
local.

Remarque – Cette fenêtre est en affichage uniquement. 

Champs de la fenêtre
Pour plus d'informations sur les champs de la fenêtre, voir 
« Select Active Cells > Select Active Cells » page 247. 
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Boutons
Refresh

Ce bouton permet d'actualiser l'affichage avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Select Active Cells > Select Active Cells 
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CHAPITRE 6

Partitionnement de la bibliothèque de 
bandes

Remarque – Le partitionnement de la bibliothèque de bandes est une fonctionnalité 
sous licence. Son installation doit être effectuée par l'intermédiaire de l'utilitaire de 
gestion de licences du système SL3000. Voir Chapitre 4, « Gestion des licences » pour 
plus de détails. 

Le partitionnement de la bibliothèque de bandes permet de réserver des parties de 
la bibliothèque de bandes SL3000 à l'utilisation exclusive d'application hôtes définies. 
Par exemple, vous pouvez définir qu'un groupe de cellules de stockage et de lecteurs 
soit dédié aux opérations Veritas et qu'un autre groupe soit réservé aux opérations 
Tivoli.Cela vous permet de configurer une bibliothèque de bandes SL3000 pour des 
applications exécutées sur plusieurs systèmes d'exploitation. 

Caractéristiques et limites du 
partitionnement
Cette section présente les principales caractéristiques et limites du partitionnement de 
bibliothèque de bandes afin de vous aider à configurer et à utiliser cette fonctionnalité 
dans votre bibliothèque de bandes SL3000. 

■ Vous pouvez configurer jusqu'à huit partitions dans votre bibliothèque de bandes 
SL3000. 

■ Une partition peut correspondre aussi bien à une seule cellule de stockage ou à un 
lecteur de bande qu'à un CAP de rotation ou des AEM entier. Il n'est pas nécessaire 
que les cellules et les lecteurs d'une partition soient adjacents. 

■ Les cellules de stockage et les lecteurs de bande affectés à une partition peuvent 
uniquement être utilisés par les hôtes affectés à cette partition. Les hôtes affectés à 
d'autres partitions n'ont pas accès au contenu de ces cellules et lecteurs. Voir 
« Cellules de stockage et lecteurs » page 277 pour plus de détails. 

■ Aucun hôte n'a accès aux cellules de stockage et aux lecteurs non affectés à une 
partition. Par exemple, une zone de cellules peut rester non affectée en prévision 
d'un futur partitionnement. 

■ Les connexions hôte-partition peuvent utiliser l'interface FC-SCSI ou HLI (TCP/IP). 
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■ Des CAP de rotation ou des AEM entiers peuvent être affectés à une seule partition 
ou peuvent être partagés par plusieurs partitions. Voir « Partitions et CAP de 
rotation et des AEM » page 279 pour plus de détails.

■ Le partage des CAP par plusieurs partitions est possible uniquement si ces dernières 
utilisent le même type d'interface hôte. En d'autres termes, les partitions FC-SCSI et 
HLI ne peuvent pas partager le même CAP. 

■ Avec la fonctionnalité de partitionnement sans interruption, l'interruption de l'hôte 
reste minimale lors de l'affectation de ressources à une partition, tandis que les 
modifications apportées à une partition n'influent pas sur les autres partitions, ni sur 
leurs connexions hôtes. Voir « Partitionnement sans interruption » page 285 pour 
plus de détails. 

Activation et désactivation du 
partitionnement
Afin de pouvoir utiliser des partitions dans une bibliothèque de bandes, la 
fonctionnalité de partitionnement doit être installée par l'intermédiaire de l'utilitaire de 
gestion des licences.Voir Chapitre 4, « Gestion des licences » page 193 pour plus 
d'informations. 

Les états d'une bibliothèque de bandes pour laquelle le partitionnement est activé 
peuvent être les suivants : 

■ Partitioned : la bibliothèque de bandes comporte au moins une partition définie par 
l'utilisateur avec un identifiant de partition valide. 

■ Non-partitioned : la bibliothèque de bandes ne comprend aucune partition définie 
par l'utilisateur. Le comportement d'une bibliothèque de bandes non partitionnée 
est le même qu'une bibliothèque de bandes pour laquelle le partitionnement 
est désactivé, c'est-à-dire que tous les hôtes ont accès à toutes les cellules de 
stockageactives, à tous les lecteurs et aux CAP de rotation et des AEM. 

Afin de désactiver la fonctionnalité de partitionnement dans une bibliothèque de 
bandes, vous devez dans un premier temps supprimer toutes les partitions. L'état de 
la bibliothèque de bandes devient « non-partitioned ». 
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Organisation de la partition
La fonctionnalité de partitionnement apporte une grande flexibilité pour l'utilisation 
de votre bibliothèque de bandes. Elle nécessite une organisation minutieuse, une 
connaissance approfondie du mappage des façades et des cellules de stockage de la 
bibliothèque de bandes, ainsi que des compétences en matière de configuration et de 
gestion des applications hôtes. Une bonne communication doit être établie entre 
l'ensemble des parties impliquées, y compris les programmateurs et les administrateurs 
du système, les utilisateurs de la bibliothèque de bandes et votre représentant du 
service technique Sun. 

Préalablement à la création de partitions, vous devez prévoir la capacité de stockage 
requise pour les cartouches de bande ainsi que le nombre de cellules libres nécessaires. 
Vous devez identifier les délimitations de chaque partition et comprendre les relations 
entre les hôtes. Vous devez vérifier le bon positionnement de l'ensemble des lecteurs de 
bande et des cartouches conformément aux affectations définies.   

Installation de la fonctionnalité de partitionnement
Les considérations spécifiques ci-après s'appliquent une fois la fonctionnalité de 
partitionnement correctement installée dans une bibliothèque de bandes non 
partitionnée. 

■ Vous pouvez débuter la création de partitions immédiatement. Il n'est pas nécessaire 
de redémarrer la bibliothèque de bandes.

■ Avant la création d'au moins une partition, la bibliothèque de bandes reste dans un 
état non partitionné, c'est-à-dire que tous les hôtes ont accès aux cellules de stockage, 
aux lecteurs et aux CAP de rotation et des AEM sous licence. 

Capacité de stockage affectée
Dans les bibliothèques de bandes partitionnées, le nombre total de cellules de stockage 
affectées à l'ensemble des partitions de la bibliothèque de bandes ne peut pas dépasser 
la capacité autorisée de celle-ci. 

Dans les bibliothèques de bandes partitionnées, aucune zone de stockage active 
n'est définie par défaut. Vous devez affecter des cellules de stockage aux partitions en 
configurant les zones de stockage actives pour chaque partition. Voir « Procédures de 
partitionnement » page 288 pour plus de détails. 

Au moment d'affecter les cartouches aux cellules de stockage, le contrôleur de la 
bibliothèque de bandes applique individuellement les règles de sélection de cellule 
prédéfinies à chaque partition. Voir « Règles d'activation des cellules » page 220 pour 
plus de détails. 
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Configuration des partitions
Vous devez utiliser la Console d'administration StreamLine Library autonome ou la 
Console d’administration StreamLine Library Web pour configurer les partitions de la 
bibliothèque de bandes. Les fenêtres de partitionnement ne sont pas disponibles depuis 
le Panneau opérateur local. 

Afin de configurer une partition, vous devez définir les informations suivantes : 

■ Informations de synthèse de la partition

■ Connexions hôte-partition

■ Délimitations des partitions

Pour plus d'informations concernant la définition des partitions de la bibliothèque de 
bandes, voir « Procédures de partitionnement » page 288. 

Informations de synthèse de la partition
Les informations de synthèse de la partition comprennent l'identifiant de la partition, le 
nom ainsi que le type de connexion hôte-partition (HLI ou FC-SCSI). Les identifiants 
des partitions doivent être uniques et compris entre 1 et 8. 

Connexions hôte-partition
Les connexions hôte-partition identifient les hôtes ayant accès à une partition. Chaque 
partition apparaît chez l'hôte comme une bibliothèque de bandes séparée. Un hôte peut 
gérer une ou plusieurs partitions. Par ailleurs, plusieurs hôtes peuvent commander une 
seule partition FC-SCSI. Toutefois, il est recommandé d'utiliser cette configuration avec 
précaution étant donné que certaines applications hôtes n'autorisent pas le partage des 
ressources. 

Connexions hôte-partition HLI

Une partition HLI (Host Library Interface) peut comporter jusqu'à 16 hôtes. Le logiciel 
de gestion de la bibliothèque de bandes (ACSLS ou HSC) permet de définir la 
configuration de la connexion hôte-partition HLI. Par conséquent, aucune fenêtre de la 
Console d’administration StreamLine Library ne permet d'afficher ou de mettre à jour 
cette information. Pour plus d'informations, consultez la documentation du logiciel de 
gestion des bandes appropriée. 

Connexions hôte-partition FC-SCSI

Une partition FC-SCSI peut comporter une ou plusieurs connexions hôte-partition. La 
configuration de la connexion hôte-partition est définie par l'utilisateur et comprend les 
informations suivantes : 

■ Le nom de port mondial de l'adaptateur de bus hôte FC-SCSI 

■ Le numéro de port de la carte Fibre Channel de la bibliothèque de bandes 

■ Le numéro d'unité logique (LUN) de la partition de l'hôte 

Voir « Configuration d'une connexion hôte-partition » page 295 pour plus 
d'informations concernant la définition de ces informations. 
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Délimitations des partitions
Les délimitations des partitions permettent d'identifier les cellules de stockage, les 
lecteurs et les CAP de rotation et des AEM faisant partie de chaque partition. Seules des 
cellules non affectées peuvent être ajoutées à une partition. De même, seules des 
cellules affectées peuvent être supprimées. 

Vous pouvez définir les délimitations des partitions en utilisant l'une des méthodes 
suivantes :

■ Sélection de cellules individuelles ou de groupes rectangulaires de cellules à ajouter 
à ou à supprimer d'une partition. Il n'est pas nécessaire que les cellules ou les 
groupes de cellules soient adjacents.

■ Sélection d'une colonne d'un module à ajouter à ou à supprimer d'une partition. Il 
n'est pas nécessaire que les colonnes soient adjacentes. 

■ Sélection d'une partie entière d'un module (avant ou arrière) à ajouter à ou à 
supprimer d'une partition. Il n'est pas nécessaire que les parties soient adjacentes. 

■ Sélection d'un module entier à ajouter à ou à supprimer d'une partition. Il n'est pas 
nécessaire que les modules soient adjacents. 

Remarque – Il est possible d'avoir des partitions sans affectation de ressources. 
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Partitions et ressources de la bibliothèque 
de bandes

Adresses des ressources de la bibliothèque de 
bandes 
Les adresses des ressources permettent d'identifier chaque ressource (cellules de 
stockage, lecteurs et CAP de rotation et des AEM) de manière unique dans la 
bibliothèque de bandes. La bibliothèque de bandes SL3000 et les hôtes associés 
respectent les règles d'adressage suivantes : 

■ Adresse interne de la bibliothèque de bandes

■ Adresse des éléments FC-SCSI des hôtes

■ Adresse HLI-PRC

Chaque partition apparaît à l'hôte comme une bibliothèque de bandes séparée, ce qui se 
reflète dans l'adresse de la partition. 

Adresse interne de la bibliothèque de bandes
L'adresse interne de la bibliothèque de bandes permet au contrôleur de la bibliothèque 
de bandes SL3000 et à l'arborescence des périphériques de la Console d’administration 
StreamLine Library d'identifier l'emplacement physique de chaque ressource. Le 
principe d'adressage utilisé par la SL3000 est une valeur à cinq chiffres, séparés par une 
virgule, précisant la bibliothèque de bandes, le rail, la colonne, la partie et la ligne tels 
que vus depuis l'avant de la bibliothèque de bandes, face aux baies de lecteurs. 

Le format de l'adresse interne de la bibliothèque de bandes SL3000 est le suivant : 
l,r,c,s,w où

■ l = numéro de la bibliothèque de bandes ou de la partition. Cette valeur est toujours 
« 1 ». 

■ r = numéro du rail. Cette valeur est toujours « 1 ».

■ c = numéro de la colonne. La numérotation des colonnes commence à partir du bord 
gauche du module de base face à la façade intérieure arrière de la manière suivante :

■ La numérotation est statique et permet l'ajout de modules sans renuméroter les 
colonnes existantes. 

■ La numérotation des colonnes à l'intérieur du module de base et à sa droite se fait 
positivement (+), de manière croissante et de gauche à droite. 

■ La numérotation des colonnes situées à gauche du module de base se fait 
négativement (-), de manière décroissante et de droite à gauche. 

■ Les panneaux du module de base sont numérotés de « 1 » à « 6 ». 

■ Les panneaux DEM (le cas échéant) sont numérotés de « -1 » à « -6 ».

■ S'il n'y a aucun DEM et qu'un CEM se trouve à gauche du module de base, les 
colonnes « -1 » à « -6 » ne sont pas prises en compte et le CEM est affecté aux 
colonnes « -7 » à  « -12 ». 
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■ Les colonnes CEM se trouvant à droite du module de base commencent par « 7 ». 

■ Les colonnes AEM de gauche sont toujours numérotées de « –33 » à « –31 ». Les 
colonnes AEM de droite sont toujours numérotées de « 31 » à « 33 ». En d'autres 
termes, la numérotation des colonnes AEM se base sur la présence d'un DEM et 
de quatre CEM à gauche et de quatre CEM à droite du module de base. 

■ s = côté. Façade arrière = « 1 » ; façade avant = « 2 ».

■ w = numéro de la ligne. Numérotation continue de haut en bas. Les valeurs valides 
sont comprises entre « 1 » et « 52 » ; la ligne « 1 » se trouvant en haut. 

Adresse des éléments FC-SCSI des hôtes
L'adresse des éléments FC-SCSI, utilisée par les hôtes connectés à la bibliothèque de 
bandes SL3000 par le biais d'une connexion FC-SCSI, permet d'identifier de manière 
unique chaque ressource de la bibliothèque de bandes mise à disposition de l'hôte. 

La numérotation des éléments FC-SCSI utilise un nombre entier pour identifier chaque 
ressource de la bibliothèque de bandes. La numérotation des éléments FC-SCSI dans les 
bibliothèques de bandes partitionnées est continue pour chaque partition même si les 
emplacements des cellules de la partition ne sont pas adjacents. Les adresses des 
éléments FC-SCSI commencent à partir du module, de la ligne et de la colonne se 
trouvant le plus en bas de la partition, puis continuent ligne par ligne jusqu'à la fin de 
la colonne, puis par colonne jusqu'au bout du module. 

En cas d'affectation de ressources supplémentaires à une partition FC-SCSI existante, 
les ressources d'origine ne sont pas renumérotées. Cela permet de minimiser les 
perturbations pour l'hôte FC-SCSI. 

Exemples d'adresses des éléments FC-SCSI

Si les modules de base et d'extension de stockage d'une bibliothèque de bandes sont 
affectés à la partition  1 et que le module des lecteurs est affecté à la partition 2, la 
numérotation des éléments FC-SCSI se fait de la manière suivante :

■ La numérotation de la partition 1 débute à partir du premier emplacement 
disponible dans le module de base et se termine au niveau de la dernière cellule 
disponible dans la cellule du module de stockage. 

■ La numérotation de la partition 2 débute à partir de la première cellule de stockage 
disponible dans les adresses PRC du module des lecteurs et se termine au niveau de 
la dernière cellule de ce module. 

Adresse HLI-PRC
L'adresse HLI-PRC (Host Library Interface-Panel, Row, Column) est utilisée par les 
hôtes connectés à la bibliothèque de bandes SL3000 par le biais d'une connexion HLI, 
y compris ACSLS et HSC. L'adresse HLI-PRC identifie de manière unique chaque 
ressource de la bibliothèque de bandes à laquelle l'hôte a accès et est attribuée par le 
logiciel de l'hôte.

L'adresse HLI-PRC se compose d'une valeur à huit chiffres indiquant la bibliothèque 
de bandes, le panneau, la ligne et la colonne correspondant à l'emplacement de la 
ressource. Le format est le suivant : ll:pp:rr:cc, où :

■ ll = numéro de la bibliothèque de bandes. Cette valeur est toujours « 00 ». 
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■ pp = numéro du panneau. La numérotation est définie par rapport au module de 
base de la manière suivante :

■ Les numéros des panneaux du module de base sont toujours « 12 » et « 13 ». 

■ La numérotation des modules situés à gauche du module de base se fait de 
manière décroissante et débute à « 11 ». Les modules à droite sont numérotés de 
manière croissante en débutant à « 14 ». 

■ Des nombres pairs sont attribués aux façades arrières. Des nombres impairs sont 
attribués aux façades avant. 

■ Les panneaux DEM (le cas échéant) sont toujours numérotés « 10 » et « 11 ».

■ S'il n'y a aucun DEM et qu'un CEM se trouve à gauche du module de base, les 
panneaux « 10 » et « 11 » ne sont pas pris en compte et le CEM est affecté aux 
colonnes « 8 » et « 9 ». Vous pouvez ajouter ultérieurement un DEM à gauche du 
module de base sans avoir à renuméroter les modules. 

■ Pour la numérotation des panneaux de l'AEM, voir « Numérotation du CAP 
HLI – CAP de rotation et des AEM » page 276. 

■ rr = numéro de la ligne du panneau. Numérotation continue de haut en bas. Les 
valeurs valables sont comprises entre 0 et 51 ; la ligne 0 se trouvant en haut. 

■ rr = numéro de la colonne du panneau. Numérotation continue de gauche à droite 
en commençant par l'avant du module. Chaque panneau comprend six colonnes 
maximum. Les valeurs valables pour les colonnes vont de 0 à 5. 

Numérotation du CAP HLI – CAP de rotation et des AEM

Remarque – HSC affiche les adresses HLI-PRC selon une notation hexadécimale. Par 
conséquent, les panneaux 10, 11 et 12 apparaissent sous la forme « 0A », « 0B » et 
« 0C », respectivement. ACSLS et la Console d’administration StreamLine Library 
affichent les adresses HLI-PRC selon une notation décimale. 

Les numéros des CAP de la bibliothèque de bandes sont attribués par module de 
gauche à droite : 

■ CAP du module de base = 6

■ CAP DEM = 5

■ Cap de rotationdans des CEM à gauche du module de base = 1–4

■ CAP de rotationdans des CEM à droite du module de base = 7–10

■ CAP des AEM à gauche du module de base = 0

■ CAP des AEM à droite du module de base = 11

Les CAP de rotation comportent une colonne de cellules avec 26 lignes. Les cellules 
sont numérotées de 0 à 25. 

L'AEM comprend un CAP de chargement en masse comportant 234 cellules réparties 
sur six colonnes. La numérotation des colonnes débute à partir de la façade arrière et 
s'effectue de gauche à droite (colonnes 0-2), puis se poursuit vers la façade avant de 
gauche à droite (colonnes 3-5). 
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Cellules de stockage et lecteurs 
L'ensemble des cellules de stockage, des lecteurs de bande et des cartouches affectés 
à une partition sont exclusivement réservés à l'hôte correspondant et ne sont pas 
disponibles pour les autres hôtes. Par exemple, si un groupe de lecteurs de bande est 
affecté à une partition, seul l'hôte affecté à cette partition est habilité à utiliser ces 
lecteurs. 

Les cellules de stockage et les lecteurs non affectés à une partition ne sont pas 
accessibles. Par exemple, une zone de cellules peut rester non affectée en prévision 
d'un futur partitionnement. 

Les fenêtres et les rapports de la Console d’administration StreamLine Library 
indiquent les états suivants pour les cellules de stockage et les lecteurs :

■ Allocated : affectation à la partition actuelle. 

■ Unallocated (ou Unassigned) : affectation à aucune partition. Possibilité d'affectation 
à toute partition existante. 

■ Unavailable : affectation à une autre partition. 

■ Not accessible : indisponible pour les opérations des hôtes. Par exemple, des cellules 
sont réservées à des cartouches de diagnostic, des cellules sont bloquées et des 
cellules ne sont pas activées. 

Remarque – Les TallBot correspondent à des ressources partagées ne pouvant être 
affectées exclusivement à une partition. 

Pour afficher les affectations des partitions aux cellules de stockage et aux lecteurs, voir 
« Partitions—Reports—Cartridge Cell and Media Summary » page 393. 

Cartouches orphelines dans les bibliothèques de 
bandes non partitionnées

Remarque – Pour plus d'informations sur les cartouches orphelines dans les 
bibliothèques de bandes non partitionnées, voir « Cartouches orphelines dans les 
bibliothèques de bandes non partitionnées » page 221. 

Dans les bibliothèques de bandes partitionnées, une cartouche orpheline correspond à 
une cartouche se trouvant dans une cellule ou un lecteur non affecté (c'est-à-dire une 
cellule ou un lecteur non affecté à une partition). 

Mise en garde – Si un hôte repère une cartouche orpheline, il risque de la considérer 
comme une cartouche vide et écraser les données. C'est la raison pour laquelle il est 
important de veiller au bon positionnement des cartouches orphelines. 

Une cartouche peut devenir orpheline pour plusieurs raisons. En voici quelques 
exemples :

■ Les délimitations des partitions ont été modifiées.

■ Une partition a été supprimée. 
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■ La cartouche a été déplacée manuellement vers une cellule non affectée ou 
inaccessible. 

En cas d'identification d'une cartouche orpheline par la Console d’administration 
StreamLine Library, un message d'avertissement s'affiche. Les actions suivantes 
permettent de corriger les problèmes de cartouches orphelines :

■ Génération d'un rapport sur les cartouches orphelines. 

■ Réalisation d'un audit de la bibliothèque de bandes. 

■ Récupération d'une cartouche. 

Pour plus d'informations concernant la vérification des cartouches orphelines et la 
résolution de problèmes, consultez les procédures ci-après :

■ « Vérification de la configuration des partitions » page 303

■ « Résolution des problèmes de cartouches orphelines » page 306

■ « Validation des modifications de la configuration des partitions » page 307
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Partitions et CAP de rotation et des AEM 

Remarque – Les CAP des AEM sont soumis aux mêmes règles et restrictions de 
partitionnement que les CAP de rotation. Dans cette section, le terme « CAP » fait 
référence à ces deux types de CAP. 

Remarque – La SL3000 ne prend pas en charge les CAP communs, les CAP partagés 
ni l'affectation de cellules du CAP individuelles à une partition. Ces fonctionnalités 
sont uniquement disponibles sur la SL500. 

Au moment de la configuration des CAP, vous devez prévoir leur utilisation. Une 
partition peut uniquement utiliser le CAP qui lui a été affecté. La SL3000 ne comporte 
pas de CAP « commun ». 

Lors de l'affectation d'un CAP à une partition, toutes les cellules du CAP sont affectées. 
Il n'est pas possible d'affecter ou de désaffecter des cellules individuelles à l'intérieur 
d'un CAP. La SL3000 ne comporte pas de CAP « partagé ». 

Affectation des CAP
Par défaut, tous les CAP d'une bibliothèque de bandes partitionnée n'ont pas 
d'affectation. L'affectation des CAP aux partitions s'effectue par le biais des fenêtres 
suivantes :

■ « Partitions—Design (Step 3b) » page 365, pour les modules de base, de lecteur et de 
CEM

■ « Partitions—Design (Step 3b) – AEMs Only » page 372, pour les modules AEM

L'affectation des CAP peut prendre l'une des formes suivantes :

■ Dedicated : le CAP est exclusivement réservé à une partition.

■ Shared : le CAP peut être utilisé par d'autres partitions que celle définie. Voir 
“Partage des CAP” pour plus de détails. 

Une fois le CAP affecté, il devient soit un CAP FC-SCSI, soit un CAP HLI en fonction 
du type d'interface hôte de la première partition à laquelle il est affecté. Par exemple, 
si vous affectez un CAP libre à une partition dotée d'une interface FC-SCSI, le CAP 
devient un CAP FC-SCSI. Par la suite, le CAP peut uniquement être affecté à d'autres 
partitions FC-SCSI. Pour basculer d'un CAP FC-SCSI à HLI, vous devez dans un 
premier temps désaffecter le CAP de l'ensemble des partitions FC-SCSI, puis affecter le 
CAP à une partition HLI.

Remarque – Les affectations des CAP ne sont pas obligatoires. Des partitions peuvent 
ne comporter aucun CAP. 
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Remarque – Étant donné que les applications hôtes FC-SCSI n'utilisent généralement 
aucune réservation de CAP, il est recommandé de réserver au moins un CAP pour 
chaque partition FC-SCSI dans la mesure du possible. Cela permet à chaque partition 
de fonctionner de manière autonome par rapport aux autres et d'éviter tout conflit 
d'utilisation des ressources pouvant survenir à cause des CAP partagés. 

Partage des CAP
Étant donné qu'une bibliothèque de bandes peut comporter plus de partitions que de 
CAP, il peut s'avérer nécessaire que des partitions partagent des CAP. Seules des 
partitions ayant le même type d'interface hôte peuvent partager un CAP. Par exemple, 
un nombre indéfini de partitions FC-SCSI peut partager un groupe d'un ou plusieurs 
CAP. De même, un nombre indéfini de partitions HLI peut partager un groupe 
différent de CAP. Toutefois, les partitions HLI et FC-SCSI ne peuvent pas partager les 
mêmes CAP. 

Pour faciliter la gestion, il est recommandé de conserver les mêmes groupes de CAP 
partagés pour l'ensemble des partitions auxquelles ils sont affectés. Par exemple, si 
vous affectez les CAP A et B à une partition et qu'une autre partition souhaite avoir 
accès à A ou à B, vous devez affecter les deux CAP au lieu de l'un des deux à la 
deuxième partition. 

Remarque – Vous devez gérer minutieusement l'utilisation des CAP partagés par les 
hôtes FC-SCSI afin d'éviter l'apparition de conflits d'utilisation. Voir « « Propriété » de 
CAP » page 280 pour plus de détails. 

Mode d'insertion automatique dans les CAP 
Le mode d'insertion automatique dans les CAP (CAP auto enter mode) permet à un 
utilisateur de la bibliothèque de bandes d'ouvrir un CAP et de réaliser une opération 
d'insertion sans avoir besoin d'émettre une demande d'insertion ou une réservation 
depuis une application hôte. Le mode d'insertion automatique est disponible pour les 
CAP affectés à une partition. Les CAP en mode d'insertion automatique ne sont pas 
bloqués. 

Les applications hôtes gèrent le mode d'insertion automatique. Pour plus 
d'informations, consultez la documentation du logiciel de gestion des bandes 
appropriée. 

« Propriété » de CAP 
Un CAP doit être utilisé par une seule partition à la fois lors des opérations d'insertion 
et d'éjection. Un CAP peut être réservé à une partition de la manière suivante :

■ Le CAP est affecté à une seule partition. Dans ce cas, la partition détient la propriété 
exclusive du CAP.
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■ Une application hôte réserve le CAP avant toute opération d'insertion ou d'éjection. 
Cela concerne uniquement les applications hôtes HLI. Voir « Réservation des CAP » 
page 282 pour plus de détails. 

■ L'utilisateur associe la partition au CAP. Cela concerne uniquement les CAP FC-SCSI 
partagés. Voir « Associations de CAP FC-SCSI partagés » page 283 pour plus de 
détails. 

■ Une partition insère une cartouche dans le CAP. Si aucune des situations ci-dessus 
ne s'applique, la première partition qui insère une cartouche dans le CAP dans le 
cadre d'une opération d'exportation devient propriétaire du CAP jusqu'à la fin de 
l'exportation et jusqu'à ce que le CAP soit fermé et vide.

Lorsqu'une partition détient un CAP, celui-ci est exclusivement réservé à cette partition 
et n'est disponible pour aucune autre. La bibliothèque de bandes envoie uniquement les 
messages « CAP opened » et « CAP closed » à l'hôte détenant la réservation. 

Pour les CAP HLI uniquement, lorsqu'un hôte essaie de réserver un CAP déjà réservé 
par une autre partition, la bibliothèque de bandes envoie un message à l'hôte émettant 
la demande et indique l'identifiant de la partition ainsi que l'identifiant de l'hôte ayant 
effectué la réservation. 

États des CAP
Un CAP doit être déverrouillé afin de pouvoir être ouvert pour insérer ou retirer des 
cartouches. Lorsqu'un CAP est déverrouillé, le voyant du bouton CAP s'allume. 

Au moment de la fermeture d'un CAP, le TallBot réalise un audit afin de déterminer la 
présence ou non de cartouches. Pendant cet audit, le CAP est verrouillé et le voyant du 
bouton CAP est éteint. Une fois l'audit terminé, le CAP revient à son état par défaut. 

Le tableau ci-dessous présente les états par défaut des différents types de CAP d'une 
bibliothèque de bandes partitionnée. 

Type de CAP
État par 
défaut

Condition 
par défaut du 
voyant du 
bouton CAP Commentaire

HLI : dédié ou 
partagé 

Verrouillé Éteint La réservation par l'hôte 
déverrouille le CAP et allume 
le voyant. Voir « Réservation 
des CAP » page 282 pour plus 
de détails. 

HLI : mode 
d'insertion 
automatique

Déverrouillé Allumé

FC-SCSI – dédié Déverrouillé Allumé

FC-SCSI – partagé Verrouillé Éteint L'association partition-CAP 
déverrouille le CAP et allume 
le voyant. Voir « Associations 
de CAP FC-SCSI partagés » 
page 283 pour plus de détails.
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Réservation des CAP
Les hôtes FC-SCSI et HLI sont habilités à utiliser les réservations des CAP. La 
réservation de CAP accorde à une partition le droit exclusif d'utiliser un CAP partagé 
pendant toute la durée d'une opération d'insertion ou d'éjection. Une fois l'opération 
terminée, l'application hôte doit annuler la réservation afin de mettre le CAP partagé à 
disposition des autres partitions. Aucune partition n'a accès au CAP tant que la 
première n'a pas terminé l'opération et annulé la réservation. 

Pour qu'une partition puisse réserver un CAP, celui-ci ne doit pas être déjà réservé 
(cela concerne uniquement les CAP partagés) et doit être vide et fermé. 

Réservation des CAP HLI 
Les applications hôtes HLI doivent respecter une procédure de réservation stricte afin 
de gérer l'utilisation des CAP par les clients hôtes. Elles doivent toujours réserver un 
CAP avant de le déverrouiller ou de déplacer une cartouche vers lui. Lorsqu'une 
application hôte HLI essaie de réserver un CAP déjà réservé par une autre partition, 
le contrôleur de la bibliothèque de bandes envoie un message à l'hôte émettant la 
demande et indique l'identifiant de la partition ainsi que l'identifiant de l'hôte ayant 
effectué la réservation. 

Annulation de la réservation des CAP 

En règle générale, l'annulation de la réservation des CAP par un hôte ACSLS ou HSC 
s'effectue de la manière suivante :

■ Opérations d'insertion : une fois toutes les cartouches correctement insérées dans la 
bibliothèque de bandes, l'hôte finalise la commande d'insertion. Le contrôleur de la 
bibliothèque de bandes libère le CAP après s'être assuré que le CAP est fermé et 
vide. 

■ Opérations d'éjection : une fois toutes les cartouches correctement éjectées, l'hôte 
finalise l'opération d'éjection. Le contrôleur de la bibliothèque de bandes libère le 
CAP après s'être assuré que le CAP est fermé et vide. 

Si, pour une raison quelconque, la réservation des CAP n'est pas annulée selon les 
indications précédentes, les autres partitions n'y auront pas accès et les cartouches 
appartenant à la première partition y resteront. Dans ce cas, il est recommandé de 
finaliser l'opération d'insertion ou d'éjection réalisée par l'hôte détenant la réservation. 
Cela permet d'obtenir l'annulation normale de la réservation des CAP. 

Remarque – Pour plus d'informations concernant la finalisation des opérations 
d'insertion et d'éjection, consultez la documentation des ACSLS ou HSC. 
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Redéfinition de la réservation des CAP 

Parfois, vous ne pouvez pas accéder à l'hôte détenant une réservation et ne pouvez 
donc pas réaliser une libération normale des CAP lorsqu'il a terminé son opération ou 
bien que vous n'êtes pas habilité à lui envoyer des commandes. Dans ce dernier cas, 
redéfinissez manuellement (annulez) la réservation des CAP. Voir « Redéfinition des 
réservations » page 337 pour plus de détails. 

Remarque – Faites preuve de précaution lors de l'utilisation de la Console 
d’administration StreamLine Library pour redéfinir une réservation de CAP. Si la 
procédure n'est pas menée à son terme, le CAP risque de rester indisponible pour 
l'ensemble des partitions et/ou les cartouches affectées à une partition risquent d'être 
insérées dans une autre partition.

Remarque – Vous pouvez utiliser la Console d’administration StreamLine Library 
pour redéfinir une réservation de CAP uniquement dans le cas d'une bibliothèque de 
bandes partitionnée. Dans le cas d'une bibliothèque de bandes non partitionnée, les 
réservations des CAP doivent toujours être annulées par l'intermédiaire des ACSLS ou 
HSC. 

Réservations des CAP FC-SCSI 
La majorité des applications hôtes FC-SCSI n'utilise pas de réservations de CAP. En 
règle générale, les applications hôtes FC-SCSI sont les propriétaires exclusifs d''un 
CAP et par conséquent ne gèrent pas le partage des CAP. Afin d'éviter tout conflit 
d'utilisation d'un CAP partagé par plusieurs partitions, vous pouvez affecter 
manuellement une partition à un CAP. Voir « Associations de CAP FC-SCSI partagés » 
page 283 pour plus de détails. 

Associations de CAP FC-SCSI partagés 
Si une partition FC-SCSI partage des CAP avec d'autres partitions, il est recommandé 
d'associer manuellement la partition aux CAP avant de réaliser une opération 
d'insertion ou d'éjection. Voir « Association d'une partition FC-SCSI à ses CAP 
partagés » page 331 pour plus de détails.

Une association partition-CAP accorde à la partition un droit d'utilisation exclusif de 
ses CAP partagés, similaire à une réservation de CAP. Cela permet d'insérer les 
cartouches dans la partition appropriée et d'empêcher les autres partitions d'utiliser 
un CAP partagé en cours d'utilisation. 

Les règles suivantes s'appliquent lors de la définition des associations partition-CAP :

■ Une seule partition à la fois peut être affectée à un CAP. 

■ La sélection d'une partition a pour effet d'affecter tous les CAP concernés à la fois. 
Vous ne pouvez pas affecter un CAP individuel à la partition. 

■ Vous pouvez sélectionner plusieurs partitions en même temps dans la mesure où les 
partitions sélectionnées ne partagent aucun CAP. 
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■ Les associations partition-CAP restent actives tant qu'elles ne sont pas supprimées. 
Les associations ne sont pas automatiquement supprimées après une opération 
d'insertion ou d'éjection. 

■ Les associations partition-CAP sont supprimées au moment du redémarrage de la 
bibliothèque de bandes, des cycles d'alimentation, des opérations d'ouverture ou de 
fermeture des portes de la bibliothèque de bandes ou de l'initialisation des CAP. 

■ Les associations partition-CAP sont supprimées si le CAP est affecté à une autre 
partition par le biais de la fenêtre Design (Step 3b). 

■ En cas de suppression d'une association partition-CAP lorsque le CAP est ouvert ou 
contient des cartouches, la propriété du CAP deviendra celle du demandeur « par 
défaut » et le CAP sera indisponible pour l'ensemble des partitions. Vous devez 
vider et fermer le CAP préalablement à son affectation à une partition. 
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Partitionnement sans interruption
La fonctionnalité de partitionnement sans interruption réduit le nombre d'interruptions 
de l'hôte qui se produisent lors de la modification des partitions. La bibliothèque de 
bandes n'a pas besoin d'être placée hors ligne pour chaque modification de partition. 
En outre, les hôtes sont isolés des modifications de partition qui ne les affectent pas 
directement.

Avant l'apparition de cette fonctionnalité, dès qu'une partition était modifiée, 
l'ensemble des partitions était placé hors ligne pendant la mise à jour de la base de 
données du contrôleur de la bibliothèque de bandes. Par conséquent, des interruptions 
de bibliothèque de bandes devaient être coordonnées à travers l'ensemble des hôtes 
connectés à une bibliothèque de bandes partitionnée. 

Les fonctions spécifiques de la fonctionnalité de partitionnement sans interruption 
varient, en fonction du type de connexion hôte-partition. Pour plus d'informations, 
reportez-vous aux sections suivantes :

■ « Partitions NDP et HLI » page 285

■ « Partitions NDP et FC-SCSI » page 286

Mise en garde – Bien que les modifications de la partition n'interrompent 
pas les hôtes de la bibliothèque de bandes, il est recommandé d'interdire 
l'accès à la bibliothèque de bandes aux autres utilisateurs avant de valider les 
modifications apportées à l'espace de travail de votre partition. Du fait que la Console 
d’administration StreamLine Library ne valide pas les délimitations de la partition par 
rapport à la base de données du contrôleur de la bibliothèque de bandes en temps réel, 
des conflits de configuration peuvent se produire si vous modifiez des délimitations de 
la partition, alors que d'autres utilisateurs déplacent des cartouches ou modifient la 
configuration de la bibliothèque de bandes. Voir « Synchronisation de l'affichage avec la 
base de données du contrôleur » page 44 pour plus de détails. 

Partitions NDP et HLI
Avec les partitions HLI, vous pouvez affecter des ressources supplémentaires à une 
partition sans arrêter les tâches hôtes ni placer la partition hors ligne. En général, une 
partition est mise hors ligne lors de la désaffectation de ressources. Dans tous les cas, 
les partitions voisines ne sont jamais dérangées.

Allocation de ressources supplémentaires à une partition
Dès que vous apportez n'importe lequel des types suivants de modification de 
partition, la partition affectée demeure en ligne  

■ Affectation d'une cellule de stockage 

■ Affectation d'un lecteur 

■ Affectation d'un CAP 
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Le contrôleur de la bibliothèque de bandes envoie un message asynchrone à tous les 
hôtes connectés à la partition, en les avertissant que la configuration de la bibliothèque 
de bandes a changé. Les hôtes connaissent alors une brève interruption lors de la mise 
à jour des informations de configuration de leur bibliothèque de bandes, puis ils 
continuent automatiquement à traiter les tâches. 

Suppression d'allocations d'une partition
Dès que vous apportez n'importe lequel des types suivants de modification de 
partition, la partition affectée est brièvement mise hors ligne : 

■ Désaffectation d'une cellule de stockage

■ Désaffectation d'un lecteur

■ Suppression d'un emplacement de lecteur vide

Une fois la modification de configuration mise à jour dans la base de données du 
contrôleur de la bibliothèque de bandes, la partition est automatiquement remise en 
ligne et le contrôleur de la bibliothèque de bandes envoie un message à tous les hôtes 
connectés à la partition, en les avertissant que la configuration a changé. Les hôtes 
connaissent alors une brève interruption lors de la mise à jour des informations de 
configuration de leur bibliothèque de bandes, puis ils continuent automatiquement à 
traiter les tâches. 

Partitions NDP et FC-SCSI
Avec les partitions FC-SCSI, vous pouvez affecter un CAP à une partition sans arrêter 
les tâches hôtes ni placer la partition hors ligne. 

Toutes les autres modifications apportées à une partition FC-SCSI entraînent la mise 
hors ligne de la partition affectée avec une condition Unit Attention. Les partitions 
voisines et leurs hôtes connectés ne sont pas dérangés.

Modifications de connexion hôte
Les modifications de connexion hôte incluent les activités suivantes :

■ Ajout d'une connexion hôte-partition

■ Modification des propriétés d'une connexion hôte-partition 

■ Suppression d'une connexion hôte-partition

Dès que vous apportez n'importe laquelle de ces modifications, la partition affectée est 
mise hors ligne avec une condition LUNS Data Has Changed Unit Attention. Les hôtes 
connectés à la partition doivent émettre les commandes appropriées, de manière à 
mettre à jour leurs informations de configuration de bibliothèque de bandes. Reportez-
vous à la documentation du logiciel de gestion des bandes pour plus d'informations 
concernant les procédures et les commandes.
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Si un hôte possède des mappages de connexion ITL nexus pour chaque connexion 
de partition, alors seule la partition concernée par la modification de connexion est 
affectée. Cependant, comme la bibliothèque de bandes SL3000 prend en charge un port 
cible (0) uniquement, il est possible que l'hôte avec plusieurs connexions de partition 
référence la même paire cible/LUN pour chacune d'entre elles. Dans ce cas, dès qu'une 
connexion hôte-partition est modifiée, toutes les partitions avec lesquelles l'hôte 
possède des connexions sont également affectées. 

Modifications de configuration de partition
Les modifications de configuration de partition incluent les activités suivantes :

■ Affectation d'une cellule de stockage 

■ Affectation d'un lecteur 

■ Désaffectation d'une cellule de stockage

■ Désaffectation d'un lecteur

■ Désaffectation d'un CAP 

■ Suppression d'un emplacement de lecteur vide 

Dès que vous apportez n'importe laquelle de ces modifications, la partition affectée est 
mise hors ligne avec une condition Mode Parameters Have Changed Unit Attention. 
Les hôtes connectés à la partition doivent émettre les commandes appropriées, de 
manière à mettre à jour leurs informations de configuration de bibliothèque de bandes ; 
consultez la documentation du logiciel de gestion des bandes pour plus d'informations 
concernant les procédures et les commandes. Dans le cas d'un ajout ou d'une 
suppression de lecteurs, la numérotation SCSI du périphérique est également mise 
à jour. 
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Procédures de partitionnement

Remarque – Le partitionnement de la bibliothèque de bandes est une fonctionnalité 
sous licence. Son installation doit être effectuée par l'intermédiaire de l'utilitaire de 
gestion de licences du système SL3000. Voir Chapitre 4, « Gestion des licences » pour 
plus de détails. 

Procédure de configuration des partitions
Au moment de la première configuration des partitions de la bibliothèque de bandes, il 
est recommandé d'utiliser les fenêtres de partition de la bibliothèque de bandes dans 
l'ordre suivant : 

1. Instructions (Step 1) : récapitulatif des consignes relatives à la procédure de 
configuration des partitions 

2. Summary (Step 2) : récapitulatif de la configuration des partitions et des 
informations concernant la connexion entre les hôtes et les partitions. Vous avez 
la possibilité d'accéder à d'autres fenêtres afin de réaliser les tâches suivantes :

■ Add Partition

■ Modify Partition

■ Delete Partition

Remarque – Les tâches suivantes concernent uniquement les connexions hôte-
partition FC-SCSI. 

■ Add Connection

■ Modify Connection

■ Delete Connection

3. Module Map (Step 3a) : sélection du module de la bibliothèque de bandes pour 
lequel vous souhaitez définir en détail les délimitations de la partition. 

4. Design (Step 3b) : affichage et éventuellement modification des informations 
détaillées relatives aux délimitations de la partition. Vous avez la possibilité 
d'accéder à d'autres fenêtres afin de réaliser les tâches suivantes :

■ Vérification de la configuration des partitions 

■ Actualisation de la fenêtre avec les données existantes de la base de données du 
contrôleur de la bibliothèque de bandes.

5. Commit (Step 4) : validation dans la base de données du contrôleur de la 
bibliothèque de bandes des modifications apportées aux fenêtres Summary(2) et 
Design (3b) et aux fenêtres contextuelles associées. Vous avez la possibilité d'accéder 
à d'autres fenêtres afin de réaliser les tâches suivantes : 

■ Actualisation de la fenêtre avec les données existantes de la base de données du 
contrôleur de la bibliothèque de bandes.
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Vous pouvez utiliser la fenêtre Reports à tout moment pour afficher et éventuellement 
enregistrer ou imprimer les informations de la base de données du contrôleur de la 
bibliothèque de bandes concernant la configuration des partitions. 

Espace de travail de la partition de la Console 
d’administration StreamLine Library
Les fenêtres de partition Summary (Step 2) et Design (Step 3b) ainsi que toutes les fe-
nêtres contextuelles correspondantes donnent accès à un espace de travail dynamique 
pour la conception de vos partitions de la bibliothèque de bandes. Toutes les informa-
tions relatives à la configuration des partitions sont enregistrées automatiquement dans 
l'espace de travail des partitions dans la mémoire de la Console d’administration 
StreamLine Library et sont conservées pendant toute la durée de votre session sur la 
Console d’administration StreamLine Library. Ainsi, vous pouvez passer d'une fenêtre 
de partition à l'autre, revenir aux fenêtres de partition autant de fois que vous le sou-
haitez sans perdre vos modifications de configuration.

La validation des informations de l'espace de travail des partitions de la Console 
d’administration StreamLine Library dans la base de données du contrôleur de la 
bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre Commit 
(Step 4). Les données risquent d'être perdues si l'un des événements suivants se 
produit avant la validation de vos mises à jour : 

■ Vous vous déconnectez de la session de la Console d’administration StreamLine 
Library.

■ Le délai de connexion de la session sur la Console d’administration StreamLine 
Library est dépassé ou la connexion vers la bibliothèque de bandes est interrompue. 

■ Vous actualisez l'espace de travail de la Console d’administration StreamLine 
Library depuis la base de données actuelle du contrôleur de la bibliothèque de 
bandes. Pour ce faire, vous devez utiliser le bouton Refresh des fenêtres 
Summary (Step 2) et Design (Step 3b) 

Mise en garde – Bien que les modifications de la partition n'interrompent 
pas les hôtes de la bibliothèque de bandes, il est recommandé d'interdire 
l'accès à la bibliothèque de bandes aux autres utilisateurs avant de valider les 
modifications apportées à l'espace de travail de votre partition. Du fait que la Console 
d’administration StreamLine Library ne valide pas les délimitations de la partition par 
rapport à la base de données du contrôleur de la bibliothèque de bandes en temps réel, 
des conflits de configuration peuvent se produire si vous modifiez des délimitations de 
la partition, alors que d'autres utilisateurs déplacent des cartouches ou modifient la 
configuration de la bibliothèque de bandes. Voir « Synchronisation de l'affichage avec la 
base de données du contrôleur » page 44 pour plus de détails. 
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Récapitulatif des tâches de 
partitionnement
Les tâches de partitionnement se divisent en plusieurs catégories :

■ « Tâches de configuration des partitions » page 291

■ « Tâches de gestion des partitions » page 310

■ « Tâches des rapports de partitions » page 323

■ « Tâches des opérations sur les CAP » page 330
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Tâches de configuration des partitions

Tâche Page

Rappel des consignes de partitionnement 292

Création d'une partition 293

Configuration d'une connexion hôte-partition (partitions FC-SCSI 
uniquement) 

295

Conception d'une partition : modules de base, DEM ou CEM 297

Définition d'une partition : modules AEM 300

Vérification de la configuration des partitions 303

Résolution des problèmes de cartouches orphelines 306

Validation des modifications de la configuration des partitions 307
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▼ Rappel des consignes de partitionnement
Cette procédure permet de revoir la procédure de partitionnement. 

1. Sélectionnez Tools > Partitions.

La première fois que vous faites cette sélection au cours d'une session sur la Console 
d’administration StreamLine Library, la fenêtre Instructions (Step 1) s'affiche 
automatiquement. 

2. Lisez les consignes s'affichant à l'écran avant de réaliser les tâches de 
partitionnement. 
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▼ Création d'une partition 
Cette procédure permet de créer une nouvelle partition de la bibliothèque de bandes et 
d'affecter sa capacité de stockage. Vous pouvez créer jusqu'à huit partitions avec des 
identifiants compris entre 1 et 8. 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Summary (Step 2) 

La fenêtre Summary (Step 2) s'affiche.

2. Cliquez sur Add Partition. 

La fenêtre contextuelle Add Partition s'affiche. 

3. Sélectionnez l'identifiant de la partition à ajouter, puis saisissez le nom, la capacité 
et le type d'interface.

Remarque – Il n'est pas nécessaire que les identifiants des partitions se suivent. Par 
exemple, vous pouvez créer une partition 2 et une partition 4 sans qu'il n'existe de 
partition 1 ou 3. 
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4. Cliquez sur OK. 

Les modifications apportées à la configuration des partitions sont enregistrées dans 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
pendant la durée de la session en cours. 

Voir « Vérification de la configuration des partitions » page 303 et « Validation des 
modifications de la configuration des partitions » page 307 pour mettre à jour la base de 
données du contrôleur de la bibliothèque avec les modifications réalisées pendant la 
session Console d’administration StreamLine Library en cours. 
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▼ Configuration d'une connexion hôte-partition

Remarque – Cette procédure concerne uniquement les connexions hôte-partition 
FC-SCSI. La configuration des connexions hôte-partition HLI s'effectue par 
l'intermédiaire du logiciel de gestion des hôtes de la bibliothèque de bandes (HSC 
ou ACSLS) et non par le biais de la Console d’administration StreamLine Library. 
Pour plus d'informations, reportez-vous à la documentation HSC ou ACSLS. 

Cette procédure permet de configurer la connexion entre un hôte et une partition 
sélectionnée. Elle est obligatoire pour permettre à l'hôte d'avoir accès à la partition.

Chaque partition peut comprendre jusqu'à neuf connexions hôtes, chacune ayant un 
LUN unique. De même, chaque hôte peut se connecter à plusieurs partitions. 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Summary (Step 2)

La fenêtre Summary (Step 2) s'affiche.

2. Cliquez sur la partition sur laquelle vous souhaitez ajouter une connexion hôte.

Remarque – Si vous sélectionnez une partition HLI, tous les boutons de la section 
Details de la fenêtre sont grisés. 
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3. Cliquez sur Add Connection. 

La fenêtre contextuelle Add Connection s'affiche. 

4. Saisissez l'initiateur (WWPN) ainsi que le LUN. 

Remarque – Chaque initiateur connecté à la bibliothèque de bandes doit comporter 
une partition de la bibliothèque de bandes affectée à LUN 0. Lors de la vérification ou 
de la validation des modifications apportées à la configuration des partitions, la 
Console d’administration StreamLine Library vous informera si un initiateur ne 
respecte pas cette condition. 

5. Cliquez sur OK. 
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▼ Conception d'une partition : modules de base, 
DEM ou CEM
Cette procédure permet d'ajouter des ressources de la bibliothèque de bandes à une 
partition ou de les supprimer de celle-ci (cellules de stockage, lecteurs de bande, et 
CAP de rotation). 

Remarque – Cette procédure s'applique aux modules de base, DEM ou CEM. Pour 
plus d'instructions sur l'affectation ou la désaffectation d'un CAP des AEM vers ou 
depuis une partition, voir « Définition d'une partition : modules AEM » page 300. 

Remarque – Les ressources de la bibliothèque de bandes peuvent être affectées à une 
seule partition à la fois. Si vous souhaitez ajouter des ressources à une partition déjà 
affectées à une autre partition, vous devez dans un premier temps supprimer les 
ressources de cette partition, puis les ajouter à la nouvelle partition. 

1. Sélectionnez Tools > Partitions.

2. Cliquez sur l'onglet Module Map (Step 3a). 

La fenêtre Module Map (Step 3a) s'affiche. 

3. Cliquez sur le module pour lequel vous souhaitez définir une partition. 
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4. Cliquez sur l'onglet Design (Step 3b).

La fenêtre Design (Step 3b) apparaît et affiche la configuration actuelle du module 
sélectionné.

5. Dans la liste déroulante Partition, sélectionnez la partition à configurer. 

Tous les champs de la fenêtre sont mis à jour pour refléter la configuration actuelle de 
la partition sélectionnée. 

Remarque – Cliquez sur les boutons Move Left ou Move Right pour afficher un 
module adjacent à celui affiché. 

6. Choisissez la méthode de sélection à l'aide de la liste Select by, puis cliquez sur le 
bouton radio Add ou Remove.

7. Le plan de la bibliothèque de bandes permet de sélectionner les ressources à ajouter 
ou à supprimer. 
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Remarque – Voir « Partitions—Design (Step 3b) » page 365 pour plus d'informations 
concernant le plan de la bibliothèque de bandes. 

Les modifications apportées à la configuration des partitions sont enregistrées dans 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
pendant la durée de la session en cours. 

Voir « Vérification de la configuration des partitions » page 303 et « Validation des 
modifications de la configuration des partitions » page 307 pour mettre à jour la base de 
données du contrôleur de la bibliothèque avec les modifications réalisées pendant la 
session Console d’administration StreamLine Library en cours. 
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▼ Définition d'une partition : modules AEM 
Cette procédure permet d'ajouter ou de supprimer un CAP des AEM vers ou depuis 
une partition. 

Vous pouvez affecter ou désaffecter la totalité d'un AEM à la fois ; il n'est pas possible 
d'affecter une partie seulement d'un AEM à une partition. Les AEM peuvent être 
partagés en plusieurs partitions qui partagent la même interface hôte-partition (HLI 
ou FC-SCSI). 

Remarque – Pour obtenir des informations détaillées sur l'ajout ou la suppression de 
ressources de la bibliothèque de bandes dans des modules de base, DEM ou CEM vers 
ou depuis une partition, voir « Conception d'une partition : modules de base, DEM ou 
CEM » page 297. 

1. Sélectionnez Tools > Partitions.

2. Cliquez sur l'onglet Module Map (Step 3a). 

La fenêtre Module Map (Step 3a) s'affiche. 

3. Cliquez sur l'AEM que vous voulez affecter à une partition. 



Tâches de configuration des partitions

418605501 • Révision AB Chapitre 6 Partitionnement de la bibliothèque de bandes 301

4. Cliquez sur l'onglet Design (Step 3b).

La fenêtre Design (Step 3b) apparaît et affiche la configuration actuelle de l'AEM que 
vous avez sélectionné. 

5. Dans la liste déroulante Partition, sélectionnez la partition à configurer. 

Tous les champs de la fenêtre sont mis à jour pour refléter la configuration actuelle de 
la partition sélectionnée. 

Remarque – Cliquez sur les boutons Move Left ou Move Right pour afficher un 
module adjacent à celui affiché. 

6. Cliquez sur le bouton radio Add ou Remove.
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7. Cliquez n'importe où sur le mappage de la bibliothèque de bandes pour sélectionner 
l'AEM et indiquer que vous souhaitez l'affecter à la partition ou le désaffecter de 
celle-ci. 

Les modifications apportées à la configuration des partitions sont enregistrées dans 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
pendant la durée de la session en cours. 

Voir « Vérification de la configuration des partitions » page 303 et « Validation des 
modifications de la configuration des partitions » page 307 pour mettre à jour la base de 
données du contrôleur de la bibliothèque avec les modifications réalisées pendant la 
session Console d’administration StreamLine Library en cours. 
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▼ Vérification de la configuration des partitions 
Cette procédure permet de vérifier les modifications apportées à la configuration des 
partitions au cours de la session de la Console d’administration StreamLine Library en 
cours. Elle vous permet de détecter les erreurs potentielles suivantes :

■ Une partition présente des cartouches orphelines. Voir « Cartouches orphelines dans 
les bibliothèques de bandes non partitionnées » page 277 pour plus de détails.

■ Des ressources de la bibliothèque de bandes ont été supprimées d'une partition. 

■ Un hôte connecté à la bibliothèque de bandes n'a aucune partition affectée à LUN 0. 

■ La capacité autorisée de la bibliothèque de bandes a été dépassée, c'est-à-dire que le 
nombre total des affectations des partitions dépasse la capacité autorisée.

Remarque – Cette procédure vérifie une partition à la fois. Si vous souhaitez vérifier 
plusieurs partitions, vous devez recommencer cette procédure pour chaque partition. 

1. Sélectionnez Tools > Partitions.

2. Cliquez sur l'onglet Module Map (Step 3a). 

La fenêtre Module Map (Step 3a) s'affiche. 

3. Cliquez sur le module pour lequel vous souhaitez vérifier une partition. 

Ce module apparaît en surbrillance à l'écran. 
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4. Cliquez sur l'onglet Design (Step 3b).

La fenêtre Design (Step 3b) apparaît et affiche la configuration actuelle du module 
sélectionné.

5. Dans la liste déroulante Partition, sélectionnez la partition à vérifier. 

Tous les champs de la fenêtre sont mis à jour pour refléter la configuration actuelle de 
la partition sélectionnée. 

6. Dans la barre Options, cliquez sur Verify. 

Les délimitations de la partition sélectionnée sont contrôlées, y compris les 
emplacements de l'ensemble des cartouches de bande. 

Remarque – Cette vérification porte uniquement sur la configuration actuelle des 
partitions dans l'espace de travail des partitions de la Console d’administration 
StreamLine Library. Elle ne contrôle pas les délimitations des partitions existantes dans 
la base de données du contrôleur de la bibliothèque de bandes. Par conséquent, elle ne 
permet pas d'identifier les conflits de configuration pouvant se produire en cas de 
déplacements de cartouche réalisés par d'autres utilisateurs ou de modification de la 
configuration de la bibliothèque de bandes, par le biais de l'Interface de ligne de 
commande, d'autres sessions sur la Console d’administration StreamLine Library ou 
d'applications hôtes, en même temps que les modifications apportées aux partitions. 

La fenêtre contextuelle Verify Results s'affiche et indique la présence ou non de 
cartouches orphelines, le dépassement éventuel de la capacité de stockage ou toute 
autre erreur détectée dans la configuration actuelle de la partition. 

Remarque – En cas de dépassement de la capacité de la bibliothèque de bandes (c'est-
à-dire si le nombre total d'affectations des partitions dépasse la capacité autorisée), 
vous devez supprimer des cellules de stockage des affectations des partitions avant de 
passer à l'étape « Validation des modifications de la configuration des partitions » 
page 307 de manière à ce que le nombre de cellules affectées soit inférieur à la capacité 
autorisée de la bibliothèque de bandes. 
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7. Cliquez sur Details pour afficher les messages d'avertissement détaillés expliquant 
les raisons de la présence de cartouches orphelines. 

Utilisez le bouton Details pour basculer entre les fenêtres développées et réduites des 
messages d'avertissement. 

8. Dans la fenêtre développée des messages d'avertissement, vous pouvez réaliser les 
actions suivantes :

■ Cliquez sur Print pour imprimer les données du message détaillé.

■ Cliquez sur Save pour enregistrer les données du message dans un fichier de 
type csv. 

9. Cliquez sur OK pour fermer la fenêtre contextuelle Verify Results et revenir à la 
fenêtre Design (Step 3b). 

Remarque – Il est recommandé de suivre la procédure « Résolution des problèmes de 
cartouches orphelines » page 306 avant de valider les données dans la base de données 
du contrôleur de la bibliothèque de bandes. 
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▼ Résolution des problèmes de cartouches 
orphelines
En cas d'identification d'une cartouche orpheline par la Console d’administration 
StreamLine Library, un message d'avertissement s'affiche. Vous devez corriger ce 
problème et redisposer toutes les cartouches orphelines avant de passer à l'étape 
« Validation des modifications de la configuration des partitions » page 307. 

Pour résoudre les problèmes de cartouches orphelines, vous pouvez réaliser les actions 
suivantes : 

■ Impression d'un rapport sur les cartouches orphelines. 

■ Réalisation d'un audit de la bibliothèque de bandes. 

■ Récupération d'une cartouche orpheline. 
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▼ Validation des modifications de la configuration 
des partitions 

Mise en garde – Cette procédure permet de mettre à jour la base de données du 
contrôleur de la bibliothèque de bandes avec les modifications apportées à la 
configuration des partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library. En cas de non respect de cette procédure 
avant de se déconnecter de la session en cours sur la Console d’administration 
StreamLine Library, les modifications apportées à la configuration de la bibliothèque 
de bandes seront perdues.

Mise en garde – Bien que les modifications de la partition n'interrompent 
pas les hôtes de la bibliothèque de bandes, il est recommandé d'interdire 
l'accès à la bibliothèque de bandes aux autres utilisateurs avant de valider les 
modifications apportées à l'espace de travail de votre partition. Du fait que la Console 
d’administration StreamLine Library ne valide pas les délimitations de la partition par 
rapport à la base de données du contrôleur de la bibliothèque de bandes en temps réel, 
des conflits de configuration peuvent se produire si vous modifiez des délimitations de 
la partition, alors que d'autres utilisateurs déplacent des cartouches ou modifient la 
configuration de la bibliothèque de bandes. Voir « Synchronisation de l'affichage avec la 
base de données du contrôleur » page 44 pour plus de détails. 

Remarque – Il est recommandé de suivre la procédure « Résolution des problèmes de 
cartouches orphelines » page 306 avant de réaliser celle-ci. 

Remarque – Vous ne pouvez pas réaliser cette procédure si la capacité actuelle de 
la bibliothèque de bandes est atteinte (c'est-à-dire si le nombre total des affectations 
des partitions dépasse la capacité autorisée). Le bouton Apply est grisé et, avant de 
continuer, vous devez supprimer des cellules de stockage des affectations des partitions 
de manière à ce que le nombre total de cellules affectées soit inférieur à la capacité 
autorisée de la bibliothèque de bandes.

1. Basculement de la bibliothèque de bandes hors ligne entre ACSLS et HSC. 

Consultez la documentation du logiciel de gestion des bandes pour plus d'informations 
concernant les procédures et les commandes.

2. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Commit (Step 4).

La fenêtre Commit (Step 4) s'affiche.

3. Dans la barre Options, cliquez sur Apply. 

Les délimitations de la partition sélectionnée sont contrôlées, y compris les 
emplacements de l'ensemble des cartouches de bande. 



Tâches de configuration des partitions

308 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

Remarque – Cette vérification porte uniquement sur la configuration actuelle des 
partitions dans l'espace de travail des partitions de la Console d’administration 
StreamLine Library. Elle ne contrôle pas les délimitations des partitions existantes dans 
la base de données du contrôleur de la bibliothèque de bandes. Par conséquent, elle ne 
permet pas d'identifier les conflits de configuration pouvant se produire en cas de 
déplacements de cartouche réalisés par d'autres utilisateurs ou de modification de la 
configuration de la bibliothèque de bandes, par le biais de l'Interface de ligne de 
commande, d'autres sessions sur la Console d’administration StreamLine Library ou 
d'applications hôtes, en même temps que les modifications apportées aux partitions. 

La fenêtre contextuelle Confirm Apply s'affiche et indique la présence éventuelle de 
cartouches orphelines ou d'autres problèmes au niveau de la configuration actuelle des 
partitions. 

4. Cliquez sur Details pour afficher les messages d'avertissement détaillés expliquant 
les raisons de la présence de cartouches orphelines. 

Utilisez le bouton Details pour basculer entre les fenêtres développées et réduites des 
messages d'avertissement. 
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5. Dans la fenêtre développée des messages d'avertissement, vous pouvez réaliser les 
actions suivantes :

■ Cliquez sur Print pour imprimer les données du message détaillé.

■ Cliquez sur Save pour enregistrer les données du message dans un fichier de type 
csv. 

6. La procédure est la suivante :

■ Cliquez sur No pour annuler la mise à jour. La base de données du contrôleur de la 
bibliothèque de bandes n'est pas mise à jour mais toutes les modifications apportées 
aux partitions au cours de cette session sont conservées dans l'espace de travail de 
partition de la Console d’administration StreamLine Library. 

■ Cliquez sur Yes pour mettre à jour la base de données du contrôleur de la 
bibliothèque de bandes.

La fenêtre contextuelle Commit Success s'affiche. 

Cliquez sur OK pour revenir à la fenêtre Commit (Step 4). 

7. Toutes les applications hôtes de la bibliothèque de bandes concernées doivent à 
présent être configurées pour prendre en compte ces mises à jour. Consultez la 
documentation du logiciel de gestion des bandes pour plus d'informations 
concernant les procédures et les commandes. 
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▼ Modification des informations de synthèse des 
partitions.
Cette procédure permet de modifier le nom d'une partition existante ou de la capacité 
de stockage qui lui est affectée.

Remarque – Voir « Modification du type d'interface d'une connexion hôte-partition » 
page 314 pour modifier le type de connexion hôte-partition (HLI ou FC-SCSI). 

Remarque – Vous ne pouvez pas modifier l'identifiant des partitions. Pour affecter un 
identifiant de partition différent, vous devez supprimer l'ancienne partition, puis en 
créer une nouvelle avec un nouvel identifiant. 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Summary (Step 2)

La fenêtre Summary (Step 2) s'affiche.

2. Dans la liste déroulante Partition Summary, sélectionnez la partition à modifier. 

3. Cliquez sur Modify Partition.

La fenêtre contextuelle Modify a Partition s'affiche.

4. Saisissez les modifications souhaitées. 

5. Cliquez sur OK pour confirmer ces modifications. 
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▼ Suppression d'une partition
Cette procédure permet de supprimer une partition de la bibliothèque de bandes. Les 
modifications suivantes concernent la configuration de la partition de la bibliothèque 
de bandes :

■ Toutes les ressources affectées à la partition sont marquées comme disponibles. 

■ Toutes les connexions hôtes de la partition sont supprimées. 

■ L'identifiant de la partition est supprimé. 

Mise en garde – La suppression de partitions peut entraîner l'apparition de 
cartouches orphelines et la perte de données. Voir « Cartouches orphelines dans les 
bibliothèques de bandes non partitionnées » page 277 pour plus de détails. 

Remarque – La suppression de l'ensemble des partitions de la bibliothèque de bandes 
modifie l'état de la bibliothèque de bandes qui devient « non partitionnée ». Tous les 
hôtes auront accès à l'ensemble des cellules de stockage actives, lecteurs et CAP de 
rotation ou des AEM.

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Summary (Step 2)

La fenêtre Summary (Step 2) s'affiche.

2. Dans la liste déroulante Partition Summary, sélectionnez la partition à supprimer.

3. Cliquez sur Delete Partition.

Une fenêtre contextuelle de demande de confirmation s'affiche.

4. Cliquez sur OK pour confirmer la suppression. 

■ S'il reste des partitions dans la bibliothèque de bandes, reportez-vous à Étape 7. 
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■ S'il ne reste aucune partition, la fenêtre Select Library Interface Type s'affiche. 

5. Sélectionnez le type d'interface de la bibliothèque de bandes à affecter à toutes les 
connexions hôtes de la bibliothèque de bandes. Les différentes options sont les 
suivantes :

■ HLI

■ FC-SCSI

6. Cliquez sur OK pour confirmer la modification. 

7. Les mises à jour sont réalisées de la manière suivante :

Les modifications apportées à la configuration des partitions sont enregistrées dans 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
pendant la durée de la session en cours. 

Voir « Vérification de la configuration des partitions » page 303 et « Validation des 
modifications de la configuration des partitions » page 307 pour mettre à jour la base de 
données du contrôleur de la bibliothèque avec les modifications réalisées pendant la 
session Console d’administration StreamLine Library en cours. 

Si la bibliothèque de bandes ne comporte plus de partitions, l'état de la bibliothèque de 
bandes deviendra « non partitionnée » après validation des mises à jour. 



Tâches de gestion des partitions

314 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

▼ Modification du type d'interface d'une connexion 
hôte-partition 
Cette procédure permet de modifier le type de connexion hôte-partition d'une partition 
existante. Vous devez faire preuve de précaution lors de l'utilisation de cette procédure 
en raison des effets potentiels suivants :

■ La modification du type d'interface peut interrompre les connexions hôtes actives. 

■ Le basculement du type d'interface de FC-SCSI à HLI peut entraîner la perte des 
informations relatives à la connexion FC-SCSI. 

■ Étant donné que le partage des CAP de rotation et des AEM entre les types de 
partition n'est pas possible, la modification du type d'interface peut entraîner la 
perte des affectations des CAP partagés existants. Cela n'affecte pas les affectations 
des CAP réservés. 

Remarque – Voir « Modification des informations de synthèse des partitions. » 
page 311 pour modifier le nom ou la capacité de stockage d'une partition existante. 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Summary (Step 2)

La fenêtre Summary (Step 2) s'affiche.

2. Dans la liste déroulante Partition Summary, sélectionnez la partition à modifier. 

3. Cliquez sur Modify Partition.

La fenêtre contextuelle Modify a Partition s'affiche.
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4. Dans la liste déroulante Interface Type, sélectionnez le type d'interface à affecter. 
Cliquez sur OK.

5. La Console d’administration StreamLine Library vérifie la configuration actuelle 
des partitions dans l'espace de travail de la Console d’administration StreamLine 
Library. Si la partition comporte des affectations de CAP partagés ou dans le cas 
de partitions FC-SCSI, des fenêtres contextuelles d'avertissement concernant la 
connexion hôte-partition s'affichent. Exemples de fenêtres contextuelles pouvant 
apparaître : 

■ Basculement de HLI à FS-SCSI :

■ Basculement de FC-SCSI à HLI :

6. Cliquez sur Yes pour confirmer la modification. 

Les modifications apportées à la configuration des partitions sont enregistrées dans 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
pendant la durée de la session en cours. 

Voir « Vérification de la configuration des partitions » page 303 et « Validation des 
modifications de la configuration des partitions » page 307 pour mettre à jour la base de 
données du contrôleur de la bibliothèque avec les modifications réalisées pendant la 
session Console d’administration StreamLine Library en cours. 
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▼ Modification des détails de la connexion hôte-
partition FC-SCSI

Remarque – Cette procédure concerne uniquement les connexions hôte-partition 
FC-SCSI. La configuration des connexions hôte-partition HLI s'effectue par 
l'intermédiaire du logiciel de gestion des hôtes de la bibliothèque de bandes (HSC 
ou ACSLS) et non par le biais de la Console d’administration StreamLine Library. 
Pour plus d'informations, reportez-vous à la documentation HSC ou ACSLS. 

Cette procédure permet de modifier le numéro de port mondial (WWPN) ou le numéro 
LUN de la bibliothèque de bandes pour une connexion hôte-partition. 

Remarque – Vous pouvez modifier le numéro de port cible de la bibliothèque de 
bandes. Celui-ci est toujours « 0 ». 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Summary (Step 2)

La fenêtre Summary (Step 2) s'affiche.

2. Dans la section Summary de la fenêtre, cliquez sur la partition pour laquelle vous 
souhaitez modifier une connexion. 
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3. Dans la section Connections, cliquez sur la connexion hôte-partition à modifier. 

Remarque – Si vous sélectionnez une partition HLI, tous les boutons de la section 
Details de la fenêtre sont grisés. 

4. Cliquez sur Modify Connection.

La fenêtre contextuelle Modify a Connection s'affiche.

5. Saisissez les modifications souhaitées. 

6. Cliquez sur OK pour confirmer ces modifications. 

Les modifications apportées à la configuration des partitions sont enregistrées dans 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
pendant la durée de la session en cours. 

Voir « Vérification de la configuration des partitions » page 303 et « Validation des 
modifications de la configuration des partitions » page 307 pour mettre à jour la base de 
données du contrôleur de la bibliothèque avec les modifications réalisées pendant la 
session Console d’administration StreamLine Library en cours. 
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▼ Suppression d'une connexion hôte-partition 
FC-SCSI 

Remarque – Cette procédure concerne uniquement les connexions hôte-partition 
FC-SCSI. La configuration des connexions hôte-partition HLI s'effectue par 
l'intermédiaire du logiciel de gestion des hôtes de la bibliothèque de bandes (HSC 
ou ACSLS) et non par le biais de la Console d’administration StreamLine Library. 
Pour plus d'informations, reportez-vous à la documentation HSC ou ACSLS. 

Cette procédure permet de supprimer une connexion hôte-partition. Une fois la 
procédure terminée, l'hôte n'aura plus accès à la partition. 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Summary (Step 2)

La fenêtre Summary (Step 2) s'affiche.

2. Dans la section Summary de la fenêtre, cliquez sur la partition pour laquelle vous 
souhaitez supprimer une connexion. 

Remarque – Si vous sélectionnez une partition HLI, tous les boutons de la section 
Details de la fenêtre sont grisés. 
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3. Dans la section Connections, cliquez sur la connexion hôte-partition à supprimer.

4. Cliquez sur Delete Connection.

Une fenêtre contextuelle de demande de confirmation s'affiche.

5. Cliquez sur OK pour confirmer la suppression. 

Les modifications apportées à la configuration des partitions sont enregistrées dans 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
pendant la durée de la session en cours. 

Voir « Vérification de la configuration des partitions » page 303 et « Validation des 
modifications de la configuration des partitions » page 307 pour mettre à jour la base de 
données du contrôleur de la bibliothèque avec les modifications réalisées pendant la 
session Console d’administration StreamLine Library en cours. 
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▼ Actualisation de l'espace de travail des partitions 
de la Console d’administration StreamLine 
Library
Cette procédure permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Les données existantes comprennent 
l'ensemble des mises à jour réalisées par les autres utilisateurs dans la base de données 
du contrôleur de la bibliothèque de bandes par le biais de Interface de ligne de 
commande, d'autres sessions sur la Console d’administration StreamLine Library ou 
d'autres applications. 

Remarque – Une fois la procédure terminée, toutes les modifications non validées 
réalisées au cours de la session ouverte sur la Console d’administration StreamLine 
Library ne sont pas prises en compte. 

1. Sélectionnez Tools > Partitions.

2. Cliquez sur l'un des onglets suivants :

■ Summary (Step 2) 

■ Design (Step 3b)

La fenêtre sélectionnée s'affiche.

3. Dans la barre Options, cliquez sur Refresh. 

La fenêtre contextuelle Partition Refresh s'affiche.

4. Cliquez sur Yes pour confirmer la mise à jour. 

Les données des fenêtres de partition sont mises à jour avec les informations de la base 
de données du contrôleur de la bibliothèque de bandes. 
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▼ Réaffectation des ressources de la bibliothèque 
La réaffectation des ressources de la bibliothèque de bandes (cellules de stockage, 
lecteurs de bande, CAP de rotation ou des AEM ou cartouches) d'une partition à une 
autre s'effectue via l'une des fenêtres suivantes : 

■ « Partitions—Design (Step 3b) » page 365, pour les modules de base, de lecteur et de 
CEM

■ « Partitions—Design (Step 3b) – AEMs Only » page 372, pour les modules AEM

Pour ce faire, vous devez respecter les deux étapes suivantes : 

1. Supprimez la ressource de la partition à laquelle elle est affectée.

2. Affectez la ressource à une autre partition. 

Voir « Conception d'une partition : modules de base, DEM ou CEM » page 297 pour 
plus de détails.

Mise en garde – La réaffectation des ressources peut entraîner l'apparition de 
cartouches orphelines et la perte de données. Voir « Cartouches orphelines dans les 
bibliothèques de bandes non partitionnées » page 277 pour plus de détails. 
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▼ Remplacement du matériel dans une bibliothèque 
de bandes partitionnée
Certains remplacements du matériel de la bibliothèque de bandes, tels que les modules 
d'extension, l'ajout d'un deuxième robot ou l'ajout de cellules du CAP de rotation, 
peuvent nécessiter le retrait partiel ou total d'un module partitionné existant. Cette 
procédure permet de remplacer ces matériels en évitant la perte des informations de 
partitionnement des parties de la bibliothèque de bandes qui ne sont pas remplacées. 

Mise en garde – En cas de non respect de cette procédure, vous risquez de perdre les 
informations relatives à la configuration des partitions de la bibliothèque de bandes 
suite à un remplacement de matériel. 

1. Désaffectez des partitions les ressources de la bibliothèque de bandes (cellules de 
stockage, CAP de rotation et des AEM et lecteurs) devant être retirées dans le cadre 
du remplacement de matériel. 

Voir « Conception d'une partition : modules de base, DEM ou CEM » page 297 pour 
plus de détails.

2. Coupez l'alimentation de la bibliothèque de bandes. 

Voir « Mise hors tension de la bibliothèque de bandes » page 499 pour plus de 
détails. 

3. Installez le matériel de remplacement.

4. Mettez la bibliothèque de bandes sous tension. 

Voir « Mise sous tension de la bibliothèque de bandes » page 500 pour plus de 
détails. 

Les allocations des partitions des parties non remplacées dans la bibliothèque de 
bandes ne sont pas modifiées.

5. Affectez les ressources de la bibliothèque de bandes ayant été ajoutées suite au 
remplacement du matériel. 

Voir « Conception d'une partition : modules de base, DEM ou CEM » page 297 pour 
plus de détails.

Mise en garde – La réaffectation des ressources peut entraîner l'apparition de 
cartouches orphelines et la perte de données. Voir « Cartouches orphelines dans les 
bibliothèques de bandes non partitionnées » page 277 pour plus de détails. 
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Tâches des rapports de partitions

Tâche Page

Affichage d'un rapport de partition 324

Impression des données des rapports des partitions 326

Enregistrement des données des rapports des partitions 327

Affichage des détails de partition 328



Tâches des rapports de partitions

324 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

▼ Affichage d'un rapport de partition 
Cette procédure permet d'afficher l'un des rapports de partition suivants :

■ Cartridge Cell and Media Summary : ce rapport affiche une liste détaillée de toutes 
les affectations des ressources aux partitions.

■ Host Connections Summary : ce rapport affiche les informations détaillées relatives 
aux connexions hôte-partition pour l'ensemble des partitions.

■ Orphaned Cartridge Report : ce rapport affiche la liste détaillée de toutes les 
cartouches orphelines.

■ Partition Details : ce rapport affiche des informations détaillées concernant une 
partition sélectionnée.

■ Partition Summary : ce rapport affiche des informations de synthèse pour l'ensemble 
des partitions.

Remarque – Les rapports de partitions affichent les données enregistrées dans la base 
de données du contrôleur de la bibliothèque de bandes. En cas de modification de la 
configuration des partitions sans validation par le contrôleur de la bibliothèque de 
bandes en utilisant la fenêtre Commit (Step 4), les données indiquées dans ces rapports 
peuvent être différentes des données affichées dans les fenêtres de partition 
Summary (Step 2) et Design (Step 3b). 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Reports

La fenêtre Reports s'affiche.
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2. Dans la liste déroulante, sélectionnez le rapport à afficher. 

La fenêtre est mise à jour avec les informations de la base de données du contrôleur de 
la bibliothèque de bandes. 

3. Les procédures ci-dessous expliquent comment imprimer les données du rapport ou 
les enregistrer dans un fichier :

■ « Impression des données des rapports des partitions » page 326

■ « Enregistrement des données des rapports des partitions » page 327 
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▼ Impression des données des rapports des 
partitions
Cette procédure permet d'imprimer un rapport de partition. Cette action peut être 
réalisée depuis toutes les fenêtres des rapports de partition. 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Reports

La fenêtre Reports s'affiche.

2. Dans la liste déroulante, sélectionnez le rapport souhaité. 

Le rapport sélectionné s'affiche. Toutes les fenêtres des rapports comprennent les 
boutons Print et Save to File. 

3. Cliquez sur Print. 

La fenêtre contextuelle Print s'affiche. 

4. Complétez la fenêtre contextuelle d'impression, puis cliquez sur Print. 

Le rapport s'imprime sur l'imprimante sélectionnée. 
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▼ Enregistrement des données des rapports des 
partitions
Cette procédure permet d'enregistrer les données des rapports de partitions dans un 
fichier de type .csv (valeurs séparées par des virgules). Plusieurs types de tableurs 
permettent de visualiser le fichier. Cette action peut être réalisée depuis toutes les 
fenêtres des rapports de partition. 

1. Sélectionnez Tools > Partitions, puis cliquez sur l'onglet Reports

La fenêtre Reports s'affiche.

2. Dans la liste déroulante, sélectionnez le rapport souhaité. 

Le rapport sélectionné s'affiche. Toutes les fenêtres des rapports comprennent les 
boutons Print et Save to File. 

3. Cliquez sur Save to File.

La fenêtre contextuelle Save s'affiche. 

4. Cherchez le répertoire dans lequel vous souhaitez enregistrer le fichier et saisissez 
son nom. 

5. Cliquez sur Save. 

Les données sont enregistrées dans le fichier souhaité. 
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▼ Affichage des détails de partition 
Utilisez cette procédure pour afficher les délimitations actuelles des partitions et leurs 
affectations. Vous pouvez également afficher des informations détaillées sur la 
cartouche, le lecteur et les emplacements de cellule de stockage. 

Remarque – Cette procédure est disponible sur le Panneau opérateur local.

1. Sélectionnez Tools > Partitions.

2. Cliquez sur l'onglet Module Map (Step 3a). 

La fenêtre Module Map (Step 3a) s'affiche. 

3. Cliquez sur le module à afficher. 

Ce module apparaît en surbrillance à l'écran. 
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4. Cliquez sur l'onglet Current Partition Definitions.

La fenêtre Partition Definitions apparaît et affiche la configuration actuelle du module 
que vous avez sélectionné.

Vous pouvez déplacer le curseur de la souris sur une cellule, afin d'afficher une 
infobulle avec des informations détaillées sur la cellule. 
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Tâches des opérations sur les CAP 

Tâche Page

Association d'une partition FC-SCSI à ses CAP partagés 331

Insertion de cartouches dans une partition 334

Éjection des cartouches d'une partition 335

Suppression d'une association partition-CAP 336

Redéfinition des réservations 337
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▼ Association d'une partition FC-SCSI à ses CAP 
partagés
Cette procédure permet d'associer une partition FC-SCSI à ses CAP de rotation ou des 
AEM partagés. Cette procédure doit être réalisée avant l'insertion ou l'éjection de 
cartouches depuis une partition FC-SCSI à condition que les DEUX conditions 
suivantes soient remplies :

■ La partition doit partager un ou plusieurs CAP avec d'autres partitions, et 

■ l'application hôte FC-SCSI ne doit pas utiliser de réservations de CAP et 
interdire/autoriser des commandes.

Remarque – Cette procédure ne doit pas être utilisée dans le cas des partitions HLI 
car les applications hôtes HLI utilisent des réservations de CAP. En cas d'utilisation de 
cette procédure pour les partitions HLI, les hôtes ACSLS et HSC n'auront pas accès au 
CAP. 

Remarque – Cette procédure n'est pas nécessaire pour les CAP FC-SCSI réservés car 
une partition est toujours propriétaire de ses CAP réservés. 

Remarque – Les CAP des AEM sont soumis aux mêmes règles et restrictions de 
partitionnement que les CAP de rotation. Dans cette section, le terme « CAP » fait 
référence à ces deux types de CAP. 

Cette procédure accorde à la partition le droit exclusif d'utilisation de ses CAP partagés 
jusqu'à la suppression de l'association. Voir « Suppression d'une association partition-
CAP » page 336 pour plus de détails. 
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1. Sélectionnez Tools > Shared CAP Assignment. 

La fenêtre Shared CAP Assignment s'affiche.

2. Cochez les cases des partitions pour lesquelles vous souhaitez insérer des cartouches. 
Voir « Affectationdes CAP partagés » page 412 pour plus d'informations sur les 
champs de la fenêtre. 

3. Cliquez sur Apply. 

La fenêtre contextuelle CAP Confirm s'affiche. 

4. Cliquez sur OK. 
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5. Réalisez l'opération d'insertion ou d'éjection. Pour plus d'informations, reportez-
vous à l'une des procédures suivantes :

■ « Insertion de cartouches dans une partition » page 334

■ « Éjection des cartouches d'une partition » page 335
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▼ Insertion de cartouches dans une partition
Cette procédure décrit comment insérer ou charger en masse des cartouches dans une 
ou plusieurs partitions. Les partitions peuvent seulement utiliser les CAP de rotation 
ou des AEM qui leur sont affectés. 

Remarque – En cas d'insertion de cartouches dans une partition FC-SCSI comprenant 
un ou plusieurs CAP de rotation ou des AEM partagés et si l'application hôte n'utilise 
pas de réservations de CAP et interdit/autorise des commandes, vous devez préalable-
ment affecter la partition à ses CAP. Voir « Association d'une partition FC-SCSI à ses 
CAP partagés » page 331. Dans le cas contraire, le CAP risque de rester verrouillé et 
d'empêcher la partition d'obtenir l'utilisation exclusive du CAP. 

1. Suivez les étapes de l'une des procédures suivantes, selon que vous utilisiez un CAP 
de rotation ou des AEM :

■ « Insertion de cartouches via un CAP de rotation » page 138

■ « Chargement de cartouches en masse via un CAP des AEM » page 142

2. À la fin de la procédure, la réservation du CAP est annulée, comme suit :

■ Si vous réalisez cette procédure depuis un hôte HLI ou FC-SCSI utilisant des 
réservations de CAP, l'hôte supprime la réservation rendant le CAP disponible aux 
autres partitions. 

■ Si, avant de réaliser cette procédure, vous effectuez une association manuelle 
partition-CAP, vous pouvez maintenant supprimer cette association si la partition a 
terminé son opération sur le CAP. Pour plus d'informations, consultez « Suppression 
d'une association partition-CAP ». 

■ Si la partition FC-SCSI utilise un CAP réservé, le CAP reste verrouillé et réservé 
pour cette partition. 
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▼ Éjection des cartouches d'une partition
Cette procédure décrit comment éjecter ou décharger en masse des cartouches d'une 
bibliothèque de bandes partitionnée. Les partitions peuvent seulement utiliser les CAP 
de rotation ou des AEM qui leur sont affectés. 

Remarque – En cas d'éjection de cartouches dans une partition FC-SCSI comprenant 
un ou plusieurs CAP de rotation ou des AEM partagés et si l'application hôte n'utilise 
pas de réservations de CAP, vous devez préalablement affecter la partition à ses CAP. 
Voir « Association d'une partition FC-SCSI à ses CAP partagés » page 331. Dans le cas 
contraire, le CAP risque de rester verrouillé et d'empêcher la partition d'obtenir 
l'utilisation exclusive du CAP. 

1. Suivez les étapes de l'une des procédures suivantes, selon que vous utilisiez un CAP 
de rotation ou des AEM :

■ « Éjection de cartouches via un CAP de rotation » page 140

■ « Déchargement de cartouches en masse via un CAP des AEM » page 144

2. À la fin de la procédure, la réservation du CAP est annulée, comme suit :

■ Si vous réalisez cette procédure depuis un hôte HLI ou FC-SCSI utilisant des 
réservations de CAP, l'hôte supprime la réservation rendant le CAP disponible aux 
autres partitions. 

■ Si, avant de réaliser cette procédure, vous effectuez une association manuelle 
partition-CAP, vous pouvez maintenant supprimer cette association si la partition a 
terminé son opération sur le CAP. Pour plus d'informations, consultez « Suppression 
d'une association partition-CAP ». 

■ Si la partition FC-SCSI utilise un CAP réservé, le CAP reste verrouillé et réservé 
pour cette partition. 
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▼ Suppression d'une association partition-CAP
Utilisez cette procédure une fois l'opération d'insertion ou d'éjection terminée à 
condition que la partition soit préalablement affectée à ses CAP de rotation ou des 
AEM partagés. Cette procédure permet de supprimer les associations partition-CAP 
précédemment définies et rend disponible les CAP partagés aux autres partitions. 

Remarque – Les CAP des AEM sont soumis aux mêmes règles et restrictions de 
partitionnement que les CAP de rotation. Dans cette section, le terme « CAP » fait 
référence à ces deux types de CAP. 

1. Sélectionnez Tools > Shared CAP Assignment. 

La fenêtre Shared CAP Assignment s'affiche.

2. Décochez les partitions affectées à des CAP. Voir « Affectationdes CAP partagés » 
page 412 pour plus d'informations sur les champs de la fenêtre. 

3. Cliquez sur Apply. 

La fenêtre contextuelle CAP Confirm s'affiche. 

4. Cliquez sur OK. 
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▼ Redéfinition des réservations
Utilisez cette procédure lorsqu'une partition a réservé un CAP de rotation ou des AEM 
partagé mais que cette réservation ne peut pas être annulée depuis l'hôte ACSLS ou 
HSC. 

Remarque – Cela concerne uniquement les bibliothèques de bandes partitionnées. 
Dans le cas d'une bibliothèque de bandes non partitionnée, les réservations des CAP 
doivent toujours être annulées par l'intermédiaire des ACSLS ou HSC. Pour plus 
d'informations, consultez la documentation HSC ou ACSLS.

Remarque – Vous devez respecter toutes les étapes de cette procédure. Si la procédure 
n'est pas menée à son terme, le CAP risque de rester indisponible pour l'ensemble des 
partitions et/ou les cartouches affectées à une partition risquent d'être insérées dans 
une autre partition. 

Remarque – Les CAP des AEM sont soumis aux mêmes règles et restrictions de 
partitionnement que les CAP de rotation. Dans cette section, le terme « CAP » fait 
référence à ces deux types de CAP. 

1. Sélectionnez Tools > Diagnostics.

2. Développez le dossier CAP, puis cliquez sur le CAP pour lequel vous souhaitez 
modifier (annuler) la réservation. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 
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3. Cliquez sur l'onglet Unreserve.

La fenêtre Unreserve s'affiche et indique la partition ayant réservé le CAP.

4. Cliquez sur Apply pour redéfinir la réservation.

La fenêtre contextuelle Unreserve Confirm s'affiche et indique « This will remove the 
reservation from the designated host... » 

■ Cliquez sur OK pour poursuivre l'opération. La bibliothèque de bandes annule la 
réservation de CAP et paramètre l'utilisateur du CAP sur « par défaut », ce qui rend 
le CAP indisponible pour l'ensemble des partitions.

■ Cliquez sur Cancel pour annuler l'opération de redéfinition et revenir à Étape 3. 

5. Si le CAP est verrouillé, vous pouvez le déverrouiller depuis la Console 
d’administration StreamLine Library. Voir « Déverrouillage de la porte d'accès du 
CAP ou de l'AEM » page 133 pour plus de détails. 

6. Appuyez sur le bouton CAP pour ouvrir le CAP. 

■ S'il est vide, reportez-vous à Étape 8. 

■ S'il contient des cartouches, retirez-les. 

7. Étiquetez les cartouches en indiquant l'identifiant de la partition qui s'affiche sur 
Étape 3. 
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8. Appuyez sur le bouton CAP pour refermer le CAP. 

Le CAP se ferme et se verrouille automatiquement et le voyant du bouton CAP s'éteint.

La bibliothèque de bandes analyse le CAP et vérifie qu'il est vide. Elle change ensuite 
l'état du CAP qui devient « unreserved », ce qui rend le CAP disponible pour 
l'ensemble des partitions auxquelles il est affecté. 

Remarque – Vous devrez peut-être actualiser l'affichage du CAP pour visualiser son 
nouvel état. 

9. Contactez une personne chargée de la gestion des cartouches enlevées afin de 
déterminer de quelle manière elles seront traitées. Si elles doivent être insérées à 
nouveau dans la bibliothèque de bandes, elles doivent être introduites dans la 
partition appropriée. 
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Référence des fenêtres de partition
Le présent paragraphe décrit en détail l'ensemble des fenêtres de la Console 
d’administration StreamLine Library concernant les partitions, organisées selon le 
chemin de navigation de la fenêtre. Par exemple, Partitions—Summary (Step 2)—
Add Connection correspond à la fenêtre accessible en cliquant sur Tools, puis sur 
Partitions dans la barre Menu, puis en cliquant ensuite sur l'onglet Summary (Step 2) 
et le bouton Add Connection. 

Remarque – Seule la fenêtre Partitions—Current Partition Definitions est accessible 
depuis le Panneau opérateur local. Les autres fenêtres sont uniquement accessibles 
depuis la Console d'administration StreamLine Library autonome ou la Console 
d’administration StreamLine Library Web.

Les fenêtres de partition se divisent en plusieurs catégories :

■ « Fenêtres de synthèse des partitions » page 341

■ « Fenêtres de conception et de validation des partitions » page 362

■ « Partition Report Screens » page 390

■ « Fenêtres d'opération de CAP de partition » page 411

Remarque – Les fenêtres de partition Summary (Step 2) et Design (Step 3b) ainsi 
que toutes les fenêtre popup correspondantes donnent accès à un espace de travail 
dynamique pour la conception de vos partitions de la bibliothèque de bandes. 
Toutes les informations relatives à la configuration des partitions sont enregistrées 
automatiquement dans l'espace de travail des partitions dans la mémoire de la Console 
d’administration StreamLine Library et sont conservées pendant toute la durée de votre 
session sur la Console d’administration StreamLine Library. Ainsi, vous pouvez passer 
d'une fenêtre de partition à l'autre, revenir aux fenêtres de partition autant de fois que 
vous le souhaitez sans perdre vos modifications de configuration. 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 
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Fenêtres de synthèse des partitions

Partitions—Instructions (Step 1)

Partitions—Summary (Step 2)

Partitions—Summary (Step 2)—Add Connection

Partitions—Summary (Step 2)—Delete Connection

Partitions—Summary (Step 2)—Modify Connection

Partitions—Summary (Step 2)—Add Connection

Partitions—Summary (Step 2)—Add Connection

Partitions—Summary (Step 2)—Modify Partition



Fenêtres de synthèse des partitions

342 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

Partitions—Instructions (Step 1)

Exemple de fenêtre

Description
Cette fenêtre affiche les consignes d'utilisation des fenêtres des partitions.

Remarque – Cette fenêtre s'affiche automatiquement lors de la première utilisation de 
Tools > Partitions au cours d'une session ouverte sur la Console d’administration 
StreamLine Library. 

Champs de la fenêtre
Aucun
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Boutons
? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports 
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Partitions—Summary (Step 2)

Exemple de fenêtre

Description
Cette fenêtre affiche des informations de synthèse concernant la bibliothèque de bandes 
et éventuellement une partition sélectionnée. 

Elle comprend également des boutons permettant de réaliser les actions suivantes :

■ Ajout d'une nouvelle partition 

■ Suppression d'une partition de la bibliothèque de bandes

■ Modification des informations de synthèse des partitions 

Remarque – Les boutons suivants concernent uniquement les connexions hôte-
partition FC-SCSI. La configuration des connexions hôte-partition HLI s'effectue par 
l'intermédiaire du logiciel de gestion des hôtes de la bibliothèque de bandes (HSC ou 
ACSLS) et non par le biais de la Console d’administration StreamLine Library. Pour 
plus d'informations, reportez-vous à la documentation HSC ou ACSLS. 
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■ Ajout d'une nouvelle connexion hôte-partition

■ Suppression d'une connexion hôte-partition

■ Modification de la configuration d'une connexion hôte-partition

Champs de la fenêtre

Partition Summary

Partition Number

Affichage uniquement.

Identifiant affecté à la partition. Les identifiants sont compris entre 1 et 8.

Cellules de stockage

Affichage uniquement.

Nombre total de cellules de stockage affectées à la partition. 

Drive Bays

Affichage uniquement.

Nombre total de lecteurs de bande affectés à la partition. 

CAP 

Affichage uniquement.

Nombre total de CAP de rotation affectés à la partition. Ce nombre correspond à des 
CAP complets et non à des cellules du CAP. 

AEM 

Affichage uniquement.

Nombre total d'AEM affectés à la partition. Ce nombre correspond à des AEM 
complets et non à des cellules de l'AEM. 

CAP+AEM Cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation et des AEM affectées à la partition. 

%Licensed Capacity 

Affichage uniquement.

Pourcentage de la capacité autorisée de la bibliothèque de bandes affectée à cette 
partition. Il se calcule de la manière suivante :

(partition) Allocated Storage Cells / (total library) Licensed Capacity 

Details for Partition n 

Remarque – Les champs suivants affichent des informations relatives à la connexion 
hôte-partition correspondant à la partition actuellement sélectionnée dans le tableau 
Partition Summary. 
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Name

Affichage uniquement.

Nom de la partition sélectionnée. 

Interface Type 

Affichage uniquement.

Type d'interface affecté à la connexion hôte-partition sélectionnée. Les différentes 
options sont les suivantes :

■ HLI

■ FC-SCSI

Remarque – Les champs suivants concernent uniquement les connexions hôte-
partition FC-SCSI. 

Connexions

Initiator (WWPN) 

Affichage uniquement.

Nom de port mondial de l'adaptateur de bus hôte FC-SCSI (HBA). 

Target Port 

Affichage uniquement.

Numéro du port du contrôleur de la bibliothèque de bandes SL3000. Ce numéro est 
toujours « 0 ». 

LUN

Affichage uniquement.

Numéro d'unité logique de la partition de la bibliothèque de bandes sur l'hôte. Il 
doit s'agir d'un numéro unique sur l'hôte. 

Total des ressources de la bibliothèque de bandes

Cellules de stockage 

Affichage uniquement.

Capacité physique totale de la bibliothèque de bandes.

Drive Bays  

Affichage uniquement.

Nombre total de lecteurs de bande dans la bibliothèque de bandes.

CAP 

Affichage uniquement.

Nombre total de CAP de rotation dans la bibliothèque de bandes.

AEM 

Affichage uniquement.

Nombre total d'AEM dans la bibliothèque de bandes.



Fenêtres de synthèse des partitions

418605501 • Révision AB Chapitre 6 Partitionnement de la bibliothèque de bandes 347

CAP cells

Affichage uniquement.

Nombre total de cellules de CAP de rotation dans la bibliothèque de bandes.

AEM Cells 

Affichage uniquement.

Nombre total de cellules de l'AEM dans la bibliothèque de bandes.

Licensed Capacity 

Affichage uniquement.

Capacité de stockage autorisée totale de la bibliothèque de bandes. 

Ressources affectées 

Cellules de stockage 

Affichage uniquement.

Nombre total de cellules de stockage affectées à l'ensemble des partitions de la 
bibliothèque de bandes dans la fenêtre Design (Step 3b). 

Drive Bays  

Affichage uniquement.

Nombre total de lecteurs de bande affectés à l'ensemble des partitions de la 
bibliothèque de bandes.

CAP 

Affichage uniquement.

Nombre total de CAP de rotation affectés à l'ensemble des partitions de la 
bibliothèque de bandes.

AEM 

Affichage uniquement.

Nombre total d'AEM affectés à l'ensemble des partitions de la bibliothèque de 
bandes.

CAP cells

Affichage uniquement.

Nombre total de cellules de CAP de rotation affectées à l'ensemble des partitions de 
la bibliothèque de bandes.

AEM cells

Affichage uniquement.

Nombre total de cellules d'AEM affectées à l'ensemble des partitions de la 
bibliothèque de bandes.

Licensed Capacity 

Affichage uniquement.

Capacité de stockage autorisée totale affectée à l'ensemble des partitions de la 
bibliothèque de bandes par le biais de la fenêtre Add Partition ou Modify Partition. 
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Ressources non affectées 

Cellules de stockage 

Affichage uniquement.

Nombre total de cellules de stockage de la bibliothèque de bandes qui ne sont 
affectées à aucune partition.

Drive Bays  

Affichage uniquement.

Nombre total de lecteurs de bande de la bibliothèque de bandes qui ne sont affectés 
à aucune partition.

CAP 

Affichage uniquement.

Nombre total de CAP de rotation de la bibliothèque de bandes qui ne sont affectés à 
aucune partition.

AEM 

Affichage uniquement.

Nombre total d'AEM de la bibliothèque de bandes qui ne sont affectés à aucune 
partition.

CAP cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation de la bibliothèque de bandes qui ne 
sont affectées à aucune partition.

AEM cells

Affichage uniquement.

Nombre total de cellules d'AEM de la bibliothèque de bandes qui ne sont affectées à 
aucune partition.

Licensed Capacity 

Affichage uniquement.

Capacité de stockage autorisée totale affectée à aucune partition de la bibliothèque 
de bandes par le biais de la fenêtre Add Partition ou Modify Partition. Il se calcule 
de la manière suivante :

(total library) Licensed Capacity – (allocated) Licensed Capacity 

Boutons
Refresh 

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 
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? (Help)

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Add Partition

Ce bouton permet d'ajouter une nouvelle partition. La fenêtre contextuelle 
Partitions—Summary (Step 2)—Add Connection s'affiche. 

Delete Partition

Ce bouton permet de supprimer la partition sélectionnée. La fenêtre contextuelle 
Partitions—Summary (Step 2)—Add Connection s'affiche. 

Modify Partition

Ce bouton permet de modifier les informations de synthèse de la partition 
actuellement sélectionnée. La fenêtre contextuelle Partitions—Summary 
(Step 2)—Modify Partition s'affiche. 

Remarque – Les boutons suivants concernent uniquement les connexions hôte-
partition FC-SCSI. 

Add Connection

Ce bouton permet d'ajouter une nouvelle connexion hôte à la partition actuellement 
sélectionnée. La fenêtre contextuelle Partitions—Summary (Step 2)—Add 
Connection s'affiche. 

Delete Connection

Ce bouton permet de supprimer la connexion hôte-partition actuellement 
sélectionnée. La fenêtre contextuelle Partitions—Summary (Step 2)—Delete 
Connection s'affiche.

Modify Connection

Ce bouton permet de modifier la configuration de la connexion hôte-partition 
actuellement sélectionnée. La fenêtre contextuelle Partitions—Summary 
(Step 2)—Modify Connection s'affiche.

Voir aussi
■ Partitions—Summary (Step 2) 

■ Partitions—Summary (Step 2)—Add Connection 

■ Partitions—Summary (Step 2)—Add Connection 

■ Partitions—Summary (Step 2)—Modify Partition 

■ Partitions—Summary (Step 2)—Add Connection 

■ Partitions—Summary (Step 2)—Delete Connection 

■ Partitions—Summary (Step 2)—Modify Connection 

■ Partitions—Module Map (Step 3a) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports 
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Partitions—Summary (Step 2)—Add Connection

Exemple de fenêtre

Description
Cette fenêtre permet de configurer la connexion entre un hôte et la partition 
sélectionnée. Chaque partition peut comprendre jusqu'à neuf connexions hôte-partition, 
chacune ayant un LUN unique. 

Remarque – Cette fenêtre est uniquement disponible pour les connexions hôte-
partition FC-SCSI. La configuration des connexions hôte-partition HLI s'effectue par 
l'intermédiaire du logiciel de gestion des hôtes de la bibliothèque de bandes (HSC ou 
ACSLS) et non par le biais de la Console d’administration StreamLine Library. Pour 
plus d'informations, reportez-vous à la documentation HSC ou ACSLS.

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Add 
Connection dans la fenêtre Partitions—Summary (Step 2). 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Connections n 

Affichage uniquement.

Identifiant de la partition sélectionnée. 
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Initiator (WWPN)

Requis.

Nom de port mondial de l'adaptateur de bus hôte FC-SCSI (HBA). 

Seize chiffres hexadécimaux. Ces chiffres peuvent être saisis en minuscule ou en 
majuscule. Toutefois, ils apparaîtront toujours en majuscule. 

Target Port

Affichage uniquement.

Numéro du port du contrôleur de la bibliothèque de bandes SL3000. Ce numéro est 
toujours « 0 ». 

LUN

Requis.

Numéro d'unité logique de la partition de la bibliothèque de bandes sur l'hôte. Il 
doit s'agir d'un numéro unique sur l'hôte. Vous pouvez créer jusqu'à neuf LUN 
uniques par partition. 

Remarque – Chaque initiateur connecté à la bibliothèque de bandes doit comporter 
une partition de la bibliothèque de bandes affectée à LUN 0. Lors de la vérification 
ou de la validation des modifications apportées à la configuration des partitions, la 
Console d’administration StreamLine Library vous informera si un initiateur ne 
respecte pas cette condition. 

Boutons
OK

Cliquez sur ce bouton pour mettre à jour l'espace de travail de partition de la 
Console d’administration StreamLine Library avec les paramètres actuels de la 
fenêtre et revenir à la fenêtre précédente. 

Remarque – En cliquant sur ce bouton, la base de données du contrôleur de la 
bibliothèque de bandes n'est pas mise à jour. 

Cancel

Cliquez sur ce bouton pour annuler les paramètres actuels de la fenêtre et revenir à 
la fenêtre précédente. 

Voir aussi
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Delete Connection

Exemple de fenêtre

Description
Cette fenêtre permet de supprimer la connexion hôte-partition actuellement 
sélectionnée. 

Remarque – Cette fenêtre est uniquement disponible pour les connexions hôte-
partition FC-SCSI. La configuration des connexions hôte-partition HLI s'effectue par 
l'intermédiaire du logiciel de gestion des hôtes de la bibliothèque de bandes (HSC ou 
ACSLS) et non par le biais de la Console d’administration StreamLine Library. Pour 
plus d'informations, reportez-vous à la documentation HSC ou ACSLS.

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Delete 
Connection dans la fenêtre Partitions—Summary (Step 2). 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Aucun

Boutons
OK

Cliquez sur ce bouton pour mettre à jour l'espace de travail de partition de la 
Console d’administration StreamLine Library avec les paramètres actuels de la 
fenêtre et revenir à la fenêtre précédente. 
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Remarque – En cliquant sur ce bouton, la base de données du contrôleur de la 
bibliothèque de bandes n'est pas mise à jour. 

Cancel

Cliquez sur ce bouton pour annuler les paramètres actuels de la fenêtre et revenir à 
la fenêtre précédente. 

Voir aussi
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Modify Connection

Exemple de fenêtre

Description
Cette fenêtre permet de modifier la configuration de la connexion hôte-partition 
actuellement sélectionnée. 

Remarque – Cette fenêtre est uniquement disponible pour les connexions hôte-
partition FC-SCSI. La configuration des connexions hôte-partition HLI s'effectue par 
l'intermédiaire du logiciel de gestion des hôtes de la bibliothèque de bandes (HSC ou 
ACSLS) et non par le biais de la Console d’administration StreamLine Library. Pour 
plus d'informations, reportez-vous à la documentation HSC ou ACSLS.

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Modify 
Connection dans la fenêtre Partitions—Summary (Step 2). 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Connections n 

Affichage uniquement.

Identifiant de la partition sélectionnée. 
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Initiator (WWPN)

Nom de port mondial de l'adaptateur de bus hôte FC-SCSI (HBA). 

Seize chiffres hexadécimaux. Ces chiffres peuvent être saisis en minuscule ou en 
majuscule. Toutefois, ils apparaîtront toujours en majuscule. 

La fenêtre affiche la valeur précédente. Vous pouvez la laisser en l'état ou la 
modifier. 

Target Port

Affichage uniquement.

Numéro du port du contrôleur de la bibliothèque de bandes SL3000. Ce numéro est 
toujours « 0 ». 

LUN

Requis.

Numéro d'unité logique de la partition de la bibliothèque de bandes sur l'hôte. Il 
doit s'agir d'un numéro unique sur l'hôte. 

Remarque – Chaque initiateur connecté à la bibliothèque de bandes doit comporter 
une partition de la bibliothèque de bandes affectée à LUN 0. Lors de la vérification ou 
de la validation des modifications apportées à la configuration des partitions, la 
Console d’administration StreamLine Library vous informera si un initiateur ne 
respecte pas cette condition. 

Boutons
OK

Cliquez sur ce bouton pour mettre à jour l'espace de travail de partition de la 
Console d’administration StreamLine Library avec les paramètres actuels de la 
fenêtre et revenir à la fenêtre précédente. 

Remarque – En cliquant sur ce bouton, la base de données du contrôleur de la 
bibliothèque de bandes n'est pas mise à jour. 

Cancel

Cliquez sur ce bouton pour annuler les paramètres actuels de la fenêtre et revenir à 
la fenêtre précédente. 

Voir aussi
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Add Connection 

Exemple de fenêtre

Description
Cette fenêtre permet d'ajouter une nouvelle partition. Vous pouvez créer jusqu'à huit 
partitions avec des identifiants compris entre 1 et 8. 

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Add Partition 
dans la fenêtre Partitions—Summary (Step 2). 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Select a Partition ID

Requis.

Identifiant de la partition à ajouter compris entre 1 et 8. 

La liste déroulante affiche les identifiants disponibles. La valeur par défaut est le 
prochain identifiant dans l'ordre numérique. 

Name 

Facultatif.

Nom que vous souhaitez donner à la partition. 

0-60 caractères ASCII. 
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Interface Type 

Requis.

Type d'interface devant être utilisé pour la connexion hôte-partition. Les différentes 
options sont les suivantes :

■ HLI

■ FC-SCSI 

Boutons
OK

Cliquez sur ce bouton pour mettre à jour l'espace de travail de partition de la 
Console d’administration StreamLine Library avec les paramètres actuels de la 
fenêtre et revenir à la fenêtre précédente. 

Remarque – En cliquant sur ce bouton, la base de données du contrôleur de la 
bibliothèque de bandes n'est pas mise à jour. 

Cancel

Cliquez sur ce bouton pour annuler les paramètres actuels de la fenêtre et revenir à 
la fenêtre précédente. 

Voir aussi
■ Partitions—Summary (Step 2) 



Fenêtres de synthèse des partitions

358 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

Partitions—Summary (Step 2)—Add Connection

Exemple de fenêtre

Description
Cette fenêtre permet de confirmer la suppression de la partition sélectionnée. Toutes les 
données de la partition, y compris les connexions hôte-partition, les délimitations de la 
partition et l'identifiant de la partition, sont supprimées de l'espace de travail des 
partitions de la Console d’administration StreamLine Library. 

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Delete 
Partition dans la fenêtre Partitions—Summary (Step 2). 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Aucun

Boutons
OK

Cliquez sur ce bouton pour mettre à jour l'espace de travail de partition de la 
Console d’administration StreamLine Library avec les paramètres actuels de la 
fenêtre et revenir à la fenêtre précédente. 

Remarque – En cliquant sur ce bouton, la base de données du contrôleur de la 
bibliothèque de bandes n'est pas mise à jour. 
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Cancel

Cliquez sur ce bouton pour annuler les paramètres actuels de la fenêtre et revenir à 
la fenêtre précédente. 

Voir aussi
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Modify Partition

Exemple de fenêtre

Description
Cette fenêtre permet de modifier le nom ou le type de connexion hôte-partition affecté 
à la partition sélectionnée. 

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Modify 
Partition dans la fenêtre Partitions—Summary (Step 2). 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Modify Partition n 

Affichage uniquement.

Identifiant de la partition à modifier. 

Name 

Requis.

Nom que vous souhaitez donner à la partition. 

0-60 caractères ASCII. 

La fenêtre affiche la valeur précédente. Vous pouvez la laisser en l'état ou la 
modifier. 



Fenêtres de synthèse des partitions

418605501 • Révision AB Chapitre 6 Partitionnement de la bibliothèque de bandes 361

Interface Type 

Type d'interface devant être utilisé pour la connexion hôte-partition. Les différentes 
options sont les suivantes :

■ HLI

■ FC-SCSI 

La fenêtre affiche la valeur précédente. Vous pouvez la laisser en l'état ou la 
modifier. 

Remarque – La modification du type d'interface peut interrompre les connexions 
hôtes actives et entraîner la perte des affectations des CAP de rotation ou des AEM 
partagés. Voir « Modification du type d'interface d'une connexion hôte-partition » 
page 314 pour plus de détails. 

Boutons
OK

Cliquez sur ce bouton pour mettre à jour l'espace de travail de partition de la 
Console d’administration StreamLine Library avec les paramètres actuels de la 
fenêtre et revenir à la fenêtre précédente. 

Remarque – En cliquant sur ce bouton, la base de données du contrôleur de la 
bibliothèque de bandes n'est pas mise à jour. 

Cancel

Cliquez sur ce bouton pour annuler les paramètres actuels de la fenêtre et revenir à 
la fenêtre précédente. 

Voir aussi
■ Partitions—Summary (Step 2) 
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Fenêtres de conception et de validation 
des partitions

Partitions—Design (Step 3b)

Partitions—Design (Step 3b) – AEMs Only

Partitions—Design (Step 3b)—Verify Results

Partitions—Commit (Step 4)

Partitions—Commit (Step 4)—Confirm Apply

Partitions—Current Partition Definitions
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Partitions—Module Map (Step 3a)

Exemple de fenêtre

Description
Cette fenêtre permet de sélectionner le module de la bibliothèque de bandes pour 
lequel vous souhaitez définir des délimitations de partition. 

Champs de la fenêtre
Select a module from the map below 

Requis.

Cette fenêtre affiche un schéma de la configuration actuelle des modules de la 
bibliothèque de bandes. Cette information provient directement de la base de 
données du contrôleur de la bibliothèque de bandes. 

Cliquez sur le module pour lequel vous souhaitez définir une partition, puis cliquez 
sur l'onglet Design (Step 3b). 
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Boutons
? (Help)

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Design (Step 3b) 

■ Partitions—Design (Step 3b) – AEMs Only 
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Partitions—Design (Step 3b)

Remarque – Cette section décrit ls fenêtres Design (Step 3b) pour les modules de base, 
de lecteur et de CEM. Pour les modules d'AEM, voir « Partitions—Design (Step 3b) –
 AEMs Only » page 372. 

Exemple de fenêtre

Description
Cette fenêtre permet de définir les délimitations de la partition en sélectionnant les 
ressources à inclure dans la partition (cellules de stockage, lecteurs de bande ou CAP 
de rotation). Vous pouvez utiliser l'une des méthodes suivantes pour ajouter ou 
supprimer des ressources dans une partition (voir « Library Map » page 369 pour 
plus d'informations) : 

■ Sélection de cellules individuelles ou de groupes de cellules 

■ Sélection d'une colonne entière d'un module de la bibliothèque de bandes (de haut 
en bas) 

■ Sélection d'une partie d'un module de la bibliothèque de bandes (avant ou arrière) 

■ Sélection d'un module entier de la bibliothèque de bandes
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Remarque – Cette fenêtre apparaît uniquement si la définition des partitions de la 
bibliothèque de bandes a été réalisée par le biais de la fenêtre Partitions—Summary 
(Step 2)—Add Connection. 

Mise en garde – La modification des délimitations des partitions peut entraîner 
l'apparition de cartouches orphelines et la perte de données. Voir « Cartouches 
orphelines dans les bibliothèques de bandes non partitionnées » page 277 pour plus 
de détails. 

Remarque – Les fenêtres de partition Summary (Step 2) et Design (Step 3b) ainsi 
que toutes les fenêtre popup correspondantes donnent accès à un espace de travail 
dynamique pour la conception de vos partitions de la bibliothèque de bandes. 
Toutes les informations relatives à la configuration des partitions sont enregistrées 
automatiquement dans l'espace de travail des partitions dans la mémoire de la Console 
d’administration StreamLine Library et sont conservées pendant toute la durée de votre 
session sur la Console d’administration StreamLine Library. Ainsi, vous pouvez passer 
d'une fenêtre de partition à l'autre, revenir aux fenêtres de partition autant de fois que 
vous le souhaitez sans perdre vos modifications de configuration. 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Partition

Requis.

Partition pour laquelle vous souhaitez ajouter ou supprimer des ressources (cellules 
de stockage, lecteurs de bande ou CAP de rotation). 

La liste déroulante affiche tous les identifiants de partition valides pour la 
bibliothèque de bandes.Elle identifie également leur type d'interface hôte (FC-SCSI 
ou HLI). Si aucun identifiant de partition n'a été défini, la liste est vide. 

Remarque – Lorsque vous sélectionnez une partition, la fenêtre est automatiquement 
actualisée et affiche les données de l'espace de travail de la partition de la Console 
d’administration StreamLine Library. 

Select by

Requis.
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Ce champ permet de choisir la méthode à utiliser pour la définition des 
délimitations de la partition. Les différentes options sont les suivantes :

■ Cell : sélection de ressources individuelles ou de groupes rectangulaires de 
ressources.

■ Column : sélection de toutes les ressources d'une colonne. 

■ Side : sélection de toutes les ressources d'une partie d'un module de la 
bibliothèque de bandes, à l'exception des CAP. 

■ Module : sélection de toutes les ressources d'un module de la bibliothèque de 
bandes, à l'exception des CAP. 

Remarque – Vous devez sélectionner Add ou Remove. 

Add 

Requis.

Ce champ indique que vous souhaitez ajouter des ressources à la partition. Vous 
pourrez uniquement cliquer sur les cellules non affectées sur le plan de la 
bibliothèque de bandes. 

Remove

Requis.

Ce champ indique que vous souhaitez supprimer des ressources de la partition. Vous 
pourrez uniquement cliquer sur les cellules déjà affectées sur le plan de la 
bibliothèque de bandes. 

Allocated to Partition n 

Remarque – En sélectionnant une partition, les données indiquées dans ces champs 
sont automatiquement mises à jour depuis l'espace de travail de la partition sur la 
Console d’administration StreamLine Library.

Storage Cells 

Affichage uniquement.

Nombre total de cellules de stockage affectées à la partition sélectionnée en fonction 
des délimitations de la partition actuellement définies. 

Drive Bays

Affichage uniquement.

Nombre total de lecteurs de bande affectés à la partition sélectionnée en fonction des 
délimitations de la partition actuellement définies. 

CAP Cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation ou des AEM affectées à la partition 
sélectionnée en fonction des délimitations de la partition actuellement définies. 
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Unallocated in Library 

Remarque – En sélectionnant une partition, les données indiquées dans ces champs 
sont automatiquement mises à jour depuis l'espace de travail de la partition sur la 
Console d’administration StreamLine Library.

Storage Cells 

Affichage uniquement.

Nombre total de cellules de stockage de la bibliothèque de bandes qui ne sont 
affectées à aucune partition.

Drive Bays

Affichage uniquement.

Nombre total de lecteurs de bande de la bibliothèque de bandes qui ne sont affectés 
à aucune partition.

CAP Cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation et des AEM de la bibliothèque de 
bandes qui ne sont affectées à aucune partition.

Licensed Capacity 

Remarque – Ce champ apparaît uniquement si la capacité autorisée de la bibliothèque 
de bandes n'a pas entièrement été utilisée. Si les affectations dépassent la capacité 
autorisée (situation de dépassement), le champ Oversubscription apparaît. 

Affichage uniquement.

Capacité autorisée totale de la bibliothèque de bandes qui n'est affectée à aucune 
partition. Il se calcule de la manière suivante :

Total licensed capacity – Total allocated storage cells 

Oversubscription 

Remarque – Ce champ apparaît uniquement si le nombre d'affectations dépasse la 
capacité autorisée (situation de dépassement). Si la capacité autorisée de la bibliothèque 
de bandes n'a pas entièrement été utilisée, le champ Licensed Capacity apparaît. 

Affichage uniquement.

Capacité autorisée totale de la bibliothèque de bandes dépassée en raison du nombre 
d'affectations de partition. Il se calcule de la manière suivante :

Total allocated storage cells – Total licensed capacity 

Vous devez supprimer les excédents d'affectations avant de valider vos 
modifications sur la fenêtre Commit (Step 4). 
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Legend 
Il s'agit de la légende du plan de la bibliothèque de bandes. L'état de chaque 
ressource de la bibliothèque de bandes (cellule de stockage, lecteur de bande ou 
cellule du CAP de rotation) s'affiche de la manière suivante : 

■ Not Accessible (rectangle blanc et b-arré d'une croix). Aucune partition n'a accès à 
la ressource. Quelques exemples de causes :

- Les cellules de stockage ont été configurées pour des cartouches de diagnostic. 

- Les cellules de stockage ne sont pas comprises dans la capacité autorisée de la 
bibliothèque de bandes. 

■ Unallocated. La ressource n'est actuellement affectée à aucune partition et par 
conséquent peut être utilisée par la partition sélectionnée. 

■ Partition n (doré). La ressource est affectée à la partition sélectionnée, partition n. 

■ Other Partitions (rouge). La ressource est affectée à une autre partition et, par 
conséquent, ne peut PAS être utilisée par la partition sélectionnée. 

■ Shared CAP (fond gris). Le CAP a été affecté à une partition minimum. Le type 
d'interface hôte affecté au CAP (HLI ou FC-SCSI) s'affiche. 

■ Cartridge (icône cartouche). La ressource contient une cartouche de bande. 

■ Les emplacements dans lesquels sont installés des lecteurs sont indiqués par une 
bordure épaisse. Les emplacements des lecteurs vides sont indiqués par une 
bordure fine. 

Library Map 
Représentation graphique de la configuration actuelle de la bibliothèque de bandes. 
L'affichage initial de la session en cours sur la Console d’administration StreamLine 
Library provient de la base de données du contrôleur de la bibliothèque de bandes. 
Ensuite, l'affichage prend en compte les données de l'espace de travail de la partition 
sur la Console d’administration StreamLine Library lorsque vous modifiez la 
configuration des partitions. L'affichage comprend les informations suivantes :

■ Type de module actuellement affiché : module de base, module d'extension de 
lecteur ou module d'extension de stockage (PEM, Parking expansion module). 

■ Identifiant numérique du module (1–12)

■ Type de connexion partition-hôte d'un CAP (FC-SCSI ou HLI) partagé 

■ Emplacement de l'ensemble des ressources (cellules de stockage, lecteurs de 
bande, cellules du CAP de rotation) à l'intérieur de la bibliothèque de bandes. 

Remarque – Positionnez le curseur sur une ressource pour afficher une infobulle 
contenant des informations détaillées sur la cellule ou le lecteur, son affectation à des 
partitions et le nom des éventuelles cartouches. 

Remarque – Si aucun identifiant de partition n'a été défini, le plan de la bibliothèque 
de bandes est en affichage uniquement.

Utilisez le plan de la bibliothèque de bandes pour modifier les délimitations de la 
partition sélectionnée. Selon l'option choisie, Add ou Remove, toutes les ressources 
sélectionnées sont ajoutées à la partition ou supprimées de celle-ci. 
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Selon le choix que vous avez fait dans le champ Select by, vous pourrez réaliser les 
actions suivantes. 

■ Select by cell : sélection d'une ressource ou de groupes de ressources. Il n'est pas 
nécessaire que les ressources d'une partition soient adjacentes. 

- Pour sélectionner une ressource, cliquez deux fois sur celle-ci.

- Pour sélectionner un groupe rectangulaire de ressources, cliquez sur la cellule 
ou le lecteur de l'un des coins du rectangle, puis cliquez sur la cellule ou le 
lecteur diagonalement opposé. 

■ Select by column : sélection d'une colonne entière du module. Il n'est pas 
nécessaire que les colonnes d'une partition soient adjacentes. Pour sélectionner 
une colonne, cliquez sur une ressource de celle-ci. 

■ Select by side : sélection d'une partie entière d'un module, à l'exception des CAP. 
Il n'est pas nécessaire que les parties d'une partition soient adjacentes. Pour 
sélectionner une partie d'un module de la bibliothèque de bandes, cliquez sur 
une ressource située dans cette partie. 

■ Select by module : sélection d'un module entier, à l'exception des CAP. Il n'est pas 
nécessaire que les modules d'une partition soient adjacents. Pour sélectionner un 
module de la bibliothèque de bandes, cliquez sur une ressource de celui-ci. 

Boutons
Move Left 

Cliquez sur ce bouton pour afficher le module de la bibliothèque de bandes situé à 
gauche du module actuellement affiché. Ce bouton est grisé s'il n'existe aucun 
module à gauche. 

Move Right 

Cliquez sur ce bouton pour afficher le module de la bibliothèque de bandes situé à 
droite du module actuellement affiché. Ce bouton est grisé s'il n'existe aucun module 
à droite. 

Verify 

Ce bouton permet de vérifier les modifications apportées à la configuration des 
partitions au cours de la session de la Console d’administration StreamLine Library. 
La fenêtre contextuelle Tools > Partitions—Design (Step 3b)—Verify Results 
s'affiche et indique la présence éventuelle de cartouches orphelines ou d'autres 
erreurs au niveau de la configuration actuelle des partitions.

Remarque – Elle contrôle une partition à la fois seulement. Si vous devez vérifier 
plusieurs partitions, vous devez recommencer cette procédure pour chaque partition. 
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Remarque – Cette vérification porte uniquement sur la configuration actuelle des 
partitions dans l'espace de travail des partitions de la Console d’administration 
StreamLine Library. Elle ne contrôle pas les délimitations des partitions existantes dans 
la base de données du contrôleur de la bibliothèque de bandes. Par conséquent, elle ne 
permet pas d'identifier les conflits de configuration pouvant se produire en cas de 
déplacements de cartouche réalisés par d'autres utilisateurs ou de modification de la 
configuration de la bibliothèque de bandes, par le biais de l'Interface de ligne de 
commande, d'autres sessions sur la Console d’administration StreamLine Library ou 
d'applications hôtes, en même temps que les modifications apportées aux partitions. 

Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Summary (Step 2) 

■ Partitions—Module Map (Step 3a)

■ Partitions—Design (Step 3b) – AEMs Only

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4) 

■ Partitions—Current Partition Definitions 

■ Partitions—Reports 
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Partitions—Design (Step 3b) – AEMs Only

Remarque – Cette section décrit la fenêtre Design (Step 3b) pour les modules 
AEM uniquement. Pour les modules de base, de lecteur et de CEM, voir 
« Partitions—Design (Step 3b) » page 365. 

Remarque – Cette fenêtre est disponible uniquement si la configuration de la 
bibliothèque de bandes contient au moins un AEM. 

Exemple de fenêtre 

Description
Vous permet de définir des délimitations de la partition en affectant toutes les cellules 
dans un AEM à une partition. Tout comme les CAP de rotation, les partitions multiples 
peuvent partager un CAP des AEM, si les partitions disposent du même type 
d'interface hôte (HLI ou FC-SCSI). 
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Remarque – Cette fenêtre apparaît uniquement si la définition des partitions de la 
bibliothèque de bandes a été réalisée par le biais de la fenêtre Partitions—Summary 
(Step 2)—Add Connection. 

Mise en garde – La modification des délimitations des partitions peut entraîner 
l'apparition de cartouches orphelines et la perte de données. Voir « Cartouches 
orphelines dans les bibliothèques de bandes non partitionnées » page 277 pour plus de 
détails. 

Remarque – Les fenêtres de partition Summary (Step 2) et Design (Step 3b) ainsi 
que toutes les fenêtre popup correspondantes donnent accès à un espace de travail 
dynamique pour la conception de vos partitions de la bibliothèque de bandes. 
Toutes les informations relatives à la configuration des partitions sont enregistrées 
automatiquement dans l'espace de travail des partitions dans la mémoire de la Console 
d’administration StreamLine Library et sont conservées pendant toute la durée de votre 
session sur la Console d’administration StreamLine Library. Ainsi, vous pouvez passer 
d'une fenêtre de partition à l'autre, revenir aux fenêtres de partition autant de fois que 
vous le souhaitez sans perdre vos modifications de configuration. 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre
Partition

Requis.

Partition à laquelle vous voulez ajouter ou supprimer des cellules de CAP des AEM. 

La liste déroulante affiche les identifiants de partition disponibles dans la 
bibliothèque de bandes. Elle indique également le type d'interface hôte (FC-SCSI 
ou HLI). Si aucun identifiant de partition n'a été défini, la liste est vide. 

Remarque – Lorsque vous sélectionnez une partition, la fenêtre est automatiquement 
actualisée et affiche les données de la partition depuis l'espace de travail de la partition 
de la Console d’administration StreamLine Library. 
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Select by

Requis.

Ce champ permet de choisir la méthode à utiliser pour la définition des 
délimitations de la partition. Quelle que soit l'option que vous choisissez, toutes 
les cellules au sein de l'AEM seront sélectionnées à la fois. 

Remarque – Vous devez sélectionner Add ou Remove. 

Add 

Requis.

Ce champ indique que vous souhaitez ajouter l'AEM à la partition. Cette option est 
valide uniquement si l'AEM n'est pas affectée actuellement. 

Remove

Requis.

Ce champ indique que vous souhaitez supprimer l'AEM de la partition. Cette option 
est valide uniquement si l'AEM est affectée actuellement. 

Allocated to Partition n 

Remarque – En sélectionnant une partition, les données indiquées dans ces champs 
sont automatiquement mises à jour depuis l'espace de travail de la partition sur la 
Console d’administration StreamLine Library.

Cellules de stockage 

Affichage uniquement.

Nombre total de cellules de stockage affectées à la partition sélectionnée en fonction 
des délimitations de la partition actuellement définies. 

Drive Bays

Affichage uniquement.

Nombre total de lecteurs de bande affectés à la partition sélectionnée en fonction des 
délimitations de la partition actuellement définies. 

CAP Cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation ou des AEM affectées à la partition 
sélectionnée en fonction des délimitations de la partition actuellement définies. 

Unallocated in Library 

Remarque – En sélectionnant une partition, les données indiquées dans ces champs 
sont automatiquement mises à jour depuis l'espace de travail de la partition sur la 
Console d’administration StreamLine Library.
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Cellules de stockage 

Affichage uniquement.

Nombre total de cellules de stockage de la bibliothèque de bandes qui ne sont 
affectées à aucune partition.

Drive Bays

Affichage uniquement.

Nombre total de lecteurs de bande de la bibliothèque de bandes qui ne sont affectés 
à aucune partition.

CAP Cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation et des AEM de la bibliothèque de 
bandes qui ne sont affectées à aucune partition.

Licensed Capacity 

Remarque – Ce champ apparaît uniquement si la capacité autorisée de la bibliothèque 
de bandes n'a pas entièrement été utilisée. Si les affectations dépassent la capacité 
autorisée (situation de dépassement), le champ Oversubscription apparaît. 

Affichage uniquement.

Capacité autorisée totale de la bibliothèque de bandes qui n'est affectée à aucune 
partition. Il se calcule de la manière suivante :

Total licensed capacity – Total allocated storage cells 

Oversubscription 

Remarque – Ce champ apparaît uniquement si le nombre d'affectations dépasse la 
capacité autorisée (situation de dépassement). Si la capacité autorisée de la bibliothèque 
de bandes n'a pas entièrement été utilisée, le champ Licensed Capacity apparaît. 

Affichage uniquement.

Capacité autorisée totale de la bibliothèque de bandes dépassée en raison du nombre 
d'affectations de partition. Il se calcule de la manière suivante :

Total allocated storage cells – Total licensed capacity 

Vous devez supprimer les excédents d'affectations avant de valider vos 
modifications sur la fenêtre Commit (Step 4). 

Legend 
Il s'agit de la légende du plan de la bibliothèque de bandes. L'état de chaque cellule 
du CAP des AEM est indiqué comme suit : 

■ Not Accessible (rectangle blanc et b-arré d'une croix). Aucune partition n'a accès à 
la ressource. Quelques exemples de causes :

- Les cellules de stockage ont été configurées pour des cartouches de diagnostic. 

- Les cellules de stockage ne sont pas comprises dans la capacité autorisée de la 
bibliothèque de bandes. 
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■ Unallocated. La ressource n'est actuellement affectée à aucune partition et par 
conséquent peut être utilisée par la partition sélectionnée. 

■ Partition n (doré). La ressource est affectée à la partition sélectionnée, partition n. 

■ Other Partitions (rouge). La ressource est affectée à une autre partition et, par 
conséquent, ne peut PAS être utilisée par la partition sélectionnée. 

■ Shared AEM CAP (fond gris). Le CAP des AEM a été affecté à une partition 
minimum. Le type d'interface hôte affecté au CAP des AEM (HLI ou FC-SCSI) 
s'affiche. 

■ Cartridge (icône cartouche). La ressource contient une cartouche de bande. 

AEM Map 
Représentation graphique de la configuration actuelle de l'AEM. L'affichage initial 
de la session en cours sur la Console d’administration StreamLine Library provient 
de la base de données du contrôleur de la bibliothèque de bandes. Ensuite, l'afficha-
ge prend en compte les données de l'espace de travail de la partition sur la Console 
d’administration StreamLine Library lorsque vous modifiez la configuration des par-
titions. L'affichage comprend les informations suivantes :

■ Type de module en cours d'affichage ; pour les AEM, il s'agit toujours d'« Access 
Module ». 

■ Identifiant numérique du module (1–12)

■ Indicateur de vue du modèle actuel (« Door Closed » ou « Door Open ») 

■ Type d'interface hôte de la ou des partitions auxquelles l'AEM est affecté 
(FC-SCSI ou HLI) 

■ Type de CAP ; pour les AEM, il s'agit toujours de « Bulk Load CAP ». 

■ Emplacement de toutes les cellules de stockage dans l'AEM 

Remarque – Positionnez le curseur sur une ressource pour afficher une infobulle 
contenant des informations détaillées sur la cellule ou le lecteur, son affectation à des 
partitions et le nom des éventuelles cartouches. 

Remarque – Si aucun identifiant de partition n'a été défini, le plan de la bibliothèque 
de bandes est en affichage uniquement.

Utilisez le plan de la bibliothèque de bandes pour modifier l'affectation de partition 
de l'AEM. Selon l'option choisie, Add ou Remove, la totalité de l'AEM est soit 
ajoutée à la partition, soit supprimée de celle-ci. 

Boutons
Move Left 

Cliquez sur ce bouton pour afficher le module de la bibliothèque de bandes situé à 
gauche du module actuellement affiché. Ce bouton est grisé s'il n'existe aucun 
module à gauche. 



Fenêtres de conception et de validation des partitions

418605501 • Révision AB Chapitre 6 Partitionnement de la bibliothèque de bandes 377

Move Right 

Cliquez sur ce bouton pour afficher le module de la bibliothèque de bandes situé à 
droite du module actuellement affiché. Ce bouton est grisé s'il n'existe aucun module 
à droite. 

Remarque – « Door Closed View » constitue la vue par défaut de l'AEM. Vous pouvez 
utiliser les deux boutons suivants pour basculer entre les autres vues. 

Show Door Open View

Cliquez sur ce bouton pour afficher la disposition des cellules du CAP des AEM, 
comme si la porte d'accès de l'AEM était ouverte et que vous inspectiez directement 
l'intérieur de l'AEM. 

Show Door Closed View

Cliquez sur ce bouton pour afficher la disposition des cellules du CAP des AEM, 
comme si la porte d'accès de l'AEM était fermée et que vous voyiez « à travers » le 
panneau de la porte d'accès avant pour inspecter l'intérieur de l'AEM. 

Verify

Ce bouton permet de vérifier les modifications apportées à la configuration des 
partitions au cours de la session de la Console d’administration StreamLine Library. 
La fenêtre contextuelle Tools > Partitions—Design (Step 3b)—Verify Results 
s'affiche et indique la présence éventuelle de cartouches orphelines ou d'autres 
erreurs au niveau de la configuration actuelle des partitions.

Remarque – Elle contrôle une partition à la fois seulement. Si vous devez vérifier 
plusieurs partitions, vous devez recommencer cette procédure pour chaque partition. 

Remarque – Cette vérification porte uniquement sur la configuration actuelle des 
partitions dans l'espace de travail des partitions de la Console d’administration 
StreamLine Library. Elle ne contrôle pas les délimitations des partitions existantes dans 
la base de données du contrôleur de la bibliothèque de bandes. Par conséquent, elle ne 
permet pas d'identifier les conflits de configuration pouvant se produire en cas de 
déplacements de cartouche réalisés par d'autres utilisateurs ou de modification de la 
configuration de la bibliothèque de bandes, par le biais de l'Interface de ligne de 
commande, d'autres sessions sur la Console d’administration StreamLine Library ou 
d'applications hôtes, en même temps que les modifications apportées aux partitions. 

Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 
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Voir aussi
■ Partitions—Summary (Step 2) 

■ Partitions—Module Map (Step 3a)

■ Partitions—Design (Step 3b)

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4) 

■ Partitions—Current Partition Definitions 

■ Partitions—Reports 
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Partitions—Design (Step 3b)—Verify Results

Exemple de fenêtre

Description
Cette fenêtre affiche une liste des erreurs de configuration au niveau de l'espace de 
travail des partitions sur la Console d’administration StreamLine Library. 

Il s'agit d'une fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Verify Results 
dans la fenêtre Partitions—Design (Step 3b). 

Les erreurs potentielles sont les suivantes :

■ Une partition présente des cartouches orphelines. Voir “Cartouches orphelines dans 
les bibliothèques de bandes non partitionnées” pour plus de détails.

■ Des ressources de la bibliothèque de bandes ont été supprimées d'une partition. 

■ Une connexion hôte n'a aucune partition affectée à LUN 0 (cela concerne 
uniquement les connexions FC-SCSI). 

En cas d'apparition de l'une de ces erreurs, la fenêtre affiche en premier lieu des 
messages d'erreur de synthèse. Vous pouvez voir les messages détaillés en cliquant sur 
le bouton Details. 

Il est recommandé de corriger toutes les erreurs avant de valider les données dans la 
base de données du contrôleur de la bibliothèque de bandes. 
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Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv. 

Remarque – Les fenêtres de partition Summary (Step 2) et Design (Step 3b) ainsi 
que toutes les fenêtre popup correspondantes donnent accès à un espace de travail 
dynamique pour la conception de vos partitions de la bibliothèque de bandes. 
Toutes les informations relatives à la configuration des partitions sont enregistrées 
automatiquement dans l'espace de travail des partitions dans la mémoire de la Console 
d’administration StreamLine Library et sont conservées pendant toute la durée de votre 
session sur la Console d’administration StreamLine Library. Ainsi, vous pouvez passer 
d'une fenêtre de partition à l'autre, revenir aux fenêtres de partition autant de fois que 
vous le souhaitez sans perdre vos modifications de configuration. 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre

Remarque – Les champs de la fenêtre sont identiques à ceux de la fenêtre contextuelle 
Partitions—Commit (Step 4)—Confirm Apply. 

Warnings found

Affichage uniquement.

Messages d'erreur de synthèse concernant la configuration de la partition. 

The library is oversubscribed. Please unallocate nnn storage cells. 

Affichage uniquement.

Cette fenêtre indique que le nombre total d'affectations de la partition dépasse la 
capacité autorisée de la bibliothèque de bandes. nnn correspond au nombre de 
cellules des affectations de la partition devant être supprimées. Le bouton Apply de 
la fenêtre Commit (Step 4) reste désactivé jusqu'à ce que le nombre total de cellules 
affectées ne dépasse plus la capacité autorisée de la bibliothèque de bandes. 

The following hosts will need re-audited

Affichage uniquement.

Nom de port mondial (WWPN) des hôtes devant vérifier leur partition de la 
bibliothèque de bandes. La cause peut provenir de la suppression de ressources de la 
bibliothèque de bandes de la partition. 

The following hosts do not have Lun 0 set

Affichage uniquement.
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Nom de port mondial (WWPN) des hôtes n'ayant pas défini de partitions de la 
bibliothèque de bandes comme LUN 0 sur l'hôte. Cette erreur concerne uniquement 
les connexions hôte-partition FC-SCSI. 

The following orphaned cartridges were found

Affichage uniquement.

Informations détaillées concernant les cartouches orphelines présentes dans la 
configuration actuelle de la partition. Cela comprend l'emplacement de la 
bibliothèque de bandes, du rail, de la colonne, de la partie et de la ligne de la 
cartouche, le numéro de série de volume de la cartouche (ID de volume) ainsi que les 
causes potentielles et les explications concernant la présence de la cartouche 
orpheline. 

Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

OK

Cliquez sur ce bouton pour annuler la mise à jour. La base de données du contrôleur 
de la bibliothèque de bandes n'est pas mise à jour mais toutes les modifications 
apportées aux partitions au cours de cette session sont conservées dans l'espace de 
travail de partition de la Console d’administration StreamLine Library. 

Details 

Cliquez sur ce bouton pour basculer entre les fenêtres développées et réduites des 
messages d'avertissement. 

Voir aussi
■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4)—Confirm Apply 
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Partitions—Commit (Step 4)

Exemple de fenêtre

Description
Cette fenêtre permet de valider les données de l'espace de travail des partitions de la 
Console d’administration StreamLine Library dans la base de données du contrôleur de 
la bibliothèque de bandes. Les données suivantes seront validées pour l'ensemble des 
partitions : 

■ Informations de synthèse de la partition 

■ Informations relatives à la configuration de la connexion hôte-partition 

■ Détails des délimitations des partitions 
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Mise en garde – Bien que les modifications de la partition n'interrompent 
pas les hôtes de la bibliothèque de bandes, il est recommandé d'interdire 
l'accès à la bibliothèque de bandes aux autres utilisateurs avant de valider les 
modifications apportées à l'espace de travail de votre partition. Du fait que la Console 
d’administration StreamLine Library ne valide pas les délimitations de la partition par 
rapport à la base de données du contrôleur de la bibliothèque de bandes en temps réel, 
des conflits de configuration peuvent se produire si vous modifiez des délimitations de 
la partition, alors que d'autres utilisateurs déplacent des cartouches ou modifient la 
configuration de la bibliothèque de bandes. Voir « Synchronisation de l'affichage avec la 
base de données du contrôleur » page 44 pour plus de détails. 

Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Mise en garde – Il est recommandé de suivre la procédure Résolution des problèmes 
de cartouches orphelines avant d'utiliser cette fenêtre. 

Mise en garde – Cette fenêtre permet de mettre à jour la base de données du 
contrôleur de la bibliothèque de bandes avec les modifications apportées à la 
configuration des partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library. En cas de non utilisation de cette fenêtre 
avant de se déconnecter de la session en cours sur la Console d’administration 
StreamLine Library, les modifications apportées à la configuration de la bibliothèque 
de bandes seront perdues.

Champs de la fenêtre
Aucun 

Boutons
Apply

Cliquez sur ce bouton pour mettre à jour la base de données du contrôleur de 
la bibliothèque de bandes avec les paramètres actuels de l'espace de travail de 
partition de la Console d’administration StreamLine Library. La fenêtre contextuelle 
Tools > Partitions—Commit (Step 4)—Confirm Apply s'affiche et indique la 
présence éventuelle de cartouches orphelines ou d'autres erreurs au niveau de 
la configuration actuelle de la partition. 
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Remarque – Ce bouton est grisé si les affectations totales des partitions dépassent la 
capacité autorisée de la bibliothèque de bandes. Pour activer ce bouton, vous devez 
supprimer des cellules de stockage dans les affectations de partition pour que le 
nombre total de cellules affectées ne dépasse plus la capacité autorisée de la 
bibliothèque de bandes.

Remarque – Ce bouton est grisé si aucune modification n'a été apportée à l'espace de 
travail de partition de la console Console d’administration StreamLine Library depuis 
la dernière validation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4)—Confirm Apply 

■ Partitions—Reports 
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Partitions—Commit (Step 4)—Confirm Apply

Exemple de fenêtre

Description
Cette fenêtre affiche une liste des erreurs de configuration au niveau de l'espace de 
travail des partitions sur la Console d’administration StreamLine Library. Il s'agit d'une 
fenêtre contextuelle qui s'affiche lorsque vous cliquez sur Apply dans la fenêtre 
Partitions—Commit (Step 4). 

Après lecture des messages d'erreur, vous pouvez valider l'ensemble des données de 
l'espace de travail des partitions de la Console d’administration StreamLine Library 
dans la base de données du contrôleur de la bibliothèque de bandes en cliquant sur le 
bouton Yes. 

Les erreurs potentielles sont les suivantes :

■ Une partition présente des cartouches orphelines. Voir “Cartouches orphelines dans 
les bibliothèques de bandes non partitionnées” pour plus de détails.

■ Des ressources de la bibliothèque de bandes ont été supprimées d'une partition. 

■ Une connexion hôte n'a aucune partition affectée à LUN 0 (cela concerne 
uniquement les connexions FC-SCSI). 

En cas d'apparition de l'une de ces erreurs, la fenêtre affiche en premier lieu des 
messages d'erreur de synthèse. Vous pouvez voir les messages détaillés en cliquant sur 
le bouton Details. 

Il est recommandé de corriger toutes les erreurs avant de valider les données dans la 
base de données du contrôleur de la bibliothèque de bandes. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv. 
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Mise en garde – La sauvegarde des informations de l'espace de travail des partitions 
de la Console d’administration StreamLine Library dans la base de données du 
contrôleur de la bibliothèque de bandes s'effectue uniquement par le biais de la fenêtre 
Commit (Step 4). En cas de fermeture de votre session sur la Console d’administration 
StreamLine Library ou d'actualisation des données de l'espace de travail avant 
validation des mises à jour par le biais de la fenêtre Commit (Step 4), toutes les 
modifications apportées aux partitions en utilisant les fenêtres Summary (Step 2) et 
Design (Step 3b) et les fenêtres contextuelles correspondantes seront perdues. 

Champs de la fenêtre

Remarque – Les champs de la fenêtre sont identiques à ceux de la fenêtre contextuelle 
Partitions—Design (Step 3b)—Verify Results. 

Warnings found

Affichage uniquement.

Messages d'erreur de synthèse concernant la configuration de la partition. 

The library is oversubscribed. Please unallocate nnn storage cells. 

Affichage uniquement.

Cette fenêtre indique que le nombre total d'affectations de la partition dépasse la 
capacité autorisée de la bibliothèque de bandes. nnn correspond au nombre de 
cellules des affectations de la partition devant être supprimées. Le bouton Apply de 
la fenêtre Commit (Step 4) reste désactivé jusqu'à ce que le nombre total de cellules 
affectées ne dépasse plus la capacité autorisée de la bibliothèque de bandes. 

The following hosts will need re-audited

Affichage uniquement.

Nom de port mondial (WWPN) des hôtes devant vérifier leur partition de la 
bibliothèque de bandes. La cause peut provenir de la suppression de ressources de la 
bibliothèque de bandes de la partition. 

The following hosts do not have Lun 0 set

Affichage uniquement.

Nom de port mondial (WWPN) des hôtes n'ayant pas défini de partitions de la 
bibliothèque de bandes comme LUN 0 sur l'hôte. Cette erreur concerne uniquement 
les connexions hôte-partition FC-SCSI. 

The following orphaned cartridges were found

Affichage uniquement.

Informations détaillées concernant les cartouches orphelines présentes dans la 
configuration actuelle de la partition. Cela comprend l'emplacement de la 
bibliothèque de bandes, du rail, de la colonne, de la partie et de la ligne de la 
cartouche, le numéro de série de volume de la cartouche (ID de volume) ainsi que les 
causes potentielles et les explications concernant la présence de la cartouche 
orpheline. 
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Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save 

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

Yes

Cliquez sur ce bouton pour confirmer la mise à jour de la base de données du 
contrôleur de la bibliothèque de bandes avec les paramètres actuels de l'espace de 
travail de la Console d’administration StreamLine Library. 

No

Cliquez sur ce bouton pour annuler la mise à jour. La base de données du contrôleur 
de la bibliothèque de bandes n'est pas mise à jour mais toutes les modifications 
apportées aux partitions au cours de cette session sont conservées dans l'espace de 
travail de partition de la Console d’administration StreamLine Library. 

Details 

Cliquez sur ce bouton pour basculer entre les fenêtres développées et réduites des 
messages d'avertissement. 

Voir aussi
■ Partitions—Commit (Step 4) 

■ Partitions—Design (Step 3b)—Verify Results 
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Partitions—Current Partition Definitions

Exemple de fenêtre

Description
Cette fenêtre affiche les délimitations actuelles des partitions et leurs affectations. Il 
s'agit de l'unique fenêtre Partitions disponible depuis le Panneau opérateur local.

Remarque – Cette fenêtre est en affichage uniquement. 

Champs de la fenêtre
Pour plus d'informations sur les champs de la fenêtre, voir l'une des sections suivantes :

■ « Partitions—Design (Step 3b) » page 365, pour les modules de base, de lecteur et de 
CEM

■ « Partitions—Design (Step 3b) – AEMs Only » page 372, pour les AEM 
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Boutons
Refresh

Ce bouton permet d'actualiser l'affichage avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Design (Step 3b) 

■ Partitions—Design (Step 3b) – AEMs Only
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Partition Report Screens

Partitions—Reports

Partitions—Reports—Cartridge Cell and Media Summary

Partitions—Reports—Host Connections Summary

Partitions—Reports—Orphaned Cartridge Report

Partitions—Reports—Partition Details

Partitions—Reports—Partition Details
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Partitions—Reports

Exemple de fenêtre

Description
Cette fenêtre permet de sélectionner l'un des rapports suivants relatifs aux partitions de 
la bibliothèque de bandes :

■ Cartridge Cell and Media Summary

■ Host Connections Summary

■ Orphaned Cartridge Report

■ Partition Details

■ Partition Summary
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Remarque – Les rapports de partitions affichent les données enregistrées dans la base 
de données du contrôleur de la bibliothèque de bandes. En cas de modification de la 
configuration des partitions sans validation par le contrôleur de la bibliothèque de 
bandes en utilisant la fenêtre Commit (Step 4), les données indiquées dans ces rapports 
peuvent être différentes des données affichées dans les fenêtres de partition 
Summary (Step 2) et Design (Step 3b). 

Champs de la fenêtre
Please select a report to display

Requis.

Cliquez sur le rapport à afficher. La liste déroulante affiche l'ensemble des rapports 
de partitions de la bibliothèque de bandes disponibles. 

Boutons
Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Details 
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Partitions—Reports—Cartridge Cell and Media 
Summary

Exemple de fenêtre

Description
Cette fenêtre affiche des informations détaillées concernant l'ensemble des ressources 
de la bibliothèques de bandes (cellules de stockage, lecteurs de bande, et cellules du 
CAP de rotation ou des AEM) et les éventuelles cartouches stockées.

Remarque – Les rapports de partitions affichent les données enregistrées dans la base 
de données du contrôleur de la bibliothèque de bandes. En cas de modification de la 
configuration des partitions sans validation par le contrôleur de la bibliothèque de 
bandes en utilisant la fenêtre Commit (Step 4), les données indiquées dans ces rapports 
peuvent être différentes des données affichées dans les fenêtres de partition 
Summary (Step 2) et Design (Step 3b). 
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Remarque – Les cellules de CAP des AEM sont identifiés comme suit : les cellules de 
CAP des AEM de gauche se trouvent dans les colonnes « -33 »  à  «-31 » ; les cellules de 
CAP des AEM de droite se trouvent dans les colonnes « -31 »  à  «-33 » . 

Remarque – Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir 
« Modification de la mise en page de la fenêtre » page 45 pour plus de détails. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv.

Champs de la fenêtre
Library 

Affichage uniquement.

Numéro de la bibliothèque de bandes dans laquelle se trouve la ressource de la 
bibliothèque de bandes. Ce numéro est toujours « 1 ». 

Rail 

Affichage uniquement.

Numéro du rail dans lequel se trouve la ressource de la bibliothèque de bandes. Ce 
numéro est toujours « 1 ». 

Column

Affichage uniquement.

Numéro de la colonne dans laquelle se trouve la ressource de la bibliothèque de 
bandes. Le référencement des emplacements des colonnes commence à partir du 
bord gauche du module de référence. « +1 » signifie vers la droite ; « -1 » vers la 
gauche.

Side

Affichage uniquement.

Partie du module dans laquelle se trouve la ressource de la bibliothèque de bandes. 
« 1 » correspond à la façade arrière ; « 2 » à la façade avant.

Row

Affichage uniquement.

Numéro de la ligne dans laquelle se trouve la ressource de la bibliothèque de 
bandes. La numérotation des lignes s'effectue de haut en bas, de manière consécutive; 
la ligne « 1 » se trouvant tout en haut.

Partition ID

Affichage uniquement.

Identifiant de la partition à laquelle la ressource de la bibliothèque de bandes est 
affectée le cas échéant. 
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Partition Name

Affichage uniquement.

Nom de la partition à laquelle la ressource de la bibliothèque de bandes est affectée 
le cas échéant. Si aucune partition n'est définie dans la bibliothèque de bandes, 
« Non-Partitioned Library » s'affiche. 

Element Type

Affichage uniquement.

Type de ressources de la bibliothèque de bandes. Les différentes options sont les 
suivantes :

■ CAP (rotational or AEM) 
■ CELL
■ DRIVE

Vol Ser 

Affichage uniquement.

Numéro de série du volume (ID de volume) de la cartouche éventuellement présente 
dans la ressource de la bibliothèque de bandes. 

Cell Status

Affichage uniquement.

État de la capacité de la ressource de la bibliothèque de bandes. Cela concerne 
uniquement les cellules de stockage. Les différentes options sont les suivantes :

■ Active : la cellule est activée et peut être utilisée pour le stockage de cartouche en 
fonction de la capacité affectée. 

■ Inactive : la cellule n'est pas activée et ne peut pas être utilisée pour le stockage de 
cartouche. 

Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save to File

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 
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Voir aussi
■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Details 
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Partitions—Reports—Host Connections Summary

Exemple de fenêtre

Description
Cette fenêtre affiche des informations détaillées sur les connexions hôte-partition de la 
bibliothèque de bandes. 

Remarque – Les rapports de partitions affichent les données enregistrées dans la base 
de données du contrôleur de la bibliothèque de bandes. En cas de modification de la 
configuration des partitions sans validation par le contrôleur de la bibliothèque de 
bandes en utilisant la fenêtre Commit (Step 4), les données indiquées dans ces rapports 
peuvent être différentes des données affichées dans les fenêtres de partition 
Summary (Step 2) et Design (Step 3b). 

Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv.
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Champs de la fenêtre

Partitions

Remarque – Les champs de cette fenêtre apparaissent également dans le rapport 
Partitions—Reports—Partition Details.

Partition ID

Affichage uniquement.

Identifiant de la partition (1-8). 

Partition Name

Affichage uniquement.

Nom de la partition. 

Connection Type 

Affichage uniquement.

Type d'interface utilisé par la connexion de la partition de l'hôte. Les différentes 
options sont les suivantes :

■ HLI 

■ FC-SCSI 

Cellules de stockage 

Affichage uniquement.

Nombre total de cellules de stockage affectées à la partition.

Media in Storage Cells

Affichage uniquement.

Nombre total de cartouches de bande dans les cellules de stockage de la partition de 
la. 

% Storage Cells w/ Media

Affichage uniquement.

Pourcentage des cellules de stockage contenant des cartouches de bande. Il se calcule 
de la manière suivante : Media in Storage Cells / Storage Cells. 

Drive Bays 

Affichage uniquement.

Nombre total de baies de disques affectées à la partition. 

CAP Cells 

Affichage uniquement.

Nombre total de cellules du CAP de rotation affectées à la partition. 

AEM Cells 

Affichage uniquement.

Nombre total de cellules du CAP des AEM affectées à la partition. 
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Total Media 

Affichage uniquement.

Nombre total de cartouches de bande de la partition, y compris les cartouches des 
cellules de stockage, CAP de rotation et des AEM et lecteurs affectés à la partition. 

Active Cells

Affichage uniquement.

Capacité totale des cellules de stockage de la affectées à la partition dans la fenêtre 
Add Partition. 

Host Connections

Initiator (WWPN)

Affichage uniquement.

Nom de port mondial d'un adaptateur de bus hôte FC-SCSI (HBA) connecté à la 
partition. 

Library Controller Port

Affichage uniquement.

Numéro du port du contrôleur de la bibliothèque de bandes SL3000 sur l'hôte. Ce 
numéro est toujours « 0 ».

LUN

Affichage uniquement.

Numéro d'unité logique de la partition de la bibliothèque de bandes sur l'hôte.

Partition ID 

Affichage uniquement.

Identifiant de la partition à laquelle l'hôte est connecté. 

Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 
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Voir aussi
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Details 
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Partitions—Reports—Orphaned Cartridge Report 

Exemple de fenêtre

Description
Cette fenêtre affiche les emplacements ainsi que les numéros de série de volume (ID de 
volume) de l'ensemble des cartouches orphelines présentes dans la bibliothèque de 
bandes. Elle indique également le motif de la présence de la cartouche orpheline. 

Remarque – Les rapports de partitions affichent les données enregistrées dans la base 
de données du contrôleur de la bibliothèque de bandes. En cas de modification de la 
configuration des partitions sans validation par le contrôleur de la bibliothèque de 
bandes en utilisant la fenêtre Commit (Step 4), les données indiquées dans ces rapports 
peuvent être différentes des données affichées dans les fenêtres de partition 
Summary (Step 2) et Design (Step 3b). 
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Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv.

Champs de la fenêtre
Library 

Affichage uniquement.

Numéro de la bibliothèque de bandes dans laquelle se trouve la cartouche orpheline. 
Ce numéro est toujours « 1 ». 

Rail 

Affichage uniquement.

Numéro du rail dans lequel se trouve la cartouche orpheline. Ce numéro est toujours 
« 1 ». 

Column

Affichage uniquement.

Numéro de la colonne dans laquelle se trouve la cartouche orpheline. Le 
référencement des emplacements des colonnes commence à partir du bord gauche 
du module de référence. « +1 » signifie vers la droite ; « -1 » vers la gauche.

Side

Affichage uniquement.

Partie du module dans laquelle se trouve la cartouche orpheline. « 1 » correspond à 
la façade arrière ; « 2 » à la façade avant.

Row

Affichage uniquement.

Numéro de la ligne dans laquelle se trouve la cartouche orpheline. La numérotation 
des lignes s'effectue de haut en bas, de manière consécutive ; la ligne « 1 » se 
trouvant tout en haut.

Vol Ser 

Affichage uniquement.

Numéro de série du volume (ID de volume) de la cartouche orpheline. 

Explanation

Affichage uniquement.

Explication de la présence d'une cartouche orpheline. 

Étant donné que ce rapport est généré par la base de données du contrôleur de la 
bibliothèque de bandes, la seule possibilité est la suivante :

■ Accès impossible par aucun hôte 
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Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Details 
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Partitions—Reports—Partition Details

Exemple de fenêtre

Description
Cette fenêtre affiche des informations détaillées concernant une partition sélectionnée. 
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Remarque – Les rapports de partitions affichent les données enregistrées dans la base 
de données du contrôleur de la bibliothèque de bandes. En cas de modification de la 
configuration des partitions sans validation par le contrôleur de la bibliothèque de 
bandes en utilisant la fenêtre Commit (Step 4), les données indiquées dans ces rapports 
peuvent être différentes des données affichées dans les fenêtres de partition 
Summary (Step 2) et Design (Step 3b). 

Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv.

Champs de la fenêtre
Partition Name

Affichage uniquement.

Nom de la partition. 

Partition ID

Affichage uniquement.

Identifiant de la partition (1-8) 

Connection Type 

Affichage uniquement.

Type d'interface utilisé par la connexion de la partition de l'hôte. Les différentes 
options sont les suivantes :

■ HLI 

■ FC-SCSI 

Assigned Cells 

Affichage uniquement.

Nombre total de cellules de stockage affectées à la partition.

Available Cells 

Affichage uniquement.

Nombre total de cellules de stockage de la bibliothèque de bandes pouvant être 
affectées à la partition.

Occupied Cells 

Affichage uniquement.

Nombre total de cellules de stockage de la partition contenant des cartouches de 
bande.

Active (Capacity Licensed) Cells 

Affichage uniquement.

Capacité totale des cellules de stockage affectée à la partition dans la fenêtre Add 
Partition. 
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Assigned Drive Bays 

Affichage uniquement.

Nombre total de baies de disques affectées à la partition.

Available Drive Bays 

Affichage uniquement.

Nombre total de baies de disques de la bibliothèque de bandes pouvant être 
affectées à la partition.

Number of Drives

Affichage uniquement.

Nombre total de lecteurs de bande installés affectés à la partition. 

Occupied Drives 

Affichage uniquement.

Nombre total de lecteurs de bande installés dans la partition et contenant des 
cartouches de bande.

Assigned CAP cells 

Affichage uniquement.

Nombre total de cellules du CAP de rotation affectées à la partition par le biais de 
CAP réservés ou partagés. 

Available CAP cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation de la bibliothèque de bandes pouvant 
être affectées à la partition. Ce nombre inclut toutes les cellules du CAP de rotation 
et des AEM dans les éléments suivants :

■ CAP affectés à aucune partition. 

■ CAP actuellement non affectés à cette partition mais affectés à d'autres partitions 
avec le même type d'interface hôte. 

Ce nombre exclut toutes les cellules du CAP de rotation et des AEM dans les 
éléments suivants : 

■ CAP actuellement affectés à cette partition.

■ CAP affectés à des partitions avec un type d'interface hôte différent. 

Occupied CAP cells

Affichage uniquement.

Nombre total de cellules du CAP de rotation dans la partition contenant des 
cartouches de bande.

Assigned AEM cells 

Affichage uniquement.

Nombre total de cellules du CAP des AEM affectées à la partition par le biais d'AEM 
réservés ou partagés. 

Available AEM cells

Affichage uniquement.
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Nombre total de cellules du CAP des AEM de la bibliothèque de bandes pouvant 
être affectées à la partition. Ce nombre comprend toutes les cellules de l'AEM dans 
les éléments suivants :

■ AEM affectés à aucune partition. 

■ AEM actuellement non affectés à cette partition mais affectés à d'autres partitions 
avec le même type d'interface hôte. 

Ce nombre exclut toutes les cellules de l'AEM dans les éléments suivants : 

■ AEM actuellement affectés à cette partition.

■ AEM affectés à des partitions avec un type d'interface hôte différent. 

Occupied AEM cells

Affichage uniquement.

Nombre total de cellules du CAP des AEM dans la partition contenant des 
cartouches de bande.

% Cell Capacity (Assigned Cells/Total Cells) 

Affichage uniquement.

Pourcentage des cellules de stockage de la bibliothèque de bandes affectées à cette 
partition. Il se calcule de la manière suivante :

Nombre de cellules affectées à la partition / Capacité physique totale de la 
bibliothèque de bandes 

Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 
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Partitions—Reports—Partition Details

Exemple de fenêtre

Description
Cette fenêtre affiche des informations de synthèse sur l'ensemble des partitions de la 
bibliothèque de bandes. 

Remarque – Les rapports de partitions affichent les données enregistrées dans la base 
de données du contrôleur de la bibliothèque de bandes. En cas de modification de la 
configuration des partitions sans validation par le contrôleur de la bibliothèque de 
bandes en utilisant la fenêtre Commit (Step 4), les données indiquées dans ces rapports 
peuvent être différentes des données affichées dans les fenêtres de partition 
Summary (Step 2) et Design (Step 3b). 

Vous pouvez modifier la mise en page et l'affichage de cette fenêtre. Voir « Modification 
de la mise en page de la fenêtre » page 45 pour plus de détails. 

Vous pouvez imprimer les données de la fenêtre ou les enregistrer dans un fichier de 
type csv.
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Champs de la fenêtre

Remarque – Les champs de cette fenêtre apparaissent également dans le rapport 
Partitions—Reports—Host Connections Summary.

Partition ID

Affichage uniquement.

Identifiant de la partition (1-8). 

Partition Name

Affichage uniquement.

Nom de la partition. 

Connection Type 

Affichage uniquement.

Type d'interface utilisé par la connexion de la partition de l'hôte. Les différentes 
options sont les suivantes :

■ HLI 

■ FC-SCSI 

Cellules de stockage 

Affichage uniquement.

Nombre total de cellules de stockage affectées à la partition.

Media in Storage Cells

Affichage uniquement.

Nombre total de cartouches de bande dans les cellules de stockage de la partition de 
la. 

% Storage Cells w/ Media

Affichage uniquement.

Pourcentage des cellules de stockage contenant des cartouches de bande. Il se calcule 
de la manière suivante : Media in Storage Cells / Storage Cells. 

Drive Bays 

Affichage uniquement.

Nombre total de baies de disques affectées à la partition. 

CAP Cells 

Affichage uniquement.

Nombre total de cellules du CAP de rotation affectées à la partition. 

AEM Cells 

Affichage uniquement.

Nombre total de cellules du CAP des AEM affectées à la partition. 

Total Media 

Affichage uniquement.
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Nombre total de cartouches de bande de la partition, y compris les cartouches des 
cellules de stockage, CAP de rotation et des AEM et lecteurs affectés à la partition. 

Active Cells

Affichage uniquement.

Capacité totale des cellules de stockage de la affectées à la partition dans la fenêtre 
Add Partition. 

Boutons
Print

Cliquez sur ce bouton pour imprimer le rapport sur l'imprimante sélectionnée.

Save

Cliquez sur ce bouton pour enregistrer le rapport dans un fichier .csv. De nombreux 
tableurs et bases de données peuvent ouvrir les fichiers .csv. 

Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 
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Fenêtres d'opération de CAP de partition

Affectationdes CAP partagés

Diagnostics > CAP—Unreserve
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Affectationdes CAP partagés 

Exemple de fenêtre

Description
Cette fenêtre permet d'associer des CAP aux partitions avant l'utilisation d'un CAP 
FC-SCSI partagé afin d'insérer des cartouches dans une partition ou de les retirer. Les 
associations partition-CAP réservent un CAP de rotation ou des AEM pour l'utilisation 
exclusive de la partition sélectionnée pendant toute la durée de l'opération d'insertion 
ou d'éjection. 
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Remarque – Cette fenêtre n'est pas disponible si la bibliothèque de bandes ne 
comporte aucun CAP FC-SCSI partagé. 

Remarque – Cette fenêtre est utilisée pour les CAP de rotation et des AEM. Dans cette 
section, le terme « CAP » fait référence à ces deux types de CAP. 

Les règles suivantes s'appliquent lors de l'utilisation de cette fenêtre :

■ Cette fenêtre concerne uniquement les CAP FC-SCSI partagés. 

■ Elle ne doit pas être utilisée pour les CAP dédiés, réservés exclusivement à une 
partition. 

■ Cette fenêtre ne concerne pas les partitions HLI car les applications hôtes HLI 
utilisent des réservations de CAP. 

■ Une seule partition à la fois peut être affectée à un CAP. 

■ La sélection d'une partition a pour effet d'affecter tous les CAP concernés à la fois. 
Vous ne pouvez pas affecter un CAP individuel à la partition. 

■ Vous pouvez sélectionner plusieurs partitions en même temps dans la mesure où les 
partitions sélectionnées ne partagent aucun CAP. 

■ Les associations partition-CAP restent actives tant qu'elles ne sont pas supprimées. 
Les associations ne sont pas automatiquement supprimées après une opération 
d'insertion ou d'éjection. 

■ Les associations partition-CAP sont supprimées au moment du redémarrage de la 
bibliothèque de bandes, des cycles d'alimentation, des opérations d'ouverture ou de 
fermeture des portes de la bibliothèque de bandes ou de l'initialisation des CAP. 

■ Les associations partition-CAP sont supprimées si le CAP est affecté à une autre 
partition par le biais de la fenêtre Design (Step 3b). 

■ En cas de suppression d'une association partition-CAP lorsque le CAP est ouvert ou 
contient des cartouches, la propriété du CAP deviendra celle du demandeur « par 
défaut » et le CAP sera indisponible pour l'ensemble des partitions. Vous devez 
vider et fermer le CAP préalablement à son affectation à une partition. 

Pour plus d'informations concernant l'utilisation de cette fenêtre et le bouton CAP 
Open, reportez-vous à « Insertion de cartouches dans une partition » page 334 and 
« Éjection des cartouches d'une partition » page 335 

Champs de la fenêtre
Sélectionnez

Sélection d'une ou plusieurs partitions pour lesquelles vous souhaitez insérer ou 
retirer des cartouches. La procédure est la suivante : 

■ Cochez la case correspondante pour sélectionner la partition. La fenêtre est 
actualisée de la manière suivante :

- Tous les CAP affectés à cette partition comportent un numéro de partition sur 
le plan de la bibliothèque de bandes.

- Les autres partitions partageant des CAP avec cette partition sont grisées. 

■ Décochez la case pour annuler la sélection de la partition. 
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Les partitions grisées ne peuvent pas être sélectionnées. Une partition peut 
apparaître grisée pour l'une des raisons suivantes : 

■ Aucun CAP n'est affecté à la partition.

■ La connexion hôte de la partition est de type HLI. 

■ Le CAP est actuellement utilisé par une autre partition partageant le CAP.

■ Le CAP est actuellement utilisé par l'utilisateur « par défaut »(utilisateur de la 
bibliothèque de bandes). 

Partition Name

Affichage uniquement.

Nom affecté à la partition. 

Partition ID

Affichage uniquement.

Identifiant affecté à la partition. Les identifiants sont compris entre 1 et 8.

Connection Type 

Affichage uniquement.

Type d'interface affecté à la connexion hôte-partition. Les différentes options sont les 
suivantes :

■ HLI

■ FC-SCSI

Library module map 

Affichage uniquement.

Cette fenêtre affiche un schéma de la configuration actuelle des modules de la 
bibliothèque de bandes. Cette information provient directement de la base de 
données du contrôleur de la bibliothèque de bandes. 

Les affectations des CAP à chaque partition sont indiquées de la manière suivante : 

■ Un « X » dans une colonne d'un module de la bibliothèque de bandes indique que 
le CAP de ce module est affecté à la partition de la ligne.

■ L'absence de « X » dans une colonne d'un module de la bibliothèque de bandes 
indique que le CAP de ce module n'est pas affecté à la partition de la ligne. 

Boutons
Apply

Cliquez sur ce bouton pour mettre à jour la base de données du contrôleur de 
la bibliothèque de bandes avec les paramètres actuels de la fenêtre. La fenêtre 
contextuelle CAP Confirm s'affiche pour demander une confirmation de la mise 
à jour. 
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Refresh

Ce bouton permet d'actualiser l'espace de travail des partitions de la Console 
d’administration StreamLine Library avec les données de la base de données du 
contrôleur de la bibliothèque de bandes. Toutes les modifications non validées 
apportées aux partitions au cours de la session ouverte sur la Console 
d’administration StreamLine Library ne seront pas prises en compte. La fenêtre 
contextuelle Partition Refresh s'affiche pour demander une confirmation de 
l'actualisation. 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Partitions—Design (Step 3b) 



Fenêtres d'opération de CAP de partition

416 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

Diagnostics > CAP—Unreserve

Exemple de fenêtre

Description
Cette fenêtre permet de modifier une réservation de CAP lancée par un hôte. La 
bibliothèque de bandes annule la réservation de CAP et paramètre l'utilisateur du CAP 
sur « par défaut », ce qui rend le CAP de rotation ou des AEM indisponible pour 
l'ensemble des partitions. 

Une fois la réservation redéfinie, vous devez ouvrir le CAP et retirer les cartouches. 
Après fermeture du CAP, le contrôleur de la bibliothèque de bandes verrouille et 
analyse le CAP afin de vérifier qu'il est vide. Il change ensuite l'état du CAP qui 
devient « unreserved », ce qui rend le CAP disponible pour l'ensemble des partitions.

Remarque – Dans le cas des CAP FC-SCSI, la redéfinition d'une réservation de CAP 
annule les éventuelles associations partition-CAP, même si le CAP est dédié à la 
partition FC-SCSI. Vous devez associer à nouveau la partition au CAP pour que celle-ci 
puisse l'utiliser.
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Remarque – Cette fenêtre est utilisée pour les CAP de rotation et des AEM. Dans cette 
section, le terme « CAP » fait référence à ces deux types de CAP. 

Voir « Redéfinition des réservations » page 337 pour plus de détails. 

Champs de la fenêtre
CAP CAP_id is status. 

Affichage uniquement.

État du CAP sélectionné. Les différentes possibilités sont les suivantes :

■ reserved by host_name : une opération CAP a été lancée par l'hôte indiqué. 
Vous pouvez utiliser cette fenêtre pour annuler la réservation du CAP.

■ reserved by host_name : une opération CAP a été lancée au niveau de la 
Console d’administration StreamLine Library. Vous ne pouvez pas utiliser cette 
fenêtre pour annuler la réservation du CAP. 

■ not reserved : le CAP n'est pas réservé. Vous n'avez pas besoin d'annuler la 
réservation du CAP. 

Module containing selected CAP is displayed below

Affichage uniquement.

Cette fenêtre affiche un schéma de la configuration actuelle des modules de la 
bibliothèque de bandes. Cette information provient directement de la base de 
données du contrôleur de la bibliothèque de bandes. 

Le CAP que vous avez sélectionné est indiqué par une flèche. 

Boutons
Apply

Cliquez sur ce bouton pour modifier la réservation de CAP effectuée par l'hôte. La 
fenêtre contextuelle CAP Confirm s'affiche pour demander une confirmation de la 
mise à jour. 

Remarque – Ce bouton n'est disponible que si l'état du CAP est 
« reserved by host_name ». 

? (Help) 

Ce bouton permet d'afficher l'aide en ligne concernant la fenêtre. 

Voir aussi
■ Affectationdes CAP partagés
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CHAPITRE 7

Utilitaires et procédures de 
diagnostic de la Console 
d’administration StreamLine Library

Événements de la bibliothèque de bandes
Le contrôleur de la bibliothèque de bandes contrôle en continu les opérations de la 
bibliothèque de bandes et journalise tous les événements. Les événements sont stockés 
sous trois en-têtes :

■ Événements de communication : communications entre l'hôte et la bibliothèque de 
bandes, la bibliothèque de bandes et la bibliothèque de bandes, et la bibliothèque de 
bandes et le lecteur. 

■ Événement d'erreur : chaque événement d'erreur reçoit un code d'action à quatre 
chiffres (hexadécimal). 

■ Événements d'avertissement : indique une perte de performance ou des conditions 
pouvant indiquer des erreurs fatales à venir. 

Écrans de contrôle des événements
Votre représentant du support technique Sun ou vous-même pouvez utiliser les écrans 
de contrôle de la Console d’administration StreamLine Library pour étudier les 
événements de la bibliothèque de bandes. Vous pouvez mettre en attente les 
informations de l'écran de contrôle des événements dans un fichier texte. 

Les informations suivantes peuvent permettre de diagnostiquer la cause de l'événement : 

■ Dateur/Horodateur : identifie le moment où s'est produit l'événement. 

■ Codes d'action : identifie la commande émise, comme « load drive ».

■ Codes de résultat : identifie le résultat de l'action demandée. Voir « Établissement de 
la liste des codes d'un résultat » page 437 pour rechercher un code de résultat. 

■ Diagnostic KSP (Known Service Plan, Plan de service connu) : identifie le mécanisme 
ou le composant responsable de la tâche ou de la défaillance. 

Remarque – Aucune option ne permet d'effacer le journal des événements.
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Autotests de la bibliothèque de bandes 
L'utilitaire de diagnostic de l'autotest est conçu pour diagnostiquer les problèmes de 
base intervenus au niveau des opérations de la bibliothèque de bandes. En général, un 
autotest est exécuté après l'installation de la bibliothèque de bandes. Il peut être exécuté 
dès que cela est nécessaire. 

Remarque – Les routines d'autotest de la bibliothèque de bandes ne coupent pas 
l'alimentation. 

Les autotests de la bibliothèque de bandes impliquent le processus suivant :

1. Contrôle du chemin d'accès des communications entre le contrôleur de la 
bibliothèque de bandes, les lecteurs et les TallBot. 

2. Exécution d'opérations get et put afin de contrôler la santé des TallBot et du CAP de 
rotation ou des AEM. Inclut les opérations get et put d'une cellule réservée à une 
cellule vide aléatoire :

■ Cellule de stockage 

■ cellule du CAP

3. Réalisation d'un audit complet de la bibliothèque de bandes. 

4. Montage et démontage des cartouches de diagnostic pour tous les lecteurs installés 
dans la bibliothèque de bandes.

Remarque – L'autotest ne démarre pas si aucune cartouche de diagnostic ne se trouve 
dans les cellules réservées.

Remarque – L'autotest est répété pour chaque type de lecteur si aucune cartouche de 
diagnostic compatible ne se trouve dans les cellules réservées. Si aucune cartouche de 
diagnostic n'est détectée pour un type de lecteur, l'opération de montage/démontage 
n'est pas effectuée pour le lecteur.
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Mises à niveau du microprogramme de la 
bibliothèque de bandes
Le microprogramme de la bibliothèque de bandes réside sur le contrôleur de la 
bibliothèque de bandes. Le microprogramme initial est installé en usine. Lorsqu'un 
nouveau microprogramme est commercialisé, vous devez utiliser l'utilitaire de 
chargement de codes pour mettre le microprogramme à jour sur la bibliothèque de 
bandes et les périphériques associés (CAP de rotation et des AEM et TallBot). 

Remarque – Le microprogramme de la bibliothèque de bandes ne contient aucune 
mise à jour des codes du lecteur.  

Sites de téléchargement du microprogramme
Le package du microprogramme de la bibliothèque de bandes SL3000 est un fichier 
.jar (archive Java).Voir « SunSolve et liens utiles » page xxxiv pour connaître les sites 
de téléchargement. 

Remarque – Vous devez disposer d'un ID de connexion et d'un mot de passe valides 
pour le site de téléchargement que vous consultez. Si vous avez besoin d'aide, contactez 
votre représentant du support technique Sun. 

Processus d'installation du microprogramme
Le processus de chargement du code du microprogramme sur le contrôleur de la 
bibliothèque de bandes est le suivant : 

1. Localisez le package de mise à niveau du microprogramme (fichier .jar ) sur le site 
de téléchargement Sun approprié. Voir « SunSolve et liens utiles » page xxxiv. 

2. Téléchargez le code dans un dossier sur votre PC ou station de travail local. 

3. Téléchargez le package du microprogramme de votre PC vers le contrôleur de la 
bibliothèque de bandes. Ce processus décompresse également le package après le 
téléchargement afin qu'il soit prêt à être activé. Voir « Téléchargement de code sur le 
contrôleur de la bibliothèque de bandes » page 442. 

4. Activez le code téléchargé sur le contrôleur de la bibliothèque de bandes. Voir 
« Activation de code sur le contrôleur de la bibliothèque de bandes » page 444. 

5. Redémarrez la bibliothèque de bandes pour rendre le code opérationnel. Voir 
« Redémarrage de la bibliothèque de bandes » page 440. 
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Audits 
Un audit consiste à lire et à cataloguer les cartouches d'une bibliothèque de bandes, à 
vérifier les emplacements des cartouches ou à valider une plage d'emplacements. Le 
contrôleur de la bibliothèque de bandes met à jour une base de données de cartouches 
qui renferme les informations suivantes pour toutes les cartouches de la bibliothèque 
de bandes :

■ Volume ID (Id de volume ou étiquette Volser) 

■ Emplacement actuel (au format de l'adresse interne de la bibliothèque de bandes)

■ État vérifié (true ou false)

La bibliothèque de bandes effectue un audit de tous les emplacements de cartouches 
dans la zone de stockage et dans la zone réservée aux moments suivants :

■ Lorsqu'une porte d'accès ou les deux ont été ouvertes et fermées. 

■ Lorsqu'une demande d'audit est effectuée via la Console d’administration 
StreamLine Library. 

■ Lorsqu'une demande d'audit de la bibliothèque de bandes effectuée par l'hôte est 
saisie. 

Vous pouvez utiliser la Console d’administration StreamLine Library pour réaliser les 
types d'audit suivant :

■ Audit physique 

■ Audit vérifié

Mise en garde – Des problèmes peuvent survenir au niveau du système si 
l'enregistrement des cartouches d'un hôte ne correspond pas à celui figurant dans la 
base de données des cartouches du contrôleur de la bibliothèque de bandes. 

Audit physique
Lors d'un audit physique, le TallBot visite les emplacements des cartouches et vérifie 
l'ID de volume des cartouches résidentes et le contrôleur de la bibliothèque de bandes 
met à jour la base de données des cartouches. Cet audit change l'état « verified » des 
emplacements des cartouches en « True ». Les périodes de réalisation des audits varient 
selon la taille de la bibliothèque de bandes. Les audits prennent environ 1/2 seconde 
par emplacement de cartouche, par TallBot.

La bibliothèque de bandes effectue un audit physique aux moments suivants. 

■ Lors de la mise sous tension de la bibliothèque de bandes, ou lorsque la porte d'accès 
d'une bibliothèque de bandes a été ouverte puis refermée. Un audit complet de 
l'ensemble de la bibliothèque de bandes est alors systématiquement réalisé. 

■ Dans les bibliothèque de bandes avec un AEM, dès la fermeture de la porte d'accès 
de l'AEM. Il s'agit d'un audit complet de l'AEM. 

■ Lorsqu'il est initié manuellement depuis la Console d’administration StreamLine 
Library. Il existe deux types d'audit physique initié manuellement :
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■ Un audit de l'ensemble de la bibliothèque de bandes : le TallBot visite toutes les 
cellules (stockage, CAP de rotation et des AEM et lecteur), catalogue les ID de 
volume et les emplacements, et met à jour la base de données des cartouches du 
contrôleur de la bibliothèque de bandes. Cet audit se déroule en tâche de fond et 
ne perturbe donc pas les opérations en ligne de la bibliothèque de bandes. Voir 
« Audit de l'ensemble de la bibliothèque de bandes » page 453 pour plus de 
détails.   

■ Audit d'une plage spécifique : le TallBot visite uniquement une plage spécifique 
de cellules (stockage, CAP de rotation et des AEM et lecteur) et met à jour la base 
de données des cartouches du contrôleur de la bibliothèque de bandes. Les 
informations sur l'audit sont affichées sur la Console d’administration StreamLine 
Library pendant la réalisation de l'audit. Voir « Audit d'une plage de cellules » 
page 455 pour plus de détails.

Audit vérifié
Un audit vérifié valide l'état d'un emplacement de cartouche ou d'une plage 
d'emplacements (CAP de rotation et des AEM et lecteurs compris) spécifique dans la 
base de données des cartouches. Si une adresse de cartouche présente « false » comme 
état vérifié, un audit physique de cet emplacement est alors effectué et la base de 
données des cartouches est mise à jour. La progression de l'audit est affiché dans la 
section Audit Console de la Console d’administration StreamLine Library. Voir 
« Exécution d'un audit vérifié » page 458 pour plus de détails. 
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Action de diagnostic du robot
L'action de diagnostic permet de contrôler ou de diagnostiquer un problème sur le 
TallBot. L'action peut être effectuée avec ou sans cartouches. 

Une action de diagnostic réussie ne réorganise pas les cartouches dans les cellules de 
stockage ; les cartouches sont renvoyées à leur emplacement d'origine à la fin de 
l'action de diagnostic. Il arrive toutefois qu'à la suite d'échecs d'action de diagnostic, les 
cartouches restent dans leur nouvel emplacement. 

Une action de diagnostic implique les éléments suivants :

■ Plage d'adresses cibles

■ Plage d'adresses de pool

■ Ordre d'accès de l'action

■ Sélection du robot

Plage d'adresses cibles 
La plage d'adresses cibles définit les paramètres d'emplacement dans une bibliothèque 
de bandes au sein de laquelle l'opération get est exécutée lors d'une action de 
diagnostic. Il existe deux types d'ordre d'accès pour une adresse cible :

■ « Ordre d'accès séquentiel » page 425 

■ « Ordre d'accès aléatoire » page 425 

Les types d'adresse cible suivants sont des types valides :

■ Cellules de stockage : réserve tous les emplacements de stockage en tant que plage 
cible/de pool

■ CAP : réserve des cellules dans un CAP de rotation ou des AEM en tant que plage 
cible/de pool. 

■ Cellules de lecteur et de stockage : réserve des lecteurs et des cellules de stockage en 
tant que plage cible/de pool.

■ Cellules système : réserve les cellules (réservées) système, contenant les cartouches 
de nettoyage ou de diagnostic, en tant que plage cible/de pool. 

■ Tout : réserve des cellules de stockage, des cellules système, un CAP de rotation ou 
des AEM et des lecteurs en tant que plage cible/de pool.

Remarque – Le fait de sélectionner les cellules de stockage, le CAP, les lecteurs, le 
système ou l'option All ne réserve en aucune façon tous les emplacements associés en 
tant que plage cible. Toutefois, seul l'emplacement auquel accède le TallBot pour une 
opération get/put n'est pas disponible pour l'hôte.
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Plage d'adresses de pool
Les emplacements de la plage d'adresses de pool servent à approvisionner les 
cartouches requises pour l'action de diagnostic vers et depuis la plage d'adresses cibles. 
Une adresse de pool est également employée dans une opération get si une adresse 
cible ne contient pas de cartouche. La plage d'adresses de pool ne répond à aucun ordre 
d'accès spécifié. Les plages d'adresses de pool n'incluent pas les emplacements des 
lecteurs.

Remarque – Les plages d'adresses de pool ne peuvent pas contenir les emplacements 
des lecteurs.

Ordre d'accès de l'action

Ordre d'accès séquentiel
Lors d'une action de diagnostic dans l'ordre d'accès séquentiel, le TallBot exécute une 
opération get en commençant par le premier emplacement des plages d'adresses cibles, 
puis il continue à visiter les emplacements de manière séquentielle sur l'ensemble de la 
plage jusqu'à ce qu'il ait effectué le nombre d'actions demandé. 

Remarque – Si vous choisissez de ne pas déplacer les cartouches, les opérations 
get/put ne sont pas exécutées. Le TallBot se positionne simplement aux adresses cibles 
et de pool.

Ordre d'accès aléatoire
Lors d'une action de diagnostic dans l'ordre d'accès aléatoire, le TallBot choisit 
aléatoirement un emplacement dans la plage d'adresses cibles afin d'obtenir une 
cartouche. Le TallBot peut également visiter plusieurs fois le même emplacement dans 
la plage d'adresses cibles afin de se procurer une cartouche. La routine à accès aléatoire 
se termine une fois que le nombre d'actions demandé est atteint. 

Si vous choisissez de ne pas déplacer les cartouches, les opérations get/put ne sont pas 
exécutées. Le TallBot se positionne simplement aux adresses cibles et de pool. 

Sélection du robot
Le TallBot qui effectue l'action de diagnostic est sélectionné en fonction des plages 
minimale et maximale que vous avez définies pour les adresses cibles et de pool. 
Plusieurs robots peuvent être sélectionnés si la plage d'adresses l'exige.
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Fonctions de contrôle du déplacement de diagnostic
Les options suivantes permettent de gérer les actions actuellement ouvertes :

Remarque – Si plusieurs actions de diagnostic sont ouvertes, chaque action possède 
alors son propre écran de contrôle.

Pour
Sélectionnez une option de 
menu Remarques

Démarrer File > Start Sequence

Interrompre File > Pause Sequence Arrête l'action de diagnostic, mais met 
à jour l'emplacement actuel dans 
l'ordre d'accès.

Arrêter  File > Stop Sequence Arrête un testeur en cours d'exécution 
ou en pause.

Reprendre File > Start Sequence Reprend un testeur en pause en 
commençant par le dernier 
emplacement connu dans la plage 
d'adresses cibles.

Effacer les messages affichés 
dans la fenêtre de l'écran de 
contrôle

File > Clear Output Window Efface les lignes du message précédent 
et continue à remplir l'écran avec de 
nouveaux messages.

Mettre en spool Spool File > Start Spooling Dirige la sortie de l'action vers un 
fichier.

Arrêter la mise en spool de 
la sortie du testeur vers un 
fichier

Spool File > Stop Spooling Arrête de diriger la sortie de l'action 
vers le fichier de spool.
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Dépannage 
Avant d'exécuter des tests de diagnostic, vérifiez les zones suivantes de la bibliothèque 
de bandes à l'aide des conseil de dépannage qui figurent dans le tableau ci-dessous :

TABLEAU 7-1 Tableau de dépannage 

Problème Action

Le voyant Service 
Required (orange) est 
constamment allumé.

Suivez la procédure ci-dessous :
À l'aide de la Console d’administration StreamLine Library, vérifiez la 
santé de la bibliothèque de bandes et des périphériques connectés 
(lecteurs, CAP de rotation et des AEM et TallBot). Pour plus de détails 
sur ces opérations, voir « Console de la bibliothèque de bandes 
StorageTek » page 37.
Pour effectuer un contrôle de santé :
1. Connectez-vous à l'application Console d’administration StreamLine 

Library.
2. Accédez au module System Detail, View > System Detail.
3. Contrôlez l'arborescence du périphérique pour les indicateurs 

suivants :
■ Device Healthy
■ Device Error
Les onglets Status (par exemple, en online/offline) et Statistics (par 
exemple, uptime, downtime, errors et warnings) fournissent davantage 
d'informations sur la santé de la bibliothèque de bandes et des 
périphériques. 
Autres contrôles :
■ Assurez-vous que les cartouches sont correctement insérées et 

orientées dans leurs cellules de stockage.
■ Inspectez la table X à la recherche d'objets ou de débris étrangers ; 

retirez-les, le cas échéant.

Le voyant CAP Open 
s'allume et clignote.

Ouvrez le CAP de rotation ou des AEM et assurez-vous que les 
cartouches dans les cellules CAP sont correctement insérées. 

La Console 
d’administration 
StreamLine Library 
n'affiche pas les 
données modifiées ou 
les informations 
demeurent statiques.

Contrôlez l'icône Console d’administration StreamLine Library 
Heartbeat.
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Le voyant orange Robot 
Fault ou Library Fault 
est constamment 
allumé.

1. Contrôlez la Console d’administration StreamLine Library pour 
rechercher des messages d'erreur. Inscrivez les messages d'erreur 
signalés.

2. Ouvrez la porte avant. Observez et notez l'état des cartouches, des 
lecteurs manuel et de bandes.

3. Assurez-vous que les cartouches sont correctement insérées et 
orientées dans leurs cellules de stockage.

4. Assurez-vous que l'emballage a été retiré.
5. Inspectez le sol de la bibliothèque de bandes à la recherche d'objets 

ou de débris étrangers ; retirez-les, le cas échéant.
6. Vérifiez l'état des lecteurs de bande.
7. Fermez la porte avant.
8. Assurez-vous que les lecteurs de bande sont correctement insérés et 

verrouillés à l'avant, en tirant et en appuyant à l'arrière du tiroir de 
lecteurs. Tout mouvement du tiroir indique qu'il doit être à nouveau 
inséré et verrouillé.

Le lecteur de bande ne 
parvient pas à éjecter 
une cartouche

Retirez manuellement la cartouche du lecteur de bande. 

L'ordinateur client ne 
peut pas communiquer 
avec la bibliothèque de 
bandes ou les lecteurs 
de bande.

1. Assurez-vous que les câbles sont correctement branchés à leurs 
connecteurs à l'arrière de la bibliothèque de bandes, des lecteurs de 
bande et de l'ordinateur client.

2. Veillez à ce que chaque périphérique SCSI sur le même bus possède 
une adresse unique, et que le dernier périphérique est correctement 
terminé.

La bibliothèque de 
bandes ne parvient pas 
à communiquer avec les 
lecteurs.
L'état du lecteur sur la 
Console d’administra-
tion StreamLine Libra-
ry indique Not 
communicating.

1. Assurez-vous que les câbles sont correctement branchés à leurs 
connecteurs à l'arrière de la bibliothèque de bandes, des lecteurs et 
de l'ordinateur client.

2. Veillez à ce que chaque périphérique SCSI sur un bus possède une 
adresse unique, et que le dernier périphérique est correctement 
terminé.

Messages de nettoyage 
ou nettoyages de lecteur 
répétés ou excessifs.

1. Remplacez la cartouche de nettoyage par une nouvelle.
2. Exécutez l'autotest de la bibliothèque de bandes et notez les erreurs 

éventuellement signalées concernant le lecteur.
3. Exécutez n'importe quel test de diagnostic de lecteur basé sur 

l'ordinateur client.

TABLEAU 7-1 Tableau de dépannage (Suite)

Problème Action
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Fichiers de support de diagnostic
Les fichiers de support de diagnostic suivants sont conservés sur la bibliothèque de 
bandes, afin d'aider au dépannage et à la résolution des problèmes d'analyse :

■ Fichier MIB

■ Fichier d'instantané de journal de bibliothèque de bandes

En fonction des circonstances, votre Sun représentant du support technique peut vous 
demander de transférer l'un de ces fichiers ou les deux sur Sun pour une évaluation 
supplémentaire, ou il peut effectuer cette opération lui-même. 

Fichier MIB
Le fichier MIB (Management Information Base) est une base de données SNMP (Small 
Network Management Protocol) qui sert à gérer vos périphériques de bibliothèque de 
bandes. Ce fichier peut être enregistré en tant que fichier texte. Voir « Transfert du 
fichier MIB de la bibliothèque de bandes » page 447 pour plus de détails. 

Fichier d'instantané de journal de bibliothèque de 
bandes

Remarque – Cette fonctionnalité est disponible à partir de la version FRS_2.30 du 
microprogramme de la SL3000 et de la version FRS_4.30 de la Console d’administration 
StreamLine Library. 

Votre Sun représentant du support technique peut utiliser des commandes CLI 
privilégiées pour générer un instantané chiffré du journal d'événements de la 
bibliothèque de bandes. Vous ne pouvez pas afficher ni modifier ce fichier. Il est 
disponible pendant 15 minutes uniquement après sa création. Voir « Transfert du fichier 
d'instantané du journal de la bibliothèque de bandes » page 449 pour plus de détails. 
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Tâches de diagnostic et d'utilitaire  
Les tâches de diagnostic et d'utilitaire de la bibliothèque de bandes se divisent en 
plusieurs catégories :

■ « Tâches de l'écran de contrôle des événements » page 431

■ « Tâches d'utilitaire de la bibliothèque de bandes » page 438

■ « Tâches d'audit » page 452

■ « Tâches d'utilitaire du CAP de rotation et des AEM » page 460

■ « Tâches d'utilitaire des lecteurs » page 466

■ « TallBot Tâches d'utilitaire » page 470

■ « Tâches d'utilitaire de porte de sécurité de l'AEM » page 487
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Tâches de l'écran de contrôle des 
événements

Tâche Page

Affichage d'unn écran de contrôle des événements 432

Mise en attente des données d'écran de contrôle des événements 
dans un fichier

433

Affichage de plusieurs écrans de contrôle 434

Établissement de la liste des codes de statut d'un périphérique 435

Établissement de la liste des codes d'un résultat 437
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▼ Affichage d'unn écran de contrôle des événements
Les informations sur l'écran de contrôle des événements sont mises à jour de manière 
dynamique en fonction de l'occurrence des événements sélectionnés. Les informations 
envoyées au cours d'une opération de messagerie (e-mail), d'impression, de sauvegarde 
ou de spool reflètent les données (et le format) affichées à l'écran au moment où 
l'opération est demandée. 

Remarque – Les écrans de contrôle des événements constituent des outils utiles pour 
analyser les causes premières des erreurs. Si la bibliothèque de bandes rencontre des 
erreurs reproductibles, vous pouvez ouvrir un écran de contrôle des événements et 
mettre en spool tous les événements vers un fichier afin de capturer les données. Par la 
suite, vous pourrez envoyer le fichier à votre représentant du support technique Sun 
pour analyse. 

Remarque – Voir « Affichage de plusieurs écrans de contrôle » page 434 pour des 
informations sur le contrôle de plusieurs événements.

1. Sélectionnez Tools > Monitors.

2. Développez le dossier Permanent Monitors. 

Les écrans de contrôle de la bibliothèque de bandes auxquels vous avez accès sont 
affichés. 

3. Cliquez sur l'écran de contrôle des événements que vous souhaitez utiliser, puis sur 
Open dans la barre Options. 

Le système affiche les données associées recueillies pour l'événement.

4. Utilisez ces options pour gérer les informations affichées à l'écran pour l'événement 
sélectionné :

5.  Pour fermer un écran de contrôle, cliquez sur le X en haut à droite de la fenêtre. 

Sélectionnez Pour

Monitor > Pause Interrompre l'affichage continu des données liées à l'événement 
sélectionné

Monitor > Resume Reprendre l'affichage des événements

Monitor > Stop Arrêter définitivement l'affichage continu des données liées à 
l'événement sélectionné

Monitor > Clear Effacer l'affichage de l'écran de contrôle des événements 
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▼ Mise en attente des données d'écran de contrôle 
des événements dans un fichier
Cette procédure permet de mettre en attente et d'enregistrer des données d'écran de 
contrôle des événements dans un fichier. Vous pourrez envoyer le fichier à votre 
représentant du support technique Sun pour vous aider à analyser les problèmes. 

1. Sélectionnez Tools > Monitors.

2. Développez le dossier Permanent Monitors. 

Les écrans de contrôle de la bibliothèque de bandes auxquels vous avez accès sont 
affichés. 

3. Cliquez sur l'écran de contrôle des événements que vous souhaitez utiliser, puis sur 
Open dans la barre Options. 

Le système affiche la fenêtre d'écran de contrôle des événements.

4. Dans la fenêtre d'écran de contrôle des événements, sélectionnez 
Spool File > Start Spooling. 

La fenêtre contextuelle Save s'affiche.

5. Cherchez le répertoire dans lequel vous souhaitez enregistrer le fichier. Dans le 
champ File Name, saisissez le nom du fichier et cliquez sur Save. 

Toutes les données d'événement sont mises en attente dans le fichier spécifié. 

6. Pour arrêter la mise en attente, sélectionnez Monitor > Stop Spooling. 

Ci-dessous figure un exemple de fichier de mise en attente :
2008-05-29T11:23:27.448  0,1,0,0     root  default       internal        281    warn   
0  rb_Reboot::reboot(): Resetting drive [0,3,4,9]
2008-05-29T11:23:27.760  0,1,0,0     root  default       internal        281    info   
0  Service Beacon is ACTIVE: Current Health Event indicates Drive 04 in Module 03 is 
not operational
2008-05-29T11:23:53.211  0,1,0,0     root  default       internal        281    info   
0  Service Beacon is ACTIVE: Current Health Event indicates Drive 04 in Module 03 is 
operational 
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▼ Affichage de plusieurs écrans de contrôle
Vous pouvez ouvrir et gérer plusieurs écrans de contrôle des événements en utilisant 
les sélections suivantes de la barre Options :

Pour Sélectionnez

Organiser de manière personnalisée les écrans de contrôle 
ouverts à l'écran

Window > Arrange

Organiser les fenêtres de l'écran de contrôle des événements à 
l'horizontale

Window > Tile 
Horizontal

Organiser les fenêtres de l'écran de contrôle des événements à la 
verticale

Window > Tile 
Vertical

Empiler les écrans de contrôle des événements Window > Cascade
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▼ Établissement de la liste des codes de statut d'un 
périphérique
Utilisez cette procédure pour établir la liste des codes de statut du périphérique et leur 
description. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet Search.

La fenêtre Library Search s'affiche. 

4. Dans la liste déroulante Search Type, cliquez sur Device Status. 

5. Renseignez le champ Device Status comme suit :

■ Pour rechercher un code de statut de périphérique spécifique, saisissez le code 
complet ; les caractères génériques et les codes partiels ne sont pas acceptés. 

■ Pour établir la liste de tous les codes de statut de périphérique, cochez la case List 
All. 
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6. Cliquez sur Search dans la barre Options. 

La fenêtre énumère les codes de statut de périphérique spécifiés et leur description. 
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▼ Établissement de la liste des codes d'un résultat
Cette procédure permet d'établir la liste des codes de résultat et leur description. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet Search.

La fenêtre Library Search s'affiche. 

4. Dans la liste déroulante Search Type, cliquez sur Result Code. 

5. Renseignez le champ Result Code comme suit :

■ Pour rechercher un code, saisissez le code complet ; les caractères génériques et les 
codes partiels ne sont pas acceptés. 

■ Pour établir la liste de tous les codes, cochez la case List All. 
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▼ Exécution d'un autotest de la bibliothèque de 
bandes 

Remarque – Les cartouches de diagnostic correspondant aux lecteurs de la 
bibliothèque de bandes doivent se trouver dans la bibliothèque de bandes. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet SelfTest.

Remarque – La fenêtre d'autotest affiche un champ Mode comportant deux options : 
disruptive et non-disruptive. Actuellement, seule l'option non-disruptive est valide. 

4. Cliquez sur l'onglet Run de la barre Options.

Pendant l'autotest, la fenêtre de la Console d’administration StreamLine Library affiche 
l'état des divers diagnostics en cours d'exécution.
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▼ Redémarrage de la bibliothèque de bandes
Cette procédure permet de redémarrer la bibliothèque de bandes. Ce processus 
implique de recharger le microprogramme à partir de la mémoire flash et de 
redémarrer le contrôleur de la bibliothèque de bandes.

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur Reboot dans la barre Options.

La fenêtre contextuelle de confirmation Reboot s'affiche. 

4. Cliquez sur OK pour continuer. 

Si la bibliothèque de bandes est en ligne, la fenêtre contextuelle de confirmation Offline 
apparaît.

5. Cliquez sur OK pour basculer la bibliothèque de bandes hors ligne. 

La fenêtre contextuelle de confirmation Reboot s'affiche 

6. Cliquez sur OK pour continuer. 

La fenêtre contextuelle Console d’administration StreamLine Library termination 
s'affiche.
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7. Cliquez sur OK pour terminer cette session de la Console d’administration 
StreamLine Library. 

Vous êtes déconnecté de la Console d’administration StreamLine Library. 

Le contrôleur de la bibliothèque de bandes redémarre la bibliothèque de bandes. Cela 
peut durer plusieurs minutes. 

Remarque – Vous ne pourrez pas vous reconnecter à la Console d’administration 
StreamLine Library avant l'initialisation complète de la bibliothèque de bandes. 
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▼ Téléchargement de code sur le contrôleur de la 
bibliothèque de bandes
Cette procédure permet de télécharger des mises à jour sur le microprogramme du 
contrôleur de la bibliothèque de bandes. Elle n'est pas utilisée pour le téléchargement 
de mises à jour de microprogramme de lecteur.

Remarque – Vous pouvez suivre cette procédure uniquement à partir de la Console 
d’administration StreamLine Library autonome ou de la Console d’administration 
StreamLine Library Web, mais pas du Panneau opérateur local. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.
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3. Cliquez sur l'onglet Load Code. 

4. Cliquez sur le bouton Browse pour rechercher l'emplacement, sélectionnez le dossier 
et le nom du fichier contenant le package du microprogramme (fichier .jar ) sur 
votre PC, puis cliquez sur Open.

5. Cliquez sur le bouton Load de la barre Options.

6. Cliquez sur OK pour confirmer le téléchargement. 

Remarque – Le processus de téléchargement doit durer cinq minutes maximum. La 
Console d’administration StreamLine Library indique la progression du transfert du 
fichier du PC vers le contrôleur de la bibliothèque de bandes.

Remarque – Le système décompresse le package à la fin du téléchargement. 

7. Lorsque le package est correctement décompressé, vous pouvez activer le code 
immédiatement ou ultérieurement. Voir « Activation de code sur le contrôleur de la 
bibliothèque de bandes » page 444 pour plus de détails.



 

Tâches d'utilitaire de la bibliothèque de bandes

444 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

▼ Activation de code sur le contrôleur de la 
bibliothèque de bandes 
L'activation du code rend le code résidant dans le contrôleur de la bibliothèque de 
bandes prêt à être utilisé. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet Activate Code.
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4. Cliquez sur Target dans le menu déroulant.

Remarque – Target fait référence au package du microprogramme ( fichier .jar ) 
contenant le code de la bibliothèque de bandes SL3000.

5. Cliquez sur le code à activer depuis la section Available Versions. 

Remarque – La version comportant un « * » comme préfixe correspond au code actif. 
Vous ne pouvez pas sélectionner à nouveau ce code pour l'activer.

6. Cliquez sur le bouton Activate de la barre Options.

Remarque – Le processus d'activation du code peut durer jusqu'à dix minutes.

Mise en garde – CORRUPTION INTERNE POSSIBLE DE FICHIERS. Ne redémarrez 
aucun périphérique dans la bibliothèque de bandes et n'exécutez aucune opération sur 
la bibliothèque de bandes pendant l'activation du code.

7. Cliquez sur OK pour continuer.

Remarque – La fenêtre Activate Console affiche l'état du processus d'activation du 
code. Le code que vous venez d'activer est répertorié dans la section Available Versions, 
marqué d'un « * ». La version décompressée et les versions précédemment activées du 
code sont également indiquées (sans le « * »). 

8. Le système vous invite à redémarrer la bibliothèque de bandes. Cliquez sur OK pour 
redémarrer la bibliothèque de bandes.

Remarque – La bibliothèque de bandes possède deux versions du fichier image 
résidant dans la mémoire flash. Une fois que la bibliothèque de bandes a terminé le 
processus de redémarrage, la dernière image devient active et la version antérieure sert 
de sauvegarde. La version antérieure peut être restaurée, le cas échéant. 

9. Cliquez sur OK pour terminer la session de la Console d’administration StreamLine 
Library.

10.Dans la fenêtre de connexion, cliquez sur Exit pour fermer l'application. 

Attendez que la bibliothèque de bandes termine son initialisation avant de vous 
reconnecter à la Console d’administration StreamLine Library.
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Remarque – Le contrôleur de la bibliothèque de bandes transfère à la Console 
d’administration StreamLine Library l'ensemble des données de configuration de 
la bibliothèque de bandes. Par conséquent, vous devez faire preuve de précaution 
lorsque vous vous connectez à la Console d’administration StreamLine Library avant 
l'initialisation complète de la bibliothèque de bandes. Des messages d'avertissement 
risquent de s'afficher indiquant que les données de configuration ne sont pas encore 
disponibles, auquel cas vous devrez quitter l'application et vous reconnecter 
ultérieurement. Par ailleurs, en cas de réalisation d'un audit pendant la séquence 
d'initialisation, les données de configuration qui s'affichent risquent de ne pas 
être totalement actualisées et exactes avant la fin de l'audit. 
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▼ Transfert du fichier MIB de la bibliothèque de 
bandes
Cette procédure permet de copier le fichier MIB (Management Information Base) SNMP 
public dans un emplacement spécifié sur votre PC ou station de travail local. Le fichier 
est enregistré en tant que fichier texte. Vous pouvez envoyer le fichier à votre 
représentant du support technique Sun par e-mail afin de permettre de diagnostiquer 
les problèmes intervenus au niveau de la bibliothèque de bandes. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet TransferFile. 

La fenêtre file transfer apparaît. 
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4. Dans le champ du fichier texte Transfer SNMP public MIB, cliquez sur le bouton 
Transfer. 

La fenêtre contextuelle Save s'affiche. 

5. Cherchez le répertoire dans lequel vous souhaitez enregistrer le fichier et saisissez 
son nom dans le champ File Name. Pensez à lui donner .txt comme suffixe. 

6. Cliquez sur Save. 

Les données sont enregistrées dans le fichier spécifié et la fenêtre contextuelle 
Transferred Successful apparaît. 

7. Cliquez sur OK pour fermer la fenêtre contextuelle. 
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▼ Transfert du fichier d'instantané du journal de la 
bibliothèque de bandes

Remarque – Utilisez cette procédure uniquement avec l'aide de votre Sun 
représentant du support technique. Votre Sun représentant du support technique doit 
avoir généré un fichier d'instantané de journal de bibliothèque de bandes lors des 15 
minutes précédentes.

Cette procédure permet de copier le fichier d'instantané de journal de la bibliothèque 
de bandes dans un emplacement spécifié sur votre PC ou station de travail local. Ce 
fichier est enregistré dans un format chiffré, vous ne pouvez donc pas l'afficher ni le 
modifier. Vous pouvez envoyer le fichier à votre représentant du support technique Sun 
par e-mail afin de permettre de diagnostiquer les problèmes intervenus au niveau de la 
bibliothèque de bandes. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.
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3. Cliquez sur l'onglet TransferFile. 

La fenêtre file transfer apparaît. 

4. Dans le champ du fichier texte Transfer log, cliquez sur le bouton Transfer. 

La fenêtre contextuelle Save s'affiche. 
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5. Cherchez le répertoire dans lequel vous souhaitez enregistrer le fichier et saisissez 
son nom dans le champ File Name. 

6. Cliquez sur Save. 

Les données sont enregistrées dans le fichier spécifié et la fenêtre contextuelle 
Transferred Successful apparaît. 

7. Cliquez sur OK pour fermer la fenêtre contextuelle. 
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▼ Audit de l'ensemble de la bibliothèque de bandes
Au cours de cet audit, le TallBot visite toutes les cellules de stockage, catalogue les ID 
de volume et les emplacements, et met à jour la base de données du contrôleur de la 
bibliothèque de bandes. 

Remarque – Bien que cet audit se déroule en tâche de fond et qu'il n'interrompe pas 
les opérations de la bibliothèque de bandes, il requiert le partage des ressources du 
TallBot. Il n'est par conséquent pas recommandé d'effectuer cet audit pendant des 
périodes d'activité de pointe. 

Remarque – Vous ne pouvez pas arrêter cet audit une fois qu'il a commencé. L'audit 
prend environ 1/2 seconde par emplacement de cartouche. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.
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3. Cliquez sur l'onglet Audit.

La fenêtre Library Audit s'affiche. 

4. Cliquez sur Yes dans le champ Entire Library. Cliquez ensuite sur le bouton Audit de 
la barre Options.

Une fenêtre contextuelle de demande de confirmation s'affiche. 

5. Cliquez sur OK pour effectuer l'audit en tâche de fond ou sur Cancel pour annuler 
l'audit.

Remarque – Une fois que vous avez cliqué sur OK, vous ne pouvez plus arrêter 
l'audit ; il ira jusqu'à la fin. 

6. Vous pouvez visualiser le rapport récapitulatif des cartouches après quelques heures 
pour connaître les derniers emplacements des cartouches et les ID de volume. Voir 
« Affichage d'un rapport de la bibliothèque de bandes » page 111 pour plus de détails.
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▼ Audit d'une plage de cellules
Au cours de cet audit, le TallBot visite uniquement une plage spécifique de cellules de 
stockage (notamment le CAP et les lecteurs) et met à jour la base de données du 
contrôleur de la bibliothèque de bandes.

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet Audit.

La fenêtre Library Audit s'affiche. 

4. Cliquez sur No dans le champ Entire Library et sur Yes dans le champ Physical 
Audit. Cliquez sur No dans le champ Verified Audit.
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5. Sélectionnez, dans les champs Start Address et End Address, les types de périphéri-
que que vous souhaitez auditer ainsi que les emplacements des adresses internes de 
début et de fin de la bibliothèque de bandes.Voir « Adresse interne de la bibliothèque 
de bandes » page 509 pour une explication plus détaillée de ce format d'adresse. 

6. Cliquez sur le bouton Audit de la barre Options.

Une fenêtre contextuelle de demande de confirmation s'affiche. 

7. Cliquez sur OK pour effectuer l'audit en tâche de fond ou sur Cancel pour annuler 
l'audit.

Remarque – Une fois que vous avez cliqué sur OK, vous ne pouvez plus arrêter 
l'audit ; il ira jusqu'à la fin. 

8. La section Audit Console affiche la progression de l'audit. 
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Remarque – Vous pouvez également visualiser le rapport récapitulatif des cartouches 
pour connaître les derniers emplacements des cartouches et les ID de volume. Voir 
« Affichage d'un rapport de la bibliothèque de bandes » page 111 pour plus de détails.



 

Tâches d'audit

458 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

▼ Exécution d'un audit vérifié
Un audit vérifié valide l'état d'un emplacement de cartouche ou d'une plage 
d'emplacements (CAP de rotation et des AEM et lecteurs compris) spécifique dans la 
base de données du contrôleur de la bibliothèque de bandes. Si une adresse de 
cartouche présente « false » comme état vérifié, un audit physique de cet emplacement 
est alors effectué et la base de données du contrôleur de la bibliothèque de bandes est 
mise à jour. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet Audit.

La fenêtre Library Audit s'affiche. 
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4. Cliquez sur No dans le champ Entire Library, sur No dans le champ Physical Audit et 
sur Yes dans le champ Verified Audit. 

5. Sélectionnez, dans les champs Start Address et End Address, les types de périphéri-
que que vous souhaitez auditer ainsi que les emplacements des adresses internes de 
début et de fin de la bibliothèque de bandes.Voir « Adresse interne de la bibliothèque 
de bandes » page 509 pour une explication plus détaillée de ce format d'adresse. 

6. Cliquez sur le bouton Audit de la barre Options.

La section Audit Console affiche la progression de l'audit. 
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▼ Réalisation d'un autotest sur un CAP de rotation 
ou des AEM 

Remarque – Actuellement, les autotests du CAP exécutent les mêmes routines que 
l'autotest de la bibliothèque de bandes. Des autotests spécifiques du CAP de rotation et 
des AEM seront disponibles ultérieurement.

1. Sélectionnez Tools > Diagnostics.

2. Développez le dossier CAP, puis cliquez sur le CAP à tester. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 

3. Cliquez sur l'onglet SelfTest.

4. Dans le menu déroulant Mode, cliquez sur Non-Disruptive. 

5. Cliquez sur le bouton Run de la barre Options.

Les messages d'état sont affichés pendant l'exécution de l'autotest. Le message 
Diagnostic completed apparaît à la fin du test. 
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▼ Basculement d'un CAP de rotation ou des AEM 
hors ligne 
Cette procédure permet de basculer un CAP de rotation ou des AEM hors ligne via la 
Console d’administration StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier CAP puis cliquez sur le CAP à modifier. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 
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3. Cliquez sur l'onglet Status.

La fenêtre affiche l'état actuel du CAP. 

4. Dans le champ Transition Request, cliquez sur Take Offline. Cliquez sur Apply. 

Toutes les tâches en suspens du CAP sont achevées, puis l'état du CAP change, comme 
suit :

■ État de santé : Warn

■ État du périphérique : Not accessible (connexions à l'hôte HLI) ; Not ready 
(connexions à l'hôte SCSI) 

■ État de l'accès : Offline
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▼ Basculement d'un CAP de rotation ou des AEM en 
ligne 
Cette procédure permet de basculer un CAP de rotation ou des AEM en ligne via la 
Console d’administration StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

Remarque – Les périphériques de la bibliothèque de bandes hors ligne présentant un 
état d'erreur ne peuvent pas se connecter tant que la cause de l'erreur n'a pas été 
corrigée. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier CAP puis cliquez sur le CAP à modifier. 

Remarque – Les CAP des AEM sont identifiés comme suit : colonne « –31 » pour un 
CAP des AEM gauche, et colonne « 31 » pour un CAP des AEM droit. 
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3. Cliquez sur l'onglet Status.

La fenêtre affiche l'état actuel du CAP. 

4. Dans le champ Transition Request, cliquez sur Bring online. Cliquez sur Apply. 

L'état du CAP est mis à jour de la manière suivante :

■ État de santé : ok

■ État du périphérique : Ready

■ État de l'accès : Online
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▼ Exécution d'un autotest des lecteurs 
1. Sélectionnez Tools > Diagnostics.

2. Développez le dossier Drive puis cliquez sur le lecteur à tester. 

3. Cliquez sur l'onglet SelfTest.

4. Dans le menu déroulant Mode, cliquez sur Non-Disruptive. 

5. Cliquez sur le bouton Run de la barre Options.

Les messages d'état sont affichés pendant l'exécution de l'autotest. Le message 
Diagnostic completed apparaît à la fin du test. 
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▼ Basculement d'un lecteur hors ligne 
Cette procédure permet de basculer un lecteur hors ligne via la Console 
d’administration StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier Drive puis cliquez sur le lecteur à modifier. 

3. Cliquez sur l'onglet Status.

La fenêtre affiche l'état actuel du lecteur. 

4. Dans le champ Transition Request, cliquez sur Take Offline. Cliquez sur Apply. 

Toutes les tâches en suspens du lecteur sont achevées, puis l'état du lecteur change, 
comme suit :

■ État de santé : Warn

■ État du périphérique : Not accessible (connexions à l'hôte HLI) ; Not ready 
(connexions à l'hôte SCSI) 

■ État de l'accès : Offline
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▼ Basculement d'un lecteur en ligne 
Cette procédure permet de basculer un lecteur en ligne via la Console d’administration 
StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

Remarque – Les périphériques de la bibliothèque de bandes hors ligne présentant un 
état d'erreur ne peuvent pas se connecter tant que la cause de l'erreur n'a pas été 
corrigée. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier Drive puis cliquez sur le lecteur à modifier. 

3. Cliquez sur l'onglet Status.

La fenêtre affiche l'état actuel du lecteur. 

4. Dans le champ Transition Request, cliquez sur Bring online. Cliquez sur Apply. 

L'état du lecteur est mis à jour de la manière suivante :

■ État de santé : ok

■ État du périphérique : Ready

■ État de l'accès : Online
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▼ Exécution d'un autotest du TallBot 

Remarque – Pour exécuter un autotest du TallBot, la bibliothèque de bandes doit 
contenir des cartouches de diagnostic. 

1. Sélectionnez Tools > Diagnostics.

2. Développez le dossier Robot, puis cliquez sur le robot à tester. 

3. Cliquez sur l'onglet SelfTest.

4. Dans le menu déroulant Mode, cliquez sur Non-Disruptive. 

5. Cliquez sur le bouton Run de la barre Options.

Les messages d'état sont affichés pendant l'exécution de l'autotest. Le message 
Diagnostic completed apparaît à la fin du test. 
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▼ Basculement d'un TallBot hors ligne 
Cette procédure permet de basculer un TallBot hors ligne via la Console 
d’administration StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier Robot, puis cliquez sur le TallBot à modifier. 

3. Cliquez sur l'onglet Status.

La fenêtre affiche l'état actuel du TallBot. 

4. Dans le champ Transition Request, cliquez sur Take Offline. Cliquez sur Apply. 

Toutes les tâches en suspens du TallBot sont achevées, puis l'état du TallBot change, 
comme suit :

■ État de santé : Warn

■ État du périphérique : Not accessible (connexions à l'hôte HLI) ; Not ready 
(connexions à l'hôte SCSI) 

■ État de l'accès : Offline

5. Le TallBot est déplacé à la fin du rail et ne peut pas être utilisé par la bibliothèque de 
bandes. Si la bibliothèque de bandes utilise la fonctionnalité de TallBot redondant, 
le deuxième TallBot reçoit toutes les demandes. 
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▼ Basculement d'un TallBot en ligne 
Cette procédure permet de basculer un TallBot en ligne via la Console d’administration 
StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

Remarque – Les périphériques de la bibliothèque de bandes hors ligne présentant un 
état d'erreur ne peuvent pas se connecter tant que la cause de l'erreur n'a pas été 
corrigée. 

1. Sélectionnez Tools > System Detail. 

2. Développez le dossier Robot, puis cliquez sur le TallBot à modifier. 

3. Cliquez sur l'onglet Status.

La fenêtre affiche l'état actuel du TallBot. 

4. Dans le champ Transition Request, cliquez sur Bring Online. Cliquez sur Apply. 

L'état du TallBot est mis à jour de la manière suivante :

■ État de santé : ok

■ État du périphérique : Ready

■ État de l'accès : Online
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▼ Définition d'une action de diagnostic 
Plusieurs routines d'action de diagnostic peuvent être configurés et exécutés 
simultanément tant que les plages d'adresses cibles et de pool ne se chevauchent pas. 

Remarque – Cette procédure requiert le partage des ressources du TallBot ; il n'est par 
conséquent pas recommandé de l'exécuter pendant des périodes d'activité de pointe. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet DiagMove puis sur l'onglet Manage. 

La fenêtre Diagnostic Move Manage apparaît.
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4. Cliquez sur Add dans la section Defined Sequence.

La fenêtre TARGET s'affiche. 

5. Complétez la fenêtre TARGET comme suit : Voir « Plage d'adresses cibles » page 424 
pour plus de détails. 

■ Dans le champ Selection Mode, cliquez sur le type de cellule à diagnostiquer. 

■ Dans les champs Minimum Address et Maximum Address, sélectionnez l'adresse 
interne de la bibliothèque de bandes des emplacements de début et de fin des 
cellules à diagnostiquer. 
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6. Cliquez sur Next. 

La fenêtre SOURCE s'affiche. 

7. Complétez la fenêtre SOURCE comme suit : Voir « Plage d'adresses de pool » page 425 
pour plus de détails. 

■ Dans le champ Selection Mode, cliquez sur le type d'adresse de pool de cartouches 
approprié. 

■ Dans les champs Minimum Address et Maximum Address, sélectionnez les 
adresses internes de la bibliothèque de bandes des emplacements de début et de fin 
du pool de cartouches à utiliser.
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8. Cliquez sur Next.

La fenêtre Sequence s'affiche. 

9. Complétez la fenêtre Sequence comme suit. Voir « Ordre d'accès de l'action » page 425 
pour plus de détails. 

■ Nom (Name) de l'action de diagnostic

■ Move Count (indiquez un nombre entre 1 et 5 000)

■ Access Order (Sequential ou Random)

■ Move Type (Robot & Cartridge ou Robot Only) 

■ Désélectionnez la case pre move cartridge compatibility
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10.Cliquez sur Finish pour terminer la configuration.

La fenêtre Diagnostic Move Manage apparaît. La séquence de diagnostic que vous 
venez de définir est indiquée dans la section Defined Sequences. 
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▼ Gestion des définitions d'action de diagnostic 
Cette procédure sert à gérer les définitions de séquence d'actions de diagnostic. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet DiagMove puis sur l'onglet Manage. 

La fenêtre Diagnostic Move Manage apparaît.
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4. Dans la section Defined Sequences, sélectionnez l'une des options suivantes :

5. Pour gérer les actions de diagnostic actuellement ouvertes, voir « Contrôle des actions 
de diagnostic ouvertes » page 485.

Sélection-
nez une 
option Pour Remarques

Add Définir une action de 
diagnostic 

Open Démarrer une action de 
diagnostic

Plusieurs actions de diagnostic peuvent être ouvertes en 
même temps tant que les plages d'adresses cible et de pool 
configurées pour les actions ne se chevauchent pas.

Modify Modifier des options 
pour une action de 
diagnostic

Cette routine d'action de diagnostic ne doit pas être ouverte 
ou, si elle l'est, elle doit être dans l'état « Stopped ».

Remove Supprimer une action de 
diagnostic

Cette routine d'action de diagnostic ne doit pas être ouverte.

Copy Copier une action de 
diagnostic existante

Copiez la définition d'une action de diagnostic, modifiez-la 
si besoin est et donnez-lui un autre nom.
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▼ Enregistrement d'une action de diagnostic dans 
un fichier 
Cette procédure permet d'enregistrer une action de diagnostic définie dans un fichier 
local sur votre PC ou station de travail. Ce fichier est enregistré en tant que composant 
JavaBean, représenté sous forme de document XML 1.0 (.xml). 

Les utilisations possibles du fichier enregistré sont les suivantes :

■ Peut servir à restaurer une action qui a été supprimée de la bibliothèque de bandes. 

■ Peut être copié dans une bibliothèque de bandes différente pour une utilisation à cet 
emplacement. 

1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.
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3. Cliquez sur l'onglet DiagMove puis sur l'onglet Manage. 

La fenêtre Diagnostic Move Manage apparaît.

4. Cliquez sur l'action de diagnostic à enregistrer, puis sur le bouton Save dans la barre 
Options. 

La fenêtre contextuelle Save s'affiche.
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5. Cherchez le répertoire dans lequel vous souhaitez enregistrer le fichier. Dans le 
champ File Name, saisissez le nom du fichier. 

6. Cliquez sur Save. 

Les données sont enregistrées dans le fichier souhaité. Voici un exemple d'extrait :
<?xml version="1.0" encoding="UTF-8"?> 
<java version="1.5.0_11" class="java.beans.XMLDecoder"> 
 <object class="com.stortek.ats.elib.opel.model.SequenceBeanList"> 
  <string>FRS_4.10</string> 
  <string>SL500</string> 
  <void method="add"> 
   <object class=
"com.stortek.ats.elib.opel.model.SequenceBeanList$SequenceBean"> 
    <void property="accessOrder"> 
     <string>Sequential</string> 
    </void> 
    <void property="moveCartridge"> 
     <boolean>true</boolean> 
    </void> 
    <void property="moveCount"> 
     <int>10</int> 
    </void> 
    <void property="name"> 
     <string>DriveDiagMove1</string> 
    </void> 
    . . .
    <void property="targetType"> 
     <string>Drive</string> 
    </void> 
   </object> 
  </void> 
 </object> 
</java> 
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▼ Démarrage d'une action de diagnostic
1. Sélectionnez Tools > Diagnostics. 

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.

La fenêtre Library s'affiche.

3. Cliquez sur l'onglet DiagMove puis sur l'onglet Manage. 

La fenêtre Diagnostic Move Manage apparaît.

4. Dans la section Defined Sequences, cliquez sur une action de diagnostic puis sur Open. 

La fenêtre Monitor est activée. 

Vous pouvez répéter cette étape pour ouvrir plusieurs actions, tant que les plages 
d'adresses cible et de pool configurées pour les actions ne se chevauchent pas.

Une fenêtre de l'écran de contrôle apparaît pour chaque action ouverte.

5. À partir de chaque fenêtre d'écran de contrôle, sélectionnez File > Start Sequence 
pour démarrer l'action. 
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▼ Contrôle des actions de diagnostic ouvertes
Cette procédure permet de contrôler l'état d'une ou de plusieurs actions de diagnostic 
ouvertes. 

1. Pour obtenir des instructions concernant le démarrage d'une ou de plusieurs actions 
de diagnostic, voir « Démarrage d'une action de diagnostic » page 484. 

2. Cliquez sur l'onglet Monitor. 

La fenêtre Monitor apparaît, avec une fenêtre de contrôle pour chaque action ouverte.

Chaque fenêtre de contrôle possède les indicateurs d'état suivants :

Indicateurs d'état Description Valeurs valides

Spooling Status Indique si la sortie de l'action est mise en 
attente dans un fichier 

True, False

State État d'exécution actuel de l'action Running, pausing, paused, 
stopping, stopped

Health État de santé actuel de l'action OK, warning, error

Completed moves Nombre d'actions terminées dans le 
nombre d'actions demandées 



 

TallBot Tâches d'utilitaire

486 Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

3. Utilisez le menu File dans chaque fenêtre Monitor pour effectuer l'une des fonctions 
suivantes :

Sélectionnez une option Pour Remarques

File > Start Sequence Démarrer 

File > Pause Sequence Interrompre Arrête l'action de diagnostic, mais met à 
jour l'emplacement actuel dans l'ordre 
d'accès.

File > Stop Sequence Arrêter   Arrête une action en cours d'exécution ou 
en pause.

File > Start Sequence Reprendre Reprend une action en pause en 
commençant par le dernier emplacement 
connu dans la plage d'adresses cibles.

File > Clear Output Window Effacer les messages 
affichés dans la fenêtre de 
l'écran de contrôle

Efface les lignes du message précédent et 
continue à remplir l'écran avec de 
nouveaux messages.

Spool File > Start Spooling Mettre en spool Dirige la sortie de l'action vers un fichier.

Spool File > Stop Spooling Arrêter la mise en spool de 
la sortie de l'action vers un 
fichier

Arrête de diriger la sortie de l'action vers 
le fichier de spool.
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Tâches d'utilitaire de porte de sécurité de 
l'AEM

Tâche Page

Redémarrage d'une porte de sécurité de l'AEM 488
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▼ Redémarrage d'une porte de sécurité de l'AEM 
Utilisez cette procédure pour redémarrer une porte de sécurité de l'AEM. Vous devrez 
éventuellement procéder de la sorte pour effacer les erreurs, si la porte de sécurité de 
l'AEM a rencontré un problème. 

1. Sélectionnez Tools > Diagnostics.

2. Développez le dossier Safety Door, puis cliquez sur la porte de sécurité de l'AEM à 
redémarrer. 

3. Cliquez sur Reboot dans la barre Options.

Si la porte de sécurité est en ligne, la fenêtre contextuelle Offline Confirm apparaît. 
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4. Cliquez sur OK pour basculer la porte de sécurité hors ligne. 

La fenêtre contextuelle Reboot Confirm s'affiche. 

5. Cliquez sur OK. 

Le contrôleur de la bibliothèque de bandes redémarre la porte de sécurité. La porte de 
sécurité est réinitialisée, puis le TallBot analyse la CAP des AEM.

La fenêtre contextuelle Reboot Success s'affiche. 

6. Cliquez sur OK pour fermer la fenêtre contextuelle. 
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CHAPITRE 8

Utilisation en mode manuel

L'hôte ne peut pas accéder à la bibliothèque de bandes en mode de fonctionnement 
manuel. Il est possible que cela soit dû à une erreur irrécupérable survenue au niveau 
de la bibliothèque de bandes ou au fait qu'un composant de la bibliothèque de bandes 
doive être dépanné ou installé. Lorsque la bibliothèque de bandes est dans ce mode, les 
montages et démontages de cartouches doivent être effectués par un technicien. 

Sécurité de la bibliothèque de bandes
Lisez attentivement les précautions de sécurité de cette section avant d'essayer d'entrer 
dans la bibliothèque de bandes. Il est primordial de suivre scrupuleusement les 
procédures de sécurité appropriées. 

Précautions de sécurité générales

Avertissement – Risque de blessure physique.  Pour empêcher que la porte 
d'accès ne se referme par inadvertance alors qu'une personne se trouve dans la 
bibliothèque de bandes, il est recommandé, lorsque vous déverrouillez la porte 
d'accès, de la bloquer en position ouverte et de conserver la clé sur vous. 

Avant d'entrer dans la bibliothèque de bandes, vous devez : 

■ Connaître l'emplacement des mécanismes de déverrouillage d'urgence de la porte. 
Voir « Mécanismes de verrouillage de la porte de la bibliothèque de bandes SL3000 » 
page 492.

■ Laisser la porte d'accès ouverte chaque fois que vous travaillez dans la bibliothèque 
de bandes. Chaque encadrement de porte comporte un interrupteur qui débranche 
l'alimentation CC et les circuits de transmission vers les moteurs de la bibliothèque 
de bandes lors de l'ouverture d'une porte d'accès. Voir « Interruption de 
l'alimentation du servo-moteur de la bibliothèque de bandes SL3000 » page 492.

■ Connaître l'emplacement des déclencheurs mécaniques de la porte. Voir 
« Déclencheurs mécaniques de la porte » page 492. 

■ Connaître les restrictions physiques. Voir « Restrictions physiques » page 493. 
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Mécanismes de verrouillage de la porte de la 
bibliothèque de bandes SL3000
Les mécanismes de verrouillage de sécurité de la porte sont situés derrière les portes 
d'accès avant du module de base et du DEM. Une clé d'accès est requise pour ouvrir les 
portes d'accès. 

Les mécanismes de verrouillage de sécurité de la porte sont constamment contrôlés par 
le contrôleur de la bibliothèque de bandes. Pendant le fonctionnement normal, si une 
porte d'accès est ouverte, une condition Arrêt robotisé d'urgence est initiée et tous les 
moteurs de la bibliothèque de bandes sont immédiatement désactivés. Ceci empêche les 
moteurs de fonctionner lorsqu'une porte de la bibliothèque de bandes est ouverte. Si la 
bibliothèque de bandes est basculée hors ligne, l'ouverture de la porte d'accès désactive 
les tensions CC vers les rails et le bus d'alimentation. 

Les interrupteurs de porte sont également contrôlés lorsque la bibliothèque de 
bandes est mise hors tension. Une batterie alimente la circuiterie afin qu'elle détecte 
l'ouverture/la fermeture d'une porte pendant que la bibliothèque de bandes est mise 
hors tension.

Lorsqu'un module de base et un DEM sont connectés ensemble, l'ouverture d'une 
porte d'accès vers l'un des deux modules suspend automatiquement les opérations sur 
l'ensemble de la bibliothèque de bandes (les deux interrupteurs de porte sont connectés 
en série).

Interruption de l'alimentation du servo-moteur de 
la bibliothèque de bandes SL3000
La fonctionnalité d'interruption de l'alimentation du servo-moteur (SPI) constitue une 
fonctionnalité de sécurité supplémentaire. Si le contrôleur de la bibliothèque de bandes 
détecte qu'un moteur de la bibliothèque de bandes est hors plage, il génère une SPI afin 
de désactiver la tension du lecteur vers le moteur défectueux. Ceci permet d'éviter que 
le servo-moteur ne s'emballe tant que la cause du problème n'a pas été déterminée. 

Déclencheurs mécaniques de la porte
Chaque poignée de verrouillage placée sur les portes d'accès du module de base et du 
DEM est dotée d'un déclencheur mécanique peint en jaune (voir la FIGURE 8-1.) Ce 
déclencheur fait office de dispositif de protection dans l'éventualité où une personne se 
trouverait dans la bibliothèque de bandes et que la porte d'accès se fermerait et se 
verrouillerait par inadvertance. Lorsque vous poussez le déclencheur, la porte se 
déverrouille et s'ouvre. 
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FIGURE 8-1 Déclencheur mécanique de la porte 

Éclairage intérieur
L'intérieur de la bibliothèque de bandes est toujours éclairé par des DEL blanches 
disposées au plafond. 

Restrictions physiques
La bibliothèque de bandes n'est pas suffisamment grande pour permettre de se 
déplacer librement. Gardez toujours en tête que son espace est restreint. 

■ Veillez à ne pas déchirer vos vêtements sur les matrices en place qui contiennent les 
cartouches (seulement 0,4 m [18 pouces] d'espace libre dans les allées).

■ Veillez également à ne pas vous cogner la tête ou le corps contre les matrices. 

■ Pour accéder à une cartouche, vous devrez peut-être déplacer un TallBot en prenant 
toutes les précautions possibles pour ne pas endommager les composants 
électroniques du TallBot. 

■ Si vous chargez ou déchargez une cartouche manuellement, tenez vos mains éloignées 
des composants de charge mécaniques et électroniques du lecteur.
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▼ Basculement de la bibliothèque hors ligne 
Cette procédure permet de basculer la bibliothèque de bandes hors ligne via la Console 
d’administration StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

Vous devrez probablement utiliser cette procédure :

■ Avant de mettre hors tension la bibliothèque de bandes

■ Avant d'ouvrir une porte d'accès de la bibliothèque de bandes

■ Lorsque la bibliothèque de bandes est inopérante et a besoin d'être entretenue 

1. Basculez tous les lecteurs de la bibliothèque de bandes hors ligne. 

Voir « Basculement d'un lecteur hors ligne » page 468 pour plus de détails. 

2. Sélectionnez Tools > System Detail.

3. Cliquez sur le dossier Library dans l'arborescence des périphériques.
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4. Cliquez sur l'onglet Status puis sur l'onglet General.

L'état actuel de la bibliothèque de bandes est affiché. 

5. Dans le champ Transition Request, cliquez sur Take offline. Cliquez sur Apply.

Toutes les tâches en suspens de la bibliothèque de bandes sont achevées, puis l'état de 
la bibliothèque de bandes change, comme suit :

■ État de santé : Warn

■ État du périphérique : Not accessible (connexions à l'hôte HLI) ; Not ready 
(connexions à l'hôte SCSI) 

■ État de l'accès : Offline 
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▼ Basculement de la bibliothèque en ligne 
Cette procédure permet de basculer la bibliothèque de bandes en ligne via la Console 
d’administration StreamLine Library. 

Remarque – Cette procédure ne s'applique qu'à condition de ne pas utiliser de 
logiciels de gestion de bandes ACSLS ou HSC ou si leurs serveurs ne parviennent pas à 
communiquer avec la bibliothèque de bandes. ACSLS et HSC ne sont pas informés en 
cas de modification de l'état de la bibliothèque de bandes ou de ses composants par le 
biais de la Console d’administration StreamLine Library, ce qui peut perturber les 
opérations de la bibliothèque de bandes. Pour plus d'informations concernant la 
modification de l'état de la bibliothèque de bandes et de ses composants par le biais 
d'ACSLS ou d'HSC, consultez la documentation du logiciel de gestion de bandes 
correspondante. 

Remarque – Les lecteurs LTO Ultrium sont automatiquement mis en ligne lors de la 
mise en ligne de la bibliothèque de bandes.

1. Sélectionnez Tools > System Detail.

2. Cliquez sur le dossier Library dans l'arborescence des périphériques.
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3. Cliquez sur l'onglet Status puis sur l'onglet General.

La fenêtre affiche l'état actuel de la bibliothèque de bandes. 

4. Dans le champ Transition Request, cliquez sur Bring online. 

5. Cliquez sur Apply. 

L'état de la bibliothèque de bandes est mis à jour de la manière suivante :

■ État de santé : ok

■ État du périphérique : Ready

■ État de l'accès : Online

6. Le cas échéant, basculez la bibliothèque de bandes en ligne vers les hôtes ACSLS et 
HSC. Pour connaître les procédures détaillées, consultez la documentation ACSLS et 
HSC. 
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▼ Mise hors tension de la bibliothèque de bandes
Cette procédure permet de mettre la bibliothèque de bandes hors tension. 

1. Basculez tous les lecteurs de la bibliothèque de bandes hors ligne. 

Voir « Basculement d'un lecteur hors ligne » page 468 pour plus de détails. 

2. Basculez la bibliothèque de bandes hors ligne. 

Voir « Basculement de la bibliothèque hors ligne » page 495 pour plus de détails. 

3. Ouvrez les portes arrière du module de base et du DEM (le cas échéant). 

4. Mettez les interrupteurs d'activation de l'alimentation sur Arrêt. 

5. Si besoin est, mettez les disjoncteurs sur les PDU sur Arrêt. 
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▼ Mise sous tension de la bibliothèque de bandes
Cette procédure permet de mettre la bibliothèque de bandes sous tension. Si les portes 
d'accès ont été ouvertes et fermées, un audit complet de la bibliothèque de bandes sera 
effectué. 

1. Ouvrez les portes arrière du module de base et du DEM (le cas échéant). 

2. Si besoin est, mettez les disjoncteurs sur les PDU sur Marche. 

3. Mettez les interrupteurs d'activation de l'alimentation sur Marche. 

4. La bibliothèque de bandes accomplit la procédure d'initialisation comme suit :

Remarque – Le contrôleur de la bibliothèque de bandes transfère à la Console 
d’administration StreamLine Library l'ensemble des données de configuration de 
la bibliothèque de bandes. Par conséquent, vous devez faire preuve de précaution 
lorsque vous vous connectez à la Console d’administration StreamLine Library avant 
l'initialisation complète de la bibliothèque de bandes. Des messages d'avertissement 
risquent de s'afficher indiquant que les données de configuration ne sont pas encore 
disponibles, auquel cas vous devrez quitter l'application et vous reconnecter 
ultérieurement. Par ailleurs, en cas de réalisation d'un audit pendant la séquence 
d'initialisation, les données de configuration qui s'affichent risquent de ne pas 
être totalement actualisées et exactes avant la fin de l'audit. 

1. Le code du contrôleur de la bibliothèque de bandes est activé.

2. Le contrôleur de la bibliothèque de bandes effectue une détection électronique des 
composants de la bibliothèque de bandes :

a. Détermine la configuration de l'alimentation CA (N+1 ou 2N). 

b. Vérifie le fonctionnement du contrôleur des lecteurs de bande. 

c. Contrôle les fonctions facultatives (par exemple, un Panneau opérateur local). 

d. Établit la communication et détermine la configuration du contrôleur TallBot. 

e. Sonde tous les lecteurs de bande et détermine leur emplacement. 

f. Interroge tous les CAP de rotation et des AEM :

- Si la porte du CAP est entièrement ouverte, elle le restera. 

- Si l'état de la porte du CAP est indéterminé, il est mis à jour sur closed and 
locked.

3. Le TallBot effectue le processus de détection physique :

a. Le TallBot balaye toute la bibliothèque de bandes afin d'en déterminer la taille. 

b. Le TallBot scanne le bloc d'identification de module dans chaque module. 

c. La bibliothèque de bandes est configurée automatiquement en fonction de ces 
informations. 
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4. Si l'une des portes d'accès a été ouverte et fermée, un audit de la bibliothèque de 
bandes commence, comme suit : 

a. Le TallBot cible sur chaque colonne des matrices (de haut en bas). 

b. Le TallBot scanne chaque colonne vers le haut en enregistrant les ID de volume de 
toutes les cartouches. 

c. L'emplacement de chaque ID de volume est enregistré dans la base de données du 
contrôleur de la bibliothèque de bandes. 

d. Les cellules de stockage dépourvues de cartouches sont marquées comme vides.

e. Si une cartouche est détectée dans un CAP de rotation ou des AEM, ce CAP est 
fermé et verrouillé. 

Remarque – Cet audit ne met pas à jour les bases de données des cartouches de l'hôte. 
Pour plus d'informations sur la mise à jour des bases de données de l'hôte, consultez la 
documentation du logiciel de gestion de bandes appropriée. 

5. La bibliothèque de bandes passe à l'état Ready.

5. Basculez la bibliothèque de bandes en ligne.

Voir « Basculement de la bibliothèque en ligne » page 497 pour plus de détails. 
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▼ Ouverture de la porte d'accès principal de la 
bibliothèque de bandes 
Cette procédure permet d'ouvrir les portes principales de la bibliothèque de bandes. 

Avertissement – Risque de blessure physique.  Pour empêcher que la porte 
d'accès ne se referme par inadvertance alors qu'une personne se trouve dans la 
bibliothèque de bandes, il est recommandé, lorsque vous déverrouillez la porte 
d'accès, de la bloquer en position ouverte et de conserver la clé sur vous. 

1. Basculez tous les lecteurs de la bibliothèque de bandes hors ligne. 

Voir « Basculement d'un lecteur hors ligne » page 468 pour plus de détails. 

2. Basculez la bibliothèque de bandes hors ligne. 

Voir « Basculement de la bibliothèque hors ligne » page 495 pour plus de détails. 

3. Introduisez la clé dans le verrou de porte, puis tournez-la pour déverrouiller la porte. 

4. Remontez le loquet de la porte pour le libérer et ouvrez la porte.

5. Tournez la clé dans le verrou, afin de déverrouiller la porte, puis retirez la clé du 
verrou et conservez-la avec vous. Ceci empêchera la porte de se fermer pendant que 
vous vous trouvez dans la bibliothèque de bandes.

6. Pénétrez dans la bibliothèque de bandes. 
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▼ Fermeture et verrouillage de la porte d'accès 
principal de la bibliothèque de bandes 
Cette procédure permet de fermer et de verrouiller les portes principales de la 
bibliothèque de bandes. 

1. Vérifiez qu'aucun élément de la bibliothèque de bandes n'est desserré.

2. Si les portes d'accès ont été bloquées en position ouverte, introduisez la clé dans le 
verrou de porte, puis tournez-la pour déverrouiller la porte. 

3. Fermez la porte et assurez-vous que le loquet s'enclenche fermement. 

4. Tournez la clé dans le verrou pour bloquer la porte en position fermée.

5. Retirez la clé du verrou et conservez-la dans un endroit sûr. 

6. Si la bibliothèque de bandes a été mise hors tension, mettez-la sous tension. 

Voir « Mise sous tension de la bibliothèque de bandes » page 500 pour plus de détails. 

Remarque – Les portes d'accès ayant été ouvertes, un audit complet de la bibliothèque 
de bandes sera effectué. 
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▼ « Accès rapide » à l'AEM
Cette procédure vous permet d'accéder d'urgence à l'AEM. 

Mise en garde – Cette procédure produit les mêmes effets sur les opérations de 
bibliothèque de bandes que l'ouverture de la porte d'accès de bibliothèque de bandes 
principale. Elle entraîne une interruption soudaine de l'activité de la bibliothèque de 
bandes, et ne doit être utilisée que dans des circonstances exceptionnelles, comme la 
défaillance d'un composant de l'AEM. Cette procédure n'abaisse pas la porte de sécurité 
de l'AEM interne. 

Remarque – Lors de la fermeture de la porte d'accès de l'AEM, un audit complet de la 
bibliothèque de bandes est démarré. Voir « Fermeture de la porte d'accès à l'AEM après 
un « accès rapide » » page 505. 

1. Insérez la clé de la porte d'accès à la bibliothèque de bandes dans le verrou Deadbolt 
Override, puis déverrouillez la porte en faisant tourner la clé dans le sens des 
aiguilles d'une montre.

Remarque – Une fois en position déverrouillée, la clé ne peut pas être retirée du 
verrou.

2. Levez le loquet de la porte d'accès à l'AEM, puis ouvrez la porte.

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture de la porte d'accès de l'AEM.

L'ensemble de l'alimentation électrique des rails est coupée, tandis que les TallBot sont 
immédiatement arrêtés. 

Toutes les tâches en cours sont brusquement arrêtées, tandis que les TallBot et les CAP 
des AEM sont placés hors ligne. 

Mise en garde – La porte de sécurité de l'AEM n'est pas abaissée. 
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▼ Fermeture de la porte d'accès à l'AEM après un 
« accès rapide »
Cette procédure permet de fermer la porte d'accès à l'AEM et de réinitialiser la 
bibliothèque de bandes après un « accès rapide » à l'AEM. 

Remarque – Cette procédure démarre un audit complet de la bibliothèque de bandes. 

1. Fermez la porte d'accès de l'AEM avec le loquet.

Mise en garde – Risque de dommages matériels. NE PAS forcer l'ouverture ou la 
fermeture de la porte d'accès de l'AEM.

2. Verrouillez la porte en tournant la clé dans le sens contraire des aiguilles d'une 
montre dans le verrou Deadbolt Override. 

■ La bibliothèque de bandes est réinitialisée. 

■ Les TallBot effectuent leur séquence d'initialisation. 

■ Un audit complet de la bibliothèque de bandes est effectué. 

■ Le CAP des AEM est mis en ligne et reprend ensuite son état par défaut. 
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ANNEXE A

Adresses des ressources de la 
bibliothèque de bandes 

Cet annexe décrit les schémas d'adressage de la bibliothèque de bandes suivants : 

■ Adresse interne de la bibliothèque de bandes – Utilisé par le contrôleur de la 
bibliothèque de bandes.

■ Emplacements HLI-PRC – Utilisés par les hôtes établissant des connexions TCP/IP 
avec la bibliothèque de bandes.

■ Emplacements des éléments FC-SCSI – Utilisés par les hôtes établissant des 
connexions FC SCSI avec la bibliothèque de bandes. 

■ Numéros du matériel du lecteur – Emplacement de la matrice physique dans lequel 
un lecteur est installé. 

■ Nom universel dynamique de lecteur – Générés automatiquement par le contrôleur 
de la bibliothèque de bandes pour les lecteurs installés. 

Ces schémas permettent de localiser toutes les ressources de la bibliothèque de bandes, 
notamment :

■ Les cellules de stockage de cartouches

■ Les emplacements des lecteurs de bande

■ Les lecteurs installés 

■ Les cellules du système/réservées

■ Cellules de CAP de rotation et des AEM 

Technologie CenterLine 
La conception modulaire de la bibliothèque de bandes SL3000 fait appel à la 
technologie CenterLine pour équilibrer les déplacements robotiques et améliorer les 
performances de la bibliothèque de bandes. La partie gauche du module de base, qui 
représente le seul module requis, sert de point milieu (centerline). Vous pouvez ajouter 
d'autres modules à gauche et à droite du module de base. Les colonnes situées à droite 
du point milieu comportent des numéros positifs (+) et celles à gauche des numéros 
négatifs (-). 
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FIGURE A-1 Point milieu (centerline) et adressage de colonnes 

Point milieu

Colonnes comportant un numéro négatif 
(-) 

Colonnes comportant un numéro 
positif (+) 

 Lecteurs -4,    -3,    -2,     -1 1,     2,     3,     4 

Cartouches -12, -11, -10, -9, -8, -7 -6, -5, -4, -3, -2, -1  1,  2,  3,  4,  5,  6 7,  8,  9,  10, 11, 12
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Adresse interne de la bibliothèque de 
bandes

Cellules de stockage
Le schéma d'adressage interne de la bibliothèque de bandes SL3000 comprend cinq 
composants : 

1. Numéro de la bibliothèque de bandes : toujours « 1 ». 

2. Numéro du rail : toujours « 1 ».

3. Numéro de la colonne : l'emplacement horizontal. La numérotation des colonnes 
commence à partir du bord gauche du module de base, depuis l'avant de la 
bibliothèque de bandes. Les colonnes situées à droite de ce bord, qu'elles se trouvent 
au sein du module de base même ou qu'elles soient connectées à droite, sont 
numérotées positivement (+), de gauche à droite, en commençant par +1. Les 
colonnes dans des modules connectés à gauche du module de base sont numérotées 
négativement (–), de droite à gauche, en commençant par –1. 

4. Partie : la façade arrière = 1, la façade avant = 2.

5. Ligne : la position verticale. La numérotation des lignes s'effectue de haut en bas et 
de 1 à 52. 

Remarque – Pour n'importe quelle bibliothèque de bandes, la numérotation réelle des 
colonnes et des lignes dépend des modules installés, ainsi que de la configuration des 
lecteurs par rapport aux cellules de stockage. Voir TABLEAU A-1 page 510 pour plus de 
détails. 

Exemple d'adresse interne de la bibliothèque de bandes - 
Module de base
Pour un exemple d'utilisation du schéma d'adressage interne de la bibliothèque de 
bandes, reportez-vous au TABLEAU A-1 page 510, où le numéro du matériel du 
lecteur 13 se décomposerait en 1, 1, +4, 1, 4, comme suit : 

1. Numéro de la bibliothèque de bandes = 1 

2. Numéro du rail = 1

3. Numéro de la colonne = +4

4. Partie = 1

5. Ligne = 4
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TABLEAU A-1 Module de base - Emplacements de la façade arrière (vus depuis l'avant de la 
bibliothèque de bandes) 

Ligne          +1          +2          +3          +4

   +1 Lecteur 4 Lecteur 3 Lecteur 2 Lecteur 1

   +2 Lecteur 8 Lecteur 7 Lecteur 6 Lecteur 5

   +3 Lecteur 12 Lecteur 11 Lecteur 10 Lecteur 9

   +4 Lecteur 16 Lecteur 15 Lecteur 14 Lecteur 13

         +1          +2          +3          +4          +5          +6

+24 Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

  ~

+35

+36 Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

  ~

+48

+49
  ~

    Pas de 
matrice

Cellule 
supérieure 
deux = 
Dépose

Diagnostic/
nettoyage 
4 cellules

Identifiant 
4 cellules

Diagnostic/
nettoyage 
4 cellules

Diagnostic/
nettoyage 
4 cellules

+52 Cellule 
inférieure = 
Échange

Remarque : Vue de l'avant de la bibliothèque de bandes.
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Deuxième exemple, l'emplacement des deux cellules de dépose sur cette façade est...

1. Numéro de la bibliothèque de bandes = 1

2. Numéro du rail = 1

3. Numéro de la colonne = +2

4. Partie = 1

5. Lignes = 49 et 50

... ce qui se traduit par 1, 1, +2, 1, 49 et 1, 1, +2, 1, 50.

Exemple d'adresse interne de la bibliothèque de bandes – DEM
Repérez le numéro du matériel du lecteur 27 dans le TABLEAU A-2 page 512. Afin 
d'illustrer l'utilisation du schéma d'adressage interne de la bibliothèque de bandes, cet 
emplacement de lecteur serait... 

1. Numéro de la bibliothèque de bandes = 1

2. Numéro du rail = 1

3. Numéro de la colonne = -3

4. Partie = 1

5. Ligne = 1

... ce qui se traduit par 1, 1, -3, 1, 1.

Deuxième exemple, l'emplacement de la matrice quatre cellules susceptible de contenir 
les cartouches de diagnostic sur cette façade est...

1. Numéro de la bibliothèque de bandes = 1

2. Numéro du rail = 1

3. Numéro de la colonne = -4

4. Partie = 1

5. Lignes = 49 à 52

... ce qui se traduit par 1, 1, -4, 1, 49 à 1, 1, -4, 1, 52.
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Cellules du système/réservées 
Deux cellules au total sont réservées dans le module de base uniquement pour les 
emplacements de dépose et une cellule est réservée en tant que cellule d'échange. 
Toutes les cellules restantes du système, indiquées dans le TABLEAU A-3 page 513, 
peuvent être utilisées pour les cartouches de diagnostic ou de nettoyage.

Le module de base comprend 12 cellules au total pour les cartouches de diagnostic ou 
de nettoyage, et le DEM 12 ou 15 cellules au total pour les cartouches de diagnostic ou 
de nettoyage. Ces cellules sont également reprises dans le TABLEAU A-3 page 513.

TABLEAU A-2 Module d'extension du lecteur – Emplacements de la façade arrière (vus depuis l'avant 
de la bibliothèque de bandes) 

         -4          -3          -2          -1 Ligne

Lecteur 28 Lecteur 27 Lecteur 26 Lecteur 25    1

Lecteur 32 Lecteur 31 Lecteur 30 Lecteur 29    2

         -6          -5          -4          -3          -2          -1

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

   13

   ~

   23

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

Cellules de 
stockage

   24

   ~

   35

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

Cellules de 
stockage 

   36

   ~

   48

Pas de 
matrice

Cellule 
supérieure 
2 = Dépose

Diagnostic/
nettoyage 
4 cellules

Identifiant 
4 cellules

Diagnostic/
nettoyage 
4 cellules

Diagnostic/
nettoyage 
4 cellules

   49
   ~

Cellule 
inférieure 
= Échange

   52

Remarque : Vue de l'avant de la bibliothèque de bandes.
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Un CEM ou un PEM ne contient aucune cellule réservée.

Cellules du CAP 
Les emplacements des cellules dans les CAP suivent un schéma de notation similaire à 
celui d'autres emplacements dans la bibliothèque de bandes : 

1. Numéro de la bibliothèque de bandes : (toujours « 1 »)

2. Numéro du rail : (toujours « 1 »)

3. Numéro de la colonne : l'emplacement horizontal. La numérotation des colonnes 
commence à partir du bord gauche (lorsque vous vous tenez face à la façade 
intérieure avant) du module de base. À partir de ce bord gauche, les colonnes 
reçoivent un numéro positif (+), de manière consécutive et de gauche à droite, sur 
l'ensemble des modules connectés à la partie droite du module de base. 

À l'inverse, si un module est relié à la partie gauche du module de base, les colonnes 
reçoivent un numéro négatif (-), de manière consécutive et de droite à gauche, sur 
l'ensemble des modules.

4. Partie : (toujours « 2 » [façade avant]).

5. Ligne : la position verticale, numérotée en partant de la cellule supérieure de la 
colonne. Les cellules sont numérotées de 1 à 13 pour le magasin supérieur et de 14 à 
26 pour le magasin inférieur. Les poignées des magasins sont situées dans les parties 
supérieures de chaque magasin du CAP. 

Remarque – La poignée du magasin n'est pas comptée comme une cellule.

TABLEAU A-3 Cellules réservées 

Emplacements 
des cellules Type de module Utilisation Emplacement

1, 1, 2, 1, 49 – 50 Module de base Cellules de dépose (réservées)
Façade arrière du module 
de base 

1, 1, -4, 1, 49 – 50
DEM Cartouches de 

nettoyage/diagnostic
Façade arrière du DEM 

1, 1, 2, 1, 51 Module de base Cellule d'échange (réservée)
Façade arrière du module 
de base 

1, 1, -5, 1, 51 DEM
Cartouches de 
nettoyage/diagnostic

Façade arrière du DEM 

1, 1, 5, 1, 49 – 52
1, 1, 6, 1, 49 – 52

Module de base
Cartouches de 
nettoyage/diagnostic 

Façade arrière du module 
de base 

1, 1, -1, 1, 49 – 52
1, 1, -2, 1, 49 – 52

DEM
Cartouches de 
nettoyage/diagnostic

Façade arrière du DEM 

 Remarque : Ne placez pas des cartouches de données dans une cellule réservée. Ces cellules sont 
masquées de la base de données du client (en d'autres termes, un TallBot en ligne ne se retrouvera 
jamais dans ces cellules).
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Exemples d'adresse interne de la bibliothèque de bandes - 
Cellules du CAP
La quatrième cellule du CAP en bas d'un module de base serait... 

1. Numéro de la bibliothèque de bandes = 1

2. Numéro du rail = 1

3. Numéro de la colonne = +5

4. Partie = 2

5. Ligne = 4

... ce qui se traduit par 1, 1, +5, 2, 4.

La sixième cellule du CAP en bas d'un DEM serait...

1. Numéro de la bibliothèque de bandes = 1

2. Numéro du rail = 1

3. Numéro de la colonne = -2

4. Partie = 2

5. Ligne = 6

... ce qui se traduit par 1, 1, -2, 2, 6.
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Emplacements HLI-PRC

Cellules de stockage
L'emplacement HLI-PRC (Host Library Interface-Panel, Row, Column) (adresse) est une 
valeur à huit chiffres séparés par une virgule (LL, PP, RR, CC) représentant le LSM, le 
panneau, la ligne et la colonne. Ce schéma d'adressage est utilisé par les clients HLI, 
notamment ACSLS et HSC, pour représenter les cellules de stockage des cartouches qui 
sont accessibles à ces clients HLI. 

Remarque – L'adresse interne de la bibliothèque de bandes SL3000 identifie 
l'emplacement physique de la cartouche dans la bibliothèque de bandes et HLI-PRC 
fait référence à l'adresse assignée par le logiciel hôte.

L'emplacement des cellules apparaît au format suivant : 

où 

LL : numéro LSM (toujours « 00 »)
PP : Panneau (par rapport au module de base – numéros décroissants à gauche et 
numéros croissants à droite ; numéros pairs = façades arrière, numéros impairs = 
façades avant)

■ Module de base = panneaux 12 et 13

■ DEM ajouté à gauche = panneaux 10 et 11

Remarque – Exception : Si un CEM est ajouté à gauche d'un module de base à la 
place d'un DEM, la numérotation des panneaux de ce module sera 8 et 9 (voir 
« Emplacements des cellules de stockage HLI-PRC – Exemple trois » page 517). Ceci 
vous permettra d'installer un DEM ultérieurement sans avoir à renuméroter les modules.

■ module ajouté à droite = panneaux 14 et 15

Remarque – RR : ligne dans le panneau (numéro compris entre 0 et 51) 
Notez la différence ici. Les lignes de l'adresse interne de la bibliothèque de bandes 
commencent par « 1 » et les lignes HLI-PRC par « 0 ».

CC : colonne dans la ligne (numérotée de gauche à droite en commençant par l'avant 
du module)

Remarque – CC : colonnes dans le panneau (numéro compris entre 0 et 5.
Notez la différence ici. Les colonnes de l'adresse interne de la bibliothèque de bandes 
commencent par « 1 » et les lignes HLI-PRC par « 0 ».

      L       L       P       P       R       R       C       C
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Emplacements des cellules de stockage HLI-PRC – Exemple un
Pour un exemple de formulation de ce schéma de numérotation, consultez le 
TABLEAU A-4. 

Dans l'exemple un, la bibliothèque de bandes se compose de deux modules. 
L'emplacement des cellules d'une cartouche sur la façade arrière du module de base 
dans la colonne 5, ligne 24, se traduirait par : 

LL = 00, PP = 12, RR = 24, CC = 05 ; ou 00, 12, 24, 05 

Emplacements des cellules de stockage HLI-PRC – Exemple 
deux
L'ajout d'un module à gauche de la bibliothèque de bandes décrite dans l'exemple un 
illustre le schéma de numérotation « décroissant gauche ». Consultez le TABLEAU A-5 
qui décrit le fonctionnement de ce schéma. 

TABLEAU A-4 Emplacements des cellules de l'interface de la bibliothèque de bandes de l'hôte – 
Exemple un

Module d'extension de lecteur Module de base

Façade arrière = panneau 10 Façade arrière = panneau 12

Numéros des colonnes des cartouches Numéros des colonnes des cartouches

0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5

Numéros des colonnes des cartouches Numéros des colonnes des cartouches

Façade avant = panneau 11 Façade avant = panneau 13

Remarque : Vue de l'avant de la bibliothèque de bandes.

TABLEAU A-5 Emplacements des cellules de l'interface de la bibliothèque de bandes de l'hôte – 
Exemple deux

Module d'extension de 
cartouche

Module d'extension de lecteur Module de base

Façade arrière = panneau 8 Façade arrière = panneau 10 Façade arrière = panneau 12

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

Façade avant = panneau 9 Façade avant = panneau 11 Façade avant = panneau 13

Remarque : Vue de l'avant de la bibliothèque de bandes.



Emplacements HLI-PRC

418605501 • Révision AB Annexe A Adresses des ressources de la bibliothèque de bandes 517

Dans cet exemple, un CEM a été ajouté à gauche du DEM. Ses panneaux sont 
maintenant numérotés 8 et 9. Ajoutez un autre module à gauche de cette bibliothèque 
de bandes et ses panneaux deviennent 6 et 7. 

À l'inverse, l'ajout d'un module à droite du module de base donnerait aux panneaux de 
ce module les numéros 14 et 15, et ainsi de suite. 

Emplacements des cellules de stockage HLI-PRC – Exemple 
trois
Le troisième exemple présenté dans le TABLEAU A-6 constitue une exception à la 
numérotation continue des panneaux. Dans cette bibliothèque de bandes, deux CEM 
ont été ajoutés à gauche d'un module de base. Notez qu'en l'absence de DEM, les 
panneaux à gauche du module de base comporte désormais les numéros 8 et 9, et non 
plus 10 et 11.

Ceci indique :

■ La seule exception au schéma de numérotation des panneaux consécutifs

■ Que si un DEM est installé ultérieurement, la numérotation des panneaux ne 
changera pas pour les modules existants

Remarque – Ce schéma de numérotation profite grandement aux clients car l'ajout 
d'un module ne nécessite aucune modification de leur configuration de panneaux 
existante.

Bien que le logiciel de gestion des bandes de l'hôte suive un schéma de numérotation à 
cinq chiffres comme celui de l'adresse de la SL3000, il existe des différences notables au 
niveau des désignations des cellules et du comportement du CAP de rotation et des 
AEM, et d'autres considérations de fonctionnement telles que celles décrites ci-dessous.

Si vous devez localiser l'emplacement HLI-PRC d'une cartouche, consultez la section 
« Localisation d'une cartouche par son ID de volume » page 147. Cette procédure 
affiche les informations sur la cartouche tant au format de l'adresse interne de la 
bibliothèque de bandes qu'au format de l'adresse HLI-PRC. 

TABLEAU A-6 Emplacements des cellules de l'interface de la bibliothèque de bandes de l'hôte – 
Exemple trois

Module d'extension de 
cartouche

Module d'extension de 
cartouche

Module de base

Façade arrière = panneau 6 Façade arrière = panneau 8 Façade arrière = panneau 12

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

Numéros des colonnes des 
cartouches

Façade avant = panneau 7 Façade avant = panneau 9 Façade avant = panneau 13

Remarque : Vue de l'avant de la bibliothèque de bandes.
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Emplacements des lecteurs
Les emplacements HLI-PRC des lecteurs diffèrent de la notation des cellules de 
stockage des cartouches. Le TABLEAU A-7 illustre le mode de fonctionnement de ce 
schéma de numérotation (vu de l'arrière de la bibliothèque de bandes). 

■ Les numéros standard correspondent à la numérotation physique des lecteurs.

■ Les numéros en exposant (en gras) correspondent aux emplacements HLI-PRC 
(ligne).

■ La numérotation HLI-PRC est séquentielle de droite à gauche (de 0 à 3) pour la 
première ligne (supérieure) du premier module.

■ Le schéma de numérotation séquentielle HLI-PRC recommence de droite à gauche 
(de 0 à 3) dans le module suivant.

■ Le numéro de la colonne est toujours 0.

Emplacements des lecteurs HLI-PRC – Exemple un
Les lecteurs utilisent des numéros de lecteurs plutôt que des emplacements de lignes et 
de colonnes. Le numéro de lecteur est attribué à la position prise par la ligne d'une 
cellule et la position prise par la colonne d'une cellule est toujours « 00 ». Par exemple, 
le numéro du matériel du lecteur de bande 20 équivaut à l'emplacement HLI-PRC 
suivant :

Bibliothèque = 00

Panneau = 12

Lecteur = 16

Colonne = 00

TABLEAU A-7 Emplacements des lecteurs de bandes de l'interface de la bibliothèque de bandes de 
l'hôte

Module de base Module d'extension de lecteur

Panneau arrière = 12 Panneau arrière = 10

        13         22         31         40         253         262         271         280

        57         66         75         84         297         306         315         324

        911         1010         119         128         3311         3410         359         368

        1315         1414         1513         1612         3715         3814         3913         4012

        1719         1818         1917         2016         4119         4218         4317         4416

        2123         2222         2321         2420         4523         4622         4721         4820

        4927         5026         5125         5224

        5331         5430         5529         5628

Remarques : Vue de l'arrière de la bibliothèque de bandes.
Les numéros en exposant (en gras) représentent les emplacements HLI-PRC (qui se traduisent 
en numéro de la ligne).
La notation des numéros standard représente le numéro du matériel du lecteur. 
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Emplacements des lecteurs HLI-PRC – Exemple deux
Dans le deuxième exemple, qui porte sur un emplacement de matériel à la place d'un 
emplacement HLI-PRC, le lecteur de bande 00, 10, 25, 00 équivaut au numéro du 
matériel du lecteur de bande 51.

Cellules du CAP 
Les emplacements HLI-PRC du CAP diffèrent de la notation utilisée pour les cellules de 
stockage des cartouches. Les CAP utilisent des numéros de CAP à la place de numéros 
de panneau. 

CAP de rotation
■ Bibliothèque = toujours 00

■ CAP = 01 à 10, comme suit :

■ CEM de gauche = 01 à 04, de gauche à droite

■ DEM = 05

■ Module de base = 06

■ CEM de droite = 06 à 10, de gauche à droite

■ Lignes = 00 à 25

■ Colonne = toujours 00

CAP des AEM
■ Bibliothèque = toujours 00

■ CAP des AEM = 00 ou 11, comme suit :

■ AEM de gauche = 00

■ AEM de droite = 11

■ Lignes = 00 à 38

■ Colonnes = 00 à 05 
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Emplacements des éléments FC-SCSI
Étant donné que la bibliothèque de bandes SL3000 offre également une interface 
de commande (bibliothèque de bandes) Fibre Channel, vous devez connaître la 
numérotation des cartouches/du CAP/des lecteurs d'après les éléments FC-SCSI. 

Le TABLEAU A-8 page 521 représente les emplacements des éléments FC-SCSI pour les 
façades arrière d'une bibliothèque de bandes qui comporte : 

■ Quatre modules

■ 166 cellules de stockage de cartouches sous licence 
■ 36 lecteurs de bande 

Le TABLEAU A-9 page 522 représente les éléments FC-SCSI pour les façades avant de 
la même bibliothèque de bandes.

Remarque – Les deux tableaux ci-dessous énumèrent les éléments FC-SCSI d'une 
bibliothèque de bandes native non partitionnée.
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Les TABLEAU A-8 et TABLEAU A-9 constituent uniquement des exemples destinés à 
vous montrer que la numérotation des éléments FC-SCSI s'applique aux : 

■ Éléments de stockage, de haut en bas, de gauche à droite, en commençant par la 
façade arrière (vue de l'avant, numéro 2000) et en continuant par le même schéma 
sur les façades avant (vues de l'avant de la bibliothèque de bandes). 

■ Éléments du CAP de rotation (éléments d'importation/d'exportation), de haut en 
bas, de gauche à droite, en commençant par le numéro de l'élément 10 au CAP du 
module de gauche

■ Lecteurs de bande (éléments de transfert de données), de gauche à droite, de haut en 
bas, en commençant par la ligne centrale du module de base (élément 1000) et en 
continuant par le DEM. 

Un emplacement de lecteur vacant n'est pas inclus dans la séquence. 

TABLEAU A-8 Emplacements des éléments FC-SCSI – Façades arrière (vues de l'avant) 

Module 
d'extension 
de cartouche

Module d'extension de lecteur 
(Ligne centrale)

Module de base 
(Ligne centrale)

Module 
d'extension 
de cartou-
che

2000 2010 1022 1023 1024 1025 1000 1001 1002 1003 2060 2070

2001 2011 1026 Vide 1027 1028 1004 1005 1006 1007 2061 2071

2002 2012 1029 1030 Vide 1031 1008 1009 1010 1011 2062 2072

2003 2013 1032 1033 1034 1035 1012 1013 1014 1015 2063 2073

2004 2014 2020 2026 2032 2038 1016 Vide 1017 1018 2064 2074

2005 2015 2021 2027 2033 2039 1019 1020 1021 Vide 2065 2075

2006 2016 2022 2028 2034 2040 2044 2048 2052 2056 2066 2076

2007 2017 2023 2029 2035 2041 2045 2049 2053 2057 2067 2077

2008 2018 2024 2030 2036 2042 2046 2050 2054 2058 2068 2078

2009 2019 2025 2031 2037 2043 2047 2051 2055 2059 2069 2079

Remarques : La numérotation des lecteurs de bande commence à la ligne centrale (façade gauche du 
module de base).
Les emplacements vides des lecteurs de bande ne sont pas comptabilisés.
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Le TABLEAU A-9 représente les emplacements des éléments FC-SCSI pour les façades 
avant de la même bibliothèque de bandes (vues de l'avant). 

TABLEAU A-9 Emplacements des éléments FC-SCSI – Façades avant (vues de l'avant) 

Module 
d'extension 
de cartouche

Module d'extension de lecteur 
(Ligne centrale)

Module de base 
(Ligne centrale)

Module 
d'extension 
de cartou-
che

2080 2090 2100 2107   (CAP) 10 2123 2130   (CAP) 36 2146 2156

2081 2091 2101 2108              2124 2131               2147 2157

2082 2092 2102 2109               2125 2132               2148 2158

2083 2093 2103 2110             ~ 2126 2133             ~ 2149 2159

2084 2094 2104 2111               2127 2134               2150 2160

2085 2095 Loquet
de 
porte

2112               Loquet
de 
porte

2135               2151 2161

2086 2096 2113               35 2136              51 2152 2162

2087 2097 2114 2117 2120 2137 2140 2143 2153 2163

2088 2098 2105 2115 2118 2121 2128 2138 2141 2144 2154 2164

2089 2099 2106 2116 2119 2122 2129 2139 2142 2155 2155 2165

Remarques : Vue de l'avant de la bibliothèque de bandes.
Les emplacements des cellules de stockage des cartouches sont consécutifs et ignorent ceux des 
loquets de porte.
Les cellules du CAP sont uniques et séquentielles, de gauche à droite (vues de l'avant de la 
bibliothèque de bandes).
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Numéros du matériel du lecteur
Le numéro du matériel d'un lecteur est strictement interne à la bibliothèque de bandes 
et est défini par le câblage électrique vers l'emplacement de lecteur. Ces numéros sont 
imprimés sur des décalcomanies sur la face intérieure des portes arrière des modules de 
la bibliothèque de bandes.

Le TABLEAU A-10 illustre ce schéma de numérotation pour le module de base (vu de 
l'arrière du module). Le TABLEAU A-11 page 524 concerne la numérotation du DEM.

TABLEAU A-10 Numérotation des lecteurs de bande du module de base – Matériel 

Numéro de 
matrice Tiroirs des lecteurs

1 Lecteur 1 Lecteur 2 Lecteur 3 Lecteur 4

Lecteur 5 Lecteur 6 Lecteur 7 Lecteur 8

Numéro de 
matrice Tiroirs des lecteurs

2 Lecteur 9 Lecteur 10 Lecteur 11 Lecteur 12

Lecteur 13 Lecteur 14 Lecteur 15 Lecteur 16

Numéro de 
matrice Tiroirs des lecteurs

3 Lecteur 17 Lecteur 18 Lecteur 19 Lecteur 20

Lecteur 21 Lecteur 22 Lecteur 23 Lecteur 24

Remarque – Les numéros indiqués sont référencés depuis l'arrière du module 
de base.
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Nom universel dynamique de lecteur
Le nom universel dynamique (dWWN) de lecteur ou les adresses Fibre Channel sont 
automatiquement générés par le contrôleur de la bibliothèque de bandes pendant 
l'initialisation de celle-ci. Le dWWN est attribué aux emplacements des lecteurs de la 
bibliothèque de bandes plutôt qu'aux périphériques. Si un lecteur est remplacé, le 
nouveau lecteur reçoit le même nom que celui qu'il remplace, ce qui élimine la nécessité 
de devoir reconfigurer le système. Trois noms universels sont réservés pour chaque 
emplacement de lecteur : noeud, port A et port B.

Remarque – La fonctionnalité dWWN est généralement activée lors de l'installation. 
La bibliothèque de bandes et les lecteurs de bande doivent tous comporter un 
microprogramme prenant en charge la fonctionnalité d'attribution de nom universel 
dynamique. Lorsque la fonctionnalité dWWN est activée, tous les lecteurs doivent 
se trouver au niveau de microprogramme approprié. Si un lecteur est doté d'un 
microprogramme de niveau inférieur, il demeure dans l'état « configuration » et ne 
peut pas être utilisé par l'hôte.

TABLEAU A-11 Numérotation des lecteurs de bande du module d'extension de lecteur – Matériel

Numéro de 
matrice Tiroirs des lecteurs

1 Lecteur 25 Lecteur 26 Lecteur 27 Lecteur 28

Lecteur 29 Lecteur 30 Lecteur 31 Lecteur 32

Numéro de 
matrice Tiroirs des lecteurs

2 Lecteur 33 Lecteur 34 Lecteur 35 Lecteur 36

Lecteur 37 Lecteur 38 Lecteur 39 Lecteur 40

Numéro de 
matrice Tiroirs des lecteurs

3 Lecteur 41 Lecteur 42 Lecteur 43 Lecteur 44

Lecteur 45 Lecteur 46 Lecteur 47 Lecteur 48

Numéro de 
matrice Tiroirs des lecteurs

4 Lecteur 49 Lecteur 50 Lecteur 51 Lecteur 52

Lecteur 53 Lecteur 54 Lecteur 55 Lecteur 56

Remarque – Les numéros indiqués sont référencés depuis l'arrière du DEM.
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ANNEXE B

Diagramme des façades 

Cet annexe fournit des diagrammes et des tableaux qui donnent des détails sur les 
éléments suivants :

■ « Façades du module de base » page 526

■ « Façades du module d'extension de lecteur » page 527

■ « Façades du module d'extension de cartouche » page 529

■ « Façades du module d'extension de stockage » page 531

■ « Façades du module d'extension d'accès » page 532

■ « Bloc de configuration » page 533

■ « Numérotation des lignes » page 534

■ « Cellules réservées/système » page 535
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Remarque – Les cellules gris clair ne sont pas accessibles tant qu'un module adjacent 
n'est pas installé dans cette partie. 

FIGURE B-1 Façades du module de base 

Module de base 

F
aç

ad
e 

av
an

t 

 ■ 140 cellules de car-
touches de données

■ Avec un CAP de rota-
tion de 26 cellules 

■ Avec un panneau 
opérateur ou une fe-
nêtre

■ 163 cellules de cartou-
ches de données 

■ Avec un CAP de rota-
tion de 26 cellules 

■ Avec une baie de car-
touches de la fenêtre

F
aç

ad
e 

ar
ri

èr
e 

■ 8 emplacements de 
lecteurs de bande 

■ 180 cartouches de 
données 

■ 16 emplacements de 
lecteurs de bande 

■ 125 cartouches de 
données 

■ 24 emplacements de 
lecteurs de bande 

■ 65 cartouche de 
données 
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FIGURE B-2 Façades du module d'extension de lecteur 

Module d'extension de lecteur 

F
aç
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e 
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■ 253 cellules de car-
touches 

■ Avec une baie de 
cartouches de la fe-
nêtre 

■ Aucun CAP de rota-
tion

■ 230 cellules de car-
touches 

■ Avec un panneau 
opérateur ou une fe-
nêtre 

■ Aucun CAP de rota-
tion 

■ 176 cellules de car-
touches 

■ Avec un CAP de ro-
tation de 26 cellules 

■ Avec une baie de 
cartouches de la fe-
nêtre 

■ 153 cellules de car-
touches 

■ Avec un CAP de ro-
tation de 26 cellules 

■ Avec un panneau 
opérateur ou une fe-
nêtre 

F
aç

ad
e 

ar
ri

èr
e 

■ 8 emplacements de 
lecteurs de bande 

■ 180 cartouche de 
données 

■ 16 emplacements de 
lecteurs de bande 

■ 125 cartouche de 
données 

■ 24 emplacements de 
lecteurs de bande 

■ 65 cartouche de 
données 

■ 32 emplacements de 
lecteurs de bande 

■ 0 cartouche de 
données 
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Remarque – Les cellules gris clair ne sont pas accessibles tant qu'un module adjacent 
n'est pas installé dans cette partie. 
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FIGURE B-3 Façades du module d'extension de cartouche  

Module d'extension de cartouche gauche 

Façade avant 
■ 260 cellules de car-

touches 

Façade avant 
■ 182 cellules de car-

touches
■ Avec un CAP de ro-

tation de 26 cellules 

Façade arrière 
■ 256 cellules de car-

touches

Module d'extension de cartouche droit 

Façade arrière 
■ 308 cellules de car-

touches 

Façade avant 
■ 234 cellules de car-

touches 
■ Avec un CAP de ro-

tation de 26 cellules 

Façade avant 
■ 312 cellules de car-

touches 
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Remarque – Les cellules gris clair ne sont pas accessibles tant qu'un module adjacent 
n'est pas installé dans cette partie. 
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Remarque – Six colonnes de baies (trois sur la façade arrière et trois sur la façade 
avant) sur la partie gauche et sur la partie droite ne sont pas accessibles pour tenir 
compte d'une unité robotisée défectueuse. 

FIGURE B-4 Façades du module d'extension de stockage 

Module d'extension de cartouches avec zone 
de parking robot (PEM) gauche 

Façade avant 
■ 156 cellules de 

cartouches 

Façade arrière 
■ 152 cellules de 

cartouches 

Module d'extension de stockage (PEM) droit 

Façade arrière 
■ 156 cellules de 

cartouches 

Façade avant 
■ 156 cellules de 

cartouches 
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FIGURE B-5 Façades du module d'extension d'accès 

Module d'extension d'accès de gauche 

Façade avant 
■ 117 cellules de CAP 

des AEM 

Façade arrière 
■ 117 cellules de CAP 

des AEM

Module d'extension d'accès de droite 

Façade arrière 
■ 117 cellules de CAP 

des AEM 

Façade avant 
■ 117 cellules de CAP 

des AEM 
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Bloc de configuration
Chaque module de la bibliothèque de bandes SL3000 comporte un bloc de 
configuration sur la façade arrière inférieure dans la colonne 4, lignes 49, 50, 51 et 52. 
Ce bloc identifie les éléments suivants : 

■ Type de module 

■ Configuration de la façade arrière 

■ Configuration de la façade avant 

■ Options pour ce module

Au cours de l'initialisation de la bibliothèque de bandes, l'assemblage robotisé visite ce 
bloc de configuration afin de déterminer la configuration du module.

FIGURE B-6 Bloc de configuration 

Types de module : 

■ Module de base 
■ DEM 
■ CEM 

■ PEM
■ AEM 

Configuration de la façade arrière : 

Cible 

Configuration de la façade avant : 

Options : 

■ Panneau opérateur 
local 

■ Fenêtre 
■ Baies de cartouches

I   I\I   I
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Numérotation des lignes 
FIGURE B-7 Numérotation des lignes 

Exemple 1 
Module de 
base 

Exemple 2 
CEM 

Les lignes indiquent l'emplacement vertical d'une 
cartouche ou d'un lecteur de bande.

Les lignes comportent toujours des numéros 
positifs. 

Les lignes des cellules de stockage sont 
numérotées de haut (1) en bas (52). 
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Cellules réservées/système 
Le module de base et le module d'extension de lecteur comportent des emplacements 
spéciaux sur la façade arrière inférieure. Ces emplacements fournissent des fonctions 
spéciales à la bibliothèque de bandes et aux lecteurs de bande. 

La FIGURE B-8 illustre ces emplacements : 

1. Emplacements d'échange (2) dans la colonne 2, lignes 49 et 50.

2. Emplacement de diagnostic (1) dans la colonne 2, ligne 51. 

3. Emplacement de diagnostic (4) dans la colonne 3, lignes 49, 50, 51 et 52. 

4. Bloc de configuration dans la colonne 4, lignes 49, 50, 51 et 52.

5. Cartouches de nettoyage (4) dans la colonne 5, lignes 49, 50, 51 et 52. 

6. Cartouches de nettoyage (4) dans la colonne 6, lignes 49, 50, 51 et 52. 

FIGURE B-8 Emplacements réservés 

Diagnostic
Diagnostic

Diagnostic Bloc de 
configu-
ration

Nettoya-
ge

Nettoya-
ge

Cible
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ANNEXE C

Manipulation des cartouches 

Cet annexe renferme des informations sur l'étiquetage et la manipulation des 
cartouches de bande utilisées dans les bibliothèques de bandes Sun StorageTek. 

Exigences concernant les cartouches
Les cartouches de la bibliothèque de bandes doivent respecter les spécifications définies 
selon la norme American National Standard Magnetic Tape and Cartridge for Information 
Interchange. Pour connaître les exigences et les spécifications d'une cartouche spécifique, 
consultez la publication et le site Web du fournisseur du lecteur.

Les cartouches de couleur sont approuvées uniquement si la densité de réflexion 
mesurée à l'aide d'un densitomètre de réflexion des couleurs X-rite 404G est supérieure 
à 0,1. Pour plus d'informations sur les cartouches de couleur, contactez votre 
représentant Sun StorageTek. 

Les mesures de la couleur sont les suivantes :

Pour plus d'informations sur les cartouches de couleur, contactez votre représentant 
Sun StorageTek.

Bande passante Bande ANSI Status T Wide (380 à 780 nm)

Plage de mesures Densité (0,00 à 2,50) D

Précision ±0,02 D

Répétabilité ±0,01 D

Diamètre d'ouverture 3,4 mm (0,13 pouce)
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Étiquettes de cartouches valides 
Les cartouches des bibliothèques de bandes doivent comporter une étiquette externe 
valide. Plusieurs étiquettes à codes à barres Code 39 standard sont prises en charge par 
la bibliothèque de bandes. 

Remarques : 

■ Les cartouches non étiquetées ne sont pas prises en charge. Voir « Cartouches non 
étiquetées » page 542.

Des cartouches pré-étiquetées sont disponibles auprès de Sun StorageTek. Pour plus 
d'informations sur la commande de ces cartouches, voir « Commande de cartouches et 
d'étiquettes » page 544.

Si vous ne commandez pas de cartouches pré-étiquetées, consultez « Application de 
l'étiquette sur une cartouche » page 545 pour obtenir des instructions détaillées 
concernant l'étiquetage correct des cartouches. Sun StorageTek ne fournit pas 
d'étiquettes de cartouche. Pour connaître un fournisseur d'étiquettes uniquement, 
voir « Commande de cartouches et d'étiquettes » page 544. 

Domaine de support et identifiant de support
Le domaine de support et l'identifiant de support identifient à eux deux le support 
d'une cartouche et l'utilisation dans la bibliothèque de bandes. Ils vous permettent 
de mélanger des types de lecteur de bande et des types de support au sein d'une 
bibliothèque de bandes. L'étiquette d'identifiant de support correspond au lecteur de 
bande ou au transport capables d'utiliser la cartouche. Le domaine du support reflète 
l'utilisation de la cartouche : données, nettoyage, diagnostic.

Cartouches de nettoyage et de diagnostic 
L'ID de volume des cartouches de nettoyage comporte CLN ; celui des cartouches de 
diagnostic indique DG.

Chaque kit de nettoyage et de diagnostic comporte une cartouche de nettoyage 
étiquetée et une cartouche de diagnostic étiquetée, avec un numéro de série de volume 
0 (zéro) pour chacun. Des étiquettes de nettoyage et de diagnostic supplémentaires sont 
envoyées avec chaque bibliothèque de bandes. 

Les cartouches de nettoyage et de diagnostic ne peuvent pas être utilisées comme des 
cartouches vides, ni par des utilitaires logiciels.

Mise en garde – ERREUR DE PROCÉDURE : Lorsque vous insérez une cartouche de 
nettoyage, le logiciel la considère comme nouvelle et remet le compteur d'utilisation à 
zéro. N'INSÉREZ PAS À NOUVEAU UNE CARTOUCHE DE NETTOYAGE ÉJECTÉE 
PAR LA BIBLIOTHÈQUE DE BANDES VIA LE CAP. 
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Codes des cartouches
La bibliothèque de bandes SL3000 prend en charge trois types d'étiquettes de code à 
barres : 

■ Pour les lecteurs T9x40, des étiquettes d'1/2 pouce fournies par Trioptic (Engineered 
Data Products/Colorflex) ou Tricode (American Eagle/Writeline). Les deux versions 
nécessitent un type d'identifiant de support différent, qui est un caractère. 

■ Pour les lecteurs T10000, des étiquettes composées de huit caractères, dont les deux 
derniers correspondent aux caractères de domaine d'identifiant de support et de 
type d'identifiant de support.

■ Pour les lecteurs LTO®, des étiquettes composées de huit caractères, dont les deux 
derniers correspondent aux caractères de domaine d'identifiant de support et de 
type d'identifiant de support. 

■ Pour les lecteurs SDLT, des étiquettes composées de sept caractères, dont le dernier 
correspond au caractère d'identifiant de support requis. 

Sun Lecteurs et cartouches de bande StorageTek
Le TABLEAU C-1 reprend les étiquettes de cartouches des lecteurs de bande Sun 
StorageTek T9840 (modèles C et D) et T10000. Ces lecteurs de bande prennent 
également en charge le chiffrement. 

TABLEAU C-1 Sun Codes des cartouches StorageTek 

Identifiant de support Type de cartouche

ID de volume + R Cartouche de données T9840

ID de volume + R (arrière-plan vert) Cartouche de données T9840C VolSafe

ID de volume + R (arrière-plan violet) Cartouche de données T9840D VolSafe

CLN (espace vierge) ID de volume + U Cartouche de nettoyage T9840

CLN (espace vierge) ID de volume + Y Cartouche de nettoyage T9840D 
(Remarque : Le T9840D comporte une 
seule cartouche de nettoyage.)

DG (espace vierge) ID de volume + R Cartouche de diagnostic T9840 

ID de volume + T1 Cartouche de données T10000

DG (espace vierge) ID de volume + T1 Cartouche de diagnostic T10000

CLN (espace vierge) ID de volume + CT Cartouche de nettoyage T10000

ID de volume + TS Cartouche de données T10000 (sport)

DG (espace vierge) ID de volume + TS Cartouche de diagnostic T10000 (sport)

CLN (espace vierge) ID de volume + CT Cartouche de nettoyage T10000 (sport)
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Lecteurs et cartouches de bande LTO

Remarque – La technologie LTO a été initialement développée par IBM, Hewlett-
Packard et Quantum. LTO est une technologie de type « format ouvert », ce qui signifie 
que les utilisateurs disposent de plusieurs sources de produit et de support. 

Les étiquettes des cartouches LTO comportent huit caractères. Les deux derniers 
caractères représentent l'identifiant de support (L3, L4, LT ou LU). CLN ou DG 
constituent les premiers caractères des étiquettes de nettoyage ou de diagnostic. Les 
lecteurs de bande LTO 4 prennent également en charge le chiffrement. 

TABLEAU C-2 Codes des cartouches LTO  

Identifiant de support Type de cartouche

L3 Cartouche de données de 3ème génération

L4 Cartouche de données de 4ème génération

LT Write once read many times (WORM), 
400 Go
Cette fonctionnalité empêche l'utilisateur 
de modifier ou d'effacer des informations 
de la bande. Pour plus d'informations, 
accédez au site Web du fournisseur et 
lancez une recherche sur WORM. 

LU Write once read many times (WORM), 
800 Go

CLN (espace vierge) + CU Cartouche de nettoyage universelle
Sun recommande d'utiliser l'étiquette 
universelle CLN + CU plutôt que l'étiquette 
spécifique à un fournisseur (CLN + C1 
pour Hewlett-Packard ou CLN + C2 pour 
IBM).

DG (espace vierge) + ID de volume Cartouche de diagnostic (apposez une 
étiquette DG sur une cartouche de données 
vierge destinée aux tests de diagnostic des 
bibliothèques de bandes) 
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Manipulation des cartouches
Une manipulation incorrecte des cartouches peut entraîner une perte de données ou 
endommager un composant de la bibliothèque de bandes. Pour manipuler correctement 
une cartouche :

■ Ne transportez pas plusieurs cartouches sans assurer leur stabilité dans un 
conteneur. Les blocs leaders risquent de s'accrocher à d'autres cartouches et de sortir 
de leur logement. 

Remarque – Les cartouches T9940 et LTO Ultrium Dispose de blocs leaders. Ceci n'est 
pas le cas des cartouches T9840.

■ Assurez-vous que le bloc leader est bien fixé à chaque fois que vous prélevez une 
cartouche. 

■ Veillez à maintenir les cartouches propres. 

■ Inspectez la cartouche avant chaque utilisation et ne placez jamais de cartouche 
endommagée dans un lecteur ou une bibliothèque de bandes. 

■ Ne libérez jamais de bloc leader pour retirer une bande d'une cartouche. 

■ N'ouvrez jamais une cartouche. 

■ Ne manipulez pas de bande en-dehors de la cartouche ; le bord de la bande pourrait 
être endommagé. 

■ N'exposez pas directement la bande ou la cartouche aux rayons du soleil ni à 
l'humidité. 

■ N'exposez pas une cartouche enregistrée à des champs magnétiques ; les données 
sur la bande risqueraient d'être détruites. 

Insertion d'une cartouche dans un lecteur ou une 
cellule
Une cartouche défectueuse ou sale peut endommager un lecteur. Avant d'insérer une 
cartouche dans un lecteur ou dans une bibliothèque de bandes de bandes, inspectez-la 
systématiquement. Recherchez les défauts suivants :

■ Cartouche fissurée ou brisée

■ Leader brisé

■ Porte d'accès à la bande brisée

■ Sélecteur de protection de fichier ou commutateur de protection d'écriture 
endommagé

■ Présence de liquide dans la cartouche

■ Étiquettes mal fixées ou dépassant le bord de la cartouche

■ Tout autre dommage évident

Vous devez insérer une cartouche dans une cellule de stockage, une cellule du CAP de 
rotation ou des AEM ou un lecteur avec le code à barres sur la partie inférieure et l'ID 
de volume lisible de droite à gauche. Le hub de la cartouche doit toujours être en bas. 
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Cartouches illisibles
Les cartouches peuvent être identifiées en tant que cartouches illisibles pour les raisons 
suivantes :

■ Cartouches non étiquetées

■ Cartouches inversées

HSC et ACSLS éjectent automatiquement les cartouches illisibles de la bibliothèque de 
bandes. Les hôtes FC-SCSI n'ont pas cette capacité ; une cartouche illisible peut être 
déplacée automatiquement vers un CAP pendant l'initialisation de la bibliothèque de 
bandes. 

Remarque – Si un nombre important de cartouches est signalé en tant que cartouches 
illisibles, il est possible qu'une caméra ou un scanner TallBot soit défectueux. Un grand 
nombre de cartouches pourrait ainsi être éjecté par erreur de la bibliothèque de bandes. 

Cartouches non étiquetées
Les cartouches ne comportant pas d'étiquette externe ne sont pas totalement prises en 
charge dans la bibliothèque de bandes SL3000. Les cartouches non étiquetées ne sont 
pas montées sur les lecteurs ; elles peuvent toutefois être déplacées entre les CAP et les 
cellules de stockage. 

■ Si une cartouche non étiquetée est placée dans un CAP, le TallBot l'y laisse. La 
position de la cartouche dépend du logiciel hôte. 

■ Si une cartouche non étiquetée est placée dans une cellule de stockage de la 
bibliothèque de bandes, au cours d'un audit, la cartouche sera signalée comme type 
de support illisible et non valide (« unreadable, invalid media type »). Selon le 
logiciel hôte, la cartouche risque de ne pas être reconnue par l'hôte ou d'être éjectée 
via le CAP. 

Cartouches inversées
Vous ne devez jamais essayer d'insérer des cartouches inversées, et notamment des 
cartouches Sun StorageTek. La manière dont la bibliothèque de bandes gère cette 
situation est fonction du type de cartouche.

Sun Cartouches StorageTek

Mise en garde – Les cartouches Sun StorageTek inversées n'entrent pas dans les 
cellules de stockage de la bibliothèque de bandes et peuvent endommager la cartouche 
et le TallBot.

■ Si une cartouche Sun StorageTek est placée inversée dans un magazine CAP, le CAP 
ne pourra pas se fermer. 



Manipulation des cartouches

418605501 • Révision AB Manipulation des cartouches 543

■ Si une cartouche Sun StorageTek est placée inversée dans une cellule de stockage de 
la bibliothèque de bandes, elle s'étendra depuis la cellule de stockage et pourra 
endommager le TallBot. 

Cartouches LTO
■ Si une cartouche LTO est placée inversée dans un magazine CAP, le TallBot l'y laisse. 

La position de la cartouche dépend du logiciel hôte. 

■ Si une cartouche LTO est placée inversée dans une cellule de stockage de la 
bibliothèque de bandes, au cours d'un audit, la cartouche sera signalée comme type 
de support illisible et non valide (« unreadable, invalid media type »). Selon le 
logiciel hôte, la cartouche risque de ne pas être reconnue par l'hôte ou d'être éjectée 
via le CAP. 

Manipulation des cartouches
La section suivante fournit des instructions de manipulation générales concernant les 
cartouches. 

Nettoyage de la partie extérieure de la cartouche 

Mise en garde – ENDOMMAGEMENT DES CARTOUCHES : Certains solvants 
peuvent endommager les cartouches. N'UTILISEZ PAS LES PRODUITS 
CHIMIQUES SUIVANTS : ACÉTONE, TRICHLOROÉTHANE, TOLUÈNE, XYLÈNE, 
BENZÈNE, CÉTONE, MÉTHYLÉTHYLCÉTONE, CHLORURE DE MÉTHYLÈNE, 
ÉTHYLDICHLORURE, ESTERS, ACÉTATE D'ÉTHYL NI AUTRES PRODUITS 
CHIMIQUES SIMILAIRES POUR RETIRER DES ÉTIQUETTES OU NETTOYER DES 
CARTOUCHES. 

Nettoyez la poussière, les salissures et l'humidité de la cartouche avec un linge non 
pelucheux. 

Utilisez les chiffons de nettoyage de bande StorageTek, PN 4046289-01 pour nettoyer les 
cartouches. Ces chiffons sont imprégnés d'alcool isopropylique. Évitez tout contact 
entre la solution et la bande ou toute pénétration de solution dans la cartouche. 

Réparation d'un bloc leader détaché
Lorsqu'une bande de cartouche T9940 ou LTO Ultrium est endommagée, utilisez 
une bande de sauvegarde si possible. En cas de détachement d'un bloc leader, et 
d'absence de bande de sauvegarde alors que la cartouche ou la bande ne présente 
aucun dommage, vous pouvez réparer le bloc leader à l'aide du kit de réparation 
disponible auprès du fournisseur de la bande. Vous pouvez utiliser la bande à une 
reprise, afin de copier les données sur une autre bande. 
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Stockage des cartouches
Les instructions ci-dessous concernent le stockage de la cartouche :

■ Ne retirez pas une cartouche de son emballage de protection avant de devoir 
l'utiliser. Utilisez le ruban d'ouverture pour retirer l'emballage au lieu d'un 
instrument coupant. 

■ Stockez les cartouches dans un environnement propre qui reproduit les conditions 
de la pièce dans laquelle elles sont utilisées. 

■ Avant d'utiliser une cartouche, assurez-vous qu'elle ai passé au moins 24 heures dans 
son environnement d'utilisation.

■ Le stockage d'archivage s'étend d'1 à 10 ans pour les bandes de cartouche 9x40 et de 
15 à 30 ans pour les bandes de cartouche LTO Ultrium.

Commande de cartouches et d'étiquettes
Contactez votre revendeur Sun StorageTek autorisé pour obtenir des cartouches 
étiquetées.

Pour obtenir des étiquettes de cartouche, contactez EDP/Colorflex :

■ Téléphone : 1.888.438.8362 (national et international)
■ Site Web : http://www.colorflex.com

Si vous avez des questions techniques, contactez le support de vente de Sun 
StorageTek :

■ Téléphone : 1.800.275.4785
■ E-mail : sales_support@storagetek.com 

http://www.colorflex.com
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▼ Application de l'étiquette sur une cartouche
1. Veillez à ce que la cartouche soit conservée à température ambiante pendant 24 

heures minimum.

2. Nettoyez la surface où doit être placée l'étiquette à l'aide d'un produit de nettoyage 
conçu à cet effet. Voir « Nettoyage de la partie extérieure de la cartouche » page 543. 

3. Retirez le support de l'étiquette d'ID de volume. 

4. Placez la cartouche à plat, dans la même position que celle adoptée pour l'insertion 
de la cartouche dans un lecteur de bande. 

5. Positionnez l'étiquette d'ID de volume avec les caractères du code à barres sous les 
caractères alphanumériques. Apposez-la en appuyant.

Remarque – Sur les étiquettes ID de volume LTO Ultrium, les caractères 
alphanumériques peuvent être verticaux ou horizontaux.

6. Si la cartouche possède une étiquette client, placez l'étiquette dans la zone adéquate 
et apposez-la en appuyant. 

7. Répétez les étapes 2 à 5 pour l'étiquette d'ID de support.

8. L'étiquette doit se trouver dans la zone réservée sur la cartouche, afin que ses bords 
soient parallèles à ceux de la cartouche. L'étiquette doit être proche du bord interne 
de cette zone réservée, mais ne doit jamais chevaucher le bord de cette zone. 

Remarques : 

■ Assurez-vous que l'étiquette n'est pas placée un autre endroit sur la surface de la 
cartouche. 

■ Veillez à ce que les bords de l'étiquette ne soient pas recourbés, car cela peut bloquer 
la cartouche dans le chargeur du lecteur. 

■ Utilisez des étiquettes qui ne laissent pas de traces lorsqu'elles sont retirées. 

■ Assurez-vous que l'étiquette contient un ID de volume.
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ANNEXE D

Serveur Web de la Console 
d’administration StreamLine Library 
Web

La Console d’administration StreamLine Library Web est une fonctionnalité standard 
de la bibliothèque de bandes SL3000 et est incluse sur le CD fourni avec chaque 
bibliothèque de bandes. Elle permet d'installer la Console d'administration StreamLine 
Library sur un serveur Web centralisé. Les clients individuels peuvent alors utiliser un 
navigateur Web pris en charge pour télécharger la Console d’administration StreamLine 
Library Web et s'y connecter. 

La Console d’administration StreamLine Library Web est déployée en tant que fichier 
Java WebARchive (.war). 

Considérations de sécurité
Le client est chargé de déployer tous les systèmes de sécurité appropriés, dont des pare-
feu, l'accès utilisateur, etc. 

Serveur requis
Vous pouvez déployer la Console d’administration StreamLine Library Web sur 
n'importe quel serveur Web compatible avec la plate-forme J2EE (Java 2 Platform, 
Enterprise Edition). Il est recommandé d'utiliser Java System Web Server. 

Remarque – Toutes les procédures indiquées dans le présent document partent du 
principe que vous utilisez Java System Web Server. 
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Installation et gestion du serveur
L'installation et la gestion du serveur de la Console d’administration StreamLine 
Library Web impliquent les procédures suivantes :

■ « Téléchargement de Java System Web Server » page 548

■ « Installation de Sun Java System Web Server » page 552

■ « Connexion à la console d'administration de Java System Web Server » page 556

■ « Installation et déploiement de la Console d’administration StreamLine Library 
Web » page 559

■ « Démarrage de la Console d’administration StreamLine Library Web » page 564

■ « Mise à jour de la Console d’administration StreamLine Library Web » page 566

▼ Téléchargement de Java System Web Server
Cette procédure permet de télécharger Java System Web Server, s'il n'est pas déjà 
installé sur votre serveur. 

Remarque – Vous devez disposer pour cette procédure d'un nom d'utilisateur et d'un 
mot de passe de compte en ligne Sun. 

1. Ouvrez un navigateur Web puis, dans la barre d'adresse ou dans le champ Address, 
saisissez l'URL de la page Sun Web Servers :

http://www.sun.com/download/index.jsp?cat=Web%20%26%20Proxy%20Servers&tab=3&subcat=Web%20Servers 

2. Dans la page Web Servers, cliquez sur le lien Web Server qui correspond à la plate-
forme de votre serveur. 
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3. Dans la fenêtre Sun Java System Web Server (ou une autre fenêtre en fonction de la 
sélection que vous avez effectuée à l'étape précédente), défilez vers le bas pour 
consulter la liste des plates-formes prises en charge et cliquez sur Download. 

4. Dans la fenêtre Sun Download Center Login, saisissez votre nom d'utilisateur 
(Username) et votre mot de passe (Password), puis cliquez sur Login.
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Remarque – Si vous n'avez pas encore créé de compte, cliquez sur Register Now et 
suivez les instructions qui s'affichent pour en créer un. 

5. Effectuez les sélections suivantes dans la fenêtre Sun Download Center :

■ Cliquez sur le bouton radio Accept License Agreement.
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■ Cliquez sur le lien Sun Java System Web Server correspondant à la plate-forme de 
votre serveur.

6. Dans la fenêtre contextuelle, cliquez sur Save to Disk pour enregistrer le fichier 
archive compressé dans le répertoire de votre choix, puis cliquez sur OK. 

Remarque – Ce processus peut durer plusieurs minutes.

7. Utilisez l'utilitaire d'extraction approprié (par exemple, gunzip, pkunzip) pour 
extraire les fichiers de Sun Java System Web Server vers le répertoire de votre choix. 
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▼ Installation de Sun Java System Web Server 
Cette procédure permet d'installer Java System Web Server, s'il n'est pas déjà installé 
sur votre serveur. 

1. Dans le répertoire dans lequel vous avez extrait les fichiers de Sun Java System Web 
Server, double-cliquez sur le fichier de configuration ou exécutez-le depuis une ligne 
de commande (setup ou setup.exe, selon votre plate-forme). 

Si vous effectuez l'installation sur une plate-forme Solaris, vous devrez sans doute 
invoquer des droits root ou sudo, selon le répertoire d'installation. Dans ce cas, 
procédez comme suit :

a. cd extraction_directory

où extraction_directory représente le répertoire dans lequel vous avez extrait les 
fichiers compressés de Java Web Server. 

b. xhost + 

c. sudo ./setup 

2. Dans la fenêtre Welcome, cliquez sur Next. 



 

Installation et gestion du serveur

418605501 • Révision AB Serveur Web de la Console d’administration StreamLine Library Web 553

3. Dans la fenêtre Software License Agreement, cliquez sur le bouton radio Yes, puis 
sur Next. 

4. Dans la fenêtre Select Installation Directory, indiquez le répertoire dans lequel 
installer le serveur Web, puis cliquez sur Next.
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5. Dans la fenêtre Type of Installation, cliquez sur Express, puis sur Next.

6. Dans la fenêtre Administration Server Settings, indiquez un mot de passe sécurisé 
pour l'utilisateur admin, puis cliquez sur Next. 
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7. Dans la fenêtre Ready to Install, lisez les informations sur l'installation, puis cliquez 
sur Install Now. 

L'installation commence et une fenêtre comportant une barre de progression s'affiche. 

8. Dans la fenêtre Installation Complete, étudiez les informations données et saisissez 
l'URL de la console d'administration spécifiée à l'étape 2 sous « Étapes suivantes ». 
Vous en aurez besoin pour la procédure suivante. 

9. Cliquez sur Finish pour quitter le programme de configuration. 
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▼ Connexion à la console d'administration de Java 
System Web Server

1. Démarrez Sun Java System Web Server, s'il n'est pas déjà en cours d'exécution : 

■ Sous Windows : cliquez sur Démarrer > Tous les programmes > Sun Microsystems 
>Web Server 7.0 > Start Administration Server. 

■ Sous Solaris : ouvrez une fenêtre de terminal et tapez la commande suivante :

sudo /opt/webserver7/admin-server/bin/startserv 

Remarque – Patientez quelques minutes, le temps que le serveur démarre. 

2. Ouvrez un navigateur Web et, dans la barre d'adresse ou dans le champ Address, 
saisissez l'URL que vous avez noté à la fin de la précédente procédure (“Installation 
de Sun Java System Web Server”). La console d'administration démarre alors. 

3. Dans la fenêtre contextuelle, acceptez le certificat du serveur et cliquez sur OK. 
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4. Dans le navigateur Web dans lequel vous avez saisi l'URL de la console 
d'administration, saisissez le nom d'utilisateur (User Name) et le mot de passe 
(Password) admin, puis cliquez sur Log in. 
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5. La fenêtre Common Tasks s'affiche. 
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▼ Installation et déploiement de la Console 
d’administration StreamLine Library Web 

Remarque – Avant d'effectuer cette activité, procurez-vous le CD d'installation de la 
Console d’administration StreamLine Library Web. 

1. Sur le serveur, introduisez le CD d'installation de la Console d’administration 
StreamLine Library Web dans le lecteur de CD. 

2. Connectez-vous à la console d'administration de Sun Java System Web Server. Voir 
« Connexion à la console d'administration de Java System Web Server » page 556 pour 
plus de détails. 

3. Dans la fenêtre Common Tasks, cliquez sur Add Web Application.

4. Dans la fenêtre Add Web Application, saisissez les éléments suivants :

■ Web Application Location : Cliquez sur le bouton Browse et accédez à 
l'emplacement du fichier opel.war sur le CD d'installation. 

■ URI : Tapez /opel

■ Laissez tous les autres champs comme champs par défaut. 
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■ Cliquez sur OK. 
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5. Dans la fenêtre Web Applications, cliquez sur Save.
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6. Dans la fenêtre Web Applications mis à jour, cliquez sur le lien Deployment Pending 
en haut à droite. 

7. Dans la fenêtre Configuration Deployment, cliquez sur Deploy. 
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8. Dans la fenêtre Results, cliquez sur Close. 

9. La fenêtre Web Applications affiche un message indiquant que l'application a été 
correctement ajoutée. 

Vous pouvez cliquer sur le bouton Home en haut à droite pour retourner à la fenêtre 
Common Tasks. 
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▼ Démarrage de la Console d’administration 
StreamLine Library Web 

1. Connectez-vous à la console d'administration de Sun Java System Web Server. Voir 
« Connexion à la console d'administration de Java System Web Server » page 556 pour 
plus de détails. 

2. Dans la fenêtre Common Tasks, cliquez sur Start/Stop Instances. 
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3. Dans la fenêtre Configuration Instances, cochez la case en regard de l'instance locale 
du serveur Console d’administration StreamLine Library Web, puis cliquez sur Start. 

Les instances de l'application de la Console d’administration StreamLine Library Web 
sont démarrées et une fenêtre comportant une barre de progression apparaît. 

4. Dans la fenêtre Results, cliquez sur Close. 
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▼ Mise à jour de la Console d’administration 
StreamLine Library Web 
Vous pouvez mettre la Console d’administration StreamLine Library Web à jour 
pendant son exécution. Les mises à jour sont automatiquement propagées aux clients 
lorsqu'ils récupèrent l'application de la Console d’administration StreamLine Library 
Web sur le serveur. 

Remarque – Avant d'effectuer cette activité, procurez-vous le CD de mise à jour de la 
Console d’administration StreamLine Library Web. 

1. Sur le serveur, introduisez le CD de mise à jour de la Console d’administration 
StreamLine Library Web dans le lecteur de CD. 

2. Connectez-vous à la console d'administration de Sun Java System Web Server. Voir 
« Connexion à la console d'administration de Java System Web Server » page 556 pour 
plus de détails. 

3. Dans la fenêtre Common Tasks, cliquez sur Edit Virtual Server.
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4. Dans la fenêtre General Properties, cliquez sur l'onglet Web Applications.

5. Dans la fenêtre Web Applications, cochez la case en regard de /opel URI, puis cliquez 
sur Update.
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6. Dans la fenêtre Update Web Application, saisissez les éléments suivants :

■ Web Application Location : Cliquez sur le bouton Browse et naviguez jusqu'à 
l'emplacement du fichier opel.war sur le CD de mise à jour. 

■ Laissez tous les autres champs comme champs par défaut. 

■ Cliquez sur OK. 

La mise à jour du serveur commence et une fenêtre comportant une barre de 
progression s'affiche. 
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7. Dans la fenêtre Web Applications, cliquez sur le lien Deployment Pending en haut à 
droite. 

8. Dans la fenêtre Configuration Deployment, cliquez sur Deploy. 

Le déploiement commence et une fenêtre comportant une barre de progression 
s'affiche. 
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9. Dans la fenêtre Results, cliquez sur Close pour retourner à la fenêtre Web 
Applications. 
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Problèmes courants et solutions
Cette section décrit les solutions à certains problèmes courants survenus lors de 
l'installation et de la maintenance de Java System Web Server. 

Erreurs lors de l'installation de Windows 2000 Sun 
Java System Web Server 

Erreur liée à Windows MSVCP60.dll 
Si vous effectuez l'installation sur une plate-forme Windows 2000 n'incluant pas la DLL 
d'exécution de Microsoft Visual C v6, MSVCP60.dll, lors de l'installation, des erreurs 
similaires à celles indiquées ci-dessous se produiront :
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Le journal d'installation du serveur Web inclura des erreurs similaires à celles indiquées 
ci-dessous :

▼ Résolution de l'erreur liée à Windows MSVCP60.dll 
Cette procédure permet de résoudre l'erreur liée à Windows MSVCP60.dll. 

1. Recherchez la chaîne suivante sur le Web :

msvcp60.dll download 

2. Téléchargez le fichier DLL dans le répertoire /winnt/system32. 

3. Supprimez le répertoire dans lequel vous avez installé en partie Java System Web 
Server lors de l'installation non aboutie.

4. Répétez l'installation de Java System Web Server depuis le début.

L'installation devrait se terminer correctement sans que l'erreur ne se produise de 
nouveau. 
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▼ Erreurs lors de l'installation de Solaris 9 & 10 Sun 
Java System Web Server

Erreur liée à la page d'accueil de Java
Si vous ne parvenez pas à démarrer l'instance de serveur et que des erreurs indiquent 
que le démarrage du point actif a échoué et que votre JVM n'a pas été trouvé, vous 
devez modifier la configuration de la page d'accueil de Java de votre Sun Java System 
Web Server. 

▼ Résolution de l'erreur liée à la page d'accueil de Java Solaris 
Cette procédure permet de résoudre l'erreur liée à la page d'accueil de Java. 

1. Connectez-vous à la console d'administration de Sun Java System Web Server. Voir 
« Connexion à la console d'administration de Java System Web Server » page 556 pour 
plus de détails. 

2. Sélectionnez Home > Common Tasks. 

3. Sous Configuration Tasks, cliquez sur Edit Java Settings. 
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4. Dans la page d'accueil de Java, saisissez le répertoire d'installation de JDK/JRE. Par 
exemple :

/usr/java 

Remarque – Vous devrez peut-être également modifier les droits sur le répertoire de 
niveau supérieur dans lequel vous avez installé Sun Java System Web Server. Pour 
qu'un utilisateur non racine démarre une instance de serveur, l'utilisateur doit être en 
mesure d'écrire dans le répertoire du serveur. Par exemple, si vous avez installé le 
serveur dans le répertoire de niveau supérieur /opt/webserver7, l'utilisateur 
démarrant l'instance de serveur doit être capable d'écrire dans ce répertoire et le 
répertoire https-server_name sous lui. Pour des informations supplémentaires, consultez 
le site de Sun Java System Web Server. 



418605501 • Révision AB  575

     

Index

A
ACSLS 32–33
Action de diagnostic (robot)

contrôle 485
définition 474–478
démarrage 484
description 424–426
enregistrement 481–483
fonctions de contrôle 426
gestion de définitions 479–480
ordre d'accès aléatoire 425
ordre d'accès séquentiel 425
plage d'adresses cibles 424
plage d'adresses de pool 425
sélection du robot 425

Adressage de la bibliothèque de bandes 27
adresse interne de la bibliothèque de bandes 509–

514
bibliothèques de bandes partitionnées et 274–276
FC-SCSI 520–522
HLI-PRC 515–519

adresse FC-SCSI
cellule de stockage 520–522
cellule du CAP 521
lecteur 86, 521

Adresse HLI-PRC
cellule de stockage ??–517

adresse HLI-PRC
cellule de stockage 515–??
cellule du CAP 519
emplacement de lecteur 86, 518

Adresse interne de la bibliothèque de bandes
bibliothèques de bandes partitionnées et 274–276
cellule de stockage ??–512

adresse interne de la bibliothèque de bandes
cellule de stockage 509–??
cellule du CAP 513

AEM
accès d'urgence 504–505
affectation aux partitions 300, 372
association à une partition 331

chargement de cartouches en masse dans une 
partition 334

déchargement de cartouches en masse depuis une 
partition 335

description 17
diagramme des façades 532
état 127
informations de synthèse 126
maintenance sans interruption et 81
partitions de la bibliothèque de bandes et 81, 279–

284
propriétés 130
redéfinir une réservation 337
redémarrage 488
suppression des associations de partitions 336
utilisation pour charger des cartouches en masse 

80
utilisation pour décharger des cartouches en 

masse 80
Affectation des CAP

partitions de la bibliothèque de bandes et 279
Aide de la console d'administration StreamLine 

Library
accès 67
description 67
navigation 67

alertes d'état
affichage 97
description 75
effacement 100

Alimentations 25, 90
état des 189
informations de synthèse 188
refroidissement des 26

Alimentations CC 25
Alimentations électriques

tâches de surveillance 184–189
Association des CAP

partitions de la bibliothèque de bandes et 283, 331
suppression 336, 412

Audits
description 422–423



576   Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

     

ensemble de la bibliothèque de bandes 453–454
initialisation de la bibliothèque de bandes et 501
physiques 422, 453–454, 455–456
plage de cellules 455–456
porte d'accès à l'AEM et 422
porte d'accès et 501
porte d'accès principal et 422
tâches 452–459
vérifiés 423, 458–459

Autotests
bibliothèque de bandes 420, 439
CAP 461
lecteur 467
Robot 471

Autotests de la bibliothèque de bandes 420
réalisation 439

B
bandes de cartouche

exigences 537
Basculer la bibliothèque de bandes en ligne 497–498
Basculer la bibliothèque de bandes hors ligne 495–496
Bibliothèque partitionnée Voirpartitions de la 

bibliothèque de bandes
bloc de configuration

diagramme 533
bloc leader, détaché 543
Bras robotisé

description 89

C
CAP

autotest 461
basculement en ligne 464
basculement hors ligne 462
capacité des 21
état 127
états

partitions de la bibliothèque de bandes et 281
fermeture 77, 135
informations de synthèse 126
maximum 21
mode d'insertion automatique 77

bibliothèques de bandes partitionnées et 280
mode manuel 77
nombre maximum de 21
ouverture 76
partitions de la bibliothèque de bandes et 79, 279–

283, 330–339, 411–417
partitions de la bibliothèque de bandes et partage 

280
propriétés 130
tâches d'utilitaire 460–465
utilisation pour éjecter des cartouches 76
utilisation pour insérer des cartouches 76

CAP des AEM
description 81

CAP manuel 77
Capacité

affectée (dans les bibliothèques de bandes 
partitionnées) 271

autorisée. Voir capacité autorisée.
des modules de la bibliothèque de bandes 7
modifications sans interruption. Voir modifications 

de capacité sans interruption.
physiques 6, 218

Capacité autorisée 217–267
augmentation 224
bibliothèques de bandes non partitionnées et 220
bibliothèques de bandes partitionnées et 220, 271
cartouches orphelines et 221
cellules actives 218
cellules inactives 218
cellules sélectionnées 218
désactivation 220
diminution 224
fichier de clé de licence et 218
incréments de 217
installation 226
minimum et maximum 217
modifications et connexions FC-SCSI 223
modifications et connexions HLI 222
règles d'activation des cellules 220, 271
Zones de stockage actives 218, 219, 220

affectation automatique 220
enregistrement des rapports 239
espace de travail de la console d'administration 

StreamLine Library 243, 254
espace de travail de la console d'administration 

StreamLine Library et 226
impression des rapports 237

capacité autorisée
cartouches orphelines et 263–265
référence des fenêtres 243–267
tâches de gestion 226–240
Zones de stockage actives

affichage 266–267
définition 229–231, 245–253
rapports 235–236, 258–265
validation 232–234, 254–257

Capacité physique 6, 218
des modules de la bibliothèque de bandes 7

Capacity on Demand 217–267
caractéristiques 217
terminologie 218

cartouche
réparation d'un bloc leader détaché 543

Cartouches
cellule initiale 83
chargement en masse 142
déchargement par l'AEM 80



418605501 • Révision AB Index    577

     

déplacements de récupération 84, 151, 153
éjection 84
éjection par le CAP 76
établissement de la liste 146
insertion 83, 138
insertion dans le CAP 83
localisation par l'adresse 84, 149
localisation par l'ID de volume 84, 147
montage et démontage 69
nettoyage. Voir cartouches de nettoyage.
non étiquetées 83
tâches de gestion 137–154

cartouches
application d'étiquettes 545
chargement par l'AEM 80
commande 544
diagnostic 540
éjection d'une partition 335
étiquettes 539
étiquettes valides 538
exigences 537
illisibles 542
insertion dans une cellule ou un lecteur 541
insertion dans une partition 334
insertion par le CAP 76
inversées 542
LTO 540, 543
manipulation 537–??, 541, ??–543
nettoyage extérieur 543
nettoyage. Voir cartouches de nettoyage.
non étiquetées 538, 542
spécifications pour la couleur 537
stockage 544
Sun StorageTek 539, 542

Cartouches de diagnostic 538
éjection 178
insertion 175
pour les lecteurs LTO 540

cartouches de diagnostic
autotests de la bibliothèque de bandes et 420

Cartouches de diagnostic 
pour les lecteurs Sun StorageTek 539

Cartouches de nettoyage 538
description 87
éjection 178
éjection des cartouches obsolètes 87
établissement de la liste 181
état 87
insertion 175
pour les lecteurs LTO 540
stockage de 513

Cartouches de nettoyage 
pour les lecteurs Sun StorageTek 539

Cartouches orphelines
bibliothèques de bandes non partitionnées et 221

bibliothèques de bandes partitionnées et 277, 306, 
401

Cellules de stockage
adresse FC-SCSI 520–522
adresse HLI-PRC 515–517
adresse interne de la bibliothèque de bandes 509–

512
Capacité physique 6
diagramme des façades 525–535

Cellules du CAP
adresse FC-SCSI 521
adresse HLI-PRC 519

cellules réservées 512
diagramme 535

CEM
Capacité physique 7
description 14
diagramme des façades 529

Chemin de contrôle 27–30
Chemin de données 30
Codes de résultat

établissement de la liste 437
Configuration de la bibliothèque de bandes

affichage 104
Console d'administration StreamLine Library

accès initial 40
autonome. Voir Console d'administration 

StreamLine Library autonome
connexion 41
déconnexion 42
description 31, 37
espace de travail des partitions et 289, 320, 382
espace de travail des zones de stockage actives et 

226, 243, 254
Identifiants de connexion 39
mise en page de la fenêtre 43
modes 38
modification de l'affichage à l'écran 45
modification des mots de passe 42
mot de passe d'activation 40
panneau opérateur local. Voir panneau opérateur 

local.
problèmes de communication 73
sécurité 39
Web Voir Console d'administration StreamLine 

Library Web
console d'administration StreamLine Library

description du serveur 547–??
Console d'administration StreamLine Library 

autonome
connexion 54
description 48–55
installation 49–50
installation des mises à jour 55



578   Guide de l'utilisateur du système SL3000 • Mai 2009 Révision AB • 418605501

     

Console d'administration StreamLine Library Web
connexion à Java System Web Server 556–558
connexion à l'aide d'un navigateur 57–62
connexion à l'aide d'une icône 63–66
démarrage sur le serveur 564–565
démarrage sur un client 57
description 56–66
description du serveur ??–574
erreurs lors de l'installation 571
exigences des clients 56
fichier Java WebArchive 547
installation de Java System Web Server 552–555
installation sur le serveur 559–563
mise à jour sur le serveur 566–570
mise à jour sur un client 57
sécurité 56, 547
serveur requis 547
téléchargement de Java System Web Server 548–

551
Console de la bibliothèque de bandes StorageTek. Voir 

Console SL
Console de la bibliothèque de bandes. Voir Console SL
Contrôleur de la bibliothèque de bandes

propriétés 105
Contrôleur des lecteurs 107

D
DEM 11–12

Capacité physique 7
configurations de lecteurs 7
diagramme des façades 527

dépannage 427
déplacements de récupération 84
diagramme des façades

AEM 532
bloc de configuration 533
cellules réservées 535
CEM 529
DEM 527
Module de base 526
numérotation des lignes 534
PEM 531

domaine, étiquettes de support 538

E
Écrans de contrôle des événements

affichage 432
description 419
mis en attente de données dans un fichier 433

écrans de contrôle des événements
affichage de plusieurs 434
tâches 431–437

Emplacements des lecteurs
adresse HLI-PRC 86, 518

État de la bibliothèque de bandes
affichage 96

Événements de la bibliothèque de bandes 419
événements de la bibliothèque de bandes Voir aussi 

écrans de contrôle des événements.
Expiration des licences 194

F
fichier d'instantané de journal

description 429
processus de transfert 449–451

Fichier de clé de licence
affichage du contenu du 198–200
capacité autorisée et 218
comparaison avec les fonctionnalités existantes 

198–200, 212, 214
description 193
écrasement 193
installation 195, 201–204, 209–211, 214
numéro de série de la bibliothèque de bandes et 

193, 199, 203, 210
réception 197
suppression 274
type de fichier 193

fichier MIB
description 429
processus de transfert 447–448

fichiers de support de diagnostic 429
Fonctionnalités de la bibliothèque de bandes 3
Fonctions sous licence

affichage des fonctions actuelles 205, 207
Capacity on Demand 217–267
installation 195, 271
partitionnement 269–417
robot redondant 24
suppression 274

G
Guide de l'utilisateur

Avertissements xxx
conventions xxxi
Mises en garde xxx
Remarques xxx

H
HSC 32–33

I
Identifiants de connexion 39
Indicateurs de santé 71
Interface de ligne de commande 30
Interface FC-SCSI 29, 108
interface FC-SCSI

affichage de l'état des ports 103
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Interface HLI 28–29, 108
affichage de l'état des ports 102

Interface TCP/IP 28–29
Interfaces hôtes

bibliothèques de bandes non partitionnées et 91, 
108

bibliothèques de bandes partitionnées et 91, 269, 
314, 316, 318, 350, 352, 354

FC-SCSI. Voir Interface FC-SCSI. 103
HLI. Voir interface HLI. 102
modification du type 108

J
Java System Web Server

connexion à la console 556–558
installation 552–555
téléchargement 548–551

L
Lecteurs

adressage 86
adresse FC-SCSI 521
autotest 467
basculement en ligne 469
basculement hors ligne 468
données réseau 163
état 160
état des voyants 165
états 86
informations de synthèse 158
maximum 7, 86
nettoyage. Voir nettoyage des lecteurs.
nom universel dynamique 524
numérotation du matériel 523
pris en charge 19
propriétés 161
refroidissement des 26
tâches d'utilitaire 466–469
tâches de gestion 157–171

Lecteurs de bande. Voir lecteurs
Lecteurs de bande. Voir lecteurs.
Logiciel de gestion de la bibliothèque de bandes 32–33
LTO

réparation d'un bloc leader détaché 543

M
Management Information Base. Voir fichier MIB.
Mettre la bibliothèque de bandes hors tension 499
Mettre la bibliothèque de bandes sous tension 500–501
mise hors tension d'urgence. Voir arrêt robotisé 

d'urgence
Mise hors tension de la bibliothèque de bandes 499
Mise sous tension de la bibliothèque de bandes 500–

501

Mises à niveau du microprogramme de la 
bibliothèque de bandes 421
activation 444
téléchargement 442

mises en garde
réinsertion d'une cartouche de nettoyage 538
solvants pour le nettoyage d'une cartouche 543

Mode automatisé (bibliothèque de bandes) 34
description 69
détermination 70
tâches 94–189

Mode automatisé de la bibliothèque de bandes 94–189
Mode d'insertion automatique (CAP)

description 77
partitions de la bibliothèque de bandes et 280

Mode de maintenance (bibliothèque de bandes) 35
Mode endommagé (bibliothèque de bandes) 35
Mode manuel (bibliothèque de bandes) 34
Modes de fonctionnement de la bibliothèque de 

bandes 34–35
modifications de capacité sans interruption. 222
Module d'extension d'accès. Voir AEM.
Module d'extension de cartouche. Voir CEM.
Module d'extension de lecteur. Voir DEM.
Module d'extension de stockage (PEM). Voir PEM.
Module de base

Capacité physique 7
configurations de lecteurs 7
description 8–9
diagramme des façades 526

Modules 4
AEM 17
Capacité 6
CEM 14
DEM 11–12
Module de base 8–9
PEM 16

Mots de passe
modification 42

N
NDP. Voir partitionnement sans interruption.
Nearline Control Solutions 32
Nettoyage automatique (lecteur)

description 88
limites de la SL3000 88

Nettoyage des lecteurs
automatique 88
configuration nettoyage automatique 173
description 87–88
éjection des cartouches de nettoyage 178
état des 182
insertion des cartouches de nettoyage 175
manuel 88, 183
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tâches 172–183
Nettoyage manuel (lecteur) 88, 183
nom universel dynamique 86, 524
nom universel dynamique. Voir dWWN
Nom universel Voir dWWN
Numérotation des lignes, diagramme 534

O
Opérations AEM

synthèse 80–82
tâches 125–136

Opérations CAP
synthèse 76–281
tâches 125–136

opérations CAP
partitions de la bibliothèque de bandes et 280

Opérations d'éjection 84
bibliothèques de bandes partitionnées et 335

Opérations d'insertion 83, 138
bibliothèques de bandes partitionnées et 334

opérations de chargement en masse 142, 334
opérations de déchargement en masse 335
Opérations de démontage 70
Opérations de montage 69
Opérations manuelles

précautions de sécurité 491–493
déclencheur de la porte d'accès 492
générales 491
interruption de l'alimentation du servo-moteur 

492
mécanismes de verrouillage de la porte d'accès 

492
restrictions physiques 493

tâches 494–503
Options d'alimentation CA 25
Options de sources d'alimentation 25

P
Panneau opérateur local

connexion 47
description 46–47
écran tactile 46
pavé numérique 46
saisie de données 46
stylo et stylet 46

partitionnement
sans interruption. Voir partitionnement sans 

interruption.
partitionnement sans interruption

partitions FC-SCSI et 286
partitions HLI et 285

Partitions de la bibliothèque de bandes
affectation d'un CAP des AEM 300
affectation des CAP 279

affichage 241, 328
association des CAP et 283, 331, 336, 412
associations d'AEM 331
CAP partagés et 280, 283
capacité affectée 271
capacité autorisée et 220
caractéristiques 269
cartouches orphelines dans 277, 306, 401
conception 273, 297, 365
configuration requise 269
création 293, 356
délimitations 273
description 269
éjection des cartouches de 335
enregistrement des rapports 327
espace de travail de la Console d'administration 

StreamLine Library et 320, 382
espace de travail de la console d'administration 

StreamLine Library et 289
états des CAP et 281
hôtes et 269, 272, 295, 314, 316, 318, 350, 352, 354
impression des rapports 326
insertion de cartouches dans 334
installation de la fonctionnalité de partitionnement 

271
modifications des informations de synthèse 311, 

360
opérations CAP 280
organisation 271–274
rapports 323–327, 390–410
récapitulatif des tâches 290
référence des fenêtres de conception et de 

validation 362–389
référence des fenêtres de synthèse 341–361
remplacement du matériel de la bibliothèque de 

bandes et 322
réservation des CAP et 282–283, 337–339, 416
ressources de la bibliothèque de bandes 277, 321, 

388
suppression 312, 358
suppression de la fonctionnalité de 

partitionnement 274
tâches de configuration 288, 291–309
utilisation d'AEM dans 279–284
utilisation des CAP dans 79, 279–283
validation 307, 382, 385
vérification 303, 379

partitions. Voirpartitions de la bibliothèque de bandes
partitions. Voirpartitions de la bibliothèque de bandes
PEM

Capacité physique 7
description 16
diagramme des façades 531

port d'accès aux cartouches (CAP). Voir CAP
Porte d'accès

audits et 501
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déclencheur de sécurité 492
fermeture 503
initialisation de la bibliothèque de bandes et 501
mécanismes de verrouillage de sécurité 492
ouverture 502

porte d'accès à l'AEM
accès rapide 504–505
audits et 422, 504, 505

porte d'accès d'AEM 81
fermeture 135

Porte d'accès de l'AEM
description 80

porte d'accès principal
audits et 422
mode automatisé et 70

porte d'accès. Voir porte d'accès de l'AEM ou porte 
d'accès principal.

porte de garage. Voir Porte de sécurité d'AEM.
porte de sécurité d'AEM 81

description 80
état 191
propriétés 192

porte de sécurité de l'AEM
tâches 190–192
tâches d'utilitaire 487–489

porte de sécurité. Voir Porte de sécurité d'AEM.
ports d'accès aux cartouches. Voir CAP.
Précautions de sécurité 491–493
précautions de sécurité

déclencheur de la porte d'accès 492
générales 491
interruption de l'alimentation du servo-moteur 

492
mécanismes de verrouillage de la porte d'accès 492
restrictions physiques 493

Prise en charge de supports mixtes 6

R
Rapport Drive Events 168
Rapport Drive Media Events 170
Rapport Media Events 155
Rapports de la bibliothèque de bandes

affichage 111
enregistrement des données dans un fichier 116
recherche 114

rapports de la bibliothèque de bandes 74
Rapports de la console d'administration StreamLine 

Library
Barre Options 74
Drive Events 168
Drive Media Events 170
Energy Monitor 118, 120, 122
Media Events 155
types 74

Rapports Energy Monitor 118, 120, 122
RealTimeGrowth 217
redémarrage

bibliothèque de bandes 440
Redémarrage de la bibliothèque de bandes 440
Redondance de l'alimentation 25
Référence des fenêtres de gestion des licences 206–215
Refroidissement 26
réparation d'un bloc leader détaché 543
Réservation des CAP

bibliothèques de bandes partitionnées 281
partitions de la bibliothèque de bandes et 282–283
redéfinition 337–339
suppression 416

Robot
action de diagnostic. Voir action de diagnostic.
autotest 471
basculement en ligne 473
basculement hors ligne 472
description 22–24
état des 186
informations de synthèse 185
propriétés 187
redondant 24
scanner de codes à barres 23

défectueux 542
tâches d'utilitaire 470–486
tâches de surveillance 184–189

S
Séquence d'initialisation de la bibliothèque de bandes 

500
bloc de configuration et 533

SLC. Voir Console SL
SNMP

prise en charge par la bibliothèque de bandes de 
30

transfert du fichier MIB de la bibliothèque de 
bandes 447–448

Status Module. Voir alertes d'état.
Statut du périphérique

établissement de la liste des codes 435
support

étiquettes d'identifiant 538
étiquettes de domaine 538

Systèmes électroniques de la bibliothèque de bandes
refroidissement des 26

T
T9940

réparation d'un bloc leader détaché 543
Tâches d'utilitaire de la bibliothèque de bandes 438–

451
Tâches de gestion de la bibliothèque de bandes 95–117
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Tâches de gestion des licences 195–205
TallBot. Voir robot.
Technologie Any cartridge, Any slot 6
Technologie CenterLine 4, 507
Tiroirs des lecteurs 20

état 167
transfert du fichier d'instantané de journal 449–451

V
VOP

affichage pour les lecteurs T10000 162
VOP des lecteurs

affichage pour T10000 162

Z
Zones de stockage actives

affectation automatique 219, 220
affectation manuelle 219
affichage 266–267
définition 229–231, 245–253
enregistrement des rapports 239
espace de travail de la console d'administration 

StreamLine Library 243, 254
espace de travail de la console d'administration 

StreamLine Library et 226
impression des rapports 237
rapports 235–236, 258–265
validation 232–234, 254–257
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